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CH-1   
Management Information Systems 

 
 
1. INTRODUCTION : 
 
1.1 Organization 
Organizations are formal social units devoted to the attainment of specific goals. 
Organizations use certain resources to produce outputs and thus meet their goals. For 
example, a business firm that produces semiconductor memory chips consumes certain 
resources (money, materials, labor, machinery, and information) and aims to meet 
certain financial objectives. A nonprofit hospital applies its resources to provide health 
care to its target population.  
Although the type of organization would largely depend on the size and nature of the 
enterprise, yet there are 4 common forms of organizational structure, namely 
(a) line organization 
(b) functional organization 
(c) line and staff organization 
(d) committee organization 

(a) Line organization : This is one of the oldest and simplest form of organizational 
structures and is also known as scalar organization, military organization, vertical 
organization or departmental organization. Under this organization structure, the line of 
authority flows vertically from the top most executive to the lowest subordinate. The 
authority concentrates in the hands of the topmost executive who delegates it to his 
subordinates, the subordinates delegate to their subordinates and so on. Thus the 
authority reduces at each successive level down the organization. The line organization 
is thus based on the superior – subordinate relationship. 

(b) Functional organization : As the name suggests, under this type of organizational 
structure, all activities in the organization are grouped together according to basic 
functions like production, marketing, finance, human resource etc. Each function is put 
under the charge of a specialist who is fully responsible for carrying out the function for 
the entire enterprise. The authority flows functionally to the divisional heads. The 
divisional heads report to one specialist with reference to one function and to another, 
for another function 

(c) Line and staff Organization : This type of organization has been evolved to achieve the 
advantages of the two forms of the organizational structures mentioned above. While the 
line organization insists too much on the unity of command, the functional organizational 
emphasizes too much on the decentralization of control. In order to strike a balance, line 
and staff organizational structure has been evolved. In this form of organization, the 
structure is basically that of the line organization but functional experts are provided to 
advise line authorities in the performance of their duties 

(d) Committee organization : In today’s complex business world, each activity taken out by 
any department affects the work of other departments. A slight change in production 
policy will affect the sales department. Similarly, change in the sales policy or a new 
sales policy, cannot be followed by the sales managers, without consulting the finance 
department or the production department.  
It should therefore be well understood that important policy decisions, which affect other 
departments should not be taken by the in-charge of the department alone, but they 
should be referred to a committee consisting of the managers of the affecting 
departments. It ensures co-operation and better co-ordination. Thus committee 
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organization is extensively used to solve the multifaceted problems of large and complex 
business units. Committee is a group of individuals especially designated to take the 
decision in matters referred to it through free interchange of ideas among its members. 
 
1.2 Management 
Management can be seen as a function, a process, a profession or a class of people. 
And along with material, capital and labour, management is considered as a resource. It 
refers to the kind of tasks and activities that are performed by managers. The specific 
natures of activities are determined by such managerial functions as planning, 
organizing, directing and controlling. In fact, management is a process of achieving an 
organization’s goals and objectives by making the fullest use of available resources like 
men, materials, machines, money, methods etc.   
 
1.3  Functions of Management :- 
The various functions of management are briefly defined as follows :  
(a) Planning : It is the process of deciding in advance the courses of action to be 
followed, when and also, how to undertake these actions. Planning involves selecting 
missions and objectives and the actions to achieve them; it requires decision making, 
that is, choosing future courses of action from among alternatives. There are various 
types of plans, ranging from overall purposes and objectives to the most detailed actions 
to be taken, such as ordering a special stainless steel bolt for an instrument or hiring and 
training workers for an assembly line. No real plan exists until a decision — a 
commitment of human or material resources or reputation — has been made. Before a 
decision is made, all that exists is a planning study, analysis, or a proposal; there is no 
real plan.  
(b) Organising : It refers to the grouping of people and activities in order to facilitate 
the achievement of the organizational objective. People working together in groups 
achieve some goal must have roles to play, much like the parts actors fill in a drama, 
whether these roles are ones they develop themselves, are accidental or are defined 
and structured by someone who wants to make sure that people contribute in a specific 
way to group effort. The concept of a "role" implies that what people do have a definite 
purpose or objective; they know how their job objective fits into group effort, and they 
have the necessary authority, tools, and information to accomplish the task. 
Organizing, is that part of managing that involves establishing an intentional structure of 
roles for people to fill in an organization. It is intentional in the sense of making sure that 
all the tasks necessary to accomplish goals are assigned and, it is hoped, assigned to 
people who can do them best.  
 
The purpose of an organization structure is to help in creating an environment for human 
performance. It is, then, a management tool and not an end in and of itself. Although the 
structure must define the tasks to be done, the roles so established must also be 
designed in the light of the abilities and motivations of the people available.  
 
Designing an effective organization structure is not an easy managerial task. Many 
problems are encountered in making structures fit situations, including both defining the 
kind of jobs that must be done and finding the people to do them.  
 
(c) Controlling : Control is the mode of checking the progress of plans and also, 
correcting any deviations that may occur along the way. Controlling is the measuring 
and correcting of activities of subordinates to ensure that events conform to plans. It 
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measures performance against goal and plans, shows where negative deviations exist, 
and, by putting in motion actions to correct deviations, helps ensure accomplishment of 
plans. Although planning must precede controlling, plans are not self-achieving. Plans 
guide managers in the use of resources to accomplish specific goals; then activities are 
checked to determine whether they conform to the plans.  
 
Control activities generally relate to the measurement of achievement. Some means of 
controlling, like the budget for expense, inspection records, and the record of labor-hours 
lost, are generally familiar. Each measures and each shows whether plans are working 
out. If deviations persist, correction is indicated. But what is corrected? Nothing can be 
done about reducing scrap, for example, Activities through persons or buying according 
to specifications, or handling sales returns unless one knows who is responsible for 
these functions. Compelling events to conform to plans means locating the persons who 
are responsible for  results  that  differ  from  planned  action  and  then  taking the 
necessary steps to improve performance. Thus, outcomes are controlled, by controlling 
what people do.  

 
(d) Directing : It is the process of activating the plans, structure and group efforts in 
the desired direction. It is needed for implementation of plans by providing the desired 
leadership, motivation and proper communication. This includes staffing and leading. 
Staffing involves filling, and keeping filled, the positions in the organization structure. 
This is done by identifying work-force requirements; inventorying the people available; 
and recruiting, selecting, placing, promoting, appraising, planning the careers of, 
compensating, and training or otherwise developing both candidates and current job 
holders to accomplish their tasks effectively and efficiently.  
Leading is the influencing of people so that they will contribute to organization and 
group goals; it has to do predominantly with the interpersonal aspect of managing. All 
managers would agree that their most important problems arise from people — their 
desires and attitudes, their behavior as individuals and in groups — and that effective 
managers also need to be effective leaders. Since leadership implies followership and 
people tend to follow those who offer a means of satisfying their own needs, wishes, and 
desires. It is understandable that leading involves motivation, leadership styles and 
approaches, and communication.  
 
Management can be grouped into three hierarchical levels - top, middle and junior 
management levels.  
Top (or strategic) management establishes the policies, plans and objectives of the 
organization as well as a budget framework under which various departments will 
operate.  
Middle (or tactical) management has the responsibility of implementing the policy and 
overall plans of the top management.  
Junior (or operational) management has the responsibility of implementing day-to-day 
operations and decisions of the middle management to produce goods and services to 
meet the revenue, profit and other goals, which in turn will enable the organization to 
achieve its overall plans and objectives.  
 
1.4  Levels Of Management :- 
Each organization is made up of several levels. These could be classified broadly into 
three categories : top, middle and junior management levels.  
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The top management performs strategic planning and the other two levels provide 
support in the form of processed information. The middle management level performs 
tactical planning and control, and needs information to discharge these managerial 
functions. The junior level is involved in day-to-day operational control and needs 
information for its working.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
(a) Strategic Planning : This level develops the strategy for deciding the objectives of the 

organization, planning resources to be used in order to attain those objectives, 
formulating policies to govern, use and disposition of the resources 

(b) Management Control : It is required by managers of various departments to measure 
performance, decide on control actions, formulate new decision rules and also allocate 
resources. 

(c)    Knowledge and Data Management : It is required by managers of various departments 
to support the organizations knowledge and data workers, to integrates new knowledge 
into the business.  Knowledge systems especially in the form of workstations and office 
systems are among the most widely used office systems.  

(d)    Operational control : It is the process of ensuring that operational activities are carried 
out to achieve optimum use of resources. It makes use of pre-established procedures 
and decision rules. 

 

Management Control 

Strategic 
Planning 

Operational Control 

Top 

Middle 

Junior 
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1.5  Managerial skills and the organizational hierarchy : 
 
The four kinds of skills required for manager or administrators  are : 
 
1. Technical skill is knowledge of and proficiency in activities involving methods, 

processes, and procedures. Thus, it involves working with tools and specific 
techniques. For example, mechanics work with tools, and their supervisors should 
have the ability to teach them how to use these tools. Similarly, accountants apply 
specific techniques in doing their job. 

2.  Human skill is the ability to work with people; it is co-operative effort; it is teamwork; 
it is the creation of an environment in which people feel secure and free to express 
their opinions. 

3.  Conceptual skill is the ability to see the “big picture," to recognize significant 
elements in a situation, and to understand the relationships among the elements. 

4.  Design skill is the ability to solve problems in ways that will benefit the enterprise. To 
be effective, particularly at upper organizational levels, managers must be able to do 
more than see a problem. They must have, in addition, the skill of a good design 
engineer in working out a practical solution to a problem. If managers merely see the 
problem and become "problem watchers," they will fail. Managers must also have 

Sector Operations Tactics Strategy 

Production • Machine settings 
• Worker schedules 
• Maintenance sch. 

• Rearrange work area 
• Schedule new products 
• Change inventory method 

• New factory 
• New products 
• New industry 

Accounting • Categorize assets 
• Assign expenses 
• Produce reports 

• Inventory valuation 
• Depreciation method 
• Finance short/long term 

 
• Debt vs. equity 
• International taxes 

Marketing • Reward salespeople 
• Survey customers 
• Monitor promotions 

• Determine pricing 
• Promotional campaigns 
• Select marketing media 

• Monitor competitors 
• New products 
• New markets 

 

Transactions, 
accounting, human 
resource management, 
inventory. 

Scheduling 
employees, 
ordering supplies. 

Day-to-day actions to keep 
the company functioning. 

Operations 

Expenses, schedules,
sales, models, 
forecasts. 

New tools to cut 
costs or improve 
efficiency. 

Improving operations 
without restructuring the 
company. 

Tactical 

External events, rivals, 
sales, costs quality, 
trends. 

New product that 
will change the 
industry. 

Competitive advantage, 
become a market leader. 
Long-term outlook. 

Strategic 

Type of Information Example Description Decision 
Level 
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that valuable skill of being able to design a workable solution to the problem in the 
light of the realities they face. 

 
The relative importance of these skills may differ at various levels in the organization 
hierarchy. The technical skills are of greatest importance at the supervisory level. 
Human skills are also helpful in the frequent interactions with subordinates. Conceptual 
skills, on the other hand, are usually not critical for  
lower-level supervisors. At the middle-management level, the need for technical skills 
decreases; human skills are still essential; the conceptual skills gain in importance. At 
the top management level, conceptual and design abilities and human skills are 
especially valuable, but there is relatively little need for technical abilities. It is assumed, 
especially in large companies, that chief executives can utilize the technical abilities of 
their subordinates. In smaller firms, however, technical experience may still be quite 
important. 
 
 

 
 
 
1.6  The Goal of All Managers :- 
 
Managers must establish an environment in which people can accomplish group goals 
with the least amount of time, money, materials, and personal dissatisfaction or in which 
they can achieve as much as possible of a desired goal with available resources. In a 
non-business enterprise such as a police department, as well as in units of a business 
(such as an accounting, department) that are not responsible for total business profits, 
managers still have goals and should strive to accomplish them with the minimum of 
resources or to accomplish as much as possible with available resources. 
 
Productivity, Effectiveness, and Efficiency : 
 
Another way to view the aim of all managers is to say that they must be productive.   
 
Definition of productivity :  Successful companies create a surplus through productive 
operations. Although there is not complete agreement on the true meaning of 
productivity, we can define it as the output-input ratio within a time period with due 
consideration for quality.  It can be expressed as follows: 
 
Productivity  = [outputs / input ]  (within a time period, quality considered) 



Srinivas MBA : MIS  2009 
 

7 
 

The formula indicates that productivity can be improved (1) by increasing outputs with 
the same inputs, (2) by decreasing inputs but maintaining the same outputs, or (3) by 
increasing outputs and decreasing inputs to change the ratio favorably. Companies use 
several kinds of inputs, such as labor, materials, and capital. "The greatest opportunity 
for increasing productivity is surely to be found in knowledge work itself, and especially 
in management."" 
 
Definitions of effectiveness and efficiency  Productivity implies effectiveness and 
efficiency in individual and organizational performance. Effectiveness is the 
achievement of objectives. Efficiency is the achievement of the ends with the least 
amount of resources. Managers cannot know whether they are productive unless they 
first know their goals and those of the organization. 
 
Management as a control system :- 
Planning, organizing, directing and controlling are the various steps in the management 
process.  All steps prior to a control are necessary but are not necessarily self assuring the 
results unless it is followed by a strong control mechanism. Management experts have 
viewed these steps as management control system. 
A definition of control is the process through which managers assure that actual activities 
conform to the planned activities, leading to the achievement of the started common 
goals.  
The control process measures a progress towards those goals, and enables the manager to 
detect the deviations from the original plan in time to take corrective actions before it is 
too late. 
 
The basic steps of the control process : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Early warning mechanism : Predicting the possibility of achieving the goals and 
standards before it is too late and allowing the manager to take corrective actions. 
2.   Performance Standard : The performance standard must be measurable and 
acceptable to all the organizations. The system should have meaningful standards relating 
to the work areas, responsibility, managerial functions and so on.  
3.  Strategic controls : Critical success factors. The system should recognize & control 
them.     

Not  OK 

Establish 
standards of 
performance 

Measure 
Performance 

Actual 
Vs 
standard 

Corrective 
action 
 

No action 

O.K. 
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4. Feedback : The control system would be effective, if it continuously monitors the 
performance and sends the information to the control center for action. It should not only 
highlight the progress but also the deviations. 
5.  Accurately and timely : The feedback should be accurate in terms of results and 
should be communicated on time for corrective action. 
6.   Realistic : The system should be realistic so that the cost of control is far less than the 
benefits. The standards are realistic and are believed as achievable. Sufficient incentive 
and rewards are to be provided to motivate the people. 
7. Information flow : The system should have the information flow aligned with the 
organisation structure and the decision makers should ensure that the right people get the 
right information for action and decision making.    
8.  Exception principle : The system should selectively approve some significant 
deviations from the performance standards on the principle of management by exception. 
 
 
What is Data ? 
Data is a series of non-random symbols, numbers, values or words, a series of facts 
obtained by observation or research, a collection of non-random facts, the record of an 
event or fact. 
Examples of Data : 
Today’s date, Measurements taken on a production line, Records of business 
transactions. 
What is Information ? 
Data that has been processed so that they are meaningful. Data that has been 
processed for a purpose. Data that has been interpreted and understood by the 
recipient. 
Examples of Information 
A bank statement, A sales forecast, A telephone directory. 
 
Information involves transforming data using a defined process, Involves placing data in 
some form of meaningful context, Is produced in response to an information need and 
hence serves a specific purpose, Helps to reduce uncertainty, thereby improving 
decision behaviour. 
Data Transformation Process involves Classification, Rearranging / sorting, Aggregating, 
Performing calculations, Selection. 
 
 
 
 
 
 
 
Value of Information : 
1. Tangible Value 
Can be measured directly, usually in monetary terms. 
Tangible value  = Benefit of Information – Cost of gathering it. 
2. Intangible Value 
Difficult to measure or impossible to quantify. 

Data 
Data Transformation 

 process 

 

Information 
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Intangible Value = Improvement of decision behaviour – Cost of gathering it. 
Qualities of Information : 
1. Time dimension 
2. Content dimension 
3. Form dimension 
4. Additional characteristics 
Attributes of Information Quality :  
 
 
 
 
 
 
 
 
 
 
What is a System ? 
It is a collection of interrelated components that works together towards a collective goal. 
Its function is to receive inputs and transform them into outputs.  
System Components 
1. Input  2. Process   3. Output  4. Feedback  5. Control mechanism. 
 
What is Information System ? 
An organized combination of People, Hardware,  Software, Communication networks, 
and Data resources, that collects, transforms and disseminates information in an 
organization. 
 
FUNCTIONS OF INFORMATION SYSTEM :  
The information systems function represents : 
1. It is a major functional area of a business as like accounting, finance, operations 
management, marketing, marketing, and HRM. 
2. It is an important contributor to operational efficiency, employee productivity and 
morale, and customer service and satisfaction. 
3. It is a major source of information and support needed to promote effective decision 
making by managers. 
4. It is an important ingredient in developing competitive products and services that give 
an organization a strategic advantage in the global marketplace. 
5.  It is a major part of the resources of an enterprise and its cost of doing business, thus 
posing a major resource management challenge. 
6.  A vital, dynamic, and challenging career opportunity for millions of men and women.  
 
2. Evolution of MIS :- 
 
Earliest use of  Information System was recorded during third millennium BC in a 
Sumerian Temple. They used clay tablets for recording receipts and issues of grains to 
the individual workers. The industrial revolution and growth in business industry along 
with development of accounting systems, organization size, and development of 

Confidence in source 
Reliability 
Appropriate 
Received by correct person 
Sent by correct channels 

Clarity 
Detail 
Order 
Presentation 
Media 

Accuracy 
Relevance 
Completeness 
Conciseness 
Scope 

Timeliness 
Currency 
Frequency 
Time period 

Additional Characteristics Form Content Time 
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computing technology have ensured the fast growth of information systems during the 
last few centuries. 
 
As business grows (from sole trading firms to global corporations), it is found impossible 
to a manager to visit all his organizations facilities, plants and warehouses. It was the 
information system that kept informed of this organizations activities. A full fledged 
information system requires in an organization to collect data at source measured with 
precision, process it immediately and keep all its file updated to feed the managers, with 
most current, highly accurate information 
 

Data is used in the form of raw material and must be subjected to manipulation or 
processing to produce useful information. An information system produces information 
using data.   

If information system produces information, which is useful for managers in planning, 
organizing, directing and controlling of the organization, then such system is called 
“Management Information System”.  

 
The information provided by MIS supports the manager to take structured (or 
programmed) decisions which are those that are based on predictable patterns of 
activity. 

Definition of MIS : 
MIS can be defined as a system that  
(a) provides information to support managerial functions like planning, organizing, 

directing, controlling.  
(b) collects information in a systematic and a routine manner which is in accordance 

with a well defined set of rules.  
(c) includes files, hardware, software and operations research models of processing, 

storing, retrieving and transmitting information to the users.  
 
Objectives of MIS : 
 
(a) Facilitate the decisions-making process by furnishing information in the proper time 

frame. This helps the decision-maker to select the best course of action.  
(b) Provide requisite information at each level of management to carry out their 

functions.  
(c) Help in highlighting the critical factors to the closely monitored for successful 

functioning of the organization.  
(d) Support decision-making in both structured and unstructured problem 

environments.  
(e) Provide a system of people, computers, procedures, interactive query facilities, 

documents for collecting, storing, retrieving and transmitting information to the 
users. 

Components of MIS : 
 
As predicted by McLeod, in 1986, a typical MIS is based on four major components. 
They are :  

(a) Data gathering – data required to the operations of the organization have to 
be gathered from both internal and external sources. 
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(b) Data entry – stored in databases. 
(c) Data transformation – in to useful information by means of computer 

programs and judgments made by technical staff and other system users. 
(d) Information utilization – applied to decision making process related to 

organizations operation. 
 

Functions of MIS : 
(a) Collect data – Internal data can be collected from company records or reports, 

marketing data, financial data, production data, personnel data and information 
compiled by manager themselves. External sources include trade publications, 
customers and consultants, government data, technology data, social change 
data, Economic data  etc.. 

(b) Store and process data – using computers. 
(c) Present information to Managers – for their use. 

 
Resources of MIS : 
 
People, hardware, software, data, and networks are the five basic resources of 
information systems.  
 
1. People resources include end users and IS specialists, hardware resources consist of 
machines and media, software resources include both programs and procedures, data 
resources can include data and knowledge bases, and network resources include 
communications media and networks.  
 
2. Data resources are transformed by information processing activities into a variety of 
information products for end users.  
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3. Information processing consists of input, processing, output, storage, and control 
activities.  
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Characteristic of MIS : 
 
(a) Management oriented :  
 
∗ The system is designed from the top to work downwards. It does not mean that the 

system is designed to provide information directly to the top management.  
 
∗ Other levels of management are also provided with relevant information.  

(b) Management directed :  

∗ Because of management orientation of MIS, it is necessary that management should 
actively direct the system development efforts.  

∗ In order to ensure the effectiveness of system designed, management should 
continuously make reviews.  

      For example, in the marketing information system, the management must determine 
what sales information is necessary to improve its control over marketing 
operations.  

(c) Integrated :  
The word 'integration' means that the system has to cover all the functional areas of an 
organization.  

It has to consider various sub systems, their objectives, information needs, and 
recognize the interdependence, that these sub-systems have amongst themselves, so 
that common areas of information are identified and processed without repetition and 
overlapping.  
 

For example, in the development of an effective production scheduling system, a proper 
balance amongst the following factors is desired :  

(i) set up costs  
(ii) manpower 
(iii) over time 
(iv) production capacity 
(v) inventory level 
(vi) money available 
(vii) Customer service.  

 

(d) Common data flows :  

Because of the integration concept of MIS, common data flow concept avoids repetition 
and overlapping in data collection and storage, combining similar functions, and 
simplifying operations wherever possible.  

For example, in the marketing operations, orders received for goods become the basis 
of billing of goods ordered, setting up of the accounts receivable, initiating production 
activity , sales analysis and forecasting, etc.  
 
(e) Heavy planning element :  
A management information system cannot be established overnight. It takes almost 2 to 
4 years to establish it successfully in  an organization. Hence, long-term planning is 
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required for MIS development in order to fulfill the future needs and objectives of the 
organization.  
The designer of an information system should therefore ensure that it will not become 
obsolete before it actually gets into operation.  
An example of such a feature of MIS may be seen in a transportation system where a 
highway is designed not to handle today's traffic requirements but to handle the traffic 
requirements five to ten years.  
 
(f) Flexibility and ease of use :  
∗  While building an MIS system all types of possible means which may occur in future 
are added to make it flexible.  
 
∗   A feature that often goes with flexibility is the ease of use.  
 
∗  The MIS should be able to incorporate all those features that make it readily 
accessible to a wide range of users with easy usability. 
 
Role of MIS : (Information needs at different levels of Management) : 
      
The role of MIS in an organization can be compared to the role of the heart. 
MIS           =     Heart 
Data         =      Impure blood 
Information =    Pure blood 
 
∗  The system is expected to fulfill the information needs of an individual, group of 

individuals, managers etc.  
 
MIS satisfies diverse needs through a variety of systems such as : 
     query systems,  
     analysis systems,  
     modeling systems,  
     decision support systems etc. 
 
Bottom Level :  
 
∗  MIS helps operational management by providing operational data for planning, 
scheduling, controlling and also helps them further in decision making at the operational 
level to correct an out of control situation.  
 
∗  Operational information pertains to the day-to-day activities of the organization and 
helps to assure that specific tasks are performed efficiently and effectively.   
 
∗  It include the production of routine and necessary information, such as financial 
accounting, payrolls, personal rosters, equipment inventories, and logistics.   
 
∗  Operation level require information for the purpose of conversion of inputs into 
outputs.  Also it supplies routine and other information to tactical tier in summarized 
form. 
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Middle Level : 

∗  MIS helps middle level management in short term planning, target setting and 
controlling the business functions.  

∗ The tactical decisions are directed towards developing divisional plans, structuring 
workflow, establishing distribution channels, acquisition of resources such as men, 
materials and money.  

∗ The tactical information helps managers to see that the resources are being used 
efficiently and effectively to meet the strategic objectives of the organization.  
 

Such information include productivity measurement (output per man-hour or per 
machine-hour), budgetary control, or variance analysis reports, cash flow forecasts, 
manning levels and profit results within a particular department of the organization, 
labour turn-over statistics within a department, short-term purchasing requirements etc.  

A large proportion of this information will be generated within the organization using 
feedback between different departments.  Tactical information is usually prepared 
regularly – perhaps weekly, or monthly and is used for decision making referred to as  
management control. 
 
Top Level : 
 
MIS helps top management in goal setting, strategic planning and also evolving the 
business plans in addition to their implementation.  
 
Strategic planning depends heavily upon information external to the organization.  
 
When this is combined with internal data, management can make estimates of expected 
results. The specifics of this information are often unique and tailor made to particular 
strategic problems.  
 
MIS in-fact plays the role of information generation, communication, problem 
identification and helps in the process of decision making.  
 
Impact of MIS : 
 
∗ The manager is kept alert by providing certain information indicating the probable 
trends in the various aspects of business.  
 
This helped in forecasting and long term perspective planning.  
 
∗ The managers attention is brought to a situation which is exceptional in nature, 
inducing him to take action or a decision in the matter.  
 
Expanding roles of the business applications of  information systems : 
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Operations and management classifications of  information systems : 
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Operations Support Systems : 
 
Operations Support Systems are used to process data generated by, and used in, 
business operations. The role of a business firm's operations support systems is to 
efficiently process business transactions, control industrial processes, support enterprise 
communications and collaboration, and update corporate databases.  
 
1. Transaction Processing Systems 
 
They record and process data resulting from business transactions. They process 
transactions in two basic ways.  
 
In batch processing, transactions data are accumulated over a period of time, and 
processed periodically.  
 
In real-time (or online) processing, data are processed immediately after a transaction 
occurs.   
 
For example, point-of-sale (POS) systems at many retail stores use electronic cash 
register terminals to electronically capture and transmit sales data over 
telecommunications links to regional computer centers for immediate (real-time) or 
nightly (batch) processing.  
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2. Process control systems : 
 
Process control systems monitor and control physical processes.  
 
For example, a petroleum refinery uses electronic sensors linked to computers to 
continually monitor chemical processes and make instant (real-time) adjustments that 
control the refinery process.  
 
3. Enterprise Collaboration Systems : 
Enterprise collaboration systems enhance team and workgroup communications and 
productivity, and are sometimes called office automation systems.  
 
For example, knowledge workers in a project team may use electronic mail to send and 
receive electronic messages, and videoconferencing to hold electronic meetings to 
coordinate their activities.  
 
B. Management Support Systems  
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When information system applications focus on providing information and support for 
effective decision making by managers, they are called management support systems.  
Conceptually, several major types of information systems support a variety of decision-
making responsibilities: 

(1) Management information systems,  
(2) Decision support systems, and  

      (3) Executive information systems. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enterprise collaboration systems 
 
1. Management Information Systems 
 
MIS provide information in the form of reports and displays to managers and many 
business professionals.   
 
For example, sales managers ,may use their networked computers and Web browsers 
to get instantaneous displays about the sales results of their products and to access 
their corporate intranet for daily sales analysis reports that evaluate sales made by each 
salesperson.  
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The components and activities of  management information systems. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
2. Decision Support Systems 
 
Decision support systems give direct computer support to managers during the decision- 
making process.  For example, advertising managers may use an electronic 
spreadsheet program to do what-if analysis as they test the impact of alternative 
advertising budgets on the forecasted sales of new products.  
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3. Executive  Information Systems 
 
EIS provide critical information from a wide variety of internal and external sources in 
easy-to-use displays to executives and managers.  For example, top executives may 
use touch-screen terminals to instantly view text and graphics displays that highlight key 
areas of organizational and competitive performance.  
 
Other Classifications of Information Systems : 
 
Expert systems can provide expert advice for operational chores like equipment 
diagnostics, or managerial decisions such as loan portfolio management.   
 
Knowledge management systems are knowledge based information systems that 
support the creation, organization, and dissemination of business knowledge to 
employees and managers throughout a company.  Information systems that focus on 
operational and managerial applications in support of basic business functions such as 
accounting or marketing are known as Functional business systems.   
 
Strategic information systems apply information technology to a firm's products, 
services, or business processes to help it gain a strategic advantage over its 
competitors.  
 
Assignment 1 :  
 
1. What are the different levels of management in an organization ? What types of 
information required in each level for effective decision making ?                      
2. Define Management Information System ? Explain various characteristics of MIS 
3. Write a note on impact of information system on an organizational effective ness. 
4. What are the different types of Information Systems ? Explain each of them ? 
 

*************************** 
 
 
 
 

Case Study 1  - E-Seva 

eSeva - an online community bill payment system, is Andhra Pradesh Government 
initiative to deliver government information and services online to the state's citizens. 
The service will provide real-time utility bill payments for water, electricity, telephone, 
municipal taxes, birth and death certificates, passport applications, permits and licenses, 
transport department services and other G2C (government-to-citizen) services 
(http://www.esevaonline.com) 

eSeva is a brain child of chief minister Mr. Chandra Babu Naidu and kicked off in 1999 
at Hyderabad. In August 2001 19 centres were started in the cities of Hyderabad and 
Secunderabad. At present there are 35 eSeva centres (with 280 service counters) The 
whole concept is based on real-time utility payment system, which is very common in 
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western world. eSeva has tied-up with ICICI bank, HDFC bank, Global Trust bank and 
UTI bank for online payments.  

The main data centre for eSeva is at Khairatabad, which is used to store all information, 
facilitate transaction and update local department servers. The citizen service centre and 
governmental departments are linked to main WAN through a LAN.  

eSeva is based on three-tier network architecture. Transactions are conducted on a real-
time basis. Departmental servers are connected to the data centre, which in turn is 
connected to the eSeva centres. Leased lines, with back-up ISDN lines, connect the 
departmental servers to the eSeva data centre. Transactions done at the eSeva centres are 
recorded directly on the server of the department concerned. 

 
 

Fig. 1: E-Seva 

 
Case Study 2 - Farmer Service Centre (FSC's)  

India is an agricultural based economy. Agri industry in India contributes over 30% of 
the GDP (gross domestic product). Farmer Service Centre (FSC's) is a pioneering concept 
nourished by government of India. Farmers and rural residents are benefited from a 
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common customer computer data base and smart card, which can be used for remote 
transactions. There are over 2 billion smart cards in use around the world. These 
enhancements to the information system will lead to rural customers being able to access 
their individual records, apply for loans and other transactional services using their 
smart card. FSC's is a major step to provide more convenience and quality service to 
rural consumers.  

FSC's is one-stop-shop for farmers to make purchases of raw materials, sell there goods 
and financial transactions. All the information related to farmer is stored on his unique 
smart card. Smart cards are safe to use. Through smart card farmers can access e-cash, it 
is a payment system which offers an alternative to paying cash for goods and services. 
Smart cards can be used for storing and dispensing cash electronically, making bills and 
coins lesser necessary and farmers can do money transaction in fast, secure way. It 
transfers funds over phone lines (which are in-turn connected to bank), making it easier 
to reload farmers smart cards. This acts as a electronic purse that allows person-to-
person payments. The telephone or internet link makes payments possible anywhere. 
Mainly all the activity are controlled and monitered by FSC's, which provide assistance 
and guidance to farmers to use smart cards for their transactions.  

All FSC's are connected to bank/financial institution through high speed, secured 
internet link. Farmers can top up there e-purse or make deposits to there banks accounts 
from FSC's. These FSC's also acts as the information centre for the government. 
Government can gather large amount of accurate rural data, also farmers can get the 
latest governmental policies like rates of crops, seeds, subsidies etc.  

Other than banking transactions, these smart cards can be used in retail payments, 
vehicle registration, farmer unique ID (citizen ID), e-governance, driving license, health 
records and for maintaining previous crops records of farmers. These farmer service 
centres, can be used as central body in monitoring and implementing of welfare schemes 
such public distribution systems, health, education & training to villagers.  
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Fig. 2: Farmer Service Centre 

 
 
 

Business Case 3 :  
 

California Pizza controls costs with IS 
 
California Pizza Kitchen (CPK) started out in 1985 as a venture by two former federal 
prosecutors who wanted to do something different. They decided to sell "designer 
pizza" in which the pizza dough is a "canvas" for exotic food toppings such as Thai 
chicken, shrimp pesto, Peking duck, or southwestern burritos.  By offering stylish 
entrees costing less than $10 in a sit-down setting, CPK mushroomed into a national 
chain of 70 restaurants in only nine years, with PepsiCo buying half-ownership in 1992. 
 
Success did not come easily to this Los Angeles-headquartered chain.  The restaurant 
business is a high-risk industry with many factors that are beyond their control-like 
:swelling competition, fickle customer tastes, and rising real estate costs.  Thus, 
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restaurants need to tightly control food and labor costs to remain profitable-without 
affecting the quality of their food or service. 
 
CPK company is poised for another take-off. It hopes to expand to 700 restaurants by 
using information systems to control food costs and make employees more productive.  
Since diners are turned away by high prices, the only way to control costs is through 
inventory and portion control -keeping precise track of the amount of ingredients used 
in each menu item and stocking only as much of these ingredients as each restaurant 
actually needs. 
 
All California Pizza Kitchen restaurants installed point-of-sale (POS) devices, which 
capture data about each item sold at the time the sale takes place. The sales data and 
inventory reports prepared by restaurant managers are transmitted from each restaurant 
to the company's central computer, where the information is consolidated and analyzed. 
An application called Inventory Express "remembers" ordering patterns, such as the 
amount of lettuce a restaurant needs each week, and also compares the amount of each 
item used to what each restaurant actually sold.  If, for example, a restaurant sold 100 
Thai shrimp pizzas in one week, it should have used a predetermined amount of 
shrimp, such as 40 pounds, based on portion measurements established by CPK 
management.  
 
Using more shrimp would indicate a problem with over portioning or waste. 
Restaurants with out-of-line portions would be told to take corrective action.  The POS-
derived data is used for other purposes besides portion control. CPK's restaurant 
operations group uses the data to determine peak sales at each location so that they can 
schedule employee work shifts. The data tell food and beverage specialists how well 
each item sells. CPK found that it should get rid of its egg-salad pizza, for instance, 
when the item registered poor sales. California Pizza now has pilot projects to move to 
more state-of-the art  information system technology.  Waiters and waitresses are 
experimenting with hand-held point-of-sale devices, which management hopes will 
boost productivity by reducing the amount of time employees spend with customers.  
 
The devices use radio frequencies to transmit orders to a computer in the back of the 
restaurant, eliminating the need for employees to run back and forth to a stationary POS 
device to place orders. CPK can also use its information systems to calculate the relative 
costs of different markets so it can determine if it has a lower profit margin on Hawaiian 
pizza in Maryland, than in Waikiki. (Pineapple should be less expensive in Hawaii than 
in the northeastern United States.) CPK's corporate accounting department can use the 
aggregated sales data to tally revenue and can manage the accounts payable and 
accounts receivable processes by combining that data with financial data residing on a 
central CPK computer. 

 
*********** 
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MIS  Chapter  2 

 
Structure of  MIS 

 
 
2.1. Structure of  Information Systems :  
 
2.1.1 Components of IS : 
An information system is a system that accepts data resources as input and processes 
them into information products as output. The figure 2.1 illustrates an information system 
model that express fundamental conceptual framework for the major components and 
activities of information systems.  
 

 
Fig. 2.1 : Business Information System model. 

 
An information system depends on the resources of people (end users and IS 
specialists), hardware (machines and media), software (programs and procedures), data 
(data and knowledge bases), and networks (communications media and network support) 
to perform input, processing, output, storage, and control activities that convert data 
resources into information products. This information system model highlights the 
relationships among the components and activities of information systems. It provides a 
framework that emphasizes our major concepts that can be applied to all types of 
information systems : People, hardware, software, data, and networks are the five basic 
resources of information systems. 
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People resource include end users and IS specialists, hardware resources consist of 
machines and media, software resources include both programs and procedures, data 
resources can include data and knowledge bases, and network 
resource include communications media and networks. 
 
Data resources are transformed by information processing activities into a variety of 
information products for end users. Information processing consists of input, processing, 
output, storage, and control activities. 
 
 

 
Fig 2.2 : The components of an information system. 

 
 

2.1.2 Information System Resources :  
 
The basic IS model shows that an information system consists of five major resources: 
people, hardware, software, data, and networks. Let's briefly discuss several basic 
concepts and examples of the roles these resources play as the fundamental 
components of information systems. You should be able to recognize these five 
components at work in any type of information system you encounter in the real world. 
Following box outlines several examples of typical information system resources and 
products. 
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(1) People Resources : 
 
People are required for the operation of all information systems. These people resource 
include end users and IS specialists. 

 End users : (also called users or clients) are people who use an information system 
or the information it produces. They can be accountants, salespersons, engineers, clerks, 
customers, or managers. Most of us are information system end users. 

 IS specialists : are people who develop and operate information systems. They 
include systems analysts, programmers, computer operators, and other managerial, 
technical, and clerical IS personnel. Briefly, systems analysts design information 
systems based on the information requirements of end users, programmers prepare 
computer programs based on the specifications of systems analysts, and computer 
operators operate large computer systems. 
 
(2) Hardware Resources : 
 
The concept of hardware resources includes all physical devices and materials used in 
information processing. Specifically, it includes not only machines, such as computers 
and other equipment, but also all data media, that is, all tangible objects on which data is 
recorded, from sheets of paper to magnetic disks. Examples of hardware in computer-
based information systems are: 

 Computer systems : which consist of central processing units containing 
microprocessors, and a variety of interconnected peripheral devices. Examples are 
microcomputer systems, midrange computer systems; and large mainframe  computer 
systems. 

 Computer peripherals : which are devices such as a keyboard or electronic - mouse 
for input of data and commands, a video screen or printer for output of information, and 
magnetic or optical disks for storage of data resources.  
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(3) Software Resources : 
 
The concept of software resources includes all sets of information processing 
instructions. This generic concept of software includes not only the sets of operating 
instructions called programs, which direct and control computer hardware, but also the 
sets of information processing instructions needed by people, called procedures. . It is 
important to understand that even information systems that don't use computers have a 
software resource component. This is true even for the information systems of ancient 
times, or the manual and machine-supported information systems still used in the world 
today. They all require software resources in the form of information processing 
instructions and procedures in order to properly capture, process, and disseminate 
information to their users. 
 
The following are examples of software resources: 

. System software : such as an operating system program, which controls and 
supports the operations of a computer system. 

. Application software : which are programs that direct processing for a particular 
use of computers by end users. Examples are a sales analysis program, a payroll 
program, and a word processing program. 

. Procedures : which are operating instructions for the people who will use an 
information system. Examples are instructions for filling out a paper form or using a 
software package. 
 
(4) Data Resource : 
Data is more than the raw material of information systems. The concept of data 
resources has been broadened by managers and information systems professionals. 
They realize that data constitutes a valuable organizational resource. Thus, you should 
View data as data resources that must be managed effectively to benefit all end users in 
an organization. 
 
Data can take many forms, including traditional alphanumeric data, composed of 
numbers and alphabetical and other characters that describe business transactions and 
other events and entities. Text data, consisting of sentences and paragraphs used in 
written communications; image data, such as graphic shapes and figures; and audio 
data, the human voice and other sounds, are also important: forms of data. The data 
resources of information systems are typically organized into: 

. Databases that hold processed and organized data. 

. Knowledge bases that hold knowledge in a variety of forms such as facts, rules, and 
case examples about successful business practices. 
 
For example, data about sales transactions may be accumulated and stored in a sales 
database for subsequent processing that yields daily, weekly, and monthly sales 
analysis reports for management. Knowledge bases are used by knowledge 
management systems and expert systems to share knowledge and give expert advice 
on specific subjects.  
 
Data versus Information : The word data is the plural of datum, though data commonly 
represents both singular and plural forms. Data are raw facts or observations, typically 
about physical phenomena or business transactions. For example, a spacecraft launch 
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or the sale of an automobile would generate a lot of data describing those events. More 
specifically, data are objective measurements of the attributes (the characteristics) of 
entities (such as people, places, things, and events). 
 
(5) Network Resources : 
 
Telecommunications networks like the Internet, intranets, and extranets have become 
essential to the successful operations of all types of organizations and their computer-
based information systems. Telecommunications networks consist of computers, 
communications processors, and other devices interconnected by communications 
media and controlled by communications software. The concept of network resources 
emphasizes that communications networks are a fundamental resource component of all 
information systems. Network resources include: 

. Communications media : Examples include twisted-pair wire, coaxial cable, fiber-
optic cable, microwave systems, and communications satellite systems. 

. Network support : This generic category includes all of the people, hardware, 
software, and data resources that directly support the operation and use of a 
communications network. Examples include communications processors such as 
modems and internet work processors, and communications control software such as 
network operating systems and Internet browser packages.  
 
2.1.3 Information System Activities :  
 
When we take a closer look at each of the basic information processing (or data 
processing) activities that occur in information systems, we should be able to recognize 
input, processing, output, storage, and control activities taking place in any information 
system you are studying. Following lists business examples that illustrate each of these 
information system activities. 
 

 
 
(1) Input of Data Resources : 
 
Data about business transactions and other events must be captured and prepared for 
processing by the input activity. Input typically takes the form of data entry activities such 
as recording and editing. End users typically record data about transactions on some 
type of physical medium such as a paper form, or enter it directly into a computer system. 
This usually includes a variety of editing activities to ensure that they have recorded data 
correctly. Once entered, data may be transferred onto a machine readable medium such 
as a magnetic disk or semiconductor memory until needed for processing. 
 
For example, data about sales transactions can be recorded on source documents such 
as paper sales order forms. (A source document is the original formal record of a 
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transaction.) Alternately, salespersons can capture sales data using computer 
keyboards or optical scanning devices; they are visually prompted to enter data correctly 
by video displays. This provides them with a more convenient and efficient user interface, 
that is, methods of end user input and output with a computer system. Methods such as 
optical scanning and displays of menus, prompts, and fill-in-the-blanks format make it 
easier for end users to enter data correctly into an information system.  
 
(2) Processing of Data into Information : 
 
Data is typically subjected to processing activities such as calculating, comparing, 
sorting, classifying, and summarizing. These activities organize, analyze, and 
manipulate data, thus converting them into information for end users. The quality of any 
data stored in an information system must also be maintained by a continual process of 
correcting and updating activities. 
 
For example, data received about a purchase can be (1) added to a running total of 
sales results, (2) compared to a standard to determine eligibility for a sales discount, (3) 
sorted in numerical order based on product identification numbers, (4) classified into 
product categories (such as food and nonfood items), (5) summarized to provide a sales 
manager with information about various product categories, and, finally, (6) used to 
update sales records. 
 
(3) Output of Information Products : 
 
Information in various forms is transmitted to end users and made available to them in 
the output activity. The goal of information systems is the production of appropriate 
information products for end users. Common information products include messages, 
reports, forms, and graphic images, which may be provided by video displays, audio 
responses, paper products, and multimedia. We routinely use the information provided 
by these products as we work in organizations and live in society. For example, a sales 
manager may view a video display to check on the performance of a salesperson, 
accept a computer-produced voice message by telephone, and receive a printout of 
monthly sales results. 
 
What characteristics would make information products valuable and useful to you? 
One way to answer this important question is to examine the characteristics or attributes 
of information quality. Information that is outdated, inaccurate, or hard to understand 
would not be very meaningful, useful, or valuable to you or other end users. 
People want information of high quality, that is, information products whose 
characteristics, attributes, or qualities help make it valuable to them. It is useful to think 
of information as having the three dimensions of time, content, and form. 
 
(4) Storage of Data Resources : 
 
Storage is a basic system component of information systems. Storage is the information 
system activity in which data and information are, retained in an organized manner for 
later use. For example, just as written text material is organized into words, sentences, 
paragraphs, and documents, stored data is commonly organized into fields, records, files, 
and databases. This facilitates its later use in processing or its retrieval as output when 
needed by users of a system.  
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(5) Control of System Performance : 
 
An important information system activity is the control of its performance. An 
information system should produce feedback about its input, processing, output, and 
storage activities. This feedback must be monitored and evaluated to determine if the 
system is meeting established performance standards. Then appropriate system 
activities must be adjusted so that proper information products are produced for end 
users. 
 
For example, a manager may discover that subtotals of sales amounts in a sales report 
do not add up to total sales. This might mean that data entry or processing procedures 
need to be corrected. Then changes would have to be made to ensure that all sales 
transactions would be properly captured and processed by a sales information system. 
 
2.2.  Strategic use of  Information Systems : 
 
2.2.1. Information Systems for competitive strategy :   
 
The strategic role of information systems involves using information technology to 
develop products, services, and capabilities that give a company strategic advantages 
over the competitive forces it faces in the global marketplace. This creates strategic 
information systems, information systems that support or shape the competitive position 
and strategies of an enterprise. So a strategic information system can be any kind of 
information system (TPS, MIS, DSS, etc.) that helps an organization gain a competitive 
advantage, reduce a competitive disadvantage, or meet other strategic enterprise 
objectives. Let's look at several basic concepts that define the role of such strategic 
information systems. 
How should a managerial end user think about competitive strategies? How can 
competitive strategies be applied to the use of information systems by an organization? 
 
Several important conceptual frameworks for understanding and applying competitive 
strategies have been developed by Michael Porter, Charles Wiseman and others. Figure 
2.3 illustrates several important concepts. A firm can survive and succeed in the long run 
if it successfully develops strategies to confront five competitive forces that shape the 
structure of competition in its industry. These are: (1) rivalry of competitors within its 
industry, (2) threat of new entrants, (3) threat of substitutes, (4) the bargaining power of 
customers, and (5) the bargaining power of suppliers. 
 
A variety of competitive strategies can be developed to help a firm confront these 
competitive forces. For example, businesses may try to counter the bargaining power of 
their customers and suppliers by developing unique business relationships with them. 
This effectively locks in customers or suppliers by creating "switching costs" that make it 
expensive or inconvenient for them to switch to another firm. Thus, competitors are also 
locked out by such strategies. Companies may use other strategies to protect 
themselves from the threat of new businesses entering their industry, or the 
development of substitutes for their products or services. For example, businesses may 
try to develop legal, financial, or technological requirements that create barriers to entry 
to discourage firms from entering an industry, or make substitution unattractive or 
uneconomical. 
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Fig. 2.3 : The competitive environment of an industry. 

 
The five basic competitive strategies to be implemented in any business are : 
1. Cost Leadership Strategy. Becoming a low-cost producer of products and services 
in the industry. Also, a firm can find ways to help its suppliers or customers reduce their 
costs or to increase the costs of their competitors. 
 
2. Differentiation Strategy. Developing ways to differentiate a firm's products and 
services from its competitors' or reduce the differentiation advantages of competitors. 
This may allow a firm to focus its products or services to give it an advantage in 
particular segments or niches of a market. 
 
3. Innovation Strategy. Finding new ways of doing business. This may involve the 
development of unique products and services, or entry into unique markets or market 
niches. It may also involve making radical changes to the business processes for 
producing or distributing products and services that are so different from the way 
business has been conducted that they alter the fundamental structure of an industry. 
 
4. Growth Strategies. Significantly expanding a company's capacity to produce goods 
and services, expanding into global markets, diversifying into new products and services, 
or integrating into related products and services. 
 
5. Alliance Strategies. Establishing new business linkages and alliances with 
customers, suppliers, competitors, consultants, and other companies. These linkages 
may include mergers, acquisitions, joint ventures, forming of "virtual companies," or 
other marketing, manufacturing, or distribution agreements between a business and its 
trading partners. 
 
2.2.2. Strategic Role of Information Systems :  
 
How can the preceding competitive strategy concepts be applied to the strategic role of 
information systems in an organization? or, How can managers use investments in 
information technology to directly support a firm's competitive strategies? 
These questions can be answered in terms of the key strategic roles that information 
systems can perform in a firm. Following table summarizes how information technology 
can be used to implement a variety of competitive strategies.  
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These include not only the five basic competitive strategies, but also other ways that 
companies can use information systems strategically to gain a competitive edge. 
Following table has examples of how companies used information technology to 
implement five competitive strategies for strategic advantage. 
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2.2.3. Strategic Use of Information Systems :   
 
(1) Improving Business Process : 
 
One of the strategic business values of information technology is its role in making major 
improvements in a company's business processes. Investments in information 
technology can help make a firm's operational processes substantially more efficient, 
and its managerial processes much more effective. Making such improvements to its 
business processes could enable a company to cut costs, improve quality and customer 
service, and develop innovative products for new markets. For example, manufacturing 
processes for everything from automobiles to watches have been automated and 
significantly improved by computer-aided design, engineering, production, and 
manufacturing resource management technologies. In the automobile industry, the 
process for the production, distribution, and sales of cars and parts and the sharing of 
vital business data by managers and others has been substantially improved by using 
the Internet, extranets, and other networks that electronically connect an automobile 
manufacturer's production and distribution facilities with car dealers and suppliers. 
 
Following table outlines many of the ways that information technology can improve 
business processes. 
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Chrysler's CATIA Pipeline : Chrysler Corporation has reorganized its vehicle 
development process into multidisciplinary platform teams interconnected by the CATIA 
Pipeline, a telecommunications network that connects nearly every part of the 
company's "extended enterprise" to every other, including external suppliers and 
contractors. The software engine that moves data through the network and manages its 
database is CATIA (Computer-Aided Three-Dimensional Interactive Application), an 
integrated computer-aided design, development, engineering, and manufacturing 
execution system from Dassault Systems of France. Product information flows 
instantaneously from all directions and in all directions, linking managers, designers, 
engineers, marketers, service technicians, suppliers, and manufacturing. 
The 1998 Dodge Intrepid and Chyrsler Concorde were the first products developed with 
the CATIA Pipeline. The cars and almost all of their components were electronically 
designed, tested, and stored in the CATIA database before any physical models or 
prototypes were made. Chyrsler designers and engineers are able to design and test 
every part thousands of times, simulate crashes, test air conditioners, plan production 
processes, and practice servicing procedures-all electronically. More importantly, CATIA 
determines how any design change affects any others and instantly notifies everyone 
affected. CATIA has thus made significant improvements to Chrysler's business process. 
The payoff to Chrysler has been dramatic reductions in costs, and major improvements 
in production efficiency and in product quality and performance. 
 
Investments in information systems technology can result in the development of unique 
products and services or processes. This can create new business opportunities and 
enable a firm to expand into new markets or into new segments of existing markets. 
The use of automated teller machines (ATMs) in banking is another classic example of 
an innovative investment in information systems technology. 
 
Citibank and ATMs : By being first to install ATMs, Citibank and several other large 
banks were able to gain a strategic advantage over their competitors that lasted for 
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several years. ATMs lured customers away from other financial institutions by cutting the 
cost of delivering bank services and increasing the convenience of such services. The 
more costly and less convenient alternative would have been to establish new bank 
branch offices. ATMs are also an example of product differentiation, single bank services 
are now provided in a new way. ATMs raised the cost of competition, which forced some 
smaller banks that could not afford the investment in new technology to merge with 
larger banks. ATMs represented an attractive and convenient new banking service 
produced and distributed to customers by making innovative changes in the delivery of 
bank services. Thus, information systems technology was used to develop a strategic 
new distribution process for bank services. 
 
(2)  Locking In Customers and Suppliers : 
 
Investments in information technology can also allow a business to lock in  customers 
and suppliers (and lock out competitors) by building valuable new relationships with 
them. This can determine both customers and suppliers from abandoning a firm for its 
competitors or intimidating a firm into accepting less-profitable relationships. Early 
attempts to use information systems technology in these relationships focused on 
significantly improving the quality of service to customers and suppliers in a firm's 
distribution; marketing, sales, and service activities. Then businesses moved to more 
innovative uses of information technology. 
 
Wal-Mart and Others : For example, Wal-Mart built an elaborate satellite network 
linking all of its stores. The network was designed to provide managers, buyers, and 
sales associates with up-to-date sales, shipping, inventory, and account status 
information to improve product buying, inventories, and store management. Then the 
firm began to use the operational efficiency of such information systems to offer better 
quality products and services and thereby differentiate itself from their competitors. 
Companies like Wal-Mart began to extend their networks to their customers and 
suppliers in order to build innovative relationships that would lock in their business. This 
creates inter-organizational information systems in which the Internet, extranets, and 
other networks' electronically link the computers of businesses with their customers and 
suppliers, resulting in new business alliances and partnerships. Electronic data 
interchange (EDI) links between businesses and their suppliers, are a prime example of 
such strategic linkages. An even stronger link is formed by automatic inventory 
replenishment systems such as those between Wal-Mart and Procter & Gamble. In that 
system, Proctor & Gamble automatically replenishes Wal-Mart's in-store stock of Proctor 
& Gamble products. 
 
(3) Creating  Switching Costs : 
 
A major emphasis in strategic information systems has been to find ways to build 
switching costs into the relationships between a firm and its customers or suppliers. That 
is, investments in information systems technology have attempted to make customers or 
suppliers dependent on the continued use of innovative, mutually beneficial inter-
organizational information systems. Then, they become reluctant to pay the costs in time, 
money, effort, and inconvenience that it would take to change to a company's 
competitors. 
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SABRE and APOLLO : A classic example is the computerized airline reservation 
systems, such as the SABRE system of AMR Corporation (American Airlines) and the 
APOLLO system of COVIA (United Airlines), used by most travel agents. Once a travel 
agency has invested a substantial sum in installing such an inter organizational system, 
and travel agents have been trained in its use, the agency is reluctant to switch to 
another reservation system. Thus, what seemed to be just a more convenient and 
efficient way of processing airline reservations became a strategic weapon that gave 
these providers a major competitive advantage. Not only does an airline reservation 
system raise competitive barriers and increase switching costs, it also continues to give 
their providers an advantage in gaining reservations for themselves, even with the 
enforcement of new legal guidelines to protect competition. Such systems also provide 
these companies with a major new line of information products. Thus, computer-based 
reservation services are a major source of revenue for their providers, which charge a 
variety of fees to travel agencies and airlines who use their systems. Both companies 
have now extended these systems to the Internet. It will be interesting to see how well 
their services compete with other airlines and online travel services on the World Wide 
Web. The low cost and easy access of Internet-based services tend to significantly 
reduce switching costs. 
 
(4) Raising Barriers to Entry : 
By making investments in information technology to improve its operations or promote 
innovation, a firm could also erect barriers to entry that would discourage or delay other 
companies from entering a market. Typically, this happens by increasing the amount of 
investment or the complexity of the technology required to compete in an industry or a 
market segment. Such actions would tend to discourage firms already in the industry 
and deter external firms from entering the industry. 
 
Merrill Lynch : Merrill Lynch's cash management account is a classic example. By 
making large investments in information technology, along with a ground breaking 
alliance with BancOne, they became the first securities brokers to offer a credit line, 
checking account, Visa credit card, and automatic investment in a money market fund, 
all in one account. This gave them a major competitive advantage for several years 
before their rivals could develop the IT capability to offer similar services on their own. 
Thus, large investments in computer-based information systems can make the stakes 
too high for some present or prospective players in an industry. 
 
(5) Leveraging a Strategic IT Platform : 
 
Investing in information technology enables a firm to build a strategic IT platform that 
allows it to take advantage of strategic opportunities. In many cases, this results when a 
company invests in advanced computer-based information systems to improve the 
efficiency of its own business processes. For example, they may develop client/server 
networks of PC and NC clients and network servers; develop intranets, extranets, and 
Internet services; hire more IS specialists; and do extensive multimedia training of end 
users. Then, armed with this technology platform, the firm can leverage investment in 
information technology by developing new products and services that would not be 
possible without a strong IT capability. 
 
An important current example is the development of corporate intranets and extranets by 
many companies, which enables them to leverage their previous investments in Internet 
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browsers, servers, and client/server networks. Another classic example was the 
development by banks of remote banking services using automated teller machines. 
This innovative business use of IT was based in part on leveraging their expertise in 
teller terminal networks, which already interconnected their branches. 
 
(6)  Developing a Strategic Information Base : 
 
Information systems also allow a firm to develop a strategic information base that can 
provide information to support the firm's competitive strategies. Information in a firm's 
corporate databases has always been a valuable asset in promoting efficient operations 
and effective management of a firm. However, information about a firm's operations, 
customers, suppliers, and competitors, as well as other economic and demographic data, 
stored in data warehouses, data marts, and other corporate databases, is now viewed 
as a strategic resource. That is, it is used to support strategic planning, marketing, and 
other strategic initiatives. In much the same way, information about best business 
practices and other business knowledge shared in intranet Web site databases is a 
strategic knowledge base.  
 
For example, many businesses are now using data mining and online analytical 
processing to help design targeted marketing campaigns to selectively sell customers 
new products and services. This is especially true of firms that include several 
subsidiaries offering a variety of products and services. For example, once you become 
a customer of a subsidiary of American Express, you quickly become a target for 
marketing campaigns by their many other subsidiaries, based on information provided by 
the American Express strategic information resource base. This is one way a firm can 
leverage its investment in electronic commerce, transaction processing, and customer 
management systems-by linking its databases to its strategic planning and marketing 
systems. This strategy helps a firm create better marketing campaigns for new products 
and services, build better barriers to entry for competitors, and find better ways to lock in 
customers and suppliers. 
 
2. 3. Strategic MIS : 
Strategic MIS is the set of systems which are considered critical to the current or future 
business competitiveness, and hence the survival of an organization. Strategic MIS also 
supplies an organization with business intelligence. In other words, if an information 
system is used in creative ways to achieve goals and fulfill set organizational missions, it 
can be considered to be a strategic MIS. 

Strategic MIS can be external or internal systems. External strategic MIS are used 
mainly by external quantities in the business environment, such as customers, suppliers, 
distributors etc and have a value added component that gives developers some time to 
reap the benefits of the system innovation. Internal strategic MIS are used by employees 
within the organization and do not have value added component. The employees focus 
on issues such as improving the quality of products, services and also enhancing the 
decision making capabilities of managers. Such systems are used at all levels in the 
organization and they have long term implications for the firm and also for the business 
processes within the firm. 

In general, Strategic MIS can be divided into 3 categories : 
(a) systems that focus on innovation fro competitive edge 
(b) systems that use information as a weapon 
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(c) systems that increase productivity and lower the costs of goods and services 
 
2.3.1 Characteristics 
There are three common characteristics in all Strategic MIS. They are : 
(a) telecommunications as a central part of SMIS 
(b) reliance on a number of vendors fro providing information technologies 
(c) cooperation among a number of organizations 

Telecommunications is a vital part of SMIS. Successful organizations transcended 
traditional organizational boundaries and eliminated the barriers of time and space 
through the use of telecommunications. However, developing and implementing 
information systems that rely heavily on telecommunications is a challenging task and 
often becomes one of the bottlenecks for the development of SMIS.  

For integration of complex technologies to develop an SMIS, a number of vendors are 
needed in many cases. Therefore, one of the ingredients of an SMIS of an SMIS is the 
ability to identify, coordinate and manage transactions with a number of vendors and 
effectively bring together diverse technologies to achieve a goal. 

Inter organizational systems are those systems which are shared by more than two 
organizations, in terms of cooperation and collaboration rather than competition. Such 
ventures often result in powerful systems enhancing productivity, reduction in operating 
costs, increased market share, creating new partnerships, especially for organizations 
that conduct business transactions in the global market. 

3. 2 Barriers of SIMS : 
Researchers, Chris Kemerer and Glen Sosa, both from the Sloan school of management, 
identified 12 barriers to successful development of SMIS. These barriers fall into 3 
categories  
(a) Problem definition 
(b) Implementation 
(c) Maintenance 

Problem definition barriers 
• Generating workable idea require leadership and team work 
• Many innovative ideas are technically infeasible 
• Many innovative ideas are prohibitively expansive 
• Many ideas die because they lack a sufficient market 

Implementation barriers 
• Telecommunications increases the complexity of implementing SMIS 
• Multiple systems are difficult to integrate 
• SMIS systems often require inter organizational cooperation 
• State of the art technologies are difficult to implement 
Maintenance barriers 
• Competitors can copy SMIS 
• Unanticipated demand can overwhelm the usefulness of an SMIS 
• Applications can be expensive to maintain or enhance 
• High exit barriers can cause devastating losses 

Organizations with limited financial resources technological sophistication and 
organizational flexibility are likely to face one or more of the above mentioned barriers. 
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4. Success and Failure of MIS : 
Most organizations use MIS more successfully than other organizations. Through 
hardware, software and technology available are the latest and the best, its use is more 
for the collection and storage of data and its elementary processing. There are some 
factors, which make MIS, a success while there are some factors, which make it a failure. 

Factors contributing to success of MIS : If MIS is to be a success, then it should have 
all the features listed below : 
• MIS is integrated into the management function. It sets clear objectives to ensure 

that MIS focuses on the major issues of the business. Also adequate development 
resources are provided and human & organizational barriers to progress are 
removed. 

• An appropriate information processing technology required to meet the data 
processing and analysis needs of the users of MIS is selected. 

• MIS is oriented, defined and designed in terms of the users requirements and its 
operational viability is ensured. 

• MIS is kept under continuous surveillance, so that its open system is modified 
according to the changing information needs.  

• MIS focuses on results and goals, and highlights the factors and reasons for non 
achievements. 

• MIS is not allowed to end up into an information generation mill avoiding the noise in 
the information and the communication system. 

• MIS recognizes that a manager is a human being and therefore, the systems must 
consider all the human behavioral aspects in the process of management. 

• MIS recognizes that the different information needs for different objectives must be 
met with. The globalization of information in isolation from the different objectives 
leads to too much information and its non use. 

• MIS is easy to operate and therefore, the design of MIS has such good features 
which make up a user friendly design. 

• MIS recognizes that the information needs become obsolete and new needs emerge. 
The MIS design, therefore, has a potential capability to quickly meet newer and 
newer needs of information. 

• MIS concentrates on developing the information support to manage critical success 
factors. It concentrates on the mission critical applications serving the needs of the 
top management. 

Factors contributing to failures : Many times, MIS is a failure. The common factors 
which are responsible for this are as follows : 
• MIS is conceived as a data processing and not as an information system. 
• MIS does not provide that information which is needed by managers but it tends to 

provide the information generally the function calls for. MIS then becomes an 
impersonal function. 

• Underestimating the complexity in the business systems and not recognizing it in the 
MIS design leads to problems in the successful implementation. 

• Adequate attention is not given to the quality control aspects of the inputs, the 
process and the outputs leading to insufficient checks and controls in MIS. 

• MIS is developed without streamlining the transaction processing systems in the 
organizations. 

• Lack of training and appreciation that the users of the information and the generators 
of the data are different, and they have to play an important role in the MIS. 
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• MIS does not meet certain critical and key factors of its users, such as a response to 
the query on the database, an inability to get the processing done in a particular 
manner, lack of user friendly system and the dependence on the system personnel. 

• A belief that the computerized MIS can solve all the management problems of 
planning and control of the business. 

• Lack of administrative discipline in following the standardized systems and 
procedures, wrong coding and deviating from the system specifications result in 
incomplete and incorrect information. 

• MIS does not give perfect information to all the users in the organization. Any 
attempt towards such a goal will be unsuccessful because every user has a human 
ingenuity, bias and certain assumptions not known to the designer. MIS cannot make 
up these by providing perfect information. 

 
 
Assignment Questions : 
 
1. Explain the different components of Information Systems and Information System 
Resources ?                                                                                                               12 M 
 
2.  Write a note on various Information System Activities                                          12 M 
 
3.  Explain how information Systems can be used for competitive Strategy              12 M 
 
4.   What are the strategic role of Information Systems ? Explain                             12 M 
 
5.  Write a note on Strategic Use of Information Systems                                         12 M 
 
6.  List the factors contributing success & failure of MIS                                            12 M 
 

 
Case 1 : Pepsi Cola Co. : Web Marketing Strategies 
Would you shop for a soft drink online? Seems like a silly question. Of all the products 
for sales in  the Universe, bottles and cans of sweet, carbonated liquid are probably the 
last things shoppers will want to buy on the Internet. Even frozen food has more 
potential. But soft drinks? They're cheap. They require no research to purchase. They 
are available on practically every street corner in the world. So why is Pepsi-Cola Co. 
trying so hard online? While many traditional advertisers have dabbled in the Net, Pepsi 
has a range of programs on the virtual air, from music sites to banner ads to Internet 
sweepstakes. Though only about 3 percent of its estimated $400 million soft drink ad 
budget goes online, that belies the emphasis the company places on the Web. "This 
medium is here to stay, and we buy that," says John Vail, director of digital media and 
marketing for Pepsi-Cola. 
One reason: Despite the difficulties in measuring online ad performance, Pepsi has 
crafted deals that already show benefits. In a barter arrangement with Yahoo! Inc.) Pepsi 
plastered the portal's logo on 1.5 billion cans. In return, Yahoo took the cola company's 
already established loyalty program, Pepsi Stuff, to new heights. A co-branded web site, 
PepsiStuff.com let consumers collect points from bottle caps. The points were 
redeemable on the 'Web site for prizes-everything from electronic goods to concert 
tickets.  
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The results were considerable. Three million consumers logged on and registered at the 
PepsiStuff site, giving the cola company detailed consumer data that normally must be 
paid for in market research or gleaned from focus groups. 
Information that once took months to obtain could now be had in days. What's more, Vail 
was able to tweak the program while it was in progress, maintaining the right inventory of 
the most popular prizes. "Instead of lagtime data, we had real-time and we could react to 
it," says Vail. Sales volume rose 5 percent during the online promotion and the cost was 
about one-fifth what it had been 'as a mail-in project. 
Pepsi has no intention of slowing its Internet rush. The 'Web is the medium of choice for 
Pepsi's prime demographic audience, those under 25. "They are going to where their 
customer hangs out and flashing their name," says Tom Pirko, a beverage consultant for 
Santa Barbara-based Bevmark Ic. "This is aimed at flipping the next generation. For 
Pepsi, the Internet is serious. It's not a toy."  
For consumer Shane Erstad, 29, that's good news. Intrigued by the prizes and the ability 
to collect the points online, he became devoted to Mountain Dew and a fan of the Pepsi 
Stuff site. Even now that the game has ended, he hasn't cut back. "I hope they repeat 
the promotion," he says. He can count on it, and much more. For Pepsi knows that its E-
commerce marketing strategies are a work in progress. Pepsi's online marketing road 
has been long and bumpy.  
 
On February 29, 1996, the company launched Pepsi World, a Web site of sponsored 
content designed to attract the youthful consumer. Sports and music news was mixed 
with online games and animation. A seven figure publicity budget backed the debut. But 
it quickly became clear through focus groups and traffic numbers that Pepsi hadn't 
reached its target. Eyeballs were too fleeting, visitors too fickle. By the summer of 1997, 
Vail revamped the site to be less of a sports news digest and more of a vehicle to 
promote Pepsi-sponsored athletes, such as NASCAR driver Jeff Gordon. 
 
Going forward, Pepsi plans to expand on its Web site-centric E-commerce marketing 
efforts. Although banner ads and other more traditional ad buys have had some success, 
it's the creation of engaging Pepsi Web sites that has given the brand the most traction 
online. For example, Vail would like to bring a virtual experience to many other Pepsi 
promotions, such as Choose Your Music, a current in-store create-your-own-CD 
promotion at participating music outlets. 
"We're looking ahead to the next evolution," says Vail. 
 
Case Study Questions 
1. What are the major business benefits of Pepsi's online marketing efforts? 
2. Do you approve of Pepsi's "Web-centric" E-commerce marketing strategy? Why or 
why not: 
3. Visit www.pepsistuff.com or other Pepsi websites. What else could Pepsi do to 
improve its web-based marketing efforts? Explain. 
 
Case 2 : General Electric Company –Evaluating E-business Strategy  
General Electric (GE) is the world's largest diversified manufacturer. Fortune named GE 
"America's Most Admired Company" in 1998, 1999, and 2000. Jack Welch, GE's CEO 
and chairman since 1981, is often cited as the most admired CEO in the United States. 
Headquartered in Fairfield, Connecticut, the company consists of 20 units, including 
Appliances, Broadcasting (NBC), Capital, Medical Systems, and Transportation Systems. 
With the acquisition of Honeywell, announced in October 2000, GE became a company 
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of $155 billion in revenue and 460,000 employees in 100 countries. Despite GE's size 
and old-economy businesses, Internet Week named GE its e-business company of 2000. 
Did GE transform itself into a digital firm? 
 
At a January 1999 meeting of 500 top GE executives in Boca Raton, Florida, Welch 
announced a new initiative to turn GE into an Internet company. Earlier initiatives 
transformed GE and are partially responsible for its phenomenal rise in profit over the 
past two decades. Those initiatives were globalization of GE in the late 1980s, "products 
plus service" in 1995, which placed emphasis on customer service, and Six Sigma in 
1996, a quality program that mandated GE units to use feedback from customers as the 
center of the program. 
 
Welch announced that the Internet "will forever change the way business is done. It will 
change every relationship, between our businesses, between our customers, between 
our suppliers." By Internet-enabling its business processes, GE could reduce overhead 
costs by half, saving as much as $10 billion in the first  
two years. Gary Reiner, GE's corporate CIO, later explained "We are Web-enabling 
nearly all of the [purchasing] negotiations process, and we are targeting 100 percent of 
our transactions on the buy side being done electronically." On the sell side Reiner also 
wanted to automate as much as possible, including providing customer service and 
order taking.  
 
GE had quietly been involved with the Internet years before the Boca Raton meeting, 
conducting more purchasing and selling on the Internet than any other non computer 
manufacturer. For example, within six months after beginning to use the Internet for 
purchasing in mid-1996, GE Lighting had reduced its purchasing cycle from 14 to 7 days. 
It also reduced its supply prices by 10 to 15 percent because of open bidding on the 
Internet. In 1997, seven other GE units began purchasing via the Net. The company 
even sold the concept to others, including Boeing and 3M. 
 
Polymerland, GE Plastic's distribution arm, began distributing technical documentation 
over the Web in 1994. It put its product catalog on the Net in 1995 and in 1997 
established a site for sales transactions. Its on-line system enables customers to search 
for product by name, number, or product characteristics, download product information, 
verify that the product meets their specifications, apply for credit, order, track the 
shipment, and even return merchandise. Polymerland's weekly on-line sales climbed 
from $10,000 in 1997 to $6 million in 2000.  
 
Welch ordered all GE units to determine how dot.com companies could destroy their 
businesses, dubbing this project DYB (destroy your business). Welch explained that if 
these GE units didn't identify their weaknesses, others would. Once armed with these 
answers, managers were to change their units to prevent 
it from happening. Each of GE's 20 units created small cross functional teams to execute 
the initiative. Welch also wanted them to move current operations to the Web and to 
uncover new Net-related business opportunities. The final product was to be an Internet-
based business plan that a competitor could have used to take away their unit's 
customers, and a plan for changes to their unit to combat this threat. Reiner ordered GE 
units to "come back with alternative approaches that enhance value to the customer and 
reduce total costs." 
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The Internet initiative started by trying to change GE's culture at the very top. GE's 
internal newsletters and many of Welch's memos became available only on-line. To give 
blue-collar workers access to the Net, GE installed computer kiosks on factory floors. 
One thousand top managers and executives, including Welch (who also had to take 
typing lessons), were assigned young, skilled mentors to work with them three to four 
hours per week in order to make them comfortable with the Web. They had to be able to 
evaluate their competitors' Web sites and to use the Web in other beneficial ways. Every 
GE employee was given training. Welch announced in 2000, that GE would reduce 
administrative expenses by 30 to 50 percent (around $10 billion) within 18 months 
through use of the Internet.  
 
Many projects came out of the initiative. For example GE Medical Systems, which 
manufactures diagnostic imaging systems, such as CAT scanners and mammography 
equipment, identified its DYB threat as aggregators, such as WebMD, which offered 
unbiased information on competing products as well as selling those products. GE 
products on these sites looked like just another commodity. The GE unit's major 
response was iCenter, a Web connection to customers' GE equipment to monitor the 
equipment operation at the customer site. iCenter collects data and feeds it back to each 
customer who can then ask questions about the operation of the equipment through the 
same site. GE compares a customer's operating data with the same equipment 
operating elsewhere to aid that customer in improving performance. In addition 
customers are now able to download and test upgraded software for 30 days prior to 
having 
to purchase it. The unit also began offering its equipment training classes on-line, 
allowing clients to take them at any time. The aggregators were also auctioning off used 
equipment that was in demand in poorer countries. Medical Systems established its own 
site to auction its own used equipment, thus opening new markets (outside the United 
States). GE Aircraft adapted iCenter and now monitors its customers' engines while they 
are in flight. 
 
GE Power Systems then developed its Turbine Optimizer, which uses the Web to 
monitor any GE turbine, comparing its performance (such as fuel burn rate) with other 
turbines of same model anywhere in the world. Their site advises operators how to 
improve their turbines' performance and how much money the improvements would be 
worth. The operator can even schedule a service call in order to make further 
performance improvements. 
 
Late in 1999 GE Transportation went live with an Internet , auction system for 
purchasing supplies. Soon other units, including Power and Medical, adopted the system. 
GE later estimated) the system would handle $5 billion in GE purchasing in 2000, and 
the company would do at least 50 percent of its purchasing on-line in 2001. The system 
lowers prices for GE because approved suppliers bid against each other to obtain GE 
contracts. It also results in fewer specification errors and speeds up the purchasing 
process. GE estimates it saves between 10 and 15 percent of purchasing costs 
altogether. 
 
GE Appliances realized that appliances are traditionally sold through large and small 
retailers and that the Internet might destroy that model, turning appliances into 
commodities sold on big retail and auction sites. GE wanted to maintain the current 
system, keeping consumer loyalty to their GE brand (versus May tag, Whirlpool, and 
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Frigidaire). Appliances developed a point-of-sale system, which they placed in retail 
stores such as Home Depot, where customers enter their own orders. The retailer is 
paid a percentage of the sale. The product is shipped from GE directly to the customer. 
GE Appliances claims it can now take products from its factories and get them shipped 
anywhere in the United States virtually overnight on a cost-effective basis. In 2000 
Appliances reported 45 percent of its sales, totaling $2.5 billion, took place on the 
Internet. It estimates 67 percent of its sales will be on the Internet in 2001. 
 
The corporation and its units have issued a blizzard of press releases touting the 
successes of each of GE's Internet initiatives and the consequent positive effect on 
financial results. "In 1999, 30 percent of our orders came in via the Web," announced 
Marian Powell, the senior vice president for e-business at GE Capital Fleet Services. 
And in 2000 "we'll have over 60 percent. That's over a billion dollars in orders." CIO 
Reiner said, "We are not talking about incremental change. We're talking total 
transformation." 
 
A January 2001 article by Mark Roberti of The Industry Standard was skeptical. Roberti 
commended GE for embracing the Internet so quickly. He also noted that "these 
endeavors are unlikely to make GE vastly more profitable. . . because the company isn't 
using the Internet to reach new markets or create major new sources of revenue." 
Roberti questioned the great savings through Internet-based cost cutting that GE 
claimed. To cut costs by moving business processes on-line, a firm "must eliminate-or 
redeploy-a significant number of employees" and "GE hasn't." For example, Roberti says, 
60 percent of orders to GE Capital Fleet Services are now placed on-line, but it has not 
reduced its call center staff. GE reports that its selling, general, and administrative 
expenses as a percentage of sales fell for the first nine months of 2000 from 24.3 in 
1999 to 23.6, a minor drop at best. Moreover, he notes caution coming from GE 
executives themselves. For example, although Reiner had projected a $10 billion saving 
over the next 18 months in 1999, in December 2000 he revised the 2001 savings to 
about $1.6 billion-not an insignificant sum, but far from the gigantic savings predicted. 
Reducing costs by having customers and employees serve themselves via the Web has 
proved elusive at other companies as well, such as IBM and UPS. Roberti claims that 
the Internet has not brought GE a significant number of new customers. 
 
Overall, Roberti points out, "Through the third quarter of 2000, GE still hadn't 
demonstrated any significant improvement in its financial results that can be directly 
attributed to e-business." Although GE has achieved genuine progress and even 
leadership, the company could not be generating the savings management had been 
predicting. He speculates that the purpose of the continuous declarations of great 
savings may be to boost the price of GE's stock. Perhaps, most importantly, Roberti 
claims that although GE's Internet activities will give the company a boost, it will take its 
competitors only a few months to catch up, leaving GE without any competitive 
advantage. 
CASE STUDY QUESTIONS 
1. Summarize the business and technology conditions causing GE to launch its Internet 
initiative. 
2. How is GE using Internet technology in its internal and external business processes? 
3. What management, organization, and technology issues did GE have to address in its 
Internet initiative? 
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4. Evaluate GE's Internet initiative. Is it successful? Is the company transforming itself 
into a digital firm? Why or why not? 
 
Case 3 : What Happened to Kmart? 
On January 22, 2002, Kmart filed for bankruptcy protection. It was the largest 
retailer ever to do so and shocked many people. Kmart had made retail history when its 
founder, the Kresge "five and dime store" chain, invented the concept of the discount 
store. The first Kmart was established in Detroit in 1962, the same year Wal-Mart 
opened its first store in Rogers, Arkansas. By the end of 1963 Kmart had 63 stores 
converted from Kresge's. In the following years, however, Wal-Mart expanded quickly by 
following a strategy of everyday low prices. Wal-Mart used information technology (IT) to 
track sales in all its stores and to replenish its fastest selling products. Wal-Mart 
demonstrated its willingness to spend needed funds on IT by installing registers with bar-
code scanners in each store during the late 1970s and early 1980s, which fed the sales 
data into the back-end store computers. The result was Wal-Mart sales data were 
always current and store managers knew what was selling well and what was not. 
In time many orders were routed straight from the Wal-Mart store to the appropriate 
supplier, and the delivery went from that supplier directly to the store. Wal-Mart recently 
developed an extranet to work closely with key suppliers on problems such as how to 
increase sales on specific products. Many analysts believe Wal-Mart has the most 
sophisticated supply chain systems in the industry. 
By 1983, with its cutting edge information systems, Wal-Mart was already spending only 
two cents per dollar getting goods to its stores while Kmart was spending five cents. 
From that differential alone, Wal-Mart could sell the same product at a price 3 percent 
lower than Kmart, an important saving to many shoppers. In 1990 Wal-Mart passed 
Kmart as the largest discount chain with annual sales of $32.6 billion for Kmart's $32.3 
billion. Wal-Mart was well on its way to becoming the world's largest retailer. In 
December 2001, Target, Kmart's other major competitor, passed Kmart as the second 
largest discount chain. Target had prospered by emphasizing its merchandising, 
distinguishing itself as a low-cost source of quality and style. 
Kmart, in contrast, used a promotions-driven business model, drumming up business by 
advertising "blue-light" specials using circulars inserted into local newspapers. In an 
attempt to stay ahead ofWal-Mart, Kmart started investing $1 billion to modernize its 
information systems in 1987. According to David Carlson, then Kmart's CIa, the 
company developed capabilities to collect the necessary data, bUt it did not use them to 
forecast demand, relying instead on management's judgments. 
Carlson notes that Kmart's suppliers promoted as many of their products as they could 
sell rather than helping Kmart to focus on the better selling items, as was Wal-Mart's 
approach. Beginning in 1984, Kmart began diversifying its businesses by acquiring 
Waldenbooks, rayless Drugstores, Sports Authority, and OfficeMax. It also opened its 
first Super Kmart Center, a much larger store that now included groceries. Kmart 
continued to lose ground to competitors while it gained the image of being old-fashioned, 
outdated, and frumpy. It had a reputation of being a run-down place to shop with an 
inferior selection of products. Many of its shelves were empty while its prices were too 
high. It was even considered to offer poor customer service and to not care about 
competition. By 1994, Kmart was on the verge of bankruptcy. It sold off its newer 
businesses to concentrate on its discount stores, and, in 1997, it inaugurated the very 
popular Martha Stewart product lines for the home. In 1999, Kmart began developing 
BlueLight.com, a Web site designed to sell a few items in order to draw customers to 
physical stores and to polish its image. In May 2000, watching its hemorrhaging continue, 
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the company hired Charles Conaway, the former CVS drugstore chain president, as 
Kmart's chairman and CEO. Conaway pledged to turn the company around within two 
years, and said his goal was to make Kmart the primary destination for mothers looking 
for low-priced clothing, housewares, and packaged food for their families. He announced 
plans to restructure Kmart to increase the productivity of Kmart stores, inventories, and 
information systems. He closed 72 stores, reducing staff by 5,000. He even announced 
Kmart would spend about $1.4 billion for IT over two years versus only $263 million 
during the previous two years. However, in August 2001, Kmart announced a second 
quarter loss of $22 million, and Conaway blamed pricing pressure, particularly from Wal-
Mart. Kmart reduced prices on 30,000 of its 70,000 items and cut down on advertising 
circulars. Consumer habits are hard to change and Kmart sales took a big hit. 
Sales at Wal-Mart and Target grew in 2001, while those at Kmart continued to decline. 
Conaway said he had not found a formula to distinguish his company from his 
competitors. Since Conaway had taken over, Kmart had increased the percentage of 
items in stock to 86 percent, compared to 73 percent two to three years earlier. In a 
conference with Wall Street analysts, Conaway said Kmart was "doing a phenomenal job 
of reinventing" its supply chain, which would be visible to all in a year's time. 
Despite Kmart's continuing falling sales and rising losses Conaway again mandated 
price cuts, this time on 50,000 products. When Fleming Companies, now Kmart's sole 
grocery supplier, suspended shipments to Kmart because of Kmart's failure to meet its 
weekly payment of $78 million, the company realized it could no longer meet all of its 
financial obligations. Kmart had to declare bankruptcy. Kmart had clearly exhibited many 
problems. For instance, former Kmart CIO Dave Carlson said he had tried to unify 
Kmart's two separate computers in its distribution system, but he was turned down 
because the project was considered to be too expensive. When Conaway was first hired, 
he wanted to find new ways to bring customers into the stores, and so he cut back on 
Kmart's primary method of Sunday circulars but offered no dear alternative strategy. In 
2000, central planners were still allocating 60 percent of Kmart's goods to specific stores. 
Conaway tried to address this problem, but by December 2001, 40 percent of its goods 
were still being allocated by central planning rather than by local stores. Also, Kmart 
continued to expand the variety of its products rather than focusing on fast selling items, 
as did Wal-Mart. Shipping was such a problem that in December 2000, being limited to 
only 900 trucks per day, Kmart was forced to choose between shipping toothpaste or 
Christmas trees. Warehousing was also an obvious problem since 15,000 truck-trailers 
were parked behind its stores holding excess inventory because they had no more 
storage space. Conaway did successfully eliminate this problem within a few months, 
thereby also reducing the "shrink" (stolen product) rate. Many analysts and observers, 
including Conaway, believed supply chain management was Kmart's most serious 
problem, particularly when compared to Wal-Mart. Kmart's promotions driven business 
model created sharp spikes and drops in demand for products and has been much more 
difficult to support with supply chain management systems than everyday low pricing 
models such as Wal-Mart's. Indications of supply chain troubles were everywhere. 
Outdated technology at the distribution centers resulted in supplies often sitting on 
pallets for 24 or more hours until they were recorded in the central tracking system. The 
shelves displaying popular products were often empty, and to reorder them from regional 
distribution centers, store merchandisers first had to hand sift through previous 
purchasing receipts. Kmart's inventory turnover rate was very low. In the year 2000, 
Kmart's was an anemic 3.6; while Wal-Mart's was 7.3, and Target's was 6.3. Gary Buzek, 
the president of IHL Consulting Group, estimated that Kmart could add $1.9 billion in 
profit just by matching its competitors' turnover rates. Conaway moved ahead quickly. In 
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July, he selected i2 Technologies of Dallas, Texas, to work with Kmart in a project to 
rebuild its supply-chain systems. i2 had been a highly successful vendor of supply-chain 
software, although principally for manufacturers, while Kmart's new software had to be 
designed for its retail business. The project was to improve Kmart's management of 
sales forecasting, inventory sourcing, logistics, and reporting. i2 planned to use the 
Kmart project to create templates for sale to the retail industry in general and then 
customize them specifically for Kmart. The project would also connect these new 
systems to appropriate in-store technology such as bar-code scanners at cash registers. 
It would also include micro merchandising, which enables individual stores to select their 
own merchandise according to the needs and demands of their local community. i2 
claimed its software would track the ability of key suppliers to supply their products. It 
would also analyze Kmart's needs, and execute the required orders, schedule shipments, 
and record the delivery of products. i2 claimed its software would reduce excess 
inventory in stores and distribution centers, thus lowering costs, and enabling Kmart to 
lower prices. Sales would then grow and profits increase. Conaway stated Kmart's 
supply chain would become the best in the retail business, although Lora Cecere, a 
Gartner analyst, did question the ability of the project to succeed in such a giant, 
complex project. 
Katrina Roche, i2's chief marketing officer, stated that "i2 excels at sales but its 
execution isn't always flawless." Supply chain management software for manufacturing 
still accounted for 90 percent of i2's business, and it had only recent and limited 
experience in the retail sector. One major roadblock was that manufacturers use a 
relatively small number of stock-keeping units (SKUs) that must be handled by supply 
chain management software. Unfortunately, Kmart had over 70,000 SKUs in its 2,100 
stores, meaning the system must deal with 147 million possible pairings, and this 
number is increased by inserting many distribution centers and time periods involved. 
The i2 software was simply not designed to handle such huge data sets. Yet advanced 
planning software is fundamental to supply chain management, and the problem could 
only be solved by Kmart purchasing more hardware; an expensive solution for a 
company facing Kmart's financial problems.   
The i2 project was organized with a team of 500 working in an isolated location. It 
included over 100 personnel from Deloitte Consulting who were to customize i2's 
existing software, making it able to track the movement of goods to Kmart's more than 
2,100 stores. Conaway announced that the first applications would go live in early 2001, 
followed by a "rapid, methodical rollout" of several dozen business releases with a total 
of93 distinct improvements, all by August 2002. 
In February 2001, several suppliers, including Pharmavite Corp. of Northridge, California, 
and Bell Sports Corp. of Irving, Texas, said they were seeing improved inventory 
management in the last three months. Also, Kmart announced a $200 million program to 
purchase and install new point-of-sale terminal cash registers from IBM to improve 
customer service with faster checkout technologies. 
In June 2001, Kmart began installing new warehouse management software called 
PkMS, from Manhattan Associates. Its goal was to move products-more quickly through 
Kmart's distribution centers to the stores, thereby cutting costs while getting the product 
on the shelves before it has been sold out. The software 
was installed at corporate headquarters and in all distribution centers. Using it, workers 
who pick, pack, and ship products to the stores use bar-code scanners to locate each 
item and to track the flow of the goods. A spokesperson said Kmart would save $15 
million a year by increasing productivity and lowering labor costs. Management hoped it 
might also increase sales. The result was that Kmart could track 30 SKUs at the 



Srinivas MBA : MIS : CH 2   2009 
 

50 
 

beginning of the third quarter (2001), 119,000 in late November, and 500,000 three 
months later. However, Buzek believed the information would be useless because 
management just didn't believe in the system. In September, the company announced a 
$148 million write-off of its previous warehouse management system because it was so 
extensively modified that it no longer could work well and cost too much to maintain. 
Observers and analysts claim the write-off included abandoning some of i2's software. 
Kmart also wrote off $65 million for two outdated distribution centers, replacing them with 
two newer ones purchased from Toys 'R" Us. In December 2001, word came out that the 
i2 project had fallen way behind. John West, i2's chief technology officer until late in 
2001, said the software worked, but the project had stalled because of Kmart's 
"operational issues." One member of the i2 users group said, "If the data's not right, it's 
not that it doesn't work; it's just that you won't get the answer you want." Interestingly, 
when i2 had problems with Nike, it also blamed its customer and not itself. According to 
Karen Peterson, a Gartner analyst, Kmart originally did not understand the complex 
difficulties of the project. Another observer, Jim Dion, president of Chicago retail 
consulting firm Dionco Inc., said that with the project's difficulty in connecting its point-of-
sale and inventory systems to its distribution systems, Kmart was still sending many of 
its orders on paper. Also in December, Kmart indicated it was now trying to modernize 
800 of its stores at a cost of around $1 billion, and that money was competing with funds 
needed to modernize its supply chain. During the Christmas 2001 selling period Kmart 
moved less product off its shelves than it had in 2000. 
When Kmart was forced to declare bankruptcy, it did indicate some plans for survival. 
Conaway announced that the company would use Chapter 11 bankruptcy protection to 
break store leases in 284 stores in 40 states and then close them. In June 2002, Kmart 
c4anged the name of its Web site from Bluelight.com to Kmatt.com to attract a younger 
audience and help focus on Kmart stores and sales promotions. (Bluelight had never 
become a profitable Web business.) Kmart.com will also see an expanded variety of 
name brand products such as Pentax cameras and Disney apparel. Management 
believes Kmart.com also meshes better than Bluelight.com with the company's current 
"Stuff of Life" campaign, which is trying to position the chain as a family-friendly budget-
minded store. 
Emphasizing exclusive brands such as Martha, Stewart, Everyday, and Joe Boxer may 
help Kmart distinguish itself from its rivals. Conaway believes Kmart should be able to 
emerge from Chapter 11of Bankruptcy in 2003. The question is, will Kmart truly be able 
to bounce back? What will it take to keep going? The company still doesn't have a low 
enough cost structure to compete with Wal-Mart's low prices, nor does it have the trendy 
image of Target. What can Kmart do to become the shopping destination of choice? 
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CH 3 
Planning  for  MIS 

 
 
3.1.  Introduction : 
 
Complexity of the information resource environment suggests that the planning 
for information systems is vital for their success. Companies that plan tend to 
achieve better results than those that do not or plan poorly. In spite of this fact, 
many companies do not put proper emphasis on information system planning, 
particularly for developing long-range information systems. With the result, 
information systems in such companies create chaos and confusion rather than 
supporting the managerial decision making. Therefore, it is essential that 
companies develop information system plan to guide in initial development of 
information systems and making subsequent changes in these systems. 
 
3.2.  Planning for Information  : 
 
An information system plan describes the structure and content of the information 
systems and how these can be developed. Since all projects relating to 
information systems cannot be developed and implemented concurrently, 
priorities must be set. Since in a dynamic organization, there are more 
opportunities for information system applications than can be handled at one time, 
an allocation process must be worked out. Further, a very important fundamental 
concept of information system planning is that the organization’s strategic plan 
should be the basis for the information system strategic plan. Therefore, there 
should be integration of information system plan to organizational plan. 
 
An information system plan has two time perspectives-long range and short 
range. The long-range plan, which usually covers three to five years, provides 
general guidelines for direction. The short-range plan provides a basis for 
specific accountability as to operational and financial performance. Since the 
short-range plan is derived out of the long-range plan, both the plans should be 
fully integrated. An information system plan usually, contains the following four 
sections: 
 
1. Information system objectives and architecture. 
2. Inventory of existing information systems. 
3. Forecast of developments affecting the plan. 
4. Specific plan. 
 
Information System Objectives and Architecture 
At the starting level of developing a plan of any type, its objectives should be 
defined so that those who are responsible for developing the plan are clear as to 
what they have to achieve through planning exercise. This is true for developing 
a plan for information systems too. However, information system objectives are 
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not ends in themselves from the organization’s point of view because these 
objectives contribute to the achievement of organizational objectives which are 
ends in themselves. Therefore, while defining the information system objectives, 
following factors should be considered : 
 
1. Organizational objectives particularly the long term. 
2. Organizational strategies to achieve those objectives, 
3. External environment affecting the operation of the organization (such as 
nature of industry, government regulations, customers, suppliers), 
4. Internal organizational constraints (such as management philosophy, 
organizational culture, etc.), and 
5. Assumptions about business risks and potential consequences. 
 
Thus, the information system objectives are defined within the overall 
organizational objectives. These objectives, in turn, provide the direction for 
developing information systems. While defining the information system objectives, 
these should be defined in both broad and operational ways. A broad objective 
defines what the information systems are going to achieve; how they would 
contribute to the achievement of organizational objectives. An Operational 
objective defines what the information systems are going to achieve in a specific 
time frame. For example, while the overall objective of the information systems 
may be defined in terms of 'providing information on a timely basis to all 
organizational units', the operational objective may be defined in terms of 
'providing periodic financial reports within 24 hours after the end of the period’. 
Based on the objectives, information system architecture is defined. Information 
system architecture provides a framework for detailed planning. It defines major 
categories of information and the major information subsystems or applications 
for the organization as a whole. 
 
Inventory of Existing Information Systems 
 
Inventory of existing information systems indicates the current status of 
information systems in use. Inventory includes such items as hardware, software, 
and applications (if the information systems are computerized); analysis of 
expenses, hardware and software utilization, and personnel utilization; and 
assessment of strengths and weaknesses of the existing information systems. 
 
The basic objective of inventory is to determine the extent to which the existing 
systems would contribute to the proposed systems. For example, when an 
organization is switching from centralized computing to client/server computing, it 
must identify which of the hardware and software (both system and application) 
can be used in the latter. Similar is the case with personnel utilization. However, 
in the case of personnel, some additional problems arise specially when there is 
a change of manual to computerized information systems. In such a case, many 
existing personnel may become redundant unless suitable training is provided to 
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them. Further, the organization has to develop plan to utilize surplus personnel 
which may result because of computerization. 
 
Forecast of Developments Affecting the Plan 
While developing an information system plan, it is necessary that future 
developments which may affect the implementation of the plan are taken into 
account. Such developments may be. in the area of information technology, 
methodology, and environment. Information technology has the greatest 
influence on the effectiveness of any information system. Therefore, how 
information technology, both in terms of hardware and Software, would shape in 
future should be given adequate consideration. Though it is very difficult to 
predict the nature of technological development at the time of preparing the plan, 
organizations acting on proactive basis can plan the assimilation of new 
technology easily because of time lag between technology development and its 
application. Usually, it happens that technology development is announced much 
earlier than its commercial use. 
 
Besides information technology, methodology change can also be forecast in 
advance. In order to incorporate methodology change, it is better to consider 
alternative system development methodologies in place of or in addition to 
traditional life cycle methods. Environmental changes, such as change in 
government regulations, tax laws, competitors' actions, etc. should also be 
included in so far as they affect information systems. 
 
Specific Plan 
After determining the above three factors, the organization can draw a specific 
plan for information systems. At the initial level, a specific plan may be prepared 
for a longer term, say up to five years. Based on this, plan may be prepared for 
shorter term, say for the next year or two years. However, these two-period plans 
should not be prepared independent of each other but both of these should be 
fully integrated. This integration can be achieved if the shorter-term plan is 
derived from the longer-term plan. The specific plan should include hardware 
acquisition schedule, purchased software schedule for both system software and 
application software, application software development schedule, software 
maintenance and conversion schedule, personnel resources required and their 
recruitment and training schedule, and financial resources required-capital 
expenditure for acquiring hardware, Software, and other accessories; operating 
expenditure for operations, maintenance, and new development. 
 
There should be a provision for updating the plan as each year passes, the 
information system plan requires updating. Future plans are affected by changes 
in technology, experience with the systems that have been developed, changing 
needs for new systems, and changes in the organization itself. The plan should 
be updated in anticipation of these changes rather than the actual changes. This 
facilitates the organization to be ready to face challenges emerging out of these 
changes. 
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INFORMATION SYSTEM GROWTH CYCLE 
Every system has a life cycle In which a system develops Into stages. For 
example, human beings have life cycle consisting of birth, adolescence, youth, 
adult, maturity, and decay. In the same way, an Information system has a life 
cycle with different stages. Nolan has presented a stage model of Information 
system life cycle. Nolan stage model is a framework for Information system 
planning that matches various features of Information systems to stages of 
growth. It is a contingency theory which states-if these features exist, then the 
information system Is In this stage. It states that an organization must go through 
each stage of growth before It can progress to the next one. Thus, the stage 
model provides a set of limits if the organization’s current stage of growth can be 
diagnosed. 
 
Information System Growth Stages 
Nolan originally presented four stages of Information system life cycle-Initiation, 
expansion (or contagion), formalization (or control), and maturity (or Integration).  
In a subsequent model, Nolan expanded these four stages into six stages-
initiation, contagion, control, Integration, data administration, and maturity. 
Management responses to growth in computing are reflected In different levels of 
control or slack with each stage. Control is characterized by management 
policies and systems which ensure efficiency of computing use. Slack is the lack 
of control and the availability of resources to experiment with application features 
not required to perform basic processing. Table 3.1 shows the levels of control or 
slack In different stages of Information system growth model. 
 
Table 3.1: Levels of control or slack in different stages 

 
 
While proposing stage model of information system growth cycle, Nolan has 
made certain assumptions about the growth dynamics of movement through the 
stages. These assumptions are as follows: 
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1. Organizational learning permits movement through stages. Organizational 
learning is the process by which an organization identifies action-outcome 
relationships, identifies and corrects errors, stores the experience in 
organizational personnel who teach new employees, and stores the systems, 
procedures, rules, computer programs, and other forms of transferring 
experience. Thus, organizational learning exhibits adaptive behaviour. This 
adaptive behaviour is useful in moving from one stage to another stage of 
information system growth cycle. For example, limited experimentation of stage 
one (initiation) is the basis for the second stage (contagion), and contagion stage 
allows diffusion of the technology before controls are applied. 
 
2. Various stages of information system growth cycle cannot be skipped because 
experience is necessary before the organization is ready for the next stage. If 
experimentation is not performed. there are no early users to promote contagion. 
If the organization goes from initiation to control directly, technology diffusion 
does not occur because the control stifles widespread trial-and-error use. 
 
3. Although there are certain natural growth processes involved, various stages 
of growth model can be planned, coordinated, and managed to move through 
stages efficiently and effectively. Organizational culture, leadership styles, and 
power relationships shift to meet the needs of each stage. Thus, various stages 
represent a sequence for planned and managed change. 
 
Nolan has also proposed that major changes in information technology eliminate 
the maturity stage. With the introduction of new hardware, software, and system 
design, the organization starts on a new growth curve as shown in Figure 3.1. 
 

 
 

Figure 3.1: Repeating stages after technology shift. 
Using Stage Model in Information System Planning 
The stage model has significant relevance in information system planning. It can 
be used in diagnosis of current stage of growth and in planning changes in 
controlled way to move to the next stage. In an organization, usually, not all 
application subsystems grow at the same rate: for example, financial information 
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system may be in stage three (control) with controlled growth, while marketing 
may require encouragement for new applications which need more slacks. Thus. 
in practice, shifts in stages and their accompanying features occur gradually and 
at different paces. The stage model describes the logic of change and the 
destination that is to be achieved. It presents the logic of information system 
growth over different stages. However, the stage model does not specify the 
mechanisms of change from one stage to another stage. To that extent, the 
model lacks specificity. Therefore, the diagnostic measurements and prescriptive 
elements of the model should be viewed as general guidelines for information 
system planning. 
 
3. 3  Techniques for Information Systems  Planning : 
 
A number of techniques have been proposed for information system planning. 
Each of these techniques tries to identify the flow of activities for developing a 
long-rage information system plan. These techniques are as follows: 
1. Derivation of information system plan from organizational plan. 
2. Strategic grid. 
3. Strategy set transformation. 
 
(1) DERIVATION OF INFORMATION SYSTEM PLAN FROM 
ORGANISATIONAL PLAN : 
One of the most useful techniques of information system planning is derivation of 
information system plan from organizational plan. Every organization has some 
kind of plan that reflects its objectives and strategy to achieve those objectives. 
The implementation of strategy brings results and control system analyses 
whether the results are in tune with objectives: If not what additional efforts are 
required. By aligning the information system plan to organizational plan, 
objectives and strategy for developing information system plan may be adopted. 
It implies that those who are responsible for developing information system plan 
must be aware of planning process and various activities involved in it so that 
information systems are geared to these activities. Figure 3.2 presents 
organizational planning process. 
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FIGURE 3.2: Organizational planning process 

 
Various activities involved in organizational planning process should not be taken 
as independent activities and their flow only in one direction. Rather these should 
be taken in an integrated way in which two activities should be considered 
mutually interacting having two-way impact. The information system plan should 
be such that it provides relevant information at each activity level and its mutual 
interaction with other activities. A brief discussion of various activities of planning, 
process and their information requirements is presented below. 
 
Defining Organizational Mission : Organizational mission is the fundamental 
purpose that explains why an organization exists and sets it apart from other 
organizations. It is a general enduring statement of the organization’s intent and 
embodies the strategic decision makers' business philosophy. Organizational 
mission becomes the cornerstone for organizational operations. The scope of 
these operations is defined in terms of markets and products, that is, which 
markets will be served by the organization by offering which products. 
Organizational mission is enduring and, therefore, it changes over a long period 
of time depending on the environmental and internal organizational factors. 
Information systems play little role in defining organizational mission. 
I 
Environmental Analysis : The second element of organizational planning 
process is environmental analysis. Since an organization operates in a society, it 
has to interact with various factors lying in the society, such as customers, 
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suppliers, financiers, competitor, government, and other organs of the society. In 
the planning process, forecast is made about the likely future behaviour of these 
factors. However, this forecast is not made in vacuum rather it is based on 
information. Here the role of information systems is vital because that make 
relevant information available. If an organization scans its environment 
intensively, the information systems must be able to provide relevant mechanism 
for such scanning. 
 
Organizational Analysis : Organizational analysis identifies the strengths 
weaknesses of the organization so that the organization is able to take 
advantages by using its strengths, and at the same time, taking measures to 
overcome its weaknesses. Organizational strengths and weaknesses are 
measured in all the functional areas-production, marketing, finance, and 
personnel-as well as its operating systems, procedures, etc. Here, information 
systems play significant role in identifying such strengths and weaknesses by 
collecting and analyzing internal information. 
 
Setting Long-term Objectives : Based on organizational mission, 
environmental analysis, and organizational analysis, long-term objectives of the 
organizations are set. These long-term objectives may be set for a plan period 
(five years or so) or even beyond that. Some organizations define their objectives 
beyond a plan period which provide guidelines for setting objectives for plan 
periods. By analyzing the information from different sources, long-term objectives 
are set so that they are more realistic and meaningful. 
 
Identifying Alternative Plans : Combination of organizational mission, 
environmental analysis, and organizational analysis enables the organization to 
generate various alternative plans which may help it achieve its long-term 
objectives. At this level, the aim is to generate as many alternatives as possible 
so that the organization has flexibility in choosing a plan for implementation. 
Information systems help in identifying such alternative plans by providing 
relevant information. 
 
Evaluating Alternative Plans : After identification of various alternative plans, 
these are evaluated to find out which one is best in the given circumstances. 
Since all the plans cannot be implemented, it is desirable to select the one that 
meets the criteria of various decision factors. For evaluating different alternatives, 
successive step method is followed. Those plans which do not meet the initial 
decision criteria, (investment requirements, degree of risks, profitability, etc.) are 
eliminated at the first step of evaluation. The remaining plans go to the next step 
where the same process is repeated. Thus, screening out the plans results into 
only few plans which require detailed evaluation in terms of their payoff, risk 
involved, and so on. Information systems provide help in evaluating various 
alternative plans by analyzing their impact on the organization. 
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Choice of a Plan : When various alternative plans are evaluated, one of these 
plans is chosen for implementation. The chosen plan should meet the 
requirements of the organization as well as the personal aspirations and 
preferences of key decision makers. Because of these personal aspirations and 
preferences, sometimes, final choice of a plan does not remain fully objective. 
Information systems apply only objective factors in choosing a plan but do not 
take subjective factors into consideration. 
 
Plan Implementation : Plan implementation involves putting a plan into action. 
For putting the plan into action, a detailed schedule of time is worked out, time-
wise resource requirement is worked out, and finally, the plan is executed. During 
execution period, information systems measure the progress of plan execution in 
terms of time schedule as well as in terms of resource application. If there is any 
deviation between predetermined and actual time schedule and resource 
application, the information systems should have mechanisms to detect such 
deviation and communicate it promptly so that corrective actions are taken for the 
remaining portion of plan execution. 
 
Results and Feedback : After the plan is implemented, it starts producing 
results. The information systems should monitor such results and provide 
feedback to management whether these results correspond with the desired 
results which were set at the time of choosing the plan. If the desired results and 
actual results show deviation, the information systems should detect the 
deviation and analyze the causes of such a deviation. Once the plan is executed, 
finding of actual results, comparing these with desired results, analyzing causes 
for deviation, and providing feedback to management become the regular 
function of the information systems. 
 
Derivation of information plan from organizational plan is a good technique for 
information system planning because the information systems can pinpoint on 
those aspects on which managers need information, the time at which they need 
it, and the form in which they need it. However, this presents some operational 
problems too. First, those who are responsible for information system design are 
not well acquainted with how actually organizational planning takes place. 
Similarly, managers who are responsible for organizational planning are not well 
acquainted with how information systems work. Thus, there is likelihood of 
mismatch between what managers need as perceived by system designers and 
as perceived by the managers themselves. In order to overcome this problem, 
both information system specialists and managers should join hands even at the 
stage of planning for information systems. Second, in many organizations, choice 
of a plan does not follow the process described here. In such organizations, 
many plans emerge as process of mental exercise of some key decision makers. 
In such a case, only, the details of plan execution are worked out and working 
out of these details is supported by the information systems. 
 
STRATEGIC GRID 
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Another technique of information system planning is the strategic grid, developed 
by McFarlan and McKenney, often called McFarlan-McKenney strategic grid.  
The strategic grid takes into account strategic impact of existing operating 
applications and strategic impact of planned application development portfolio. 
Both of these dimensions may have either high or low strategic impact on the 
information systems. By combining both these dimensions, four types of 
information system planning situations can be identified as shown in Figure 3.3. 
 

 
FIGURE 3.3: McFarlan-McKenney strategic grid 

 
Each of the four cells of strategic grid defines the position of the information 
system activity relative to the organization as follows: 
 
Support : When both dimensions of impact-strategic impact of existing operating 
applications and strategic impact of planned, application development portfolio-
are low, information system applications that -support the activities of the 
organization are required. These systems emphasize traditional data processing 
applications. Information system activities are not vital to critical operations and 
are not included as part of future strategic directions. 
 
Factory : When strategic impact of planned application portfolio is low but 
strategic impact of existing operating applications is high, factory cell of 
information systems is relevant. In this situation, information system applications 
are vital to the successful functioning of well-defined and well-accepted activities. 
However, information systems are not part of future strategic directions. 
 
Turnaround : When strategic impact of planned application development 
portfolio is high but strategic impact of existing operating applications is low, 
information systems fall in turnaround cell. Turnaround is a transition state from 
support to strategic. The organization has had support-type applications, but is 
now planning for applications vital to strategic success of the organization. 
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Strategic : When strategic impact of planned application development portfolio 
as well as strategic impact of existing operating applications are high, strategic 
information systems are relevant. Information system activities are critical to the 
current competitive strategy and to the future strategic directions of the 
organization. Existing information system activities are part of the new strategic 
directions. 
 
Strategic grid provides an analysis of current and planned portfolio status. It can 
be used to change direction. The cell can then be used to suggest the 
information system planning and the strategy to be adopted for preparing 
information system plan as shown in Table. 
 

 
 
The strategic grid of information system is a diagnostic tool to understand the 
role of information systems in an organization. The position in the grid explains 
the level of involvement of top management in information system planning and 
the relationship between information system planning and organizational 
planning. However, strategic grid suffers from one basic limitation. It merely 
explains what is happening rather than what should happen. If an organization 
desires to be more strategic in its use of information systems, the grid does not 
explain how this can be done. 
 
STRATEGY SET TRANSFORMATION 
Sometimes, it is not possible to derive information system objectives and plan 
based on organizational plan. This happens more so when organizational plan 
does not emerge as a sequential process and organization’s strategic position is 
not specified clearly. In this situation, information system planning cannot derive 
meaningful clues from organizational plan and strategy. Therefore, strategy set 
transformation approach is used for information system planning. King has 
provided a model of strategy set transformation which helps in defining 
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information system objectives and the process that can be adopted for its 
planning.   
 
Strategy set transformation proceeds in the following manner : 
1. Explicate the organization’s strategy set by : 
A. Delineating the organization’s stakeholders-owners, employees, suppliers, 
customers, etc. 
B.  Identifying the objectives of each stakeholder and 
C. Identifying the organizational strategy to satisfy the objectives of each 
stakeholder. 
2. Validate the organizational objectives and strategies by asking top 
management to critique the statements. The organizational objectives and 
strategies form the organizational strategy set. 
3. Transform the organizational strategy set into the information system strategy 
set by: 
A. identifying one or more information system objectives for each organizational 
objective and strategy set. 
B. identifying information system constraints from organization strategy set and 
from information system objectives: 
C. identifying information system design strategy based on organization strategy 
set, information system objectives, and information system constraints. 
 
How strategy set transformation process can be used for information system 
planning can be explained by an example. Suppose an organization desires to 
improve its cash flow in order to pay for its creditors (stakeholder) and improve 
organizational profitability (meeting owners' objectives). The organizational 
strategy to improve cash flow is to collect from its debtors fast. Based on this, 
information system objective may be to improve billing. 
 
Strategic organizational attributes relative to use of computerized information 
systems and decisions models will be reflected in information system constraints 
affecting the billing system. These can be expressed in information system 
design strategies, such as pilot projects for training, prototyping for system 
development, etc. 
 
Strategic Approach for Determining Information Requirements 
 
For information system planning, an organization has to determine its information 
requirements. Such requirements must be defined for the organization as a 
whole as well as for its different subsystems. To ensure that the information 
systems play effective role in generating competitive advantage to the 
organization, it is essential that the organization adopts strategic approach to 
identify its information requirements. Strategic approach of information 
requirement determination takes both environmental as well as organizational 
factors into account. A strategic approach for determining information 
requirements takes into account the following factors: 
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1. Critical success factors. 
2. Competitive forces. 
3. Value chain. 
 
CRITICAL SUCCESS FACTORS 
 
Critical success factor approach of determining information requirements argues 
that the information requirements of an organization are determined by a small 
number of critical success factors (CSFs) relevant to the organization and the 
industry in which it operates. CSFs are those characteristics, Conditions, or 
variables which when maintained and sustained, can have significant impact on 
the success of an organization competing in a particular industry. A CSF may be 
a characteristic such as product features, a condition such as high capital 
investment, or any other variable. A basic nature of CSFs is that they differ from 
industry to industry-consumer goods versus industrial goods, differentiated 
versus undifferentiated industries, local versus global industries and so on.  The 
following table presents some examples of CSFs relevant for different industries. 
 
Table : Critical success factors in different industries 
 

 
 
Using industry CSFs. managers can develop critical success factors in the form  
of organizational characteristics which match with industry CSFs. For example, if 
an industry CSF is in the form of wide-area distribution network, managers set 
objective in terms of developing this distribution network. Similarly, objectives can 
be set for all CSFs. In order to use CSF approach for identifying information 
requirements, managers need to generate as much information as possible by 
going through the following ways: 
1. CSFs can be identified based on logic, heuristics, or even a rule of thumb 
rather than through any theoretical model. These are based on long years of 
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managerial experience which leads to the development of intuition, judgment, 
and hunch. 
2. CSFs can also be identified internally in the organization by using creative 
techniques like brainstorming, or interviewing the key managers in the 
organization. 
3. CSFs can be deduced from other companies' statements, expert opinions. 
organizational success stories. etc. When CSFs are identified, managers set 
objectives in these areas which, in turn, become the basis for determining the 
information requirements. 
In fact, the basic premise in using CSF approach is that there is a small number 
of objectives that managers can easily identify and information systems focus on 
those objectives. For example, if an organization operating in toothpaste industry 
has set its objective to have certain rate of return on investment (first-level 
objective), it has to define its market share (second -level objective). In order to 
achieve its second-level objective, it has to define new product development 
(third-level objective). Since product is the source of generating revenue, product 
features must match the CSFs of the toothpaste industry (in terms of form, 
flavour, foam, and freshness). 
Similarly, objectives can be set in relation to distribution network, product 
promotion, etc. At all these levels, different types of information are required. 
 
Advantages of CSF Approach 
 
There are certain advantages of using CSF approach in identifying the 
information requirements: 
1. CSF approach produces a smaller data set to analyze for determining 
information requirements. Rather than going through a broad enquiry into what 
information is required by different managers. 
CSF approach focuses on a small number of items.  
2. CSI approach can be tailored to the structure of each industry, with different 
competitive strategies producing different information systems. It also depends 
on the industry position and even the geographical locations. Therefore, this 
approach produces systems that are more tailored to the organization. 
3. CSF approach takes into account the changing environment with which the 
organization and its managers must deal. It forces the managers to have a look 
at the environment and consider how their analysis of it shapes their information 
needs. 
4. CSF approach brings consensus among top managers about what is important 
to measure to gauge the organizational success. This enables the managers to 
focus their attention on how information should be handled. 
 
Limitations of CSF Approach 
CSF approach suffers with some limitations too which are as follows: 
 
1. There is no rigorous method of identifying CSFs either industry wise or 
organization-wise. Whatever factors managers may perceive as being critical 
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may not truly be critical. Therefore, for identifying  various CSFs, managers need 
high-level of imagination and experience.  
2, CSF approach focuses more on managers individually rather than focusing on 
the organization as a whole. What might be a CSF from a manager's point of 
view, may not be a CSF from the organization’s point of view. Therefore, 
confusion arises as to the basis on which information requirement is to be 
assessed. Thus, this approach does not provide the base for aggregating 
individual CSFs into a clear organizational pattern relevant for information system 
design. 
3. CSF approach is specifically useful for higher-level information systems-
decision support systems and executive information systems. It assumes that 
transaction processing systems have already been well developed in the 
organization. If that is so, CSF approach is useful otherwise it leaves a vacuum. 
 
COMPETITIVE FORCES 
Many forward-looking organizations design their information systems to counter 
the threats generated by competitive forces and develop competitive advantage. 
Often competing organizations talk about the nature of competition in terms of 
their existing competitors. To some extent, this may be true. However, 
competition is not manifested only in other players in the market; it is rooted in its 
underlying economics, and competitive forces exist that go well beyond the 
establ1shed players in a particular industry. Buyers, suppliers, potential entrants, 
and substitute products. all are competitors in the sense that they may be more 
or less prominent or active depending on the nature of the industry. Michael 
Porter has identified five forces that shape competition in an industry as shown in 
following Figure.  
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Threats of Entry : 
It is a famous saying that no business remains more attractive than others over 
the long run. This happens because if the industry is very profitable, there will be 
entry of many organizations in the field and position will become normal like any 
other industry. New entrants to an industry bring new capacity, the desire to gain 
market share, and have substantial resources. However, there are different kinds 
of barriers for newcomers in a field. If these barriers to the entry are high and a 
newcomer can expect sharp retaliation from the entrenched competitors, 
obviously he will not pose a serious threat of entry. There are six sources of 
barriers to entry. 
1. Economies of scale-emerging from high volume of production, resulting into 
economies in production, research, marketing, financing, and other part of 
business. 
2. Product differentiation-strategy adopted by existing players to differentiate their 
products from those of new entrants. 
3. Capital requirements-the need to invest large financial resources by new 
entrants. 
4. Cost advantages independent of size-emerging due to learning process 
adopted by new entrants. 
5. Access to distribution channels-the new entrants may be required to set up 
their distribution channels. 
6. Government policy-restrictions imposed by government to enter a particular 
business. 
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Bargaining Power of Buyers :  
Bargaining power of buyers exerts an influence over the organizations to shape 
their prices. quality of products and services offered. distribution channels used. 
etc. If there is a powerful buyer group, there will be buyers market and the 
producers' profits will suffer. Buyer group is powerful in the following 
circumstances: 
1. It is concentrated or it purchases in large volume. Large-volume buyers are 
particularly potent forces if heavy fixed costs characterize the industry. 
2. If the products it purchases from the industry are standard or undifferentiated. 
The buyers when they are sure that they can find alternative suppliers, may play 
one organization against another. 
This may happen with industrial products. 
3. If the products it purchases from the industry form a component of its product 
and represent a significant proportion of its costs, the buyers are likely to shop for 
a favorable price and purchase selectively. 
4. If buyers earn low profit, they will be more price-sensitive. In case of their high 
profit, they will be less price-sens1t1ve. 
5. Where industry's product is unimportant to the quality of buyers' product, they 
will be more price-sensitive. 
6. If the buyers pose a problem of backward integration, they will dominate in 
dealing with the industry in such a case. Such possibility is more in the case of 
textiles, automobiles, etc. 
 
Substitute Products : 
The amount of competition in an industry depends on the substitutability of 
products of the industry. By placing a ceiling on prices it can charge, substitute 
products or services limit the potential of an industry. Substitute products that 
deserve the most attention strategically are as follows: 
1. Products that are subject to improving their price-performance trade off with 
the industry product pose significant problem to the industry concerned. 
2. If the product is being produced by an industry earning high profit, threat for 
substitute product is high Higher threat is generated because more attention is 
paid to find out the substitute of the product earning high profit. 
 
Rivalry for Position :  
Various factors, discussed above, are mostly external form of competition and 
operate as homogenizing factors for all the competitors in an industry. 
Competition from within, that is among different players, is the most crucial factor 
which every organization should take into account. Rivalry among existing 
competitors takes the familiar form of jokeying for position, that is, increasing 
market share at the cost of competitors. Intense rivalry is related to a number of 
factors in an industry which are as follows: 
 
1. There are numerous competitors in an industry and all of them are trying for 
the same end-result, that is, increasing their sales and capturing higher market 
share. 
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2. Often industry growth is slower as compared to the rate of growth in product 
supply offered by numerous competitors. With the result, rivalry becomes keen 
among competitors. 
3. The product may lack differentiation and buyers are likely to switch over from 
one brand to another, based on price-performance relationship. 
4. When exit barrier is high because of investment locked up in specialized 
assets, the companies have to keep their operation on even if they are incurring 
losses. In order to reduce these losses, companies may go for intense marketing. 
5. Different competitors use different strategies based on pricing, product 
innovation, promotion, and other forms of differentiation. Each of them has 
different idea about how to do business, how to compete. and how to run head-
on into each other. 
 
Competitive Force Model and Information Systems 
After analyzing, the competitive forces, an organization requires to develop 
information systems that should provide relevant information to counter the 
threats posed by these forces or likely to pose threats in future. Thus, an 
organization must have information on the following aspects: 
 
1. Measuring performance of own products. 
2. Measuring performance of competitors' products. 
3. Reactions of buyers and suppliers. 
 
Measuring Performance of Own Products : An organization requires 
information to measure the performance of its own products. For each product, 
information is required region-wise and customer-wise over a  period of time to 
make a comparative analysis. Further, the information is required for the industry 
as a whole in which the organization operates to gauge the performance vis-a-vis 
total industry performance. If the organization has multiple products, such 
information is required for each product. Starting with data processing systems 
which provide base for structured information, the organization can design 
structured information systems which generate structured reports. 
 
Measuring Performance of Competitors' Products : Along with measuring the 
performance of its own products, the organization should measure the 
performance of competitors' products. Though there are certain industries where 
concerned associations provide the information about market share of different 
players, information is available quite late which has more of historical relevance 
and less of strategic relevance. Same is the case with various marketing 
research agencies which publish information quite late.  
 
In order to overcome this problem, the organization should develop its own 
marketing research information systems which may pinpoint what product a 
buyer buys and the reason why he buys. This information enables the 
organization to position and promote its products in a better way. 
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Reactions of Buyers and Suppliers : The organization is required to know the 
reactions of its buyers and suppliers. This can be done by developing wide area 
network to link buyers and suppliers so that there is continuous dialogue between 
the organization and its buyers and suppliers. While the number of suppliers may 
be limited, this may not be the case with buyers particularly in consumer products. 
Therefore, in such a case, the organization can link itself with distributors. Wide 
area network not only ensures continuous interaction with buyers and suppliers. 
it also enables the organization to schedule delivery and order placing. 
 
VALUE CHAIN 
Value chain analysis helps an organization to define the information which it 
needs to operate efficiently and thereby developing competitive advantage. 
Every organization performs a chain of activities. These activities are interrelated, 
and each activity creates a value important to the whole chain. Based on this, 
Porter has proposed the value chain to create more customer value.  Accordingly, 
every organization is a collection of activities that are performed to design. 
Produce, market. Deliver, and support its products. The value chain identifies 
nine strategically relevant activities that create value in a business. These nine 
value-creating activities consist of five primary activities and four support 
activities as shown in following figure. 

 
 
The value chain analysis is based on a typology of primary and support activities. 
Primary activities are the activities directly involved in the creation and transfer of 
products and services to the customers. Each value configuration has its own set 
of primary activities. Support activities enable and improve the performance of 
the primary activities and comprise procurement, technology development, 
human resource management and firm infrastructure (Porter, 1985). 
 
In the value chain model the basic logic of value creation is the transformation of 
input into products, mainly through sequential processes. The evaluation of the 
product and related services is the source of customer value. An example is the 
assembly line using long-linked technology to produce standard products at low 
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cost. Primary activities of a value chain are inbound logistics, operations, 
outbound logistics, marketing & sales, and service. 
 
 
3. 4.  Risks in Information  Systems : 
 
Defining the values must be supplemented by assessment of the risks 
associated with the realization of values from the IT infrastructure. Broadly, there 
are four types of risks, namely, organizational risk, IT infrastructure risk, 
definitional risk and technical feasibility risk. 
 
1. Organizational risk : The value of the IT infrastructure to the performance of 
the enterprise depends upon a host of environmental factors in the organization. 
The availability of necessary skills for implementation of information system 
projects and exploitation of IT infrastructure is sometimes a major constraint in 
the success of a information system project. Many organizations find resistance 
to the use of IT infrastructure within the organization, even when the necessary 
skills are available or are not very difficult to develop. Such a resistance, 
generally, is caused by the fears that might be created due to communication 
gap regarding implications of using IT infrastructure for a given application on the 
achievements of personal goals of the personnel associated with the application. 
For example, use of IT infrastructure in Indian banking industry faced a lot of 
resistance in the beginning from staff at various levels. The resistance was 
caused primarily due to the fear of possible retrenchments when the automation 
results in reduced manpower requirement. 
 
Such resistance causes non-utilization or underutilization of IT infrastructure 
resulting in failures of applications in delivering the benefits of IT. The success in 
realization of benefits also depends upon the work culture in the enterprise. 
Installation of e-mail facility did not improve the communication system in the 
organization and the infrastructure remained grossly underutilized in some 
organizations where interpersonal communication was restricted. In other cases, 
where there existed an environment of openness in communication, it was a 
complete success. 
 
2. IT infrastructure risks : Sometimes, the architecture of the existing IT 
infrastructure and the strategies of the on-going information systems are such 
that they are not in tune with the proposed information system project. Some 
projects have greater degree of dependence on the existing IT infrastructure. The 
degree of IT infrastructure risk is greater in such cases. However, if the proposed 
projects fit easily into the overall plan of the existing IT infrastructure, the 
probability of success is even higher. For example, the success of a customer 
information support system will depend upon the strength of the sales information 
system, production information system, financial accounting information system, 
etc. If these information systems are not mature, there is a greater risk of 
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customer information system not realizing the anticipated benefits. Rather, it may 
add more confusion to the existing chaos.  
 
3. Definitional risk :  The specific objectives that are sought to be achieved 
through the proposed, information system projects are to be defined properly or 
communicated to and received by the information system designers. Any 
ambiguity in the objectives and related details regarding the project may cause 
the projects not to deliver what was evaluated at the time of acceptance of the 
proposal. The definitional risks are greater in the case of projects that are 
complex in nature and relate to less tried processes. The definitional risks are 
lower in case of well established process, other things remaining equal. There is 
no dearth of cases wherein there is huge gap between what was targeted and 
what was finally delivered by the information systems. A market intelligence 
system, for example, aims at offering information regarding the rivals' plans may 
finally turn out to be a simple application aggregating the sales figures and 
analyzing trends in market shares. This may happen due to communication gap 
at the time of designing the application and definitional problems relating to what 
constitutes a market intelligence. 
 
4. Technical risk : The rapid advancements in the information technology 
occurring in hardware; software and data organization, make the new 
technologies very attractive in terms of stated return to cost ratios. There is 
always a temptation to jump into to new technology bandwagon. In fact, adoption 
of new technology in most of the cases is the obvious decision as the new 
technology seems to be distinctly superior to the old one. However, there is 
always a risk of adopting new and untried technologies. The projects that involve 
use of untried technologies are more risky than the ones that use well 
established and commercially tried technologies. Thus, the process of evaluating 
information system proposals involves definition and measurement of values for 
the tangible and intangible benefits of the system. These values are matched 
against the potential sources of risks of failures of information systems in 
achieving these values. 
 
Assignment Questions : 
 
1.  Explain all the stages of Information System Plan                                      12 M 
 
2.  Write a note on Nolan’s model of Information Systems Growth cycle.       12 M 
 
3.  What are the 3 techniques used for IS planning. Explain each in detail     15 M 
 
4. What are the different factors in strategic approach for determining information 
requirements in an organization? Explain each.                                              15 M 
 
5.  Write a note on risks in Information Systems. 

************************ 
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CHAPTER 4 
 

Introduction to Computers  
 
 
Computer is an electronic device that can perform a sequence of automatic and 
/ or logic operations and produce useful results, without human intervention, 
except in preparing the device and, possibly initiating the operations.  It performs 
operations under the direction of step –by – step stored program of instructions.  
 
We live in an age where computer has become a necessity. We find computers 
everywhere around us helping us in doing things which would have otherwise 
taken years to complete. To give you an example, when computerization of 
billing of telephone bills in Delhi was taken up, there was a backlog of more than 
6 months. This was resulting in lots of losses to Delhi Telephones. If you do not 
send the bill, nobody will pay you. So within the next 3 months, not even the 
pending bills were sent, but current ones were also issued, This resulted in Delhi 
Telephone having surplus money within 3 months of computerization. And they 
invested a part of it buying out new computers. 
 
EVOLUTION OF COMPUTERS 
 
Computers were very slow to begin with and they have gone through lots of 
changes over the last century. Though we are quite happy with the current 
generation of computers, but still we have to look back and see how the current 
computers have been developed over the period. 
 
The earliest need for the counting was felt as early as stone age. Pebbles were 
used for this. Later on, Egyptians counted by drawing pictures on the wall. All 
this led to the development of Abacus by Indians and Egyptians. It was later on 
modified by the Chinese. 
 
ABACUS : 
The Chinese have a great fascination for the abacus. On the streets of Beijing, a 
few years ago, you could see them using it. It consists of 10 rods of beads. Each 
bead represents a number. Each rod contains 7 beads, 2 in the top section  and 
5 in the lower section. A bead in the lower half represents a single unit whereas 
a bead in the upper half represents 5. A representation is made by moving the 
bead towards the central rod. Thus each number is represented. 
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An abacus representing a number 8174260847 is shown above. 
 
NAPIER'S BONE : 
John Napier, the mathematician from Scotland, devised a set of rods for use in 
calculations involving multiplication. These rods were carved from bones and 
thus, were called "Napier's Bone". 
 
 
PASCAL'S MACHINE : 
It was way back in 1642 that Blaise Pascal developed a machine, which could 
not only add but also do multiplication and division. Later on, lots of modifications 
were done using rods, toothed wheels, bones, etc. 
 
DIFFERENCE ENGINE 
In 1823, Charles Babbage developed a machine called Difference Engine. This 
machine was based on the punch card technology developed earlier by Joseph 
Marie Jacquard, known for his invention called Jacquard's Loom. 
 
He later improved the machine and called it Analytical Engine. It was based on 
mechanical gears. His technology of storing data and automation of it is still the 
base of all the modern-day computers. 

This is why Charles Babbage is called the Father of Computers. 
 
HOLLERITH'S  PUNCHED CARDS : 
In 1890, a census (counting of population) took place In USA. Herman Hollerith 
devised a machine of punched cards. The cards used to have holes for different 
answers. When these cards passed through the machine, a hole would allow the 
current to pass and thus it was taken  as Yes  and  if there was  no  hole  
punched  and  the current did  not  pass,  it was taken as No. Hollerith later on 
formed a company, which grew up and is now known as International Business 
Machines (IBM). 
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During the Second World War, the Germans developed computers known as Z1 
and Z2 machines. These were useful for breaking the enemy codes. 

 
ENIAC & MARK I  : 
In 1946, John Mauchly and Presper Eckert developed the first electronic 
computer known as ENIAC. It was based on the technology earlier developed by 
Howard Aitken and Grace Hopper in 1944 in the form of a machine known as 
Mark 1. 
 
In 1936, after reading Lady Loverlace's notes Aiken begin to think that a modern 
equivalent of the analytical engine could be developed. So the first electro-
mechanical computer the MARK 1 was developed by him in 1944 under the 
sponsorship of IBM. It was essentially a serial collection of electromechanical 
calculators and had many similarities to Babbage's analytical machine. 
 
Dr. John W Mauchly collaborated with J Presper Eckert Jr. at the University of 
Pennsylvania to develop a machine that would compute tables for the US Army. 
The end product was the first fully operational electronic computer, which was 
completed in 1946 and named as ENIAC (Electronic Numerical Integrator and 
Computer). 
 
Until then all computers used the movements of mechanical parts to perform 
their operations and store, but ENIAC, the first electronic computer used the 
movements of electrons do its calculations. Because pulses of electrons can be 
made to move much faster than the mechanical parts, the electronic computers 
operate much faster than mechanical ones. 
 
This computer was actually known as first generation computer, since it was 
based on Valve technology. The other computers which come into this category 
are NIVAC. LEO, WHIRLWIND, EDVAC, etc. 

 
But this was the first generation of computers. Later on we had the second, third, 
fourth and fifth generation of computers.  
 
COMPUTER GENERATIONS : 
 
As mentioned above the development of computer over the ages has been 
divided into 5 generations. These are listed below with the year when they have 
been around and what was the main storing method: 
 
First Generation     :This was based on Thermionic Valve or so called 

 Vacuum Tube                                    1949 
Second Generation: This was based on Transistors                      1956 
Third Generation     : Integrated Circuits or ICs                               1966 
Fourth Generation   :Microprocessors Chips                                  1975 
Fifth Generation      : Very Large Scale Integration Systems          1990 
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The First Generation : 
 
The main computer during this period was UNIVAC (Universal Automatic 
Computer). It was developed by Mauchly and Eckert for Remington Rand 
Corporation, and was installed in the US Bureau of the Census in 1951. Later 
that year, CBS news gave the UNIVAC national exposure when it correctly 
predicted Dwight Eisenhower's victory in the presidential election with only 5% of 
the votes counted. 
 
In the first generation, vacuum tubes—electronic tubes about the size of light 
bulbs— were used as the internal computer components. However, because 
thousands of such tubes were required, they generated a great deal of heat, 
causing many problems in temperature regulation and climate control. 
 

After the success of UNIVAC, IBM made a beginning and started manufacturing 
and marketing computers. IBM's first entry into the commercial computer market 
was the IBM 701 in 1953. It was IBM 650, introduced in 1954, which brought 
fame to IBM. The IBM 650 was designed as a logical upgrade of existing 
punched card machines. 
 

The Second Generation : 
 
Transistor, a small device that transferred electric signals across a resistor, was 
developed in this generation. It revolutionized electronics in general and 
computers in particular. Transistors were much smaller than vacuum tubes and 
they had numerous other advantages, they needed no warm up time, consumed 
less energy and were faster and more reliable. 
 
Lots of programming languages were developed in this generation. Like 
FORTRAN in 1954, COBOL in 1959 and ALGOL in 1960. Along with the 
Assembly language, these programming languages were instrumental in the 
development of more computers here. 

 
Honywell established itself as a major player in the second generation of 
computers.  
Burrough, UNIVAC, NCR, CDC and Honywell together became the biggest 
competitors to IBM. Main computers in this generation were: Honywell 4000, 
PDP-8, IBM 7090, IBM 70941. 

 
The Third Generation : 
 
Silicon, a non-metallic substance found in common beach sand as well in rocks, 
became the most important role player in this generation. It is principally used as 
a semiconducting material for making  Silicon chip, the integrated circuit. This 
element is important in the study of computers because the circuitry of the 
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computer is etched on a chip of Silicon. It was in 1965 at Santa Clara County. 
Silicon Valley, in USA, where the production of Silicon Chip (IC) was started. An 
integrated circuit (IC) is a complete electronic circuit on a small chip of Silicon. 
The chip which is less than 1/8 inch square and contains millions of electronic 
components. In 1965 ICs began to replace transistors in computers. The 
resulting machines were called third generation computers. 
 
The beginning of the third generation was proclaimed by the IBM 360 in 1964. 
This computer which was based on ICs became the role model for other 
computers to come.  
 
Besides IBM 360, the other computers to prosperous during this period were 
CDC 7600 and POP II, etc. 
 
The Fourth Generation : 
 
This generation of computers were based upon the development of large scale 
integration (LSI) circuitry. This generation was in fact, an extension of the third 
generation technology. The base technology was still the integrated circuit. This 
is not to industry has experienced a mind boggling succession of advances in the 
further say that two decades have passed without significant innovations. In fact, 
the computer miniaturization of circuitry, data communications, and the design of 
computer hardware and software. 
 
This generation saw the emergence of Altair 8800 in 1975, Apple II from Apple 
Computer.  
 
The Fifth Generation : 
 
This term was coined by the Japanese to describe the powerful intelligent 
computers they wanted to build by the mid 1990s. Later the term became more 
broad to cover the several research fields too related to computer intelligence, 
artificial intelligence, expert systems and natural language. 
 
But the true focus in this generation has been connectivity. The method of 
connecting computers called networking and its use in the development of 
Internet, which has really revolutionized the way we look at the computers now. 
 
This all lead to most important computer of the century, called the Personal 
Computer. 
 
PERSONAL COMPUTERS : 
 
As mentioned above, in 1981, IBM introduced the first Personal Computers. The 
technology used in it was so simple that it took no time for others to copy it and 
make computers which are known as IBM compatible computers. They are 
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known as IBM clones too. Since then, IBM has brought out different 
versions/models with variations of floppy disks, hard disks, chips, etc., making 
them faster and faster. 
 
The various versions of IBM PC compatible computers are shown below: 
Model             RAM Chip       Type of Chip        Floopy D        Floopy D     H.D 
 
PC-XT                      640 K                     8088                            2                         0                  0 
PC-XT                      640 K                     8088                            1                         0              20 MB 
PC-AT/286              1028 K                   80286                           1                         1              40 MB 
PC-AT/386                4 MB                    80386                           1                         1            120 MB 
PC-AT/486                8 MB                    80486                           1                         1            260 MB 
PC-Pentium             16 MB                 Pentium                          0                         1            720 MB 
PC-PII                      32 MB                Pentium-II                        0                         1            4 GB 
PC-PIII                     64 MB                Pentium-III                       0                         1            10 GB 
PC-PIV                    128 MB                Pentium-IV                      0                        1            40 GB 
 
Note :  
            1 Byte  =  one character (0 to 9 or a to z or special characters) 
 
 
Another type of computers which are very popular throughout the world but not in 
India are Apple Computers. All the computers are manufactured and sold by the 
parent company known as Apple Computer Products. 
 
APPLE COMPUTERS : 
These computers have other versions also. Version Apple HE was the first one. 
But later on they came up with a series of computers known as Macintosh (Mac, 
as is popularly known). These computers have become very popular with those 
people who have to use the computer for designing and artistic work, since the 
picture clarity is these computers in very high. 

 
CLASSIFICATION OF COMPUTERS : 
 
Generally, computers can be divided into 3 types. 
  1.    Analog Computers 
2.     Digital Computers 
3.     Hybrid Computers 
 
ANALOG  COMPUTERS : 
 
In this type of computers, numerical magnitudes are represented by physical 
quantities such as electric current, voltage, or resistance, mechanical 
movements, etc. These are machines which are designed to perform 
arithmetical functions upon numbers where the numbers are represented by 
physical quantity. 
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Analog computers are widely used in manufacturing units where temperatures, 
pressure or flow of liquids are to be monitored continuously. It is also used at 
petrol pump where petrol pump contains an analog processor that connects fuel 
flow measurements into quantity and price values. 
 
Among the various drawbacks of using Analog computers are: They do not have 
the ability to store data in large quantities; They do not have the logical facilities; 
They can perform only arithmetical functions but are more costlier. 
 
DIGITAL COMPUTERS : 
 
A digital computer operates on data in the form of digits, rather than the physical 
quantities used in analog computers. That is, its input must be discrete rather 
than continuous and may consist of combinations of numbers, characters and 
special symbols, written in appropriate programming language. 
 
Digital computers can be classified into two parts: 
 
General Purpose Digital Computers 
They are also known as all purpose digital computers. Theoretically they can be 
used for any type of applications, e.g., computers that are used for payroll, 
graphs, analysis, etc. 
 
Special Purpose Digital Computers 
A digital computer is 'designed to solve problems of a restricted type. That is, 
special purpose digital computer is designed to be especially efficient in a 
certain class of applications, e.g., computers installed in washing machines. 
 

HYBRID COMPUTERS : 
 
This type of computers are hybrid of the above two types. A hybrid computer may 
use or produce analog data or digital data. It can be obtained either by 
interconnecting a digital and analog computer via a hybrid interface or the analog 
unit is integrated as a part of central processor of a digital computer which 
ultimately helps in getting input/output directly. 
Hybrid computers are generally used in scientific applications or in controlling 
industrial processes, in both situations the user is able to exploit the machine's 
ability to process both discrete and continuous data using accurate digital 
subroutines where necessary and the analog machines for fast integration 
functions. 
 
ClASSIFICATION BY SiZE : 
 
If we classify the computers by their sizes, we would have the following 
classification 
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1.  Super Computers 
2.  Mainframe Computers 
3.  Super Mini Computers 
4.  Mini Computers 
5.  Micro Computers or Personal Computer 
 
 
Super Computers : 
 
A supercomputer contains a number of processing units which operate in parallel 
to make it faster.  They  are  in fact,  very large  computers and  are  thus  used  
for bigger applications. In India, there are many super computers, in which one 
such computer which is used by the Meteorological department weather 
forecasting. 
 
Mainfrarne Computer : 
It is  again  a  large  computer  but where  it differs  from  super computer  is  that  
it  can  be connected to various computers to share facilities. For example, a 
Systern/370 can be attached to several personal computers so that they can 
share programs and data. Mainframe computers are used in research 
organizations, large industrial banks, airlines, and railway reservations where 
large data base is required. 
 
A typical application is the airline reservation system. The airlines have a main 
frame computer at their head office where information of all the flights is stored. 
Small computers installed at booking offices, are attached to the central data 
bank so that upto date information of all the flights is available. 
 
The structural configuration of the main frame consists of  : 
1. Data communication equipment. 
2. Interface equipment for a variety of high speed and low speed input/output 

devices.  
3. Primary storage. 
4. Secondary storage. 
5. Central processors with multiprogramming facilities. 
 
The main frame computers have following characteristics : 
 
1. They are big general purpose computers capable of handling all kinds of 

problems whether scientific or commercial.  
2. They can accept and transfer data from I/O devices at the rate of millions of 

bytes per second. 
3. They can accept all types of high level languages. 
4. They can support a large number of terminals say up to 100 or more. 
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5. They usually have instruction sets that give them the flexibility to operate 
automatically on 2 bytes (half-word) or 8 bytes (double word). 

6. They have large on-line storage capacities and can support a number and 
variety of peripheral devices like magnetic tape drives, hard disk drives, visual 
display units, printers, and telecommunication terminals. 

7. They routinely have high speed cache memory, which enables them to 
process applications faster than mini or micro computers. 

 
The limitations of main frame computers are due to their high cost, large in size, 
high power consumption, requirement of skilled workers and expensive 
peripherals like requirement of air-conditioning etc. 
 
Super Mini Computers : 
These are cross between minicomputers and super computers. They are 
commonly used as dedicated computers, for one processing function at a time. 
 
Mini Computers : 
They are inferior to mainframe computers both in speed and storage. They can 
also support various terminals. In fact, they can support upto 100 terminals. 
Minicomputers have operating systems with multitasking and network capabilities 
enabling them to serve more than one user. They find applications in 
organizations having a heavy work load but finding the main-frame expensive to 
buy. 
 
The most important advantage of a mini computer over the main-frame is that it 
is cheaper  in cost, smaller in size, very rugged and reliable. It does not require 
air- conditioning and can be operated at room temperatures. The main use of 
these systems in education, in local government bodies, and also as a front end 
processors to  a main-frame computer. It is also being used in word processing. 
In business, they are being used for invoicing, stock control, pay roll, sales 
analysis etc.  
 
The mini computers have following characters : 
1. They can accept and transfer data from I/O devices at the maximum speed of 

4 MB per second. 
2. They can support up to a maximum of 100 terminals. 
3. They usually employ micro-processors in the CPU, both for data storage as 

well as data manipulation. 
4. They have operating systems with multitasking and network capabilities 

enabling them to serve more than one user. 
5. As per size, price and capabilities to support the number and variety of 

perifherals and terminals, they are further subclassified as (a) mini mini 
computers, (b) midi mini computers, and (c) maxi mini computers.  

 
Compared to main-frame computers, mini computers are comparatively slow and 
their capabilities are limited. 
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MICRO COMPUTERS AND PERSONAL COMPUTERS : 
Microcomputers are digital computers whose processing unit consist of one or 
more microprocessors, one or more input/output units and sufficient memory to 
execute instructions. 

 
They are usually desktop or portable devices with a display, a keyboard and tape 
disk and diskette storage. They are designed primarily for stand-alone operation 
but can be used as workstation in terminal emulation mode. 
The advantages of micro-computers are :  
1. They use very little power. 
2. They are less costly. 
3. They are portable. 
4. They are stable and reliable, once tested and proved to work, they can go on 

working for years. 
 
Compared to main-frame and mini computers, they are slow and have limited 
capabilities but they provide good value for money. 

 
Personal computer is a type of microcomputer primarily intended for stand-alone 
use by an individual. PCs are designed primarily to give independent computing 
power to a single user and are inexpensively priced for purchase by individuals 
or small business. IBM introduced the first personal computer called IBM-PC on 
12/02/1981. 

 
INTRODUCTION TO MICROPROCESSORS : 
Microcomputer is so called because it uses the microprocessor chip. Basically all 
the microcomputers consist of 3 main chips: microprocessor chip, input/output 
chip and memory chip. A microprocessor chip can be further divided into control 
unit and arithmetic logic unit. It is here that all the processing of the computer 
takes place. 

 
Each personal computer has been based on certain chip of the likes of 8088, 
80286, 80386, etc. These chips have been introduced by Intel Corporation. 

 
 
CENTRAL PROCESSING UNIT (CPU) : 
As mentioned above this is the unit where all the processing takes place. It can 
be further divided into: Main Memory, Control Unit and Arithmetic Logic Unit. 
 
Memory : 
The memory unit can be defined as the brain of the computer. But, it does not 
store the information for long, It has the information only for the time when it is 
processing it. Once processed it passes on the information and gets the new 
information for processing. 
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There are two types of memory: Non volatile memory and Volatile memory. 
 
Non Volatile Memory 
In it the memory chip always retains the data which holds even when the 
computer turned off, e.g., ROM. One of the main reason of having ROM is to tell 
the computer is do when it is turned on. There are two main  parts of non volatile  
memory:  PROM (Programmable Read Only Memory) and EPROM (The 
Erasable Programmable Read Only Memory).  
 
Volatile Memory 
As the name suggests it is volatile in nature and loses its contents when the 
computer is shut off. It is called RAM (Random Access Memory). The main 
purpose of this memory is to hold programs and data which are under 
processing. 
 
Capacity of RAM 
The capacity of RAM is stated in terms of the number of bytes it can store. 
Memory capacity is usually stated in terms of Kilobytes (KB), which is equivalent 
to 1024 (210) bytes of storage, and in terms of megabytes (MB) which is 
1,048,576 (220) bytes. 
 
Note that 1 KB is about 1000 and 1 MB is about 1,000,000, thus the origin of the 
prefixes kilo (thousand) and mega (million). Occasionally you will see memory 
capacities of individual chips stated in terms of Kilobits (Kb) and megabits (Mb). 
 
There are several types of memory that can be implemented in a given machine. 
Dynamic Random Access Memory (DRAM) is the most common low-cost and 
flexible RAM available. DRAM is now usually implemented using SIMM (Single 
In-line Modules) packs and SIMM slots. Static RAM (SRAM) is much faster, but 
also much more expensive. DRAM is usually used in the cache portion of the 
machine because of speed requirements. 
 
Static Memory is made up of flip-flops and it stores a bit as a voltage. Dynamic 
Memory is made up of MOS transistor gates and it stores a bit as a charge. The 
advantage of dynamic memory is that a large number of transistor gates can be 
placed on a memory chip: thus it has high density and is faster than static 
memory. The disadvantage is that bit information stored gets leaked, so the 
information needs to be read and written again after every few msec. This is 
called refreshing the memory. 
 
Function of RAM 
RAM provides the processor with temporary storage for programs and data. All 
programs and data must be transferred to RAM from an input device or from 
secondary storage before programs can be executed or data can be processed. 
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RAM space is always at a premium; therefore, after a program has been 
executed, the storage space it occupied is reallocated to another program 
awaiting execution. The input message is interpreted and the processor initiates 
action to retrieve the appropriate program and data from secondary storage. 
 
This is a non-destructive read process, i.e., the program and data that are read, 
reside in both RAM (temporarily) and secondary storage (permanently). The data 
are manipulated according to program instructions and an information is 
received at output. 
 
A program instruction or a piece of data is stored in a specific RAM location 
called an address. Addresses permit program instructions and data to be 
located, accessed and processed. The content of each address is constantly 
changing as different programs are executed and new data are processed. 
 
Bubble Memory 
If the surface of a  non-magnetic material is coated with a thin layer of magnetic 
material which is magnestised in the opposite direction away from the surface. 
These bubbles can be moved around and used to represent the binary digits. 
Bubble memories can not replace the main memory (CMOS) because they are 
too slow. However they can contain a great deal of information in a small space 
and may be used to replace the magnetic disk eventually, as they have the 
advantage of no moving parts. 
 
Flash Memory (Flash RAM) 
These memory chips are non-volatile and are therefore a true replacement for 
disk storage. The contents of the flash memory can be altered by the computer, 
and the data can still be retained when the power is turned off. 
 
Access to data in flash memory is not as fast as a RAM, but is still many times 
faster than retrieving data using a disk drive (secondary storage). Because flash 
memory does not use any moving parts that draw power, it is used when power 
consumption must be kept to a minimum. This is particularly good for portable 
computers relying on batteries. 
 
The first common application of flash memory will probably be replacing hard 
disks in laptop and notebook computers. Next, you will be able to plug your 
laptop's memory card into your PC to transfer programs and data between them 
easily. Flash chips are currently being used in cellular phones and cockpit flight 
recorders and they are replacing disks in some handheld computers. 
 
Flash memory chips are being produced in credit-card like packages, which are 
smaller than a disk drive and require only half the power, that is whey they are 
being used in notebook computers and handheld personal digital assistants. 
 

FACTORS AFFECTING PROCESSING SPEED 
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Registers 
The size of a register (16-bit register or 32-bit register) which is also called the 
word size indicate the amount of data with which the computer can work. The 
bigger the size of register, the faster the computer can process a set of data. 
Registers retain information on a temporary basis. 
They are not considered part of main memory. Registers have the ability to 
receive information, hold it temporarily and then pass it on as directed by 
supervisory control unit. 
There are several type of registers: 
Instruction Register : It holds the instruction which is being executed. 
Address Register: It holds the storage location address. 
Accumulator: It collects results. 
 
Memory and Computing Power 
More RAM make the computer run faster. The computer does not necessarily 
have to load an entire program into memory to run it, but the more of the 
program it can fit into memory, the faster the program will run. The computer 
loads only the most essential parts into memory. When it needs access to other 
parts of the program on the disk, it can unload, or swap out non essential parts 
and swap in program code or data it needs. 
 
Computer's Internal Clock 
Every microcomputer has a system clock made up of quartz crystal. The 
molecules in the crystal vibrate millions of times per second which is constant. 
The system uses the vibration of the crystal (quartz) in the system clock to time 
its processing operations. The clock speed is measured in hertz. Pentium CPU 
today have clock speed from 200 MHz to 400 MHz. 
 
Bus 
The system bus carries bits between CPU and only one peripheral at a time. In 
computer terminology bus refers to the paths between the components of a 
computer. 
There are three main buses: 
1.  Data bus 
2.  Address bus and 
3.  Control bus. 
 
Data Bus 
It  is  an  electrical  path  that  connects  the  CPU,  memory  and  other  
devices  on  the motherboard, tn real sense bus is a group of parallel lines. The 
number of lines in the bus affects the speed at which data can travel between 
hardware components. Since each wire can transfer one bit at a time, a 16-wire 
bus can move 16-bits at a time, which is 2 bytes. Similarly a 32-bit bus can 
transfer 4-bytes at a time. 
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In computer industry a data bus with 16-bit wide is called as Industry Standard 
Architecture (ISA) bus. A 32-bit bus is known as Extended Industry Standard 
Architecture (EISA) bus. 
 
Address Bus 
It connects only the CPU and memory and helps in locating memory address 
faster. The number of lines in It determines the maximum number of memory 
addresses, Today most CPUs have 32-bit address buses that can address 4GB 
(over 4 billion bytes) of memory. 
 
Control Bus 
It controls the direction, flow, origin and destination of data. It comprises of 
various single tines that carry synchronization signals. Control bus are individual 
lines that provide a pulse to indicate an CPU operation. 
 
The CPU generates specific control signals for every operation it performs. 
These signals are used to identify a device type with which the CPU intends to 
communicate. 
 
Cache Memory 
A cache is similar to RAM except that it is extremely faster compared to normal 
memory. The cache speeds up processing storing frequently used data or 
instructions in its high-speed memory. Whenever the CPU requests information 
from RAM, the cache controller intercepts the request and searches its own 
memory for the requested information. If the information is not there the CPU 
retrieves the required data from the memory (RAM) and also sends a copy back 
to the cache. The next time the CPU needs the same information, the cache 
finds that information and quickly sends it to the CPU leaving RAM out of the 
loop. 
 
Math Coprocessor 
When the computer has to do a lot of floating-point arithmetic (viz; in 
spreadsheet, drawing programs or CAD programs) the presence of a math 
coprocessor either built into the CPU (viz: 486 DX-2 or Pentium, onwards) or 
added on the motherboard (viz; in 286, 386- in these 287 and 387 chip act as 
math coprocessor) can speed up processing considerably. 
 
So math coprocessor is a chip or part of a chip that is specially designed to 
handle complicated mathematical operations. 
 
Flash Memory 
A long-standing speed problem has been the rate of accessing data from a 
secondary storage device such as a disk, a rate significantly slower than internal 
computer speeds. To overcome this, flash memory (non-volatile RAM) can be 
used. Since data and instructions will be ever-closer to the microprocessor, 
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conversion to flash memory chips would have a pivotal impact on  a computer’s 
processing speed. 
 
CONTROL UNIT : 
It is the center of all the activities of the computer. The control unit contains 
circuitry that uses electrical signals to direct the entire computer system to carry 
out or execute stored program instructions. 
 
The control unit does not execute instructions itself, but it tells others what to do. 
 
Arithmetic Logic Unit : 

It executes all the arithmetic and logical operations. The arithmetic operations 
can be Addition, Subtraction, Multiplication, and Division. The logical operations 
can be: Equal to, Less than and Greater than. 
 
SEMICONDUCTORS 
Consisting of very small silicon chips these are mainly used for memory of the 
computer. They are different types varying in terms of speed and reliability. 
 
lNTEGRATED CIRCUIT 
They are nothing but the electronic circuits on a small silicon chip. This chip is 
capable performing a variety of functions as a substitute for different electronic 
components of the computer. 
 
HARDWARE 
Computer hardware is a collective term used to define the various parts of the 
computer you can see and touch with your hands. The various components of 
these are the Monitor, Keyboard and Central Processing Unit. 
 
One can have additional hardware like printer, scanner attached to the computer 
too. 
 
SOFTWARE 
A program is a set of instructions given to the computer to perform a certain 
task. It is known as the software of the computer.  There are two main types of 
software: 
 
System Softwore 
The software used to operate and maintain a computer system and also used by 
a programmer to develop application software is known as System Software. 
Various software under this category are:DOS, Windows, etc. System Software 
is further classified as (a) Operating system software and (b) language software. 
 
Applicotion Software 
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The software which performs specific tasks, like railway ticketing, telephone 
billing, salary and wages calculation, etc., is called the application software. 
 
DATA 
It is the raw form of information which is given to the computer for processing. 
Data is 
name given to the basic facts such as name, age. address, telephone number, 
etc. 
 
INFORMATION 
It is the collection of data in a meaningful form. So all data which has some 
meaning is 
called information. Please remember Data and Information is not the same thing. 
Data is raw but information is organized form of data. 
 
PROCESSING 
When the data is put into the computer to give some results, the work which the 
computer performs is called Processing. 
 
BIT 
It is the smallest storing space in the computer. 
BYTE 
A group of 8 bits form a Byte. A computer's capacity is measured in terms of 
bytes. It is required to store a character—numeric (0 to 9), alphabetic (a to z) or 
(A to Z) and special characters like these: ! @ # £ % h & * f etc. 
 
But certain large computers can perform operation in parallel, i.e., it can process 
two or more sets of data simultaneously. 
Before an instruction can be executed, program instructions and data must be 
placed into memory from an input device or a secondary storage device. 
CPU Performs the following steps for each instructions: 
1. The control unit fetches the instruction from memory (RAM) or cache memory 
and  located to the program register and then to decoder. 
 
2. The control unit decodes the instruction and directs that the necessary data to 
be moved from memory to ALU. 
 
These first two steps together are called instruction time or I-time  
 
3. The ALU executes the arithmetic or logical instruction. 
4.  The ALU stores the result of this operation in the appropriate memory position   
     or register 
These two steps together are called execution time or E-time. Each ALU unit has 
an internal clock that produces pulses at a fixed rate to synchronize all computer 
operations. The repetition of the instruction/execution cycle continues until all the  
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instructions have been processed. The speed of processing depends on the    
clock  speed of the computer hardware. 
 
The time taken by control unit to process one instruction is called a machine 
cycle—a Combination of two cycles, i.e., fetch and decode cycle, and execute 
cycle. 
 
In the fetch and decode cycle phase the control unit obtains an instruction from 
primary storage(RAM) and stores it in an instruction register and then it decodes 
the instruction by looking  up the instruction's operation code in a table. 
 
Each type of CPU can only understand a particular type of instruction set. 
 
In the execute cycle phase the supervisor control unit executes the instruction by 
actually performing the task indicated. 
 
Sometimes  the instruction simply requires the transfer of data value from one 
primary Storage location to another, e.g., increment a particular variable. Such 
type of task does not require the ALU. 
 
MOTHEBOARD 
The most important part of the CPU is Motherboard. As the name suggests it is 
the mother of all boards. All other boards are secondary to it. All instructions pass 
through this first. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Various components on the motherboard are: 
Memory    :   These slots are there for putting the memory chips. Most of the 
new motheboards have capacity for 128 MB of RAM. 
CPU :             This is the main slot for the PC. 
Additional :    These are there for putting additional attachments like Video card, 
etc. 
BIOS :             Basic Input Output Instructions chip which is fixed on the 
motherboard to run the PC. 



Srinivas MBA : MIS : CH 4   2009 
 

89 
 

Clock           This chip is there for providing the running dock within the PC to 
give you the time and date. 
Ports    :   Most PCs now-a-days come with 2 parallel and 2 serial ports where j 
                 can put your mouse, printer, etc. 
IDE  :  These are used for connections to floppy disk, hard disk, CD-ROM drive, 
etc 
 

********************* 
Assignment  
 

1. Write a historical note on evolution of computers ? 
2. Write a note on various generations of computers with example ? 
3. How computers are classified based on (i) nature of electronic circuits 

involved ? (ii) by their size ? 
4. What are the different blocks of a computer explain the functions of each 

block ? 
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CHAPTER  4(b) 
 

PROGRAMMING LANGUAGES 
 
INTRODUCTION 
The Software is generally classified into two categories on the basis of 
application suitability of the programs: 
 1. System Software 
 2. Application Software 
 
System Software : 
System Software referrers to all programs which make the computer work and 
commonly supplied by the manufacturers of the Hardware. System Software is 
the Software required for the basic operations of the Computer which consists of 
a large number of functions which are specific to the hardware devices 
constituting a particular computer system. 
I System Software is further classified as 
 1.  Operating system Software 
 2. Language Software 
II Language software comes in four forms 
 1. Assembler 
 2. Compilers  
           3. Interpreters 
           4.  Editors. 
COMPUTER LANGUAGE 

A language is a system of communication. A programming language is the 
language used to communicate with computer. The programming language are 
part of the Software or programming aids provided by the manufacturer. All 
computer languages can be classified in following broad categories: 

1.             Low level Languages 
a.           Machine level Language 
b..          Assembly Language 

2.            High level Languages 
 MACHINE LANGUAGE 
The computer understands nothing but 0s and I s (machine language) is also 
referred to as an absolute language. These machine instructions are divided into 
two parts. 

1.           Operation (code) 
2.           Operand (address) 

In the early stages of programming, the programmer was required to write his 
program in strings of 0s (zeros) and Is and also calculated and allocated  the 
core storage locations for his data and/or instructions. This was really very 
tedious and great proportion of his time was wasted in these routine jobs. Later 
on it   was found that the capabilities of the computer can themselves be used to 
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relieve   the programmer of these strenuous routine jobs.   Operations     such as    
translating a program into detailed machine codes, allocating storage place 
inside the computer, organising, establishing and accounting for sequences for 
short jobs are precisely the high grade clerical work the computer can handle. It 
is therefore, only rational to expect the machine to do it.  This provided the 
motivation for the birth of programming languages. 
The instructions to the computer are provided with the help of a programming  
language by preparing a program. The language whose design is governed by 
the circuitry and the structure of the machine is known as Machine language 
consisting of instruction codes in the format. 
 
OPERATION 
CODE 

OPERAND 
(ADDRESS) 

 
The operation code denotes the operation which is to be performed (e.g. add, 
multiply; write onto output device etc.), and the power of a computer is the 
number of operations that it can execute (i.e., the number of instructions in an 
instruction set ). The operand part of the instruction code gives the specific 
location address of the data to which the operation code is to be applied 
(remember that the CPU main store is divided into thousands of identifiable 
address locations). If the \ data requires more than one address location its 
length is also indicated, thereby identifying (without numbering each one) the 
next sequential location address(es) that contain the rest of the data. 
 
ADVANTAGES OF MACHINE LANGUAGE 
1. Machine Languages make efficient use of storage – language instructions and 
their storage in computer memory can be controlled. 
2. Instructions of a machine language program are immediately executable.  
They require no compilation or translation steps. 
3.  Machine language instructions can be used to manipulate the individual bits in 
a byte of computer storage. 
 
DISADVANTAGES OF MACHINE LANGUAGE 
1. machine languages are machine dependent. 
2. Although easily used by the computer, machine languages is difficult to 
program.  It is necessary for the programmer either to memorize the dozens of 
code numbers for the commands in the machine’s instruction set or to   
constantly refer to a reference card.  
3. It is difficult to correct or modify machine language programs.  Checking 
machine instructions to locate errors is about as tedious as writing them initially. 
 
ASSEMBLY LANGUAGE: 
 The language which substitutes letters and symbols for the numbers in the 
machine program is called an assembly language or symbolic language.  A 



Srinivas MBA : MIS : CH 4   2009 
 

92 
 

program written in symbolic language that uses symbols instead of numbers is 
called an assembly code or symbolic program.  The translator program that 
translates an assembly code into the computer’s machine code is called an 
assembler.  The assembler is a system program which is upplied by the 
computer manufacturer.  It is written by system programmers with great care.  It 
is so called because an addition to translating the assembly code into machine 
code, it also assembles the machine code into the main memory of the computer 
and makes it ready for execution. A symbolic program written by a programmer 
in assembly language is called source program. After the source program has 
been converted into machine language by an assembler, it is referred to as 
object program. 
In the 1950's mnemonic operation  codes and symbolic addresses were 
developed. First introduced in the second generation  computers, the word  
mnemonic (pronounced nemonik ) refers to a memory aid. Letter symbol 
mnemonics were substituted for the numeric machine language operation codes. 
Each computer has a mnemonic code although the actual symbols vary among 
different makes. Machine language is still used by the computer as it processes 
data, but assembly language program first translates the specified operation 
code symbol into its machine language equivalent. 
 
ADVANTAGES OF ASSEMBLY LANGUAGE 
 
1.  It is not required to keep track of memory locations. 
2.  Insertions and deletions are quite easy. 
3.  Revision of complete program is quite easy. 
4.  Requires fewer instructions to accomplish the same result. 
5. Assembly language is easier to understand and because mnemonics are used 
instead of numeric op-codes and suitable names are used  as data.  
6. While writing programs in assembly language, fewer errors are                           
made, and those that are made are easier to find and correct                           
because of the use of   mnemonics and symbolic field names. 
7.   Assembly language programs are easier for people to modify than machine 
language programs. 
 
DISADVANTAGES OF ASSEMBLY LANGUAGE 
1.  Programs based on such languages cannot be executed on small sized  
computers. 
2.  Programs take longer to code because of the more complex nature of the 
language. 
3.  Lack of portability of programs between computers of different makes. 
 
HIGH LEVEL LANGUAGES 
To overcome the low level language difficulty of machine dependency, high level 
problem-oriented (or machine independent) languages were developed. Such 
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programming languages, with an extensive vocabulary of words and symbols, 
are used to instruct a computer to carry out the necessary procedures, 
regardless of the type of machine being used. 
 
High level languages do to have the one instruction to one instruction relationship 
which is a feature of symbolic languages.  Instead one high level language 
instruction language instruction (a macro instruction) may generate a number of 
machine code instruction. This allows the programmer to abandon the two part 
format of low level instructions and as he can work relatively independently of the 
machine the programming task is considerably eased. High level languages are 
constantly being developed and improved and as more and more systems 
capable of on line and real time operation languages were designed for 
interactive use via a terminal. 
Interactive languages provide facilities for the programmer to make corrections 
and /or changes to his program during its compilation and execution. The 
increasing availability of mini computers and micro computers has speeded up 
this process of developing languages that enable the user to obtain maximum 
use of the computer, without undergoing an extended period of special training or 
incurring the considerable post of employing a computer programmer. 
 
ADVANTAGES OF HIGH LEVEL LANGUAGES 
1.  Machine independence: High level languages are machine        
independent. This is a very valuable   advantage because it      means that a  
company changing computers even to one from a different   manufacturer  will 
not be  required to rewrite ail the programs that it is currently using. 
 
2. Easy to learn and use: These languages are very similar to the languages 
normally used by us in our day lo day life. Hence they are easy to learn and use. 
The programmer need not learn anything about the computer he is going to use. 
 
3. Easier to maintain: Programs written in high level languages are easier to 
maintain than assembly language or machine languages program. 
 
4.  Fewer Errors: In case off high level languages, since the programmer need 
not write all the small steps carried out by the computer, he is much less likely to 
make an error. 
 
5. Lower program preparation cost: Writing programs in high level languages 
requires less time and effort which ultimately leads to lower program preparation 
cost. 
 
6. Better documentation: A high level languages is designed in such a way that 
its Instructions may be written more like the language of the problem. 
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7. High-level programs may be used with different makes of computer with little 
modification.  Thus, reprogramming expenses are greatly reduced, when new 
machines are acquired. 
 
8.  Higher-level language programs are much shorter than machine language or 
assembly language programs. A single line in a     higher level language program 
may translate into five or ten or even hundreds of machine language instructions. 
9. Writing of source programs in these languages does not require the 
knowledge of the internal structure of the computer. 
10. Modification, if required, in programs written in these languages are quite 
easy and straight forward. 
11. Prograrnmers can move to different installations using high level languages 
without having to learn new languages. 
12. They are more user friendly. 
 
DISADVANTAGES OF HIGH LEVEL LANGUAGES 
The disadvantages of using a high level language as opposed to a low 
level language are: 
 1. Lack of flexibility: Because the automatic features of high level languages 
always occur and are not under the control of the programmer, they are less 
flexible than assembly languages. 
 
2. Runs slower due to the generality of the statements and the fact  that they are 
potable between different machines provided a suitable compiler is available.       
Such languages are machine independent. 
 
3. A source of program written in a high level language needs a complier which is 
loaded into the main memory of the computer and thus occupies enough of 
memory space. The memory available for a source program is greatly reduced. 
Hence these languages are machine independent. 
 
4. Lower efficiency: As the programs written in a high level languages take more 
time to run and require more main storage, they tried to be less efficient in the 
use of the CPU and other facilities.  
 
LANGUAGE TRANSLATORS: 
 As discussed earlier, any program that is not written in machine language 
has to be translated before it is executed by  the computer.  Language translators 
perform the translation of high level languages or assembly language into 
machine language.  In addition they check for some types of errors that may be 
present in the program being translated. 
 
There are three types of translator programs: 
 1 compilers 
 2 Assemblers and 
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 3. Interpreters   
 
COMPILERS 
Compiler is a standard program written and supplied by the computer 
manufacturer translating the program written in a high language (viz. Fortan, 
Cobol etc.) to the equivalent machine code of the computer. This process of 
translation called compilation. The compilation process consists of first loading 
the computer with the compiler and then inputting the source program via 
punched card called compilation. The compilation process consists of first 
loading the computer with the compiler and then inputting the source program via 
punched card magnetic tape. As such, the compiler produces an object program 
on a deck punched cards or magnetic tapes and also a print out of the program 
instruction. 
 
The operating system calls a compiler for a particular language from the 
secondary storage and load if info the primary storage. The compiler checks 
each       coded instruction lo see that It follows the rules for that language, uses 
proper  spelling and syntax. All acceptable Instructions arc translated into the 
machine language and stored. In case of errors in the program, it communicates 
this information to the programmer in the form of diagnostic messages.  These 
messages appear on the printer or the designated devices along with a listing of 
program instructions.  The program can be executed only after it is found to be 
error free during the compilation run.  Though an assembler also performs the 
same hob as is done by a compiler, still  there is a basic difference between the 
two.  The assembler translates symbolic address into actual core storage 
locations.  Each mnemonic instruction is normally converted into a machine code 
instruction on a one for one basis. Compiler, on the other hand, is far more 
complex to design and write as each source program instruction in a high level 
language such as Cobol generates a number of machine code instructions.  Also, 
compiler occupies  more storage space and takes more processing time than an 
assembler. 
 
The various tasks that the compiler has to accomplish during compilation are as 
follows: 
1. Read each line of the source program and convert it into machine language.  
2. Allocate space in memory for the storage location as defined in the pro gram 
to be executed. 
3. Combine the machine code generated with the appropriate subroutines from 
the library. 
4. Identify the proper order of processing, so that execution is as fast as possible 
and minimum storage space in memory is required. 
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Complier have been written for many of the commonly used computer languages 
such as BASIC, FORTRAN, C, AND PASCAL. The complier translates an entire 
program from the source of code, i.e., the program written in a high level 
language, to object code, i.e., machine code. These machine instructions can 
then be run on the computer to perform the particular task as specified in the 
high level language program. 
 
REMARK:    The complier can diagnose the following kinds of errors in a source 
program: 
a.         Illegal Characters 
b.         Illegal combination of characters 
c.         Improper sequencing of instructions in a program. 
A source program containing an error diagnosed by the compiler will not be 
compiled into an object program. The compiler will print out a suitable message 
indicating this, along with a list of coded error messages which indicate the type 
of errors committed. The error diagnostics is an invaluable aid to the 
programmer. 
 
ASSEMBLER 
Assembler translates a program written in assembly language in to machine 
language. Apart from the fact that it deals with a low level language rather than a 
high level language, and thus has less of a gap to bridge in translation, are 
assembler operates in the same way as the compiler does. It translates complete 
source program into an object program, identifying any errors along the way. The 
assembler will list or display these errors as well as the complete source and 
object programs, If the program is error free, the job control program will let run 
immediately, or save the object program so that it may run it later without 
translating it again.  
 
Assembler is supplied by the computer manufacturer.  
 
INTERPRETER : 
Interpreter is another type of translator used translating high level languages into 
machine code It takes one statement of a high level language and translates it 
into a machine instruction which is immediately executed. Translation and 
execution alternate for each statement encountered in the high level language 
problem. In other words, are interpreters translates one instruction and the 
control unit executes the resulting interpreters translates one instruction and the 
control unit executes the resulting machine code, next instruction is translated, 
and the control unit executes the resulting machine code instruction, and so on. 
INTERPRETER COMPILER 
1. translates the program line by line Translates the entire program  
2. Requires less main memory Requires more main memory 
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3. Each time the program is executed 
every line is checked for syntax and 
then converted to equivalent machine 
code 

Converts the entire program to 
machine code, when all the syntax 
errors are  removed and executes the 
object code directly 

4. Source program and the interpreter 
are required for execution 

Neither source nor the complier are 
required for execution 

5. Good for fast debugging and at 
testing stage 

Slow for debugging and testing 

6. Execution time is more Execution time is less 
7. No security of source code Security of source code. 
 
EDITORS: 
     These programs are used to compose and modifying other programs.  They 
are primarily text editing programs that allow programmers to add, delete, insert 
and edit the text of instructions which will be subsequently compiled or 
assembled, depending on the language used.  Examples are Turbo ‘C’  editor, 
Norton editor Turbo Pascal editor, WordStar, Excel. 
 
Editors are interactive programs that are stored in memory and allow the user to 
write a program, generate text, or make wide variety of changes and additions 
inn either of these.  If for example, a source program needs correction because it 
has failed to compile properly, an editor can be used to make the necessary 
changes to the program.  Once the final program is error free, it may be compiled 
and the editor can be asked to store the final text in a file.  The final text can also 
be stored on an external storage medium such as tape or disk or output to a 
printer.  The editor is normally stored on some external mass storage media and 
whenever required called into the RAM. 
Before a program can be executed, it must be placed on the main storage. 
Special programs able to read programs from input or storage devices and place 
them into the main storage are called loaders. In modern computer, the loader is 
permanently stored in ROM and is fixed part of the computer itself. Thus, it is 
easy to load any external program on to the computer's main memory. Closely 
related to the loader is another utility lo assist the assembly process called the 
linkage editor. The linkage editor allows independently written assembly 
language program to share data and variables by linking them together when 
they are loaded into computer memory and run. 
 
APPLICATION SOFTWARE 
An application program is a program written for or by a user to perform a 
particular job. It can be categorized in to two ways. 
a.        General purpose application Software 
b.        Specific purpose application Software 
Genera] purpose application Software such as an electronics spread sheet, word 
processors, graphics have wide variety of applications.  Specific purpose 
application software, such as pay role, sales analysis, Inventory management is 
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used only for the application for which it is designed.  Application Programmers 
write these programs.  
 
 
Assignment Questions :  

1. What is a computer language ? How it is classified ? Explain the features, 
advantages and disadvantages of each type ? 

2. What are the different types of language translators ? Explain each in 
detail ? 

3. What is software ? How it is classified ? Give any four differences between 
interpreter and compiler ?  
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Introduction to Database Management Systems 
 
 
WHAT IS A DATABASE? 
 
A database is a collection of logically related data that are organized in such a 
way, so as to facilitate easy accessing and processing of data. Databases 
contain data, not information. By itself database is meaningless and worthless, 
but through proper design and use of the database, it can be an essential tool for 
producing information for making management decisions. 
 

Database is a collection of data designed to be used by different people.  It is a 
collection of interrelated data stored together, with controlled redundancy to 
serve one or more applications in an optimal fashion.  The data are stored  in 
such a fashion that they are independent of the programs of people using data.  
A common and controlled approach is used in adding new data and modifying 
and retrieving the existing within the database. 
Database management systems (DBMS) are support programs that work in 
conjunction with the operating system to create, store, process, retrieve, control 
and manage the data. The DBMS acts as an interface between the application 
program and the data in the database. 
 
Data are binary computer representations of stored logical entities.  
Relationships  represent a  correspondence  between  the  various  data  
elements.    Constraints  are  predicates that define the correct database states 
where the schema describes the Organization of data and relationships within 
the database. The schema defines the various views of the database for 
database management system component’s use and for applications’ security.  A 
schema separates the physical aspects of data storage from the logical aspects 
of data representation. 
 
The internal schema defines how and where data are organized in a physical 
data storage. The conceptual schema model defines the stored data structures 
in term of the database model used.  
 
The external schema defines a view or views of the database for  particular 
users. A database management system provides services for accessing the 
database while maintaining the required correctness and consistency features of 
the stored data. 
 
WHY A DATABASE? 
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Why should an organization choose to use an integrated database to store its   
operational data? A general answer to this question is that a database system 
provides the organization with centralized control of its data. This is in sharp 
contrast to situation that prevails in many enterprises, where typically each 
application has its private files in its own tapes and disk, so that the data is widely 
dispersed therefore difficult to control. 

 
Deficiencies of pre-database : 
 
Deficiencies of pre-database information processing include (but not limited to) 
the  following : 
 

•  Encoded data (data hard-coded in the application) 
•  Interdependence between programs and data files 
•  Data repetition or redundancy 
•  Data inconsistency 
•  Lack of data integrity 
•  Ad hoc representation of relationships 
•  Ad hoc data management techniques 
•  Lack of coordination across applications using common data 
•  Lack of data security mechanisms 
•  Inability to manage concurrent access to data 
•  Non-uniform back-up and recovery methods 
 

OBJECTIVES OF DATABASE : 
The objectives which management should keep in mind as they design and 

organise a database are : 

(a) Provide for mass storage of relevant data. 

(b) Make access to the data easy for the user. 

(c) Provide prompt response to the user requests for data. 

(d) Make the latest modifications to the database immediately. 

(e) Eliminate redundant data. 

(f) Allow multiple users to be active at one time. 

(g) Allow for growth in the database system. 

(h) Protect the data from physical harm and unauthorized access. 

 
 
 
ADVANTAGES OF DATABASE : 
 
The advantages of having data in a database is summarized below; 
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1. Redundancy can be reduced  In non-database systems, each application or 
department has its own private files resulting in a considerable amount of 
redundancy of the stored data.  Thus, storage space is wasted.  By having a 
centralize most of this can be avoided. We do not say or suggest that all 
redundancy should be  eliminated.  Sometimes there are sound business and 
technical reasons for maintaining multiple  copies of the same data.  In a data 
base system, however, this redundancy can  be controlled.   
 
2. Inconsistency can be avoided  This is really a corollary to the above point. 
When the same data is duplicated and changes are made at one site, which is 
not propagated, to the other site, it gives rise to inconsistency. Then the two 
entries regarding the same data will not agree.   At  such times, the data is said 
to be inconsistent. So, if redundancy is removed, the chances of having 
inconsistent data is also removed. 
 
3. Data can be Shared : The existing applications can share the data in a 
database. 
 
4. Standards Can be enforced : With the central control of the database, the 
database administrator can enforce standards.   
 
5. Security : restrictions can be applied with complete authority over the 
operational data, the database administrator can ensure that the only means of 
access to the database is through proper channels.  He can define authorization 
checks to be carried out whenever access to sensitive data is attempted.  
Different checks can be established for each type of access (retrieve, modify, 
delete, etc.) to each piece of information in the database. 
 
6. Integrity : can be maintained.  Integrity means that the data in the database is 
accurate.  Centralized control of the data helps in permitting the administrator to 
define integrity constraints to the data in the database. 
 
7. Conflicting requirements can be balanced.  Knowing the overall requirements 
as opposed to the individual requirements, the database can be structured to 
provide an overall service that is best for the organization. 
 
CHARACTERISTICS OF DATA IN A DATABASE 
 
The data in a database should have the following features. 
 
1. Shared - Data in a database are shared among different users and 
applications. 
2.  Persistence - Data in a database exist permanently in the sense, the data 
can live beyond the scope of the process that created it. 
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3.  Validity/Integrity/Correctness - Data should be correct with respect to the 
real world entity that they represent. 
4.  Security - Data should be protected from unauthorized access. 
5. Consistency - Whenever more than one data element in a database 
represents related real-world values, the values should be consistent with 
respect to the relationship. 
6. Non-redundancy - No two data items in a database should represent the 
same real-world entity. 
7. Independence - The three levels in the schema (internal, conceptual and 
external) should be independent of each other so that the changes in the schema 
at one level should not affect the other levels. 
 
File Pointers : 
File pointers establish linkage between records and are a basic part of the file 
organization of all data base models except the relational model. A pointer is 
placed in the last field of record. A pointer is the address of another, related 
record that is “pointed to” and the pointer directs the computer system to that 
related record. File pointers are used with many database organizations.   
 
Linked Lists : 
 
A linked list is a group of data records arranged in an order, which is based on 
embedded pointers. An embedded pointer is a specific data field that links one 
record to another by referring to the other record. The field is embedded in the 
first record, i.e., it is a data element within the record. 
 
Linked list often have a head, which is a pointer to the first record. It has a tail, 
which points to the last record. One can start at head and follow the list to the tail, 
or one can start in the middle and follow the list to the tail. The user can not start 
in the middle and go back to the head.  In other words, the linked list is a one-
way street. 
 
The following figure shows a linked list of customer records. Each row is a 
record. The records are arranged sequentially using customer number as the 
key. Each record includes a data element, which identifies assigned salesperson. 
In the right most field of record there is a pointer (a link) that chains together all 
customers records for a particular salesperson say salesperson 23. It can be 
assumed that customer 23694 is at the head of the list. The pointer links this 
record to a record for customer 25410 and so on until the tail for customer 30111 
is encountered. The asterisk in the link indicates the tail of the list. 
 
This chaining feature is very powerful. The application program can initiate a 
search at the beginning of the file looking for first customer assigned to 
salesperson 23. When that record is found, the salesperson links enable the 
program to follow the chain and process records only for salesperson 23. It is 
more convenient method than searching through the entire file. 
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Customer    Salesperson 

Number 
Salesperson link\ 

22504      
23694    23 25410 
24782      
25409      
25410    23 30102 
26713      
28914      
30004      
30102    23 30111* 
30111    23  
30417      
31715      
      
 
 
Components of DBMS  
A DBMS has 3 main components 

(a) Data dictionary system (DDS) 

(b)      Data definition language (DDL) 

(c)      Data manipulation language (DML) 

(a) Data dictionary system (DDS) : The data dictionary system is an 
encyclopedia of information concerning each data element. It describes the data 
and its characteristics, such as location, size and data type. It also identifies the 
origin, use, ownership and also the methods of data access and data security. 
When it exists in a file, special software is necessary to create it, maintain it and 
make it available for use. Such software is called a data dictionary system. A 
good data dictionary would ensure consistent definitions of data across different 
databases. If there were to be a change to the data, it would also identify all the 
databases affected by the change.  

 
(b) Data Definition Language (DDL) : The data definition language is used to 
create the data, describe the data and define the schema in the DBMS. It serves 
as an interface for application programs that use the data. Once the data 
dictionary has been created, its definitions must be entered into the DBMS.  The 
primary functions of DDL are : 
 

1. Describes the schema and subschemas. 
2. Describes the fields in each record and record’s logical name. 
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3. Describe the data type and name of each field. 
4. Indicate the keys of the record.  
5. Provide for data security restrictions. 
6. Provide for logical and physical data independence. 
7. Provide means for associating related records or fields. 

 
For example, if a payroll program needs the employment number of an 
employee, the DDL defines the logical relationship between the employment 
number and the other data in the database, and acts as an interface between 
the payroll program and the files that contain the employment numbers. 

 
(c) Data Manipulation Language (DML) : A data manipulation language is a 
language that processes and manipulates the data in the database. It also allows 
the user to query the database and receive summary reports and / or customized 
reports. DML enables the user to access, update, replace, delete and protect 
database records from unauthorized access. 
 
The functions of DML are : 
 
1. Provide techniques for data manipulation such as deletion, replacement, 

retrieval, sorting, or insertion of data or records. 
 
2. Allows user and application programs to process data on logical basis rather 

than physical location basis. 
 
3. Provide access which is independence of programming languages.  
 
4.    Provide for use of record relationships. 
 
 
WHAT IS A DATABASE MANAGEMENT SYSTEM? 
 
A database management system (DBMS) is a software that provides services for 
access a database, while maintaining all the required features of the data.   The 
major components of a DBMS are shown in the figure (a)  & (b). 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

Fig. (a) DBMS  as interface between application program and database. 

User 
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   DBMS Database 
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Some of the services provided by a DBMS are given below : 
A transaction is a sequence of database operations that represents a logical unit 
of work. It accesses a database and transforms it from one state to another.   A 
transaction can update a record, delete one, modify a set of records, etc.   When 
the DBMS does a  'commit', the changes made by the transaction are made 
permanent.  If you don't want of make the changes permanent you can rollback 
the transaction and the database will remain in its original state. 
 
Concurrency  management  Concurrency   management  is the database 
management activity of coordinating the actions of database manipulation  
that operate concurrency  access shared data and can potentially interfere with 
each other.  The goal of an ideal concurrency management mechanism is to 
allow concurrency while maintaining the consistency of the shared data. 
 
Recovery The objective of recovery in a database is to ensure that the aborted 
or failed transactions do not create any adverse effects on the database or 
transactions.   Recovery mechanisms in a DBMS make sure that the database 
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returned to a consistent state after a transaction fails or aborts. Recovery is very 
much related to concurrency in the sense that, the more the more concurrency, 
the more is the chance of an aborted transaction can affecting many other 
transactions. 
 
 
Security :Security refers to the protection of data against unauthorized access. 
Security mechanisms of a DBMS make sure that only authorized users are given 
access to the data in the database.  The level of access for each user and the 
operate each user can perform on the data will be monitored and controlled by 
the DBMS depending on the access privileges of the users. 
 
Language interface The DBMS provides support languages used for the 
definition and manipulation of the data in the database. The data structures are 
created using the data definition language commands. The data manipulation is 
done using the data manipulation commands.  By providing language support for 
data definition manipulation the DBMS create an environment where the users 
can do their without worrying about the physical implementation. 
 
Data Catalog: Data Catalog or Data Dictionary is a system database that 
contains the descriptions of data in the database (metadata).  It contains 
information about relationships, constraints and the entire schema that organize 
these features unified database. The data catalog can be queried to get 
information about the structure of the database. 
 
Storage management : The DBMS provides a mechanism for the management 
permanent storage of the data. The internal schema defines how the data should 
be stored by the storage management mechanism and the storage manager 
interfaces with the operating system to access the physical storage. 
 
WHY DBMS? 
A DBMS provides a secure and survivable medium for the storage and retrieval 
of data.  If the   users and applications do not share data among themselves and 
if the longevity of the data is only till  the end of the process or application  that 
created it, then  there is not much need for a DBMS.  But in real world, the data 
is shared and is persistent (that a, the data  has  a  life  beyond  the  boundaries  
of the  programs  and  applications  that created it).  Also, the real world data 
have a structure. It is related to one another and has constraints.   These 
features are well represented and can be efficiently managed using a DBMS.    
Also,  the  different  users  of the  data  need  to  create,  access  and manipulate 
the data.   The DBMS provides mechanisms to achieve these objectives without 
compromising the security and integrity of the data.  Therefore, if the data is  
shared, if it is persistent,  if the users want it be  secure and  easy to access and  
manipulate,  then  use  of  a  database  management  system  is  the  best  
available  alternative. 
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TYPES OF DATABASE MANAGEMENT SYSTEMS 
 
Database Models 
A database model is the method of organizing data and represents the logical 
relationships among data elements in the database. The most popular database 
models are 

(a) Hierarchical model 
(b) Network model 
(c) Relational model 
(d) Object-oriented model 

(a) Hierarchical model : This structure helps to establish logical relationships 
among various data elements of multiple files and arrange the elements in a 
hierarchy. Each box in the model is a record and is sometime referred to as a 
node. In such a model, each record on one level can be related to multiple 
records on the next lower level. A record that has subsidiary records is called 
a parent and the subsidiary records are called children. Data elements in this 
model are well suited for a one to many relationships with other data 
elements in the database. The figure below provides an example of the 
hierarchical model 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the figure above, link fields establish the logical relationships. The links are 
represented by the thin lines, that connect data elements of the various 
records in the lower portion. Once a salesperson record is retrieved, the link 
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in that record can lead to another record that is logically related to that 
salesperson. A link field in the second record leads to the third record and so 
on, thereby creating a chain reaction through an entire set of files. 
This model is ideally suited for problems in which the data elements have a 
natural hierarchical structure. The disadvantage is that it is necessary to 
identify the groups of files that must be logically integrated before the 
database. Hence, a hierarchical data model may not always be flexible 
enough to accommodate the dynamic needs of an organisation. 

 
(b) Network model : In the network model, each record in the database can 

have multiple parents, ie; the relationships among data elements can have a 
many to many relationship. The figure below shows a network model for an 
inventory system. 

 
In the network model, databases can be translated from hierarchical model to 
network and vice versa. The main difference between the network model and 
hierarchical model is that in a network model, a child can have a number of 
parents whereas in a hierarchical model, a child can have only one parent. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
The advantage of the network model is that it promotes flexibility and data 
accessibility, since data elements at a lower level can be accessed without 

Order 
Entry  
records 

Inventory 
Master 
records 

Dealer 
records 

Shop 
schedule 

Sub 
assembly 
records 

Part 
Description 
records 

Supplier 
records 



Srinivas MBA : MIS : CH 4   2009 
 

109 
 

accessing the data elements above them. This model is efficient, easy to 
understand and can be applied to many real world problems that require 
routine transactions. The disadvantage is that  

(i)  it is complex to design and develop  
(ii)  it has to be fine tuned frequently so that relationships among different 

pieces of data are true representations of the real world. 
 (iii) it requires that the relationships among all the data elements  be defined 

before development starts, and changes often demand a major 
programming efforts 

 (iv) for large databases, operations and maintenance of the network model 
are time consuming and expensive 

 
(c) Relational model : In this model, data is represented using two dimensional 

tables called relations, which are made of columns and rows. Each column 
represents a field, also referred to as an attribute, each row represent a 
record, also referred to as a tuple. Relational databases are a popular way of 
organizing data for business needs because of their flexibility. Relational 
databases use three fundamental operations : select, project and join. The 
select operation is a horizontal cut so that only selected rows (records) are 
included in the query results. The project operation creates a subset of 
columns (or a new table) designed to meet the information needs of the user. 
The join operation joins, or links two or more tables, if the information 
requested by the user is not found in one table.  
The advantages of a relational model are that it enables a computer system 
to accommodate a variety of file inquiries in an efficient manner. Also 
additional indexes can be constructed at a later point of time as new data 
processing requirements dictate. The major disadvantages of the relational 
model are that the index portion of the file must be created and maintained 
along with the file records. In some cases the index portion of the file may be 
larger than the file itself resulting in wastage of storage space. Also the file 
index must be searched sequentially before the actual file records are 
obtained, resulting in wastage of time. 

 
Relationships within a data model 
To understand the relationships concepts, we have to understand the terms used 
in explaining the same. They are : entity, attributes, values, key attributes and 
records 

(a) Entity : The entity is a place, person, thing, event etc about which the 
information is recorded. Examples are customer, bank account etc 

(b) Attributes : The attribute characterize the entity or describe the entity 
meaningfully. Example is that if house is an entity, then its attributes are 
color, number, owner etc 

(c) Values : Each attribute of an entity has a value and is known as a data 
value. The data value could be quantitative or descriptive, depending 
upon the attributes. That is, the size of the house will be the area and 
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hence quantitative while the construction quality would be qualitative. The 
attributes could have a single value or multiple values. 

(d) Key attributes : Some attributes can be a key attributes of an entity. 
Using this key attribute, we can find the values of other attributes. For 
example, customer number is an attribute of an entity “customer”. From 
this key, we can find the name of the customer, his address and account 
balance. 

(e) Record : The record is a collection of the attributes of an entity. The set of 
the attribute values is called as a record. 

There are 3 types of relationships between entities. They can be shown in an 
entity-relation diagram. Also known as E-R diagram. 

(a) one-to-one  
(b) one to many 
(c) many to many 

Let us take the hospital environment to understand the relation types. The 
patient, bed, hospital room and surgeon are the entities in the environment and 
their relations are as shown below : 
 

 

 

 

 

 

 

 

At a given point of time, a patient occupies a bed or a bed is assigned to a 
patient. Since the patient cannot occupy more than one bed, the relationship is 
one to one. 
 

 

 

 

 

 

At a given point of time, one or more patients are assigned to a hospital room, 
hence the relationship between the hospital room and the patients is one to 
many. 
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A surgeon operates on many patients or a patient may have been operated upon 
by many surgeons. Hence, the relationships both ways is many to many.  
The relationships are built on the assumption that the patient, hospital room, 
surgeon and hospital bed have unique key as the identifiers. 
 
Recent developments in databases 
The recent developments in database technology are 

(a) Distributed databases 
(b) Client server architecture 
(c) Object oriented databases 
(d) Multi media databases 

(a) Distributed databases : A distributed database is a database distributed 
over single or multi vendor computer hardware located in different geographic 
areas. Some examples are network of libraries, network of corporate offices 
in the country etc. The distributed databases have become popular because 
of two main reasons. First, in the earlier days, many organisations created 
individual databases for different applications such as payroll, personnel data, 
employee benefits etc Unfortunately, many of these databases could not 
communicate with each other because they were created on different 
systems. Distributed databases provide a way to overcome this problem. 
Second, the business units of an enterprise may be geographically dispersed 
and the information needs and demands of each location may be different. 
Distributed databases help to store the data where it is most needed or used, 
and help to customize the data to meet the needs of individual business units. 

(b) Client server architecture : A computing paradigm based on client server 
architecture makes it possible to inter operate among different database 
management systems, among a network of heterogeneous hardware and 
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software platform.  Here the load is optimally distributed among clients and 
servers. Typically, servers are high end performance machines supporting 
heavy transaction processing processes called server processes, the clients 
are likely to be low end PC class machines with rich graphical user interface 
and end user driven. With client server architecture, a network user can 
initiate several client processes in many windows among many servers; they 
could be heterogeneous hardware and a software running on machines that 
are geographically dispersed.  Yet the user feels that he is being served by all 
the servers. 

(c) Object oriented databases :  

Object-oriented model represents an entity as a class.  A class represents both 
object attributes as well as the behavior of the entity.   For example a book class 
will have not only the book  attributes  such  as  ISBN,  Title, Author,  Publisher,  
Year of Publishing, Distributor   Price, etc. but also procedures that imitate 
actions expected of a book such as Update price, etc.  
 
Instances of the class - object - corresponds to individual books.  Within   an 
object, the class attributes takes specific values, which distinguish one book  
from another.   However the behavior patterns of the class is shared by all the 
objects belonging to the class. 
 
The object-oriented model does not restrict attribute values to the small set of 
native data  types usually associated with databases and programming 
languages, such as integer, numeric, character, etc.  Instead the values can be 
other objects.  For example, one  of the attributes of a book can be distributor 
and the value of that attribute can be a distributor  object corresponding to the 
distributor who is distributing the book. 
 
The object-oriented  model  maintains relationships through  logical  
containment. Consider the book-distributor example.  You find the distributor of a 
particular book as one of its attributes.  Since distributor is an object in its own 
right, you can recursively examine  its  attributes.  The  distributor  object  can  
have  a  title  attribute. 
(d) Multimedia databases : The traditional databases were limited to a few data 

types like numeric (integer and real) and character string. However, the 
increasing complexity of database applications calls for handling more 
complex data objects like scanned images (maps, pictures, photographs etc), 
audio and video images. Databases to handle such complex data objects are 
known as multimedia databases. Until recently, databases were limited to 
hold ASCII data only. Most of the real life applications however need an ability 
to handle information, which is rich, such as images, audio images, video 
clippings etc. A new generation of databases is being built to accommodate 
multimedia.  OOP is a promising technique to handle multimedia databases. 

 
Three Types of Data Descriptions : (Three types of schema) : 
 



Srinivas MBA : MIS : CH 4   2009 
 

113 
 

In DBMS, the data is described in three ways : 
1.  From the application programmers view point – a description of subschema. 
2.  From the global logical view point – a description of the schema. 
3.  From the physical view point – a description of the physical records and their 
linkages. 
 
Subschema is the application programmer’s view of the data in a database. 
 
Schema is an overall conceptual or logical view of relationships between the data 
in a database. 
 
The different schemas used to reflect different views of the database are : 
1.  External schema or user schema is user’s view of a part of database. 
2.  Conceptual schema is the overall logical view of the database. 
3.  Internal schema or data storage definition is the way the data is physically 
organized in a database. 
 
Each user of a database is concerned with only a small portion of the database. 
Each user is interested in only a part of the entities in the database, only a part of 
the attributes of those entities, and certain relationships among them. 
 
The conceptual schema represents the real entities and their relationships. It 
contains integrity rules and authorization rules, but it does not contain information 
about how the data items are stored. 
 
The internal schema (or physical data model) describes how the database is 
organized for physical storage and access. It includes information on ordering of 
records, block sizes, storage indexes, use of pointers, and access strategies 
being used. 
 
Following figure shows the general model of database system. 
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Normalization :  
 
It is a process of simplifying the relationship between data elements in a record. 
Through normalisation, a collection of data in a record structure is replaced by 
successive record structures that are simpler and more predictable and therefore 
more manageable. The reasons why it is carried out are : 
 
(i) To structure the data so that any pertinent relationships between entities 

can be represented.  
(ii) To permit simple retrieval of data in response to query and report 

requests. 
(iii) To simplify the maintenance of the data through updated inventories and 

deletions. 
(iv) To reduce the need to restructure or recognize data when new application 

requirements arise. 
Normal forms are groups of mathematical rules that can be used to test 
decisions, when arranging attributes to form entities and when selecting keys 
during the database design process. The process of applying rules of normal 
form is called Normalisation. 
 
As a part of designing database, systems analysis and design techniques include 
“Data Analysis”.  Data analysis uses the normalization procedure which 
simplifies entities, removes redundancies from the system data and finally builds 
a data model, which is both flexible and adaptable to the future requirements of 
the organization. 
 
The degree of Normalization includes : 
 

1. First Normalization Form (1NF) 
2. Second Normalization Form (2NF) 
3. Third Normal Form (3NF) 
4. Boyce –Codd Normal form which include 

1.  Fourth Normal Form (4NF) 
2. Fifth Normal Form (5NF). 

 
Each greater degree of normalization includes the lesser degrees. For example, 
data that is in the Third Normal Form is also in the Second Normal Form and the 
First Normal Form. However, it may or may not follow the values of the Boyce-
Codd Normal Form. 
 
1. First Normal Form :  
 
This  is the lowest level of normalisation. It states that data is in first normal form, 
if the pool of valid values that may appear in an attribute contains only Atomic 
Values (Atomic values can not be decomposed into smaller values).  
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2.   Second Normal Form : 
 
Data is in Second Normal Form if it is in 1NF and every non-key is functionally 
dependent on the primary key. (An attribute is a non-key if it is not part of the 
primary key). The purpose of 2NF is to eliminate repeating groups and to ensure 
that the remaining attributes belong to this entity.  
 
An attribute is functionally dependent on a key if the attribute contains only one 
value which depends on that key. For example, the attribute SALARY contains 
only one value which depends on the key NAME. One way to eliminate repeating 
groups is to create a new attribute (field) for each value expected as shown in 
following figure.  However, this has two disadvantages : 
1.  It limits number of groups that may be stored. 
2.  It uses too much space. 
 
If an arbitrary limit of five dependents is made in this example, we can not handle 
an employee who has six or more dependents. On other hand, if an employee 
does not have any dependents, the space allocated is wasted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Third Normal Form (3NF) : 

 
Name Salary Dependent 
Rama 10,000 Seetha 
  Lava 
  Kusha 
 
Unnormailsed data representing group 
 
Name Salary Dependent 

1 
Dependent 
2 

Dependent 
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Rama 10,000 Seetha Lava Kusha 
 
1 NF – Separate entities 
 
Name Salary (Rs.) 
Rama 10,000 
 
 
 
 
 
2 N F   -Multiple fields 

Seetha 
Lava 
Kusha 
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Data is in Third Normal Form (3NF) if and only if it is in 2NF and every non-key 
attribute is non-transitively dependent on the primary key. The purpose of 3NF is 
to ensure that attributes directly belong to the entity. 
 
Transitivity is a mathematical principle that states that if a relation is true between 
the first value and the second and the third, then the relationship must also be 
true between the first and the third.  
 
The following are the examples of transitivity : 
If  A < B and B < C, then A < C 
If  A > B and B > C, then A > C 
If  A = B and B = C, then A = C 
 
Or 
 
If A is functionally dependent on B and If B is functionally dependent on C, then A 
is functionally dependent on C. 
 
For example, an employee record may have the name and salary of the 
supervisor as attributes. The supervisor’s salary is functionally dependent on the 
supervisor’s name and the supervisor’s name is functionally dependent on the 
employee’s name.  Therefore, the supervisor’s salary is transitively dependent on 
the employee’s name.  To correct this problem, the attributes directly dependent 
on the supervisor should kept as a separate entity. 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 

Name Salary Supervisor Sup. Salary 
Rama 15,000 NARAYANA 30,000 
Krishna 18,000 NARAYANA 30,000 
Hari 22,000 NARAYANA 30,000 
 
 
2 N F but not in 3 N F transitively dependent 
 
NAME SALARY 
NARAYANA 30,000 
                       Supervisor 

NAME SALARY 
RAMA 15,000 
KRISHNA 18,000 
HARI 22,000 

 
Separate entities3 N F 
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Comparison between File Management and Database Management : 
 
File management means traditional approach to managing data stored in files. It 
involves application programs using input / output routines to open, read, write 
and close data files.  The difference between file management and database 
management are listed in following table. Neither approach is better than the 
other. Thus trade offs are involved in selecting an approach.  
 
TOPIC File Management Database Management 
Data redundancy High Low 
Data independence Low High 
Application maintenance Higher maintenance cost Low maintenance cost 
Integrity control Provided by programmer Provided by DBMS 
Unanticipated queries A custom program has to 

be written 
A query language can be 
used. 

Data relationship Handled by application An integral part of DBMS 
Overhead Little CPU and storage 

overhead 
More processing power 
and storage is needed 

Database ownership Applications may have 
their own private data 

All data belongs to the 
DBMS 

Database design More files may be 
designed as needed 

More time and effort is 
spent to develop 
database 

Database administrator Not needed Needed to coordinate 
user community. 

Availability of trained 
programmers 

Most programmers are 
trained to use file 
management 

The average programmer 
needs training to use 
database. 

 
 
 

Networking : 
 
A computer network is a collection of computers and terminal devices connected 
together by communication system. The set of computers may include large-
scale computers, medium scale computers, mini computers and micro-
computers.  
 
Types of Networks :-  
 
Based on the structure, the computer networks are divided into four types as : 
 

(1) Local Area Networks (LAN) 
(2) Wide Area Networks  (WAN) 
(3) Metropolitan Area Networks (MAN) 
(4) Storage Area Networks (SAN) 
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(1)  Wide Area Networks (WAN) :-  
A WAN covers a large geographical area with various communication facilities 
such as long distance telephone service, satellite transmission, and under-sea 
cables. The WAN typically involves best computers and many different types of 
communication hardware and software.  Examples of WAN are interstate 
banking networks and airline reservation systems. Wide area networks typically 
operate at lower link speeds (about 1 Mbps).  
Following are the salient features of WAN : 
(i)  Multiple user computers connected together. 
(ii)  Machines are spread over a wide geographic region. 
(iii) Communications channels between the machines are usually furnished by 
third party (a Telephone company, a public data network). 
(iv) Channels are of relatively of low capacity. 
(v)  Channels are relatively error-prone (error rate of 1 in 105 bits transmitted). 
 
(2)  Local Area Networks (LAN) :- 
 
LAN covers limited area. A typical LAN connects as many as hundred or so 
computers that are located in a relatively small area, such as a building or 
several adjacent buildings. Organizations have been attracted to LAN because 
they enable multiple users to share software, data, and devices. Unlike WAN 
which use point – to - point  links between systems, LANs use a shared physical 
media which is routed in the whole campus to connect various systems. LANs 
use high speed media (1 Mbps to 30 Mbps or more) and are mostly privately 
owned and operated. 
 
Following are some salient features of LAN : 
 
(i)  Multiple user computers connected together 
(ii)  Computers are spread over a small geographic region 
(iii) Communication Channels between the machines are usually privately owned. 
Channels are relatively high capacity. 
(iv) Channels are relatively error free (bit error rate of 1 in 106 bits transmitted) 
 
The critical reasons that LAN has emerged as popular are : 
1.  Security 
2.  Expanded PC usage through inexpensive workstations 
3.  Distributed processing 
4.  Electronic Mail and Message Broadcasting 
5.  Organizational benefits like cost, maintenance etc. 
6.  Data management benefits 
 
(3) Metropolitan Area Networks (MAN) : 
 
A MAN is somewhere between LAN and WAN. The term MAN is sometimes 
used to refer networks which connect systems or local area networks within a 
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metropolitan area. MANs are based on fiber optical transmission technology and 
provide high speed (10 Mbps or so) between sites. 
 
A MAN can support both data and voice, cable television networks are examples 
of MANs that distribute television signals. A MAN just has one or two cables and 
does not contain any switching elements like WAN. 
 
(4) A Storage Area Network (SAN) : SAN is a dedicated, centrally managed, 
secure information infrastructure, which enables any-to-any interconnection of 
servers and storage systems. A SAN :  
(a) Facilitates universal access and sharing of resources. 
(b) Supports unpredictable, explorative information technology growth. 
(c) Provides affordable 24 hours x 365 days availability. 
(d) Simplifies and centralizes resource management. 
(e) Improves information protection and disaster tolerance. 
(f) Enhances security and data integrity of new computing architectures. 
 
NETWORK STRUCTURE OR TOPOLOGY  
 
The geometrical arrangement of computer resources and communication 
facilities is known as network structure.  There are four basic network structures : 
 

1. Star network 
2. Bus network 
3. Ring network 
4. Mesh network 

 
1. Star Network :- 
 
In this system, numbers of terminal computers are connected to a central 
computer as shown below.  In this system, if it is desired to transmit information 
from one computer to another, it can be done only by sending the details through 
central computer. 
 
A star network is particularly appropriate for organizations that require a 
centralized processing facility. For example, a star network may be used in 
banking for centralized record keeping in an on-line branch office environment.  
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Advantages : 
 

(a) It is easy to add new and remove computers from central computers. 
(b) A single branch computer failure does not bring down the entire network. 
(c) It is easier to diagnose network problems through a central hub. 

 
Disadvantages : 
 

(a) If the central computer fails, the whole network ceases to function. 
(b) The cable cost is more in case of star network compared to any other 

networks. 
 
2. Bus Network :- 
 
This structure is very popular for local area networks. In this structure, a single 
network cable runs in the building or campus and all computers are linked along 
with this communication line with two endpoints called the bus or backbone. Two 
ends of the 
cable are 

terminated with terminators. 
 
 
 
 
 
 

C C S C P 
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Advantages : 
 
1. Reliable in very small networks as easy to use and understand. 
2. Cabling requirement  is least compared to all other type of network structures. 
3. Easy to extend.  Two cables can be easily joined with a connector, making a 
longer cable for more computers to join the network. 
 
Disadvantages : 
 
1. Heavy network traffic can slow a bus considerably. 
2. Each connection between two cables weakens the electrical signal. 
3. The bus configuration is difficult to trouble shoot. 
 
3.  Ring Network :- 
 
This is another structure for Local Area Network. In this structure, the network 
cable passes from one computer to another until all computers are connected in 
the form of a loop or ring.  There is a direct point-to -point link between two 
neighbouring computers. These links are unidirectional which ensures that 
transmission by a computer traverses the whole ring and comes back to that 
particular computer. 
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Advantages : 
1.  Ring networks offer high performance for a small number of workstations or 
for larger networks where each station has a similar workload. 
2.  Ring networks can span longer distances than other types of networks. 
3.  Ring networks are easily extendable. 
 
Disadvantages :  
1.  Relatively expensive and difficult to install. 
2.  Failure of one computer in the network can affect  the whole network. 
3.  It is difficult to trouble shoot a ring network. 
4.  Adding or removing computers can disrupt the network. 
 
4.  Mesh Network :- 
 
In this structure, the computers are randomly connected using communication 
links.  
 

********** 
 
Assignment Questions : 
1. What is a database? Why it is used ? Give the objectives, characteristics, and 
advantages of database in database Management system ? 
 
2. What is a database management system ? Why it is used ? What are its 
components ?  What are different types of databases used in practice ? 
 
3. What are the three types of data descriptions in a database management 
system ?  Differentiate between conventional file management system and 
database management system ? 
 
4.  What is a computer network ? Based on the structure how they are classified? 
Explain the silent feature of each type ?  
 
5.  What are the different structural arrangements of  computers in a network ? 
Explain each with suitable block diagram ? 
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MIS  Chapter  5 
 

Decision Making Process in  MIS 
 
 
1.  Introduction : 
 
2.  Decision Making Process  : 
 
3.  Decision Supporting Systems : 
 
1. Introduction to Decision Making : 
 
Decision making is an indispensable component of management process and 
managers' life is filled with making decisions after decisions. Managers see 
decision making as their central job because they constantly choose what is to 
be done, who is to do, when to do, where to do, and how to do. 
 
William Moore has equated it with management when he says that "management 
means decision making”. 
 
The word decision has been derived form the Latin word 'decidere' which means 
a cutting away or a cutting off. Thus, a decision involves a cut of alternatives 
between those that are desirable and those that are not desirable. The decision 
is a kind of choice of a desirable alternative. Decision making is a process to 
arrive at a decision; the process by which an individual or organization selects 
one position or action from several alternatives.  
 
Shull et al. have defined decision making as follows: "Decision making is a 
conscious process involving both individual and social phenomena based upon 
factual and value premises which concludes with a choice of one behavioral 
activity from among one or more alternatives with the intention of moving toward 
some desired state of affairs." 
 
Decision making thus, is an act of projecting one's own mind upon an opinion or 
a course of action. In decision making, three aspects of human behaviour are 
involved: (1) cognition-activities of mind associated with knowledge; (2) conation-
the action of mind implied by such words as willing, desire, and aversion; and (3) 
affection-the act of mind associated with emotion, feeling, mood, and 
temperament. Based on the above concept of decision making, its features can 
be derived as follows: 
1. Decision making implies that there are various alternatives and the most 
desirable alternative is chosen to solve the problem or to arrive at expected 
results. A problem situation which does not have alternatives is not really a 
problem requiring a solution though the problem may be quite injurious. 
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2. Existence of alternatives suggests that the decision maker has freedom to 
choose an alternative of his liking through which his purpose is served. 
3. Decision making may not be completely rational but may be judgemental and 
emotional in which personal preferences and values of the decision maker play 
significant role. 
4. Decision making is a goal-directed process. It implies that the decision maker 
attempts to achieve some results through decision making. 
 
2. TYPES OF DECISIONS 
Decision making is involved in every walk of life; it is relevant in organisational as 
well as non-organisational context. In organizational context. decisions may vary 
from major ones like determination of organisational objectives or deciding about 
major projects to specific decisions about day-to-day operations. Therefore, there 
are different decisions which are made by managers in the organisations.  
 
There are different ways in which decisions may be classified. One way of 
classifying these decisions is to group them into routine and nonroutine. In 
another way, these decisions are classified as programmed and non-
programmed. These are further classified as strategic and tactical or operational 
decisions. Strategic decisions are non-programmed and nonroutine while tactical 
(also known as operational) decisions are mostly routine and programmed.  
 
Programmed Decision 
A programmed decision. also known as structured decision. is routine and 
repetitive and is made within the framework of organisational policies and rules. 
These policies and rules are established well in advance. to solve recurring 
problems in the organisation. For example. the problem relating to promotion of 
employees is solved by promoting those employees who meet promotion criteria. 
These criteria are established by promotion policy and the managers have just to 
decide which employees meet promotion criteria and the decision is made 
accordingly. Programmed decisions are comparatively easier to make as these 
relate to the problems which are solved by considering internal organisational 
factors. Such decisions are made by managers at comparatively lower levels 
where the factors affecting decision making are static and well-structured. 
 
Non-programmed Decision 
A non-programmed decision. also known as unstructured decision is relevant for 
solving unique/unusual problem in which various alternatives cannot be decided 
in advance. For such a decision. the situation is not well-structured and the 
outcomes of various alternatives cannot be arranged in advance. For example, if 
an organisation wants to take actions for growth, it may have several alternative 
routes like going for a grass-route project or taking over an existing company. In 
each situation. the managers have to evaluate the likely outcomes of each 
alternative to arrive at a decision. For evaluating the likely outcomes of these 
alternatives. The managers have to consider various factors, many of which lie 
outside the organisation. A common feature of non-programmed decisions is that 



Srinivas MBA : MIS : CH 5  2009 
 

125 
 

they are novel and non-recurring and, therefore, readymade solutions are not 
available. Since these decisions are of high importance because of their long-
term consequences, these are made by managers at higher levels in the 
organisation. 
 
Semi-programmed decisions :  
 
In these types of decision, at least one but not more than two of the above stages 
can be handled by a well defined preset procedure. An example of such a 
decision is the intelligence phase, which is well structured, having diverse kinds 
of variance analysis. Here a comparison with a budget is undertaken in a well 
defined way to indicate the need for a decision. Subsequent stages of design and 
choice are, however, not handled by any set procedure. 
 
3. DECISION-MAKING CONDITIONS 
Decision making involves selection of an alternatives which is put into action and 
whose impact is known in future period. Thus, the decision maker makes the 
decision for future conditions. In fact. a decision is not a process of making the 
future decision but a means of reflecting the future in today's decision. The future 
conditions for a decision vary along a continuum ranging from condition of perfect 
certainty to condition of complete uncertainty as shown in Figure 5.1. 
 

 
 
In each of these conditions, knowledge of outcome of the decision differs. An 
outcome defines what will happen if a particular alternative or course of action is 
chosen and implemented. Knowledge of outcome of each decision alternative is 
important when there are multiple alternatives and only one alternative is to be 
chosen. In the analysis for decision making, three types of knowledge with 
respect to outcomes are usually distinguished as shown in Table. 
 
Table 5.1 : Outcomes in different decision-making conditions : 
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Since there is variation in the knowledge of outcomes of different alternatives in 
different decision-making conditions, decision making strategy differs in each 
case. 
Certainty 
When the decision maker knows exactly which nature of state will occur, a 
condition of certainty exists. This means that the decision maker will be able to 
make perfectly accurate decision time after time. Such a condition exists when 
decision involves action in immediate future, and the decision maker has made 
such a decision a number of times with the same results. Under this condition, 
the information required for decision making is highly structured and structured 
decision-making techniques are applied. 
Usually. such structured decisions are made at lower management in the 
organisation at which level, personnel are engaged in routine and repetitive 
functions. 
 
Risk 
Most of the major organisational decisions, particularly involving high investment. 
are made under the condition of risk in which only some information is available 
but that is not sufficient to answer overall question about the outcome of the 
decision. In such a condition, the decision maker has to decide two things-
amount of risk involved in a decision and amount of risk that the organisation is 
ready to assume. Amount of risk involved can be calculated by risk analysis while 
the organisation's propensity to take risk depends on its risk taking ability and risk 
taking attitudes. Thus. in the condition of risk, part of the information can be in 
structured form while part of the information may be in unstructured and 
qualitative form. Thus, the decision cannot be perfectly structured but it cannot 
also be perfectly unstructured but it is semi-structured. Usually, semi-structured 
decisions are made at higher middle and top levels of the organisations. Since 
many qualitative information is used for making semistructured decisions, these 
are influenced by personal preferences of the decision maker. 
 
Uncertainty 
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If a decision involves a condition about which the decision maker has no 
information about the relative chances of any single outcome, he is said to be 
operating under condition of uncertainty. Since the decision maker does not have 
any information on which he can develop any analysis for decision making, the 
best he can do is to be aware that he has no chance of predicting the events. 
Thus, the type of information that the decision maker can use is highly 
unstructured and even fragmented. Thus, it can be seen that a decision may be 
either structured, semistructured, or unstructured and not only structured or 
unstructured. 
Further, the degree of structuring in a decision can be seen in terms of 
continuum in which degree of structuring varies as shown in Table : 
 
Table 5. 2: Managerial decisions, level of structuring and support systems 

 
 
4. DECISION-MAKING PROCESS 
When a manager makes a decision, it is, in effect, the organisation's  response to 
a problem. As such, a decision should be thought of as a means rather than an 
end. Every decision is the outcome of a dynamic, process which is influenced by 
multiple forces. However. what are the different stages of this process, there is 
no unanimity. Herbert Simon, an expert on decision making has proposed three 
phases of decision making intelligence, design, and choice. As against these 
phases, Rubenstein and  Haberstroh have proposed five phases-recognition of 
problem or need for a decision, analysis and statement of alternatives, choice 
among the alternatives, communication and implementation of decision, and 
follow-up and feedback results of decision.  
 
For our further analysis, three phases of decision making as proposed by Simon 
will be taken in which the fourth phase of decision implementation is added 
because mere choice of an alternative does not complete decision-making 
process unless managers as decision makers commit resources for 
implementing a decision. Based on this, decision making process has been 
presented in Figure 5.2. 
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Figure 5.2 : Phases in decision-making process. 
 
Various phases of decision-making process presented in Figure 5.2 are more 
relevant for non-programmed decisions. Problems that occur infrequently are 
unstructured and are characterized by a great deal of  uncertainty regarding the 
outcomes of various alternatives, require the managers to utilize the entire 
process. For frequently occurring structured problems, it is not necessary to 
consider the entire process because decision rules are developed to handle such 
problems and it is not necessary to develop and evaluate various alternatives 
each time such a problem arises. 
Let us now discuss the various phases, problems involved there in, and the type 
of information systems required to furnish information to overcome these 
problems. 
 
(a) Intelligence Phase : 
Intelligence phase of decision-making process involves searching the 
environment for conditions calling or decisions. This is related with the 
identification and formulation of the problem which is to be solved by the decision. 
A problem is the gap between present state of affairs and desired state of affairs 
on the subject-matter of decision. Problem finding is a difficult proposition as a 
famous writer, Charles Kettering, suggests when he observes, "it is not that 
people, can't see the solution; it is that they can't see the problem." Problem 
finding is just like the diagnosis of a patient by a doctor. When the doctor makes 
a diagnosis, he has a normal, healthy person in his mind and he also has fairly 
clear concept of what a healthy person is. With this model as the desired result, 
he looks for disparities in the patient's actual state of health or factors which 
indicate whether his future health will fall short of normal. In the case of 
organizational decision making, however, a decision maker cannot rely on a 
commonly accepted norm such as a healthy person. In organizational context, a 
problem exists whenever one faces a question whose answer involves doubt and 
uncertainty. In order to overcome this doubt and uncertainty, the manager, as a 
decision maker, develops some models of what is desired, differences between 
desired and reality are identified, and differences are evaluated to find out- 
whether they constitute a problem.  
 
Pounds has identified four types of models that produce expectations against 
which reality is measured: 
1. Historical models in which the expectation is based on an extrapolation of past 
experience. 
2. Planning models in which the plan is the expectation. 
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3. Models of other people in the organization, such as superiors, subordinates, 
other departments, etc. 
4. Extra organizational models in which expectations are derived from 
competition, customers and professional organizations. 
 
When a problem is identified, it remains vague at the initial stage. In order to 
make it more clear and specific, problem formulation is required so that design 
and choice phases operate on the right problem. At this stage, the problem 
identified earlier, is defined more precisely and some complexity is reduced.  
 
MacGrimmon and Taylor have suggested four strategies for reducing complexity 
and formulating a problem: 
1. Determining the boundaries (clearly identifying what is included in the 
problem). 
2. Examining changes that may have precipitated the problem. 
3. Factoring the problem into smaller sub-problems. 
4. Focusing on controllable elements.  
For this phase of decision making, information requirement is in the form of 
exception reporting, that is, what kind of deviation exists between desired state of 
affairs and actual state of affairs. Such type of information is provided by 
structured information- systems that deliver a wide variety of detailed information. 
 
(b) Design Phase : 
 
Design phase of decision making involves generation of possible alternatives 
through which the problem can be solved. A problem can be solved in several 
ways, however, all the ways cannot be equally satisfying. Further, if there is only 
one way of solving a problem, no question of decision arises. Therefore, the 
decision maker must try to find out the various alternatives available in order to 
get the most satisfactory result of a decision. Identification of various alternatives 
not only serves the purpose of selecting the most satisfactory one, but it also 
avoids bottlenecks in operation as alternatives are available if a particular 
decision goes wrong. However, it should be borne in mind that - it may not be 
possible to consider all alternatives either because some of the alternatives 
cannot be considered for selection because of obvious limitations of the decision 
maker or information about all alternatives may not be available. Therefore, while 
generating alternatives, the concept of limiting factor should be applied. A limiting 
factor is one which stands in the way of accomplishing a desired objective. If 
these factors are identified, managers will confine their search for alternatives to 
those which will overcome the limiting factors. For example, if an organisation 
has limitation in raising sizable finances, it cannot consider projects involving 
high investment. 
 
A decision maker can use several sources for identifying alternatives his own 
past experience, practices followed by others, and using creative techniques. 
Past experience. applied in most cases of decision making, takes into account 
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the actions taken by the decision maker in the past  with obvious differences 
between the former challenges and the present one. The successful action of the 
past may become an alternative for the future. This is a very simple approach but 
has obvious limitations because there may be so much chances in the decision 
context that old action becomes totally irrelevant. Copying from the experiences 
of others is another way of generating alternatives. Thus, alternatives used by 
successful decision makers can be thought of as alternatives of decision making. 
This is also practiced by many organizations after making suitable amendments 
in the light of changed decision context. Importing of technology from foreign 
countries with suitable changes is good example of this type of alternatives. The 
third method of generating alternatives is through creative process where various 
exercises are taken to generate entirely new ideas. 
The design phase of decision making may require more intelligence so that the 
manager can decide if a particular alternative is suitable for solving the problem. 
This phase may entail more carefully specified and directed information activities 
which are, generally, provided by decision support systems as they operate on 
simple models and can be operated with limited data. 
 
(c) Choice Phase : 
Choice phase of decision making involves choice of an alternative which can be 
put into action to solve the problem. For choosing an alternative which aims at 
solving the problem in the most appropriate way in a given situation, the manager 
must evaluate all the alternatives generated at the design stage. However, all 
alternatives available for decision making will not be taken for detailed evaluation 
because of the obvious limitations of managers in evaluating all alternatives. The 
energy of managers is limited and psychologically most of them prefer to work on 
plans that have good prospect of being carried out. In narrowing down the 
number of alternatives, two approaches can be followed-constraint on 
alternatives and grouping of alternatives of similar nature. The decision maker 
develops a list of limits that must be met by a satisfactory solution. He may treat 
these limits as constraints, that is, he may check proposed alternatives against 
limits, and if an alternative does not meet them, he can discard it. In the second 
approach, various alternatives can be grouped into classes on some specific 
criteria important to decision making. A representative alternative from one group 
may be selected for further analysis. After identifying the group that shows up the 
best, decision maker can concentrate on alternatives within this group. This 
method is very helpful in decision making regarding the location of plant. 
Warehouse, etc. 
 
Having narrowed down the alternatives which require serious consideration, the 
decision maker will go for evaluating how each alternative may contribute 
towards the solution of the problem or objectives supposed to be achieved by 
implementing the decision. Evaluation of various alternatives dissects an 
alternative into various tangible and intangible factors. Tangible factors are those 
which can be quantified because they are quite obvious like the cost per unit 
investment required, output to be received, etc. Such factors can be measured 



Srinivas MBA : MIS : CH 5  2009 
 

131 
 

easily though their happening may not be measured with certainty; for example, 
demand projection at a given price in a particular alternative. As against these, 
intangible factors are mostly qualitative and cannot be measured in terms of 
quantity. Therefore, some definitions can be used for such factors. For example. 
in a plant location various non-economic factors like psychological problem 
arising out of displacement of persons from the plant site, ecological balance, etc. 
have to be taken into account which cannot be quantified. In evaluating an 
alternative, both these factors have to be taken into account.  
 
Evaluation of various alternatives presents a clear picture as to how each of 
these contributes to solution of the problem. A comparison is made among likely 
outcomes of the various alternatives and the most appropriate one is chosen. 
Choice aspect of decision making is, thus, related to deciding the most 
acceptable alternative which fits with the organizational objectives. It may be 
seen that the chosen alternative should be acceptable in the light of 
organizational objectives, and it is not necessary that the chosen alternative is 
the best one.  At the choice phase of decision making,  the manager requires 
information tools that can keep track of the consequences, costs, and 
opportunities by each alternative generated at the design phase. The manager 
requires a larger decision support system to develop more extensive data on a 
variety of alternatives and to use complex analytical models to account for all the 
consequences. 
 
(d) Implementation Phase : 
Once an alternative is chosen. it is implemented, that is, it is put into action. Truly 
speaking, the actual process of decision making ends with the choice of an 
alternative through which the objectives can be achieved. However, decision 
making, being a continuous and ongoing process, must ensure that the problem 
has been solved and the objectives have been achieved by the chosen 
alternative. Unless this is done, managers will never know what way their choice 
has contributed. Therefore, the implementation of decision may be seen as an 
integral aspect of decision. Once the creative and analytical aspects of decision 
making through which an alternative has been chosen are over the managerial 
priority is one of converting the decision into something effective. This is the 
implementation aspect of decision making. The basic difference between 
decision making as an analytical process and implementation is that the former 
requires the use of conceptual skills since it translates the abstract ideas into 
reality. For example, suppose that there is a change in consumers tastes. This 
change is very abstract and cannot be seen unless some specific techniques and 
measurements are applied. How this change can provide opportunity to the 
organization is mostly a conceptual exercise requiring managers to interpret what 
changes are taking place and what products or services w1ll be preferred in the 
changed situation. 
 
Implementation. on the other hand, relates to putting a decision into practice so 
that objectives of decision are achieved. This practice will provide further 
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feedback for evaluating the soundness of the decision and if need be, a change 
in the decision. Implementation of a decision requires the communication to 
subordinates, getting acceptance of subordinates over the matters involved in the 
decision, and getting their support for putting the decision into action. The 
decision should be effected at appropriate time and in proper way to make the 
implementation more effective. The effectiveness of implementation is important 
because it is only effective action through which organizational objectives can be 
achieved. When a decision is put into action, it brings certain results. These 
results provide indication whether decision making and its implementation is 
proper. Therefore, managers should take follow-up action in the light of feedback 
received from the results. If there is any deviation between objectives and results 
this should be analyzed and factors responsible for this deviation should be 
located. The feedback may also help in reviewing the decision when conditions 
change which may require change in the decision. 
 
At the implementation phase, managers can use structured information system 
that provides routine reports on the progress of a solution. This system should 
also indicate the difficulties that arise, resource constraints, and possible 
corrective actions. For this purpose. information systems may -range from 
integrated management information systems to much smaller systems as well as 
project planning software operating on microcomputers. 
 
Table 5.3 presents the summary of decision-making phases. Information 
requirement. and supporting information systems. 
 
Table 5.3: Decision-making phases. Information required and supporting 
information systems 
 

 
 
METHODS OF DECIDING AMONG ALTERNATIVES 
There are different methods to evaluate various alternatives through which a 
problem can be solved. In evaluating alternatives, an attempt is made to find out 
the likely outcome of each alternative so that the alternative which is likely to 
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provide maximum outcome is chosen. In evaluating the likely outcomes of 
various alternatives, generally, following methods are used: 
1. Optimization techniques. 
2. Pay-off matrices. 
3. Decision tree. 
4. Game theory. 
5. Elimination by aspects. 
6. Decisional balance sheet. 
 
5. Decision Supporting Systems (DSS) : 
 
DSS are an application of Herbert Simon model. In this mode, there are 3 phases 
ie; intelligence, design and choice. The DSS basically helps the information 
system in the intelligence phase where the objective is to identify the problem 
and then go to the design phase for solution. The choice of selection criterion 
varies from problem to problem. Therefore, it is required to go through these 
phases again and again till a satisfactory solution is found. These systems are 
helpful in making a decision and also its performance evaluation. These systems 
can be used to validate the decision by performing the sensitivity analysis on 
various parameters of the problem. 
 
In decision making, programmed decisions, because of its rule base structure, 
can be computerized, as inputs, processing methodology, analysis and choice of 
decision making are predetermined. DSS can be built around the rule in case of 
programmed decision situation, while in non programmed decisions, the rules are 
not fixed or predetermined and requires the user to go through the decision 
making cycle as indicated in the Herbert Simon model, every time. 
 
5.1 DSS definition 
 
The term, decision support system refers to a class of systems, which support 
the process of decision making. The emphasis is on support rather than on 
automation of decisions. DSS allows the decision maker to retrieve data and test 
alternative solutions during the process of problem solving. 
DSS can also be defined as a set of well integrated, user friendly, computer 
based tools that combine data with various decision making models – qualitative 
and quantitative – to solve semi structured and unstructured problems. 
 
5.2 DSS characteristics 
The following are the desirable characteristics for a DSS : 
• DSS helps the decision maker in the decision making process 
• DSS is designed to solve semi structured and unstructured problems 
• DSS supports decision makers at all levels, but is most effective at the tactical 
and strategic levels 
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• DSS makes general purpose models, simulation capabilities and other 
analytical tools available to the decision maker 
• DSS is an interactive, user friendly system that can be used by the decision 
maker with little or no assistance from an MIS professional 
• DSS can be readily adapted to meet the information requirements for any 
decision environment 
• DSS provides the mechanisms to enable a rapid response to a decision 
makers request for information 
• DSS has the capability to interface with the corporate database 
• DSS is not executed in accordance with pre-established production schedule 
• DSS is flexible enough to accommodate a variety of management styles 
• DSS facilitates communication between levels of decision making 
 
5.3 Types of DSS 
 
The different types of decision support system are as follows : 
(a) Status inquiry systems : The number of decisions in the operational 
management and some at the middle management are such that they are based 
on one or two aspect of a decision making situation. It does not call for any 
elaborate computations, analysis, choice etc for decision making. If the status is 
known, the decision  is automatic ie; status and solution is a unique relation. 
(b) Data analysis systems : These decision systems are based on comparative 
analysis and makes use of a formula or an algorithm. But, these processes are 
not structured and therefore, vary. The cash flow analysis, inventory analysis and 
the personnel inventory systems are examples of the analysis systems. The use 
of simple data processing tools and business rules are required to develop this 
system. 
(c) Information analysis system : In this system, the data is analysed and the 
information reports are generated. The reports might be having some exceptions 
as a feature. The decision makers use these reports for assessment of the 
situation fro decision making. The sales analysis, accounts receivables system, 
market research analysis are examples of such systems. 
(d) Accounting Systems : These systems are not necessarily required for 
decision making but they are desirable to keep track of the major aspects of the 
business or a function. The content of these systems is more of data processing, 
which leads to formal reporting, with exceptions if necessary. These systems 
account items such as cash, inventory, personnel and so on, and relate it to 
norms developed by the management for control and decision making. 
(e) Model based systems : These system are simulation models or optimization 
models for decision making. These decisions, generally are one time and 
infrequent, and provide general guidelines for operation or management. The 
product decision mix decision, material mix, job scheduling rules, resource or 
asset or facilities planning systems are the examples. 
 
5.4 Components of DSS 
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There are three main software components of a DSS. These are 
(a) database management system (DBMS) 
(b) model management system 
(c) support tools.  
(a) Database Management Systems : To solve a problem, the necessary data 
may come from internal or external databases. In an organization, internal data 
are generated by systems such as TPS and MIS; external data come from a 
variety of sources such as newspapers, online data services, databases 
(financial, marketing, manufacturing, human resource etc). Some examples of 
external data are government regulations, tax codes, census figures, competitors, 
market shares, economic indicators, interest rates, and inflation. The data in the 
DSS database are managed by the DBMS, which covers compilation of data, 
manipulation of data, data generation, data updating, data maintenance and 
dissemination of data.  
(b) Model Management Systems : Model management system stores and 
accesses models that managers use to make decisions. Such models are used 
for designing a manufacturing facility, analyzing the financial health of an 
organization, forecasting demand for a product or service, and determining the 
quality of a particular batch of products. Although most models are quantitative, 
decision makers use qualitative models also to make decisions. 
 The model builder, a component of many model bases, provides a structured 
framework for developing models by helping decision makers identify the 
variables and the interrelationships among the variables in the model. A model 
builder creates, identifies, processes, stores, updates, and maintains different 
decision making models and ensures that these models are consistently applied 
when decisions are made. The model builder also contains a model dictionary for 
consistency in the definitions and uses of models. Some models that decision 
makers use to make decisions are: statistical models, production models, 
marketing models, human resource models, financial and accounting models, 
and strategic models. These models are extensively used in different functional 
areas of a business.  
(c) Support Tools : Support tools like online help, pull down menus, user 
interfaces, graphical analysis, error correction mechanisms, facilitate the user 
interactions with the system. Interfaces are an important support tool especially 
in the case of a DSS. Better the interface, the greater will be the chances of 
system being accepted by the user. Although managers recognize the power and 
potential of DSS, the main problem to its adoption is a lack of people with training 
in computer technologies. In such an environment, good interfaces can make or 
break the system. 
 
5.5 Functions of DSS 
There are five functions of a DSS facilitating managerial decision making. They 
are 
• Model building  
• 'What if' analysis 
• Goal seeking 
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• Risk analysis 
• Graphical analysis.  
(a) Model building: This allows decision makers to identify the most appropriate 
model for solving the problem on hand. It takes into account input variables, 
interrelationships among the variables, problem assumptions and constraints. 
For example, a marketing manager of a television manufacturing company is 
charged with the responsibility of developing a sales forecasting model for color 
TV sets. A model builder uses a structured framework to identify variables like 
demand, cost and profit, analyze the relationships among these variables, 
identify the assumptions, if any (e.g., assume the prices of raw materials will 
increase by 5% over the forecasting period), and identify the constraints like the 
production capacity of the plant. All this information is then integrated by a 
system into a decision making model, which can be updated and modified 
whenever required.  
(b) 'What-if' analysis : This is the process of assessing the impact of changes to 
model variables, the values of the variables, or the interrelationships among 
variables. This helps managers to be proactive, rather than reactive, in their 
decision making. This analysis is critical for semi-structured and unstructured 
problems because the data necessary to make such decisions are often either 
not available or incomplete. Hence, managers normally use their intuition and 
judgment in predicting the long-term implications of their decisions. Managers 
can prepare themselves to face a dynamic business environment by developing 
a group of scenarios (best-case scenario, worst-case scenario and realistic 
scenario).  
(c) Goal seeking : It is the process of determining the input values required to 
achieve a certain goal. For example, house buyers determine the monthly 
payment they can afford (say for example, Rs. 5,000) and calculate the number 
of such payments required to pay the desired house.  
(d) Risk analysis : It is a function of DSS that allows managers to assess the 
risks associated with various alternatives. Decisions can be classified as low risk, 
medium risk, and high risk. A DSS is particularly useful in medium risk and high 
risk environments.  
(e) Graphical analysis : This helps managers to quickly digest large volumes of 
data and visualize the impacts of various courses of action. S L Jarvenpaa and G 
W Dickson studied the relative advantages and disadvantages of tabular and 
graphic output. They recommended the use of graphs when:  
• Seeking a quick summary of data  
• Detecting trends over time  
• Comparing points and patterns at different variables  
• Forecasting activities  
• Seeking relatively simple impressions from a vast amount of information.  
The researchers suggested that a tabular presentation be used when it is 
necessary to read individual data values.  
Jarvenpaa and Dickson has also offered the following tips when choosing 
between the various types of graphs:  



Srinivas MBA : MIS : CH 5  2009 
 

137 
 

• Line or bar charts are preferred for summarizing data.  
• Grouped line or bar charts are good for showing trends over time.  
• Grouped bar charts are better than pie charts for presenting parts of a whole.  
• Grouped line or bar charts are good for comparing patterns of variables.  
• Use horizontal rather than vertical bars when comparing variables.  
• Use single line or bar charts to compare individual data points between 
variables 
• Put data values on the top of the bars in a bar chart for easier reading. 
 
Note : 
 
Types of decisions 
There are three types of decisions 
• Programmed decisions 
• Non programmed decisions 
• Semi programmed decisions  
(1) Programmed decisions : The decisions in which a problem is solved by a 
predefined procedure or algorithm. These decisions are repetitive and routine in nature 
and are capable of being modeled mathematically in their entirety.  
The examples of such decisions are :  
(i) preparation of pay in accordance with the laid out regulations 
(II) inventory ordering.  
To arrive at the programmed decisions, a solution manual to problems is prepared to 
help the users. Some characteristics of such decisions are :  
(i) These decisions can be delegated 
(ii) The cost of solving a problem is low compared to non-programmed rules 
(iii) Such decisions can be made with the help of the computer system.  
(2) Non programmed decisions : These decisions are unstructured, occasional, of 
high consequence, complex and involve major commitments. There is no predefined 
program or set decision rule or algorithm available to solve these problems automatically.  
The examples of such decisions are :  
(i) advertising budget 
(ii) new product decisions 
(iii) acquisition of capital projects 
 
Some characteristics of such decisions are 
(i) These decisions are novel and difficult to structure in logical mathematical terms. 
(ii) These decisions cannot be delegated, and are based on management direction, 
thinking and deliberations, e.g., purchase of scarce and capital items under fluctuating 
price conditions cannot be delegated 
(iii) Computers cannot be used directly for such decisions. However, they may be used 
to process large volumes of necessary data.  
(3) Semi programmed decisions : In these types of decision, at least one but not more 
than two of the above stages can be handled by a well defined preset procedure. An 
example of such a decision is the intelligence phase, which is well structured, having 
diverse kinds of variance analysis. Here a comparison with a budget is undertaken in a 
well defined way to indicate the need for a decision. Subsequent stages of design and 
choice are, however, not handled by any set procedure. 
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Assignments :  
 

1. What is decision making ? What are the types of decisions ?  
2. What do you mean by decision support system ? What are their 

characteristics, types, components and functions ? 
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CH -6 
Approaches for System Development 

 
 
System development includes those activities that go into producing an 
information system solution to organizational problems or to take advantages of 
environmental opportunities. System development consists of two broad phases-
analysis and design. System analysis includes analysis of a problem which the 
organization will try to solve with an information system. It is a phase of system 
development process in which the system analyst or system development team 
determines what the new system should accomplish. 
 
System design provides details of how a system will meet the information 
requirements as determined by the system analyst/system development team. It 
is a phase of system development process in which the general requirements 
defined in the analysis phase are converted into detailed specifications for the 
new system. 
Different approaches can be used for system development which can be 
classified as follows : 
1. System development life cycle. 
2. Prototyping. 
3. Rapid application development. 
4. End-user development. 
 
In some of these approaches, top-down method is followed while in some others, 
bottom-up method is followed. Further an integrative method can be followed by 
integrating the top-down and the bottom-up methods. 
Therefore,, before going through the details of system development approaches, 
it is desirable to go through top-down, bottom-up, and integrative methods. 
 
Top-down Method. Under top-down method, the development of an information 
system starts from the identification of organisational objectives, its environment, 
and constraints under which it operates. On the basis of these, following steps 
are followed : 
1. The strategic and tactical decisions are made for achieving organisational 
objectives.  
2. Major functions and activities are identified which are relevant for carrying out 
these decisions. 
3. From the functions and activities. the major information requirements are 
determined. 
4. Based on information requirements, model of information flow in the 
organization is developed which acts as a guide for designing the information 
systems. 
5. By using the model of information flow. various information subsystems are 
defined. Each subsystem comprises various modules. A module is a basic unit 
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for information system development. The selection of a module for developing 
the system is made on the basis of priority assigned to various modules. 
6. Various subsystems and their modules are coordinated and integrated. The 
information system so developed is viewed as a total system fully integrated 
rather than being a collection of loosely coordinated subsystems. 
 
In top-down method. top management of the organization takes initiative in 
formulating organizational objectives and strategies and communicates these 
down the line to middle and lower management levels for translating these into 
performance results. Managers at the middle and lower levels seldom play any 
role in objective and strategy formulation: they focus their attention on strategy 
implementation and operational control. 
 
Bottom-up Method. In bottom-up method. the development of information 
system starts from the identification of life stream systems which are essential for 
the day-to-day business operations. For example, payroll, sales order, inventory 
control etc. Initially, information systems for these life streams are developed 
which are in the form of transaction processing systems. Other systems are 
developed subsequently based on the user needs. Following steps are followed 
in bottom-up method of system development: 
1. For each life stream, basic transactions, information file requirements, and 
information processing programs are identified. 
2. Based on basic transactions, information file requirements, and information 
processing programs, information system for each life stream is developed. 
3. After thoroughly examining various applications, files, and records, data kept in 
different files of each information system are integrated. Integration of data 
enhances shareability of database. It also ensures that uniform data are being 
used by all programs and also provides added capability for enquiry processing 
as well as ad hoc requests for reports. 
4. After database is created, various planning and decision support systems are 
developed for management planning and control. 
5. After the planning and decision support systems start functioning, these are 
integrated into a model base having a variety of models including regression 
analysis, operations research models etc. 
6. At the last stage, strategic planning models are added to the information 
system by collecting and storing the external information relevant for strategic 
planning. 
Thus, in bottom-up method, a system grows in real response to user needs. 
However. this method suffers from one basic limitation that is integration of 
various subsystems may need redesigned system due to the changing 
requirements and new interfaces with other subsystems. 
 
Integrative Method: Integrative method tries to overcome the limitations of top-
down and bottom-up methods by balancing both the methods. In integrative 
method, managers at all-levels are permitted to play role in system development. 
In this method, top management initiates the structure and design of the 
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information system suitable to the organization which is presented to managers 
at middle and lower levels for soliciting their views and necessary modifications. 
The managers at these levels are advised to suggest changes, additions, 
deletions and return the design along with their suggestions to the top 
management. Based on these suggestions, a revised design is drawn which is 
again sent down the line for comments and necessary modifications. This 
process continues till a system design is finalized which is satisfactory to 
personnel at all the levels. 
 
System Development Life Cycle 
System development life cycle (SOLC), or simply called system life cycle (SLC), 
is based on the life cycle stages of natural systems. Natural systems go through 
the four stages of life cycle-birth, growth, maturity, and decay. In the same way 
an information system, which is a man-made system, passes through different 
stages though it is not necessary that these stages exactly resemble the stages 
of natural systems. An information system development life cycle has different 
stages as shown in Figure 1. 
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The system developer may progress from one stage to another methodologically 
solving the problems involved and achieving the desired results. However, there 
is a need for caution in isolating various stages of SOLC. These stages have 
been isolated in a sequence for learning purpose and in actual practice they may 
overlap. Each stage may act as a basis for modifying earlier actions. For 
example, based on performance criteria a particular proposed system has very 
high ranking but if it requires a hardware system which is not feasible, the system 
may not be considered useful for further action and fresh system development 
process may begin. 
 
Therefore, various stages of SOLC should be taken in this perspective. They are : 
Project Definition : Project definition stage determines whether or not the 
organization has a problem and whether or not the problem can be solved by 



Srinivas MBA : MIS : CH 6  2009 
 

143 
 

launching a new system. Thus, at this stage, the need for a new system is 
recognized. The basis for a new system is the recognition of a need for improving 
an information system or a procedure. This need leads to a preliminary surveyor 
an initial investigation to determine whether an alternative system can solve the 
problem. It entails looking into the duplication of effort, bottlenecks, inefficient 
existing procedures, or whether parts of the existing system need 
computerization. If the problem is serious enough, the management may want to 
have an analyst to look at it. Such an assignment implies a commitment specially 
if the analyst is hired from outside the organization. In larger organizations, 
where, formal procedures are the norm, the analyst's first job is to prepare a 
statement specifying the scope and causes of the problem. He may then review it 
with the users for accuracy. 
 
System Analysis : At this stage, an analysis of the problems of the existing 
system is undertaken and how the new system is likely to overcome these 
problems is specified. For this purpose, a system analysis is undertaken which is 
a detailed study of various operations performed by a system and their 
relationship within and outside the system. During analysis, data are collected 
about the available files, decision points, and transactions handled by the 
existing system. There are various tools which are used for analysis, such as 
data flow diagrams, questionnaires, interviews, on-site observations, etc. Once 
this analysis is completed, the analyst has a firm understanding of what can be 
done to overcome various problems. Various alternative systems are evolved 
and feasibility study is undertaken to determine their suitability.  
 
System Design : System design is the most creative and challenging phase of 
system life cycle. System design describes how a chosen system will be 
developed. It prescribes the technical specifications (analogous to the -- 
engineer's blueprints) that will be applied in the chosen system. It also includes 
the construction of program and program testing. System design involves certain 
steps. The first step is to determine how the input is to be produced. The second 
step involves designing input data and database that meet the output 
requirements. Data processing phases are handled through program 
construction and testing. including the list of the programs needed to meet the 
system's objectives and complete documentation. 
 
Implementation. System implementation phase is less creative than the design 
phase. It is basically related to user training, site preparation, and file conversion. 
Depending on the nature of the new system, user training is planned and 
conducted. Site preparation is required when the new system is quite different as 
compared to earlier one like the use of communication network by the new 
system. Conversion from old to new system takes place either at the time of user 
training or little later. 
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Post-implementation. After the new system is installed and user staff is 
adjusted to the changes created by the new system, post-implementation stage 
begins which consists of mainly evaluation and maintenance. 
Evaluation involves an analysis of how the new system is achieving its objectives 
originally envisaged. Users and technical staff may go through a formal post-
implementation audit that determines how well the new system is working and if 
not what kind of changes are required. 
Maintenance involves maintaining hardware, software, and other devices with a 
view to have their optimum life. Post-implementation may also involve enhancing 
the capacity of the present system either by'-updating hardware and software or 
by adding balancing equipment or both.  
Once the new system is in place it will work through its useful life and reach to 
the level of maturity and finally decay yielding place to another system. How 
much time the system takes from maturity to decay depends on its capability and 
the information requirements of the organization. 
Following table presents information about approximate percentage of effort 
required by each stage of system life cycle. 
 

 
Advantages of System Life Cycle 
System life cycle approach of developing information systems is the most 
conventional and traditional though it offers certain advantages in developing 
transaction processing systems and structured information systems that are well 
defined. In these cases, system life cycle approach offers the following 
advantages: 
1. Since the information requirements can be expressed in structured form, 
system life cycle approach provides chronological stages in developing the 
required information systems. 
2. Project scheduling and its execution can be determined well in advance to 
ensure that the required information systems are developed well in time. 
3. Once a system is developed and is in place, enhancement in its capability can 
be achieved on continuous basis, though to a limited extent only, without 
unnecessarily disturbing the system. 
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Considering the above advantages, business organizations use this approach for 
developing transaction processing and structured information systems. This 
approach is also appropriate for complex technical systems, such as space 
satellite launches, air traffic control refinery operations, etc. Such systems need a 
rigorous and formal information requirement analysis, pre-defined specifications 
and tight control over system development process. 
 
Limitations of System Life Cycle 
System life cycle approach has some serious limitations. particularly for 
developing semi-structured and unstructured information systems. These 
limitations are as follows: 
 
1. System life cycle approach is ill-suited for developing decision oriented 
systems. Decision making may be unstructured and fluid particularly for strategic 
and other non-programmed decisions. For such decisions, information 
requirements change constantly and decisions have no well-defined models or 
procedures. Lack of this specification may inhibit the system developers from 
exploring and discovering the problem structure and they may not be able to 
proceed in right direction for system development. 
 
2. System life cycle approach is quite rigid and inflexible. It allows for revision of 
the system to ensure that information requirements are met. However, when 
information requirements are incorrect or an error is encountered, the sequence 
of life cycle can be repeated but that generates volumes of additional documents, 
thereby increasing development time and cost. Because of the time and cost to 
repeat the sequence of life cycle activities, this approach encourages freezing of 
specifications early in the development process. 
 
3. Life cycle approach is very resource intensive. Tremendous amount of time is 
required in gathering information and preparing specifications. This involves very 
high cost. Sometimes, time taken in system development is such that by the time 
the system becomes operational, information requirements change necessitating 
a new system. This possibility is more for those organizations that operate in fluid 
environment like financial services, consultancy, etc. In order to overcome the 
limitations of system life cycle approach some other approaches have been in 
use for system development. These are prototyping, rapid application 
development, and end-user development. 
 
Prototyping 
Prototyping is an approach for developing information systems quickly as 
compared to long-drawn process adopted in system life cycle approach. 
Prototyping is the process of developing an experimental information system 
quickly and inexpensively for demonstration and evaluation so that end users can 
better determine information requirements. The prototype endorsed by the users 
can be used as template to develop the final system. Prototype is a working 
version of an information system or part of the system but it is meant to be only a 
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preliminary model. Once, this becomes operational, it is further refined until it 
conforms precisely to users' requirements. For many applications, a prototype is 
extended and enhanced over and over again before a final design is accepted. 
Once the design is accepted, the prototype is converted to a polished information 
system. 
 
Prototyping process is iterative approach of system development because the 
steps required to develop a system can be repeated over and over again. It has 
been said that prototyping replaces unplanned rework with planned iteration with 
each version more accurately reflecting users' requirements. Prototyping process 
presented in following Figure consists of basically four steps-identification of 
basic information requirements. developing the initial prototype. using the initial 
prototype, and refining and enhancing working prototype to the extent that it 
becomes acceptable to be operational prototype. 
 
Identification of Basic Information Requirements. At the first step the system 
designer works with users to understand their basic information requirements. 
The system developer is an information system specialist. He discusses with 
different users about their information requirements and the forms in which the 
information is required. 
 
Developing the Initial Prototype. Based on the understanding of user 
information requirements and the forms in which the information is required the 
system developer develops the initial prototype quickly mostly by using fourth 
generation languages and microcomputer tools, such as Natural. 
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Focus. -Structured Query Language along-with spreadsheets, word processing, 
etc. Besides these, some features of computer-aided software engineering can 
be used supported by multimedia software tools that present users with 
interactive storyboards that sketch out the tasks of the proposed system for 
evaluation and modification. 
Using the Initial Prototype. After the initial prototype is ready, it is put to 
operation to determine what refinements are required. Users are encouraged to 
use the prototype as extensively as possible and are encouraged to give their 
suggestions for refinements. Since the initial prototype may perform only the 
most important functions of the proposed system or it may contain the entire 
system with a restricted file. Refinements are required frequently. 
 
Refining and Enhancing the Prototype. If the initial prototype is not acceptable, 
that is, it does not meet the users' requirements. This is treated as a working 
prototype requiring further refinement and enhancement. After the prototype is 
refined and enhanced, the system development cycle returns to step 3, that is 
using the refined prototype. This process is repeated until the prototype becomes 
acceptable and usable as operational prototype that furnishes the specifications 
for the application or is adopted as the production version of the system. 
 
Advantages of Prototyping 
Certain types of information systems can be developed more efficiently and 
effectively using prototyping than using the traditional system life cycle. 
 
For example, Du Pont Company of USA used prototyping along-with user 
interface to develop more than 400 new programs with no failure and reduced 
maintenance by 70 to 90 per cent. Prototyping offers the following advantages in 
developing information systems: 
 
1. In a situation where there is some uncertainty about information requirements 
or design solutions. prototyping is the most useful approach. In decision-oriented 
applications, where requirements tend to be very vague, these may be difficult to 
identify in advance. 
 
Further. the requirements tend to change substantially as system implementation 
progresses. Management realizes that better information system is needed but is 
unsure what this entails. In such a situation, prototyping comes to rescue 
because it adopts evolutionary approach to system development. 
 
2. Prototyping provides opportunity for user interface in system development. 
User needs and behaviour are not entirely predictable and are strongly 
dependent on the context of the situation. Prototyping enables users to react 
immediately to the parts of the systems they will be dealing with. Based on such 
reactions, system developer may refine the system immediately to suit the users. 
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3. When prototyping is used for system development. the morale and satisfaction 
of users remain high because of their- active involvement in system development 
and its refinement. Because of higher morale and satisfaction, users not only 
accept the new system but also show enthusiasm in making the system 
successful. 
4. A system can be developed quickly by using prototyping. It eliminates the 
excess costs of system development and design flaws that occur when 
information requirements are not fully captured the first time around. 
 
Limitations of Prototyping 
Prototyping may not be suitable for all types, of applications. It may neither 
substitute careful information requirement analysis, structured design 
methodology or thorough documentation, nor totally replace system life cycle 
approach. Systems that are based on batch processing or systems that rely on 
heavy calculations and complex procedural logic are generally unsuitable for 
prototyping. In these situations, prototyping has the following limitations: 
 
1. For using prototyping, large systems must be divided so that a prototype can 
be developed for one part at a time. However, subdividing a large system may 
not be possible without a thorough information requirement analysis by using the 
conventional approach, since it may be hard to see how different parts will affect 
each other. 
 
2. Easily and rapidly developed prototypes may encourage the developers to 
move too quickly towards a working model without capturing even a basic set of 
requirements. This may be problematic when a large system is under 
development. 
 
3. The final steps to convert a prototype into a polished system may not be 
carried out. If the prototype works reasonably well, management may not see the 
need for reprogramming and redesign. Some of these hastily developed systems 
may be difficult to maintain and support in a regular production environment. 
Since many prototypes may not be developed carefully their technical 
performance may be very inefficient. 
 
4. Any system needs testing to evaluate its performance before it is put in actual 
application. However. since prototypes are developed so effortlessly that 
developers may assume that testing can be handled by the end-users on their 
own. and any oversights can be corrected later. With the result. documentation 
may not be kept up to date. 
 
Notwithstanding the above limitations, prototyping is useful in developing certain 
types of systems, particularly the smaller ones in whose case information 
requirements can be assessed in stages. 
 
Rapid Application Development 
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Rapid application development (RAD) has the same objective of developing a 
system rapidly as does the prototyping but is broader in scope as compared to 
prototyping. The term RAD, coined by computer consultant and author James 
Martin, refers to a development life cycle to develop systems quickly without 
sacrificing their quality. RAD is an integrated set of strategies. methodologies and 
tools that exist within an overall framework called information engineering the 
name given by Martin. RAD approach treats system development as 
organization-wide activity rather than being confined to a system development 
team. There are four essential ingredients of RAD-management, people, 
methodologies, and tools. Management, specially top management is the prime 
mover of RAD. It initiates and supports RAD and ensures that it believes in 
experimenting and is early adapter of a new methodology. The management 
should create an environment conducive of system development quickly People. 
In RAD, variety of people contribute to system development. 
 
Rather than constituting a single team of system developers as is done in 
conventional life cycle, RAD emphasizes the constitution of several teams with 
each team working in its specialized area only. Thus, there may be teams for 
requirement planning, user design construction, user review, and cutover. 
Members of these teams are specialists in the methodologies and tools that are 
required to perform their specialized tasks. Martin has called these teams as 
SWAT team with SWAT standing for 'skilled with advanced tools'. 
 
Methodologies : The basic methodology used in RAD is known as RAD life 
cycle which consists of four phases-requirement planning, user design, 
construction, and cutover. These phases like the system development life cycle 
reflect the systems approach in system development. In this approach end-users 
play key role in all phases participating with information specialists. 
 
Tools : RAD tools mainly consist of fourth-generation languages and computer-
aided engineering (CASE) tools and facilitate prototyping and code generation. 
Fourth-generation languages enable information specialists or users to generate 
computer code without using conventional programming languages. Following 
Figure presents information engineering that provides overall framework for rapid 
application development. 
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Figure illustrates the top-down nature of overview of rapid application 
development involving data (left-hand side) and activities involved (right-hand 
side). The process begins at the strategic level with strategic information 
resource planning that is applied to the entire organization. Martin has called 
strategic information resource planning as information strategy planning. At the 
next stage, business area analysis is conducted for each business unit of the 
organization to define the activities or processes and data that are necessary to 
operate the unit efficiently. 
 
After business area analysis, rapid application development proceeds in four 
steps-requirement planning, user design, construction, and cutover. These steps 
are quite similar to system development life cycle with a major difference, that is, 
in RAD, many specialized teams are involved in the development process 
against the single team involved in SDLC. 
 
Advantages of Rapid Application Development : 
There are many advantages of RAD as compared to SDLC or even prototyping. 
RAD can be applied for developing systems in which requirements are precisely 
defined in advance as well as those systems in which such requirements cannot 
be defined in advance. The major advantages of RAD are as follows: 
 
1. The system development is completed in comparatively much lesser time as 
compared to SDLC. This is possible because system development activities are 
divided among a number of teams rather than assigned to one team. 
 
2. Since each team performs the activities relevant to its specialized area only, 
the contribution of each team becomes quite relevant which helps in achieving 
high system performance. 
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3. RAD can be applied for developing all types of systems. Thus, it has very wide 
applicability. 
 
Limitations of Rapid Application Development : 
There are some problems in applying RAD though these problems are of 
operational nature. These problems are as follows: 
 
1. Application of RAD requires active support of the top management. If the top 
management is change resistant, this support may be lacking and RAD may not 
be applied successfully. 
 
2. There is high need of interaction and coordination among various teams 
involved in RAD. If the organization does not have mechanisms for this 
interaction and coordination, RAD may not contribute positively. 
 
End-user Development 
In end-user development, information systems are developed by the end-users 
themselves with or without little assistance from technical specialists. End-user 
development has been made possible because of fourth-generation languages 
and other tools. Even though these tools are less computer efficient than 
conventional programming languages, decreasing hardware costs have made 
them technically and economically feasible. With fourth generation languages, 
graphic languages, and microcomputer tools-word processing software, 
spreadsheets, data management software, and integrated software packages, 
end-users can access data, create reports, and develop an entire information 
system on their own without professional system analysts or programmers. 
Alternatively, end-users may seek technical support from information system 
specialists and perform many system development activities on their own. Such 
activities might have been undertaken by the information system department in 
the past. Many of these end-user-developed systems can be created more 
rapidly than by using conventional system life cycle as shown in following Figure. 
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Requirements for End-user Development : 
There are certain requirements which must be fulfilled for making end-user 
development feasible. These requirements are connectivity, information centre, 
and procedures to manage end-user computing. 
 
Connectivity : For end-user development, it is essential that end-users are 
provided connectivity to central database which stores different types of data that 
can be used by end-users. Normally, in end-user development, emphasis is put 
on manipulating the existing data for generating information to make decisions. 
Thus, effective database management systems and client/server computing and 
networking are pre-requisites of end-user development. 
 
Information Centre : Information centre is a special facility that provides training 
and support for end-user computing. An information centre has hardware, 
software, and technical specialists that supply end-users with tools, training. and 
expert advice so that users can create information system applications on their 
own. Information centre hardware may consist of mainframes, minicomputers, 
microcomputers, workstations or a combination of these. Typical software tools in 
information centre include word processing software, planning or modeling 
software, desktop database software, graphics software, report generators, user-
friendly fourth generation languages for queries or simple applications and high-
level programming languages for fourth-generation application development. 
Technical specialists combine expert knowledge of hardware, software, and 
databases for end-user applications with strong interpersonal skills. They 
function primarily as consultants to users though they may also take part in the 
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analysis, design, and programming of complex applications. A typical information 
center, provides the following services to the end-users: 
 
1. Training in high-level languages and development tools. 
2. Assistance in accessing and transferring data. 
3. Assistance with applications, queries. and reports requiring highlevel 
programming languages. 
4. Consultation on appropriate tools and methodologies for developing 
applications.  
5. Assistance in establishing quality assurance standards and controls. 
6. Generation and modification of prototypes. 
 
Procedures to Manage End-user Computing : The organization should ensure 
that end-user development is not random but organized so that these 
developments are incorporated in organization’s overall information systems. 
Therefore, the organization should provide procedures and policies for such 
developments. The organization should also develop controls on end-user 
development that should include the following: 
1. Cost justification of end-user development. 
2. Organization-wide standards for microcomputers. word processing software, 
graphics software, and query and reporting tools. 
3. Quality assurance review. 
4. Controls for end-user development applications covering testing, 
documentation, accuracy, and completeness of input and update, backup, 
recovery, and supervision. 
 
Advantages of End-user Development : 
Many organizations have achieved appreciable gains through end-user 
development because it offers following advantages: 
1. End-user development produces customized systems which serve the needs 
of end-users in a better way. These systems focus directly on the information 
requirements of end-users. 
2. Systems can be developed instantly in many cases which ensures timely 
availability of information. Time value of information is very high in decision 
making. . 
3. End-users have direct control over the systems developed by them. This 
phenomenon provides them more satisfaction. 
 
Limitations of End-user Development : 
End-user development has its own problems and limitations which are as follows: 
1. End-user development can be used only in limited applications, particularly for 
manipulating small files. Thus, applications with extensive procedural logic and 
updating requirements cannot be handled by this method. 
 
2. If end-user development takes place at a massive scale. there would be 
numerous systems: These may generate coordination problem, and if these are 
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not properly coordinated. there may be confusion and chaos. Taking into account 
the advantages and limitations of end-user development, it can be concluded that 
it cannot replace the more elaborated system development methods like the 
ones discussed earlier but can be used to develop applications in a limited way. 
 
Following Table summarizes the major advantages, limitations, and suitability of 
alternative approaches of system development. 
 

 
Organizations may adopt anyone of these approaches or a combination of two or 
more approaches as the need may be. to develop their information systems. 
However. before going through the process of developing their own information 
systems. they may consider a question-should they develop their own systems or 
should they go for outsourcing these systems from outside? The answer of this 
question lies in analysis of outsourcing. 
 
Outsourcing Information Systems : 
If an organization does not want to develop and operate its own information 
systems, it can hire an external agency that specializes in these services to do 
the work. The process of turning over the organization’s computer centre 
operations, telecommunications networks, and application development to 
external vendors is known as outsourcing. The decision of outsourcing 
information systems is like a make or buy decision. In a make or buy decision, 
two types of factors are taken into consideration-cost factors and non-cost factors. 
In cost factors, the organization compares costs of making and costs of buying. If 
costs of making are more than costs of buying, it can go for buying from outside. 
However, make or buy decision does not solely depend on cost consideration but 
non-cost factors sometimes become more important. These non-cost factors are 
quality, regularity of supply, reliability of supply, etc. Thus, cost and non-cost 
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factors must be considered in making decision about outsourcing information 
systems. 
 
When to Outsource : 
With outsourcing becoming an acceptable norm, organizations, be startups or 
well-established, are under constant pressure to outsource cost-effective and 
quality information systems. However, before going for outsourcing, the 
organization must decide what to outsource and what not to outsource because 
information system outsourcing is not like a product outsourcing; an information 
system requires confidentiality which is of paramount importance to the 
organization. Therefore, the organization must define the type of' role that the 
information systems are expected to play in the organizational functioning. Based 
on this criterion, there may be a number of circumstances under which 
outsourcing is useful. These are as follows: 
 
1. Criticality of Information Systems : Some information systems or 
applications may be critical to the organization while others may not be so critical. 
Those systems that have limited potential for the organization to generate 
competitive advantage may be considered as non-critical. Clermont has 
developed a matrix combining two factors-penalty for problems and reward for 
excellence-to identify the systems that can be outsourced.  
 

 
Thus, those systems which do not have high reward for excellence and low 
penalty for problems like cafeteria accounting (accounting of different varieties 
excluding management accounting) may be outsourced easily. Even systems 
having somewhat higher penalty for problems but low reward for excellence like 
payroll may also be considered for outsourcing. The basis idea is that even if 
excellence is achieved in these areas, there may not be much gain, As against 
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these. airline reservation. plant scheduling, engineering analysis tools, etc. which 
have high reward for excellence may be developed in-house because they are 
critical to the organization. 
 
2. Interruptions in Information Systems : When interruptions in information 
systems are not critical to the organization, these can be outsourced. For 
example. interruptions in insurance claim processing systems are not critical to 
the organization and it can work without these for few days. When .interruptions 
in information systems are critical to the organization like computerized banking, 
airline reservation system, etc. they may require in-house development and 
operation. 
 
3. Capabilities of Existing Information Systems : When organization’s existing 
information systems have limited capabilities, or they are ineffective or technically 
inferior, outsourcing may be better alternative. Some organizations use 
outsourcing to revamp their information system technology. For example, 
organizations may use outsourcing to make the transition from traditional 
mainframe computing to client/server computing. 
 
Managing Outsourcing : 
Outsourcing of information systems requires effective managing because there 
are many issues which must be solved carefully. For managing outsourcing, the 
organization can do the following things: 
1. After deciding what is to be outsourced, the organization must choose the 
vendor from whom to outsource. Choosing a vendor is the most critical issue. 
While choosing a vendor, quality, reliability of supply, and regularity of supply 
besides costs should be taken into consideration. 
2. A good working relationship between the organization and the vendor should 
be developed which must be based on mutual trust and respect so that both the 
parties understand the positions of each other. 
3. Contract between the organization and the vendor should be worked out 
explicitly so that what each party expects from another is made very clear. 
Provisions must exist in the contract for incorporating the changing requirements 
of the organization. The contract should also contain the clause relating to 
information security and penal provisions for breaching this clause. 
4. The organization should constantly re-evaluate its vendors and decisions to 
outsource in the light of changing business conditions and the growing pool of 
vendors. 
Advantages of Outsourcing : 
Outsourcing is becoming popular because many organizations perceive it as 
being more cost effective than developing and operating their own information 
systems because outsourcing offers following advantages: 
1. Economy : Outsourcing is economical as compared to in-house development 
and operation of information systems. Economy emerges from the vendors' side 
because of two reasons. First, vendors are information system specialists that 
help to do a job better with lesser amount of effort. 
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Second, vendors produce Dame type of systems in huge volume thereby they 
have. economy of scale. Therefore, they can provide same service and value for 
less cost than the cost of an internal organization. For example, Loh and 
Venkatraman have observed that while some outsourcing vendors offer reduction 
of 50 per cent in information technology costs, saving of 15-30 per cent is more 
common. 
2, Flexibility : An organization’s business growth, and consequently more 
information needs, can be accommodated through outsourcing without making 
changes in its information system infrastructure. As information technology 
permeates the entire value chain of a business, outsourcing may provide 
superior control of the business and its costs and capabilities can be adjusted to 
meet changing business needs. 
3. Cost Predictability : In outsourcing, costs of information and its related 
services can be predicted in advance as the costs are settled before the supply 
commences. In in-house development and operation, such costs cannot be 
predicted accurately in advance. If information costs constitute a significant 
portion of the total costs of products/services, cost predictability is quite useful in 
decision making for offering these products/ services. 
 
4. Making Fixed Costs Variable : In the case of in-house development and 
operation of information systems, most of the costs-hardware costs, software 
costs, and personnel costs-become fixed. Even if the organization is not using 
these resources to the full extent, these costs have to be borne by the 
organization. In the case of outsourcing, these costs remain variable as costs are 
determined in terms of per unit of services. The organization is required to pay 
only costs of those services that have been utilized. 
 
5. Freeing up Financial Resources : One of the main advantages of 
outsourcing is that the organization is able to free up its financial resources that 
might be required for in-house development and operation' of information 
systems. In many cases, costs of setting up computer centers and developing, 
programs are quite high. If the organization is able to deploy its freed financial 
resources in an alternative use, it can enjoy more benefits than tying-up with 
information systems which otherwise can be outsourced. 
 
Disadvantages of Outsourcing : 
Outsourcing is not free from limitations and disadvantages which limit the extent 
of taking various advantages. These disadvantages are as follows: 
 
1. Loss of Control : In outsourcing, the organization loses its control over 
information systems. Outsourcing places the vendor in an advantageous position 
where the client organization has to accept whatever the vendor does. If a 
vendor becomes the organization’s only alternative for developing and operating 
its information systems, the organization has to accept whatever technologies the 
vendor provides. 
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2. Vulnerability of Strategic Information : In outsourcing, there is a possibility 
of information system vulnerability. Trade secrets and other information of 
strategic use may be leaked to organization’s competitors. 
 
This may be quite harmful to the organization and it may lose its competitive 
advantage in the process. Therefore, it is desirable to process such information 
in-house. 
 
3. Dependency. Because of outsourcing, the organization is dependent on its 
vendor and. to some extent, its fate is tied up with the vendor. If something goes 
wrong with the vendor, the client organization is also affected adversely. 
Considering the advantages and the disadvantages of outsourcing, it may be 
concluded that an organization should not fully depend on outsourcing. It may 
outsource only those information systems which have lesser strategic importance. 
 
DISCUSSION QUESTIONS 
1. What do you mean by system development? What are the steps involved in 
top-down, bottom-up, and integrative system development? 
2. What are the different approaches for system development? Discuss their 
advantages, disadvantages, and suitability. 
3. What are the stages of system development life cycle? Describe these stages 
briefly. What are the advantages and limitations of system development life cycle?  
4. What is prototyping approach of system development? What are its 
advantages and limitations? 
5. What is rapid application development approach of system development? 
What are its advantages and limitations? 
6. What is end-user development approach of system development? Discuss its 
advantages. limitations, and suitability. , 
7. What do you mean by outsourcing information systems? What are its 
advantages and limitations? Discuss the precautions which should be taken in 
outsourcing information systems. 
 

******* 
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MIS  Chapter  7 
 

Form  Design  
 
 
1.  Introduction : 
Information system not only involves computer but also the manual systems and 
both the systems must be compatible. Even in a fully computerized system, 
some manual operations are needed. Computer data entry is a manual operation. 
So ease of data entry is one of the major considerations in the design of 
information system. Forms are used for entering data. Data entry or for that 
matter any computer operation, involve some interaction with computer. The 
computer system is designed to respond user's commands and input data in a 
manner that makes it easier to operate and use. Codification of items becomes 
necessary for computerized system. Codes should be designed to facilitate data 
entry, reduce data entry errors and also make it easy for user to relate it to items. 
 
2.  Principles : 
A form is it surface for presenting or entering information in a specified format. An 
organization uses form for variety of purposes such as employee bio-data, leave 
application, traveling allowance, deposit and withdrawal of money, material 
requisition, work order1 purchase order, material inspection report, performance 
appraisal report, self appraisal report and so on.  
 
Though the paper is the traditional and still the most widely used medium, the 
use of video screen for directly entering data and presenting information is 
rapidly increasing. Many of the principles which apply to the design of paper 
documents are also equally applicable to screen documents. A good format 
enables relevant information to be obtained, transmitted, stored, retrieved and 
interpreted in a better manner at minimum cost and effort. 
 
Form design is sometimes considered as a low-level activity and not given much 
importance. The defects in many forms can be attributed to this attitude. Badly 
designed forms can impede collection of correct information and also increase 
the chances of misrepresentation and misinterpretation.  Good form design is not 
possible without proper system analysis. The purpose of a form cannot be 
considered in isolation from the objectives of the organization. The occasion for 
form design may arise as part of a system study. Also request for a new form 
sometimes leads to study and modification in the system. 
 
3.  Controls  : 
The content, layout, makeup, printing and paper are the main considerations in 
form design. 
1. Content : The content of the form consists of all the words, spaces, boxes, etc, 
including the title of the form, detailed headings and instructions if any for its use. 
The title should be brief and meaningful to the users. Also, item headings should 
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be self-explanatory. If an instruction is critical, such as 'USE CAPITAL LETTERS', 
it should appear before the space where the entry is to be made. If there are 
more number of instructions, then these may be numbered in relation to the 
headings. 
2. Layout: Layout is concerned with those aspects that enhance the appearance 
of form and make the form more comprehensible. It involves deciding the font 
and size of letters, spacing, paragraph margins and positioning of contents to fit 
on the size of paper. 
3. Make-up: The term 'make-up' denotes all the physical features of a form other 
then printing and paper. It includes features such as sets of forms are to be made 
in pads or to be used as continuous stationery, use of interleaved carbons or 
chemical coating for making multiple copies, all multiple copies are to in single 
color or different colors, any punching or perforations required or not. Make-up 
sometimes costs more than both paper and printing. A comparison needs to be 
made between the additional cost of make-up and the benefits derived due to 
decrease in time, stationery wastage, and errors. 
4. Printing: Forms should be so designed that will facilitate printing. The quality of 
printing is decided based on its use and volume. Those who are in charge of 
printing may be' consulted on this matter. Sometimes the layout of form may 
have to be amended to facilitate printing. 
5. Paper: Forms should be on standard size of paper. The weight and thickness 
of paper are also important criteria. 
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MIS  Chapter  8 
 

Charting Techniques 
 
 
1.  Introduction : 
 
2.  Performance Indices  : 
 
3.  Flow Charting  :  Definition  and Uses : 
 
4.  Flow Charting  Symbols  :  

(a) For  Systems  : 
(b) For Programming  : 

 
5.  Information Oriented System Flow Charts : 
 
6.  Process  Oriented System  Flow Charts  : 
 
7.  Flow Chart  Data Flow Diagrams : 
 
 

Flow Charting 

 
Programming Process : 
 
The set of detailed instructions which outline the data processing activities to be 
performed by a computer is called a program. 
 
The computer programming process may be subdivided into six separate 
phases: 
 
1. Program analysis 
2. Program design 
3. Program coding 
4. Program debugging 
5. Program documentation 
6. Program maintenance 
 
In program analysis phase, one can use algorithms, flow charts and Data flow 
diagrams. 
 
Algorithm :- 
A list of instructions specifying a sequence of operations that give answer to any 
problem of a given type is called an algorithm. 
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For example, the procedure for adding two signed numbers a and b : 
1. If a and b have the same sign, go to step 5 
2. Subtract  the smaller magnitude from the larger magnitude 
3. Give the result the sign of number with larger magnitude. 
4. Stop 
5. Add the magnitude of numbers a & b 
6. Give the result the sign of number a 
7. Stop 

 
Flow Charts :- 
 
For many applications a simple list of steps (algorithm) is sufficient for stating the 
problem in a clear manner. But in complex problems, a flow chart is required.  

 
A flow chart contains the sequence of steps involved in solving a problem. A flow 
chart helps to avoid the accidental omission of intermediate steps. 
 
Flowchart can be divided into 4 categories : 
1. System outline charts (Global map). 
2. System flowcharts (National map). 
3. Run flowcharts (State map). 
4. Program flowcharts (District map). 
 
 
1. System outline charts : - 
 
These charts merely lists inputs, files, processes, and outputs required without 
considering any sequence.  
 
For example, chart of sales order processing : 
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2. System Flowchart :- 

 
 
It presents an overview of the data flow through all parts of a data processing 
system. 
 
It also represents flow of documents, the operations or the activities performed. 
 
The system flowchart for a computer system consists of : 
1. The sources from which input data is prepared and the devices used. 
2. The processing steps or sequence of operations involved. 
3. Intermediary or final output prepared and the device used for their storage or 

printing. 
 
Example : PAYROLL 
 
Payroll data    ->  Compute monthly compensation -> Pay cheques & payroll 
reports. 
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3. Run Flowcharts :-  
 
This is the detailed version of the system flowcharts. It contains the details of 
each compute operation. 
 
Example : Sales order processing system : 
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Program Flowcharts : 
 
Program flowcharts are the most detailed and are concerned with the logical / 
arithmetic operations on data within CPU. 
 
Here, the data flows between CPU and input / output. 

 
Start / end 
 
  Box 
(Process) 
 
 
Diamond 
(decision) 
 
Input / Output    
 
Document    
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     Floppy diskette 
   Or online storage   
 

 
 
     Magnetic Tape  

 
 
      Manual Input       
 

 
     Display      
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Data Flow Diagrams : 
Data Flow Diagram (DFD) is a graphical description of a system's data and the 
processes that transform these data from one 'form to another. Some graphical 
symbols are used to construct data flow diagram. 
These symbols are given below. 
 

 
A DFD may consist of several external entities, processes, and data flows and 
data stores. An arrow identifies data flow -data in motion. These data flows 
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originate from some source and after being transformed by processes are 
received by some destinations. The source or destination of a data flow is called 
external entity. It is denoted by a rectangle. A circle or ellipse stands for a 
process that converts data into information. An open-end box represents a data 
store - data at rest, or a temporary repository of data. A square / rectangle 
defines a source (originator) or destination of system data. 
 
DFDs are simple to draw and easily depicts the basic components of a system. It 
can be drawn in increasing level of detail, staring with a summary high level view 
and proceeding to more detailed lower level views. Thus, it supports modular, 
structured and top-down approach to design of information system The highest 
level of data flow diagram (level-O DFD) that depicts the summary of a system or 
process is called Context Diagram. 
 
Consider a system for processing orders received from customers. The system 
after processing a customer's order sends either an order acceptance or an order 
rejection to the customer. The system also generates a sales report and sends it 
to the management. Here the customer and management are the external 
entities. The summary level-O DFD or Context Diagram of the above system is 
shown in figure. 

 
Figure 1: Context diagram of Order Processing System 

 
The same Context diagram can be depicted in greater detail by level-1 DFD as 
shown in figure 2. The "check order" process may result in rejection of order, 
whereas "enter order" process will result in acceptance of order. "Perform Sales 
Analysis" process will give rise to the sales report. All these processes are part of 
the "Order Processing" process in figure 1. In fact, level-l DFD contains four 
processes as a part of the "Order Processing" process', These are designated as 
"check order", "2 enter order", "3 Update data file" and "4 Perform Sales 
Analysis" as shown in figure 2. 
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Figure .2: Level.1 DFD of Order Processing System 

 
Example 2 : 
Let us consider another example of a bank system. The account holder gives 
payment (deposits) and receives payment receipt. The context  diagram is shown 
in figure 3. 

 
 

Figure 3: Context diagram of bank system 
Level-1 DFD of the above Context diagram that depicts some greater detail of 
the process is shown in figure 4. Each of the above data flow diagram can be 
exploded into still detailed DFDs. For example the process-2 (update account) is 
shown in greater detail in level-2 DFD in figure 5. Thus a higher level DFD forms 
a parent-child relationship with its lower level DFDs. 
 

 
Figure 4: Level-1 DFD of bank system 
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Figure 5: Level-2 DFD ofprocess-2 (update account) of bank system 
 
Note the way the processes are numbered in above DFD. This convention of 
numbering processes makes it easier for people to link it to its higher level.DFD. 
This way of numbering is called leveling of DFDs. The process of leveling DFDs 
is illustrated in figure 6. 
 
Physical and Logical DFD: DFD are of two types; i.e. Physical DFD and Logical 
DFD. The DFDs considered so far are examples of logical DFD. A logical DFD 
specifies various logical processes performed on - data. It does not specify who 
does the processing, where the processing is done or on which physical device 
data are stored. The above facts are specified by physical DFD. An example of 
physical DFD is shown in figure 7. It shows the process for withdrawal of money 
from bank by an account holder against withdrawal voucher. The DFD shows 
that the processing of withdrawal voucher is processed at five different desks. 
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Fig 6 : The process of leveling DFDs is illustrated in figure 6. 

 
 Fig 7 : An example of physical DFD 
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Example 3 : 
Data Flow Diagram of Business Process : (Zero level) 
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Data Flow Diagram of Marketing Process  : (First level) 
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CH - 9 
System Analysis & Design 

 
After identifying a particular approach for system development, system analysis 
and design phases start. System analysis is concerned with study of various 
operations to be performed by the system and their relationship within and 
outside the system. System design prescribes the technical specifications that 
will be applied in the chosen system. It also includes the construction of program 
and program testing. 
 
SYSTEM ANALYSIS : 
The basic objective of system analysis is to determine the feasibility of a system,  
and how it will meet the requirements of system users. Though in a typical 
system development life cycle, these activities are assigned to a system analyst, 
the current approach is to divide these activities among different teams having 
members with specialization in different fields. A system analyst is an information 
system expert having intensive knowledge of computer hardware and software. 
His major functions are defining requirements, gathering data, analyzing data, 
drawing up system specifications, designing system, and testing system. System 
analysis involves the following aspects of system development: 
1. Feasibility study. 
2. Requirement analysis. 
3. Structured analysis. 
 
FEASIBILITY STUDY 
Feasibility study is the process of determining whether a system is appropriate in 
the context of organizational resources and constraints and meets the user 
requirements. The basic objectives of the feasible study are to identify whether 
the proposed system is feasible and will be more appropriate than the existing 
system. before the commitment of organizational resources to the system. At this 
stage, the system development team (often a team consisting of appropriate 
number of persons is constituted for system development rather than entrusting 
the job to a single system analyst) defines the problems or opportunities, 
establishes overall objectives of the system and defines the scope of the system. 
A feasibility study covers economic feasibility, technical feasibility, operational 
feasibility, and legal feasibility. 
Economic Feasibility : Economic feasibility involves determination of whether 
the given system is economically viable. It is done through cost/benefit analysis 
of the system to identify whether the benefits are more than the costs. For a 
system to be economically viable, its benefits must be more than its costs.  
Technical Feasibility : Technical feasibility analyses whether the proposed 
system is technically viable with the available hardware. Software, and technical 
resources. It centres around the existing technical facilities and the extent to 
which these can support the proposed addition. If additional technical facilities 
are required to implement the system, technical feasibility also takes into account 
whether the required technology is available in the market and is compatible with 
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the organization’s existing technology. The technological risk involved in the 
technology to be acquired is also assessed. 
Operational Feasibility : Operational feasibility, also known as behavioral 
feasibility, determines whether the proposed system will work effectively within 
the existing managerial and organizational framework. Often a new system faces 
resistance from people as they are inherently resistant to change while the new 
system requires change. It is a common phenomenon that computer installations 
have something to do with transfer, retraining, and job status of employees. 
Similarly, resistance may come from management too if the new system does not 
fit with the existing organizational policies relating to information systems. For 
example, if the new system requires distributed databases while the existing 
policy is to have a centralized database, the new system will face resistance from 
the management. Operational feasibility must take these factors into account 
while measuring the operational viability. 
Legal Feasibility : Legal feasibility tries to ensure whether the new system 
meets the requirements of various information technology regulations, such as 
privacy laws, computer crime laws, software theft laws, malicious access to the 
data, international laws, etc. Government of India has formulated a 
comprehensive Act, known as Information Technology Act. 2000  that provides 
regulations for the use of information technology. 
 
Steps in Feasibility Study 
Many feasibility studies are disillusioning for both users and analysts. These 
studies often presuppose that when the feasibility document is being prepared, 
the analyst is in a position to 'evaluate solutions. Further, many studies tend to 
overlook the confusion inherent in a system development- the constraints and the 
assumed attitudes. With the result, such studies hardly serve the purpose of 
decision making. Therefore, in order to make feasibility study report meaningful 
for decision making a logical procedure must be followed which consists of the 
following steps. 
1. Constitution of a Project Team : The objective behind constituting a project 
team is that future users of the system should be involved in its design and 
implementation. Their knowledge and experience in the operations area are 
essential to the success of the system. While a small project may not require a 
team but it is essential for larger projects or when the organization is switching 
from manual to computerized system. 
The team may consist of system analysts and user staff. In some cases, even 
outside consultants and information system specialists may be included in the 
team. The team should have a project leader who may guide the other members 
as to how to proceed for the job. 
2. Identification of Potential Candidate Systems : Keeping in mind the 
objectives for which a new system is required. Alternative candidate systems 
should be identified. All systems work on the principle of equifinality. This 
principle suggests that a system can reach the same final state from differing 
initial conditions and by a variety of paths. It implies that many information 
systems may be able to achieve pre-determined objectives though their 
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approaches may be different. Therefore, at this stage, a number of systems 
should be identified so that the project team has several alternatives to choose a 
system that best fits organizational requirements. 
3. Identification of Characteristics of Candidate Systems : At this stage, the 
team identifies the various characteristics of candidate systems so that those 
systems that do not meet the initial selection criteria are eliminated as it is difficult 
and time consuming to have a detailed evaluation of large number of systems. 
These initial criteria may be in the form of volume of investment required, 
operational efficiency, organizational constraints etc. Only those systems that 
meet these initial criteria go to the next step. 
4. Performance and Cost Evaluation : Detailed performance and cost 
evaluation is carried for those systems which pass successfully through the 
previous step. At this stage, performance of each system is evaluated against the 
performance criteria set before the start of the feasibility-study. Whatever the 
criteria may be set. there has to be as close a match as possible. Besides 
performance, each system should be evaluated in terms of costs too. The costs 
include all types of costs-cost of initial investment in additional hardware, 
software, and physical facilities, development and installation cost, cost of 
training, updating the software, documentation, and the recurring operating cost. 
In many systems, initial investment cost may be low but its operating cost may be 
high to offset the advantage of lower initial cost. This fact should be taken into 
account. 
5. Weighing System Performance and Cost Data : Often performance and 
cost move in the same direction. that is.. if the cost is high. it is associated with 
high performance though it may not be true for all systems. Therefore, mere 
absolute figures of performance and costs are not sufficient to choose a system. 
This problem may be overcome by assigning certain weights to performance 
criteria and costs. For example, weights can be assigned to performance criteria 
like system accuracy, growth potential, response time, user friendly, etc. In the 
same way, weights can be assigned to different components of costs. 
6. Selection of the Best System : Based on the weights assigned to different 
systems, the system may be selected that has the highest weight score. 
However, in actual practice, mere weight scores of different systems are not the 
sole criteria for selecting a system but other organizational factors like 
organizational policy to procure capital goods (hardware, software, etc. are 
capital goods), resource constraints, suppliers' reputation, etc. play important role 
in the selection of a system. Therefore, these factors should be taken into 
account. . 
7. Preparation of Feasibility Report : When the feasibility study is complete the 
project team prepares a feasibility report on the basis of which management 
takes suitable action including the final selection of a system. After all, a project 
team can make only recommendations for a particular system and does not have 
authority to choose the system. Usually, a project report contains the following 
items: 
A. Covering letter containing briefly the nature of the study, general findings, and 
recommendations. 
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B. Table of contents indicating location of various parts of the study. 
C. Overview of the study indicating its objectives and reasons for undertaking it. 
D. Detailed findings indicating the projected performance of the systems and 
costs involved. 
E. Recommendations and conclusions suggesting the management the most 
beneficial and cost-effective system. 
F. System design and implementation schedule indicating the time to be taken in 
completing various activities and the time by which the system becomes ready 
for operational use. 
G. Appendix that may include documents, memos, and data compiled during the 
course of study. 
Presentation of written feasibility report may be followed by oral presentation by 
key team members before management. During oral presentation, doubts about 
various aspects, if exist, can be removed. After the final decision about a system 
is made by management, subsequent activities proceed. 
 
REQUIREMENT ANALYSIS 
Requirement analysis is the most crucial stage of system analysis in which an 
analysis is done about who requires what information in what form and  when. 
These three Ws are very important aspects because a system is meant for its 
users and not for designers and operators. Requirement analysis defines the 
scope of the system and the functions it is expected to perform. If the system is 
not designed according to information requirements, it will fail to achieve its 
objective in spite of choosing the best system. 
What information is required by the end users of a system depends on the 
organization and its strategy to use information systems for generating 
competitive advantage. From this point of view, information requirements must 
be analyzed using strategic approach involving critical success factors, value 
chain, and competitive forces model. However, since managers might be using 
these approaches in their decision making, at this stage, the system 
development team might be more interested in analyzing how users do the job 
and what information they need for doing the job. For this purpose, the team may 
use a variety of tools to identify the requirements-procedures and forms used, 
on-site observation, interviews, questionnaires, and systems used in other similar 
organizations. 
 
Procedures and Forms Used : Every organization uses certain procedures and 
forms in performing different functions. A procedure is a series of related tasks 
that make up the chronological sequence and the established way of performing 
the work .to be accomplished. If an organization has adopted the policy of 
formalization, various procedures are codified in a procedure manual. Information 
for completing a procedure can be found in the manual. However, before 
extracting the information from the manual, it is necessary for the project team to 
ensure that the manual is updated and reflects the present situation. 
Like procedures, an organization uses different types of forms for conducting its 
operations. Printed forms are widely used for capturing and providing information. 
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The objective of getting information from forms is to understand how forms are 
used. The following questions in this context may be useful: 
1. Who are users of the forms and how useful are these forms for them? 
2. Do forms have all the necessary information? What items should be added, 
deleted or changed? 
3. How many and what departments do receive the forms? What are the 
purposes of receiving the forms? 
4. How does the information contained in a form help other users to make better 
decisions? 
On-site Observation : Another method of gathering information for analysis is 
on-site observation. It is the process of recognizing and noting people, objects 
and occurrences to obtain information. The analyst's role is that of information 
seeker' and he is expected to be detached from the system being observed. The 
major objective of on-site observation is to get as close as possible to the system 
being studied. For this reason, it is important that the analyst is knowledgeable 
about the general makeup and activities of the system. The analyst should try to 
find out the answers of the following questions through on-site observation: 
1. What kind of system is it and what does it do? 
2. Who is responsible for running the system and who are other important 
persons involved in it? 
3. What is the history of the system and how did it reach its present state? 
4. What kind of system is it in comparison to other systems of the organisation? 
 
Interviews : Information can be collected about the likely requirements through 
the personal interviews. Interview is a formal, in-depth conversation conducted to 
gather information about how the present systems work and what modifications 
are required in them. Interviews can be used for two main purposes-as an 
exploratory devise to identify relations or verify information and to capture 
information as it exists. In conducting an interview, the analyst should proceed in 
the following manner: 
1. Setting stage for interview by explaining the purpose of interview and nature of 
information required. 
2. Setting rapport with interviewees to seek as much information as possible. 
3. Asking questions and initiating deliberations for seeking information. 
4. Obtaining and recording information solicited through the interview. 
Questionnaires : A questionnaire is a formalized written schedule containing 
different questions relevant to the object being studied. It obtains and records 
specified and relevant information with tolerable accuracy and completeness. A 
questionnaire can be directly administered by the analyst himself and gets the 
questionnaire filled himself on the basis of information provided by the 
respondent or can be administered indirectly by requesting the respondent to fill-
up the questionnaire. Detailed questionnaires are quite useful for collecting 
quantitative information where the response size is quite small and the response 
is well structured. 
Systems Used in Other Organisations : When the organisation for which a 
system is being developed, does not have specific and methodological systems. 
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information can be collected by studying the system of the similar nature. 
Information about such systems can be gathered from professional journals, 
consultants' reports, and other publications. However, while gathering information 
from these sources, it must be ensured that the information is relevant for the 
organization under study. 
 
STRUCTURED ANALYSIS 
In analyzing the present system and likely future requirements of the proposed 
system, the analyst collects a great deal of relatively unstructured data through 
procedure manuals, interviews, questionnaires and other sources. The traditional 
approach is to organize and convert the data through system flowcharts which 
support future development of the system and simplify communication with the 
users. However, a system flowchart represents a physical rather than a logical 
system. It makes difficult to distinguish between what happens and how it 
happens in the system. In order to overcome this problem, structured analysis is 
undertaken which is a set of techniques and graphical tools and allow the analyst 
to develop a new kind of system specifications that are easily understandable to 
the users. Structured analysis uses data flow diagram. Structured analysis has 
the following features: 
 
1. Structured analysis is graphic that presents a picture of what is being specified 
and is a conceptually easy-to-understand presentation of the application. 
2. The process used in structured analysis is partitioned so that a clear picture of 
progression from general to specific in the system flow emerges. 
3. Structured analysis is logical rather than physical. It specifies in a precise, 
concise, and highly readable manner the working of the system. 
4. In structured analysis, certain tasks that are normally carried out late in the 
system development are undertaken at the analysis phase. For example, user 
procedures are documented during analysis rather than in design or 
implementation phase. 
 
SYSTEM DESIGN : 
System design is the most crucial stage of system development process as the 
design determines the success or failure of the system. System design involves: 
1. Reviewing the system's informational and functional requirements and  
2. Developing a model of the new system, including logical and physical 
specifications Of outputs, inputs, processing, storage, and procedures. Before we 
proceed to the designing of outputs, inputs, storage, processing. and procedures, 
it is worthwhile to go through the concept of and activities involved in logical and 
physical design. Figure 1 presents logical and physical design of a system. 
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Logical Design. Logical design, also known as conceptual design, lays out the 
components of the system and their relationship to each other as they appear to 
users. It shows what the system will do as opposed to how it is actually 
implemented physically; It contains input/output specifications, file specifications, 
and processing specifications. Input/output specifications describe the forms in 
which input data will be required and the forms in which outputs will be presented 
to users. File specifications describe the way in which various files will be 
organized. Processing specifications describe the mode of data processing. . 
 
Physical Design. Physical design, also known as detailed design, translates the 
abstract logical design into specific technical design for the new system. It 
includes details of output design, input design, data storage design, processing 
design and procedure design. Physical design follows logical design as this stage 
converts the specifications developed at the logical level into specific technical 
design. 
 
Output Design 
Computer output refers to any information generated by a system whether 
printed or displayed. In fact, the main objective of a system is to generate 
information in a form which users can use. At the system analysis stage, the 
system development team identifies the outputs the proposed system should 
produce in order to satisfy the information requirements of the users. In designing 
outputs, the factors that should be considered are content, form, format, volume 
and timeliness. Content refers to the actual pieces of information that should be 
provided to users. Form refers to the way in which the information is provided like 
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text, graphics, visual, audio, or a combination of these. Format refers to the 
manner in which information is physically arranged like tabular, running text, and 
so on. Volume refers to the details that should be provided, whether in summary 
form or details of all items included in a report. Timeliness refers to the time at 
which the information is provided. Output (information) may be presented to 
users either in printed form or screen display form, the two forms commonly used 
in business organizations. Printed or display can be either in tabular form or 
graphic form. 
 
Tabular Form: In general, end-users are more accustomed in receiving 
information in tabular form. Financial data, sales data, production data, inventory 
data, etc. are generally presented in tabular form. Certain information in tabular 
form is more important and can be made more visible than in other form. In order 
that tabular information is meaningful, it should include the following items : 
1. Exceptions to normal expectations. 
2. Major categories or groups of activities. 
3. Summary of major categories or activities. 
4. Unique identification information. 
In the output design, tabular output should ensure the above items.  
 
Graphic Form : In graphic form. information is presented in the form of charts. 
Diagrams, bars, etc. which not only provide visual appeal but also ease the 
process of drawing inference from the information. For example, how much 
growth a business organization has achieved during the successive periods can 
be presented by bars where comparison can be made easily. Similarly, various 
components of cost of production can be shown by pie chart for meaningful 
inference. 
Printed Form : Tabular and graphic presentation of information may be either in 
printed form or screen display form. Both require certain specific layout. A layout 
is the arrangement of items on the output medium. In preparing the layout of a 
printed report or document, certain guidelines should be followed: 
1. Reports and documents should be designed to read left to right and from top 
to bottom. 
2. The most important items of the report should be highly visible to locate. 
3. Report/document should contain title. date of preparation, page number and 
column headings. 
4. Each data item should have a heading which should be short but descriptive. 
Data items that are related to each other should be grouped together in the 
report. 
5. Control breaks should be used in the report to increase readability. 
Control break reports are those in which repeating columns can be grouped 
together and exceptions can be highlighted. 
6. Sufficient margin should be left on all sides of the report to enable the users to 
write their comments in case these are needed. 
Screen Display Form : Sometimes. printed reports may not be required and 
inferences from the information can be drawn from looking it at the screen. 
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Designing of screen display layout begins with verifying the characteristics of the 
display screen. such as physical dimensions of the screen, number of rows and 
columns of data that can be displayed, degree, of resolution of colours, number 
of colours available, methods of highlighting-underline, bold, blinking, intensities, 
etc., and methods of intensity control. In designing screen display output, areas 
must be allocated to headings/titles, contents of the display, messages and 
instructions and explanation of the information if required. 
 
Input Design 
For generating outputs, matching inputs are required which requires input design. 
Input design consists of developing procedures for data preparation, developing 
steps that are necessary to put data into a usable form for processing. and data 
entry. The objective of input design is to make data entry as easy, logical, and 
free from errors as possible. In input design, the focus is on computer operators 
and not on end-users. In entering data, operators need to know the following: 
1. The allocated space for each field in the computer memory. 
2. Field sequence which must match that in the data source. 
3. The format in which the data fields are entered, for example, filling out the date 
field requires edited format-mm/dd/yy or dd/mm/yy. 
In input design, many of the issues that are involved in output design are also 
involved here, such as content, form, volume, timeliness, etc. For capturing input 
data. different devices can be used, such as keyboard, online entry without using 
keyboard, and source data automation-scanners, voice input devices and 
sensors. The input design should take these devices into consideration. When 
keyed input system, which is most common, is used, it requires form design, 
coding, and data entry. 
 
Form Design : Forms are printed papers that are filled by those persons who 
supply the information. Since forms are used as data source, these must be 
designed properly. In designing forms, following guidelines should be followed: 
1. Contents of the form should be in the same sequence in which the data are 
entered in the computer. 
2. Forms should be divided in logical sections. such as headings, identification 
and access, instructions, body, comments, verification, and signature with date. 
3. Forms should be created to serve one or more purposes in recording, 
processing, storing, and retrieving information for various businesses. 
4. Forms should be designed in such a way that these ensure correct and 
speedy completion. 
 
Coding : Coding is the process of assigning codes to lengthy descriptions. A 
code is a brief number, title, or symbol that denotes a particular description. 
Coding is required because a computer has limited memory and if detailed 
descriptions are used for inputs, they will occupy memory unnecessarily. For 
example, instead of using business-to-business as input, its code B2B is used as 
input, or business-to-consumer is coded as B2C, and so on. Although coding 
methods may exist in manual system also, it is usually necessary to modify these 
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to suit computer capabilities since human beings can work with bad and 
unorganized coding but not the computer. 
 
Designing Data Entry : Designing of an efficient data entry method is a pre-
requisite for the system being successful. To the extent data entry can be made 
automatic, there would be speed and accuracy. While keyed data input is more 
common, other source data automation devices, such as magnetic ink character 
recognition (MICR) device, optical character recognition (OCR) device, pen-
based input device, etc. can be used for data input. Apart from using various 
devices to improve the quality of data entry, input validation can also be used for 
this purpose. The system designer may assume that data entry errors will occur.  
 
Storage Design 
In every information system, data storage is required for concurrent use as well 
as for future use. There can be two approaches for designing data storage 
system. First, data can be stored in individual files with one file for each 
application. Second, a database can be developed which can be shared by 
different users as the need arises. Further, database can be either centralized or 
distributed. While a file system may be more effective because separate files are 
designed for specific programs, this method tends to create data redundancy. 
Therefore, this method is more suitable for smaller organizations having limited 
number of applications. In larger organizations, where the number of end-users is 
quite large and computer networking system is followed, database method is 
more appropriate. This method allows different users to use data in different 
forms. 
 
Processing Design 
Processing design focuses on the design of software resources, that is, the 
programs needed by the proposed information system. It involves developing 
detailed specifications for the program modules. Processing design produces 
detailed program specifications to meet user interface. Processing design must 
also produce specifications that meet the control and performance requirements 
developed in the analysis stage. Software to be used for data processing may be 
either developed in-house or can be procured from the market depending on the 
information technology capability of individual organizations.  
 
Procedure Design 
Procedure design specifies how the computer will function from data entry stage 
to output stage. The procedure indicates the logic of data processing and flow of 
the system control step by step. The steps in the procedure are shown in the 
computer system flow chart. The broad steps in the procedure are as follows: 
 
1. Data entry-as per the input design specifications. 
2. Data validation-as per the data validation specifications controlling data errors 
and absence of required data. 
3. Transaction validation-preventing the entry of wrong transactions. 
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4. Edit and update-completing records before data processing through data 
editing and updating. 
5. Data processing-sorting. merging. collating. and computing data. 
6. Output processing-indicating whether output is to be printed, displayed, or 
stored. 
 
Documentation 
After completion of system analysis and design, documentation is required. 
Documentation describes how an information system works from both a technical 
and end-user standpoint. It is a written record of different phases of a system 
development and establishes design and performance criteria for these phases. 
Lack of proper documentation often leads to system failure. Therefore, 
documentation should be done carefully. Since, documentation provides detailed 
procedures of how a system works, such procedure should be prescribed for all 
types of personnel who come in contact with the system. These personnel are 
end-users, secondary users, computer operating personnel, and trainers. 

******* 
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CHAPTER 10 

 
Information Systems in Functional Areas  

 
Every information system requires certain objectives; inputs, outputs, process 
and database. All these parameters have to be identified for the design of each 
information system. Therefore, the block diagram of a typical information system 
will be as follows: 
 
1.  OBJECTIVES 
2.  INPUTS 
3.  PROCESSES 
4.  OUTPUTS 
5.  DATABASES 
 
1. PRODUCTION  CONTROL  SYSTEM 
 
Production is based on three M's such as: 
 
Man power 
Equipment (Machine) 
Material 
 
These things are basic requirements for any production till it has been 
completed. 
 
Objective : 
The objectives of the production control system are as follows : 
i. To ensure that sufficient stock is available. 
ii. To expand orders into material requirement, determine production process 
required and work out a production schedule. 
 
Inputs : 
The necessary inputs to the system are as follows: 
i. Data on customer orders 
ii. Production availability 
iii. Production stock availability 
The various input documents are as follows : 
i.  Current stock list 
ii. Stock on order 
iii.Demand forecast 
iv. Re-order list 
 
Process : 
The production control system will look like figure 1. 
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Figure 1 : Production Control System 
 
The Order processing subsystem sends orders to the finished goods stock 
subsystem, which in turn intimates the Production planning subsystem if the 
stock level is low. If the Production planning subsystem asks for raw materials to 
Production stock subsystem and sends a production schedule to Production 
subsystem. 
The information system needs to know a lot about the following : 
i. Forecast demand 
ii. Methods of production 
iii. Resources required 
iv. Timing of processes 
 
Databases: 
The detail record layouts can be given as follows: 
 



SRINIVAS MBA:MIS:CH 10  2009 
 

189 
 

 
 
The two databases are required for the production control systems, which are 
shown as follows: 
i. Stock file (Master file) : This gives the inventory available. 
ii. Order file (Transaction file) : This gives the detail about customer's orders. 
iii. Job files (Master file): This gives the detail about the production done. 
 
Outputs: 
The various outputs are as follows : 
i.  Material requisitions to stock subsystem 
ii. Production schedule to production subsystem 
The detail output reports are as follows  ; 
i. Material requisition report 
ii. Production schedule report 
iii. Production cost report 
 
2. INVENTORY CONTROL SYSTEM 
The unfinished, semi finished and finished products are called "stock". The 
usable things are called inventory. The term inventory refers to the stockpile of 
product a firm is offering for sale and components that make up the product. In 
other words, inventory is composed of assets that will be sold in future in the 
normal course of business operation. Inventory is expensive. It is also essential. 
The important thing is that in hand. It shouldn't be much more or much low. 
Therefore it is needed to control the stock. Inventory control is often the data 
processing application that provides the greatest potential benefit of a company. 
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Objectives : 
The objectives are as follows : 
i. To provide high quality service to customers by utilizing a fast, accurate and 
efficient method of filling customer order and avoiding stock-out. 
ii. To keep the amount of money invested in inventory required covering 
inventory changing cost as low as possible. 
iii. To provide management with information needed to assist or achieve the two 
proceeding objectives. 
 
Inputs: 
The necessary inputs for the inventory control system are as following 
i.  Accepted order data 
ii. Transaction data 
iii. Data describing stock received by the receiving dept. 
iv. Miscellaneous Transaction data 
 
Process: 
 

 
 

Figure3: Inventory Control System 
A firm should place neither too large nor too small orders considering the benefits 
derived from an inventory and the carrying cost of it. An optimum level of the  
orders to be placed should be determined. The optimum level is popularly known 
as Economic Order Quantity. EOQ is defined as that level of inventory order that 
minimizes the total cost associated with inventory management. 
Reorder point (ROP) is stated in terms of the level of inventory at which an order 
should be placed with the suppliers for replenishing the current stock of 
inventory.  
Clearly the information system needs to know a lot about the following : 
i. demand forecast 
ii. expenses on availability 
Outputs: 
The general outputs of inventory control systems are as follows: 
i. Economic Order Quantity (EOQ) 
ii. Recorded.point (ROP) 
Databases: 



SRINIVAS MBA:MIS:CH 10  2009 
 

191 
 

The two databases required for the inventory control systems are as follows: 
i. Master file: This gives relatively permanent data regarding the 
various transactions with the customers. 
ii. Back-order file: This gives the necessary information regarding the unfilled 
customer's order. 
The detail record layouts of the files are as follows: 

 
 
3.  PURCHASE INFORMATION SYSTEM 
 
Purchasing department is one of the vital points of the industry because it 
controls the purchase made in the organization. A mass production organization 
which needs a continuous flow of material require a dynamic purchase 
department, which acts as a mediator between the industry and the supplier. 
Purchasing means supply of materials, machinery and servicing needed for 
production and maintenance of the industry. 
Objectives: 
The main objectives of purchase information system are: 
i. To purchase the right material 
ii. To purchase material in right quantity. 
iii.To obtain material of right quality 
iv. To process reliably 
v. To purchase material at economic cost. 
vi. To receive material at right time. 
Inputs: 
The inputs are: 
i. Material requisition report 
ii. Previous cost of materials 
Process: 
Based on the material requisition report, the Purchase department gives orders 
to the suppliers. The suppliers are selected based on the lowest quotation and 
quality of materials. Therefore, the information system needs to know a lot about 
the following: 
i. Material cost 
ii. Material quality 
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Figure 4: Purchase Information System 

 
A purchase requisition is prepared and vendors are selected accordingly. 
Purchase order preparation and release of schedule follow this. A status report is 
prepared and based on capacity monitoring again a purchase requisition is 
prepared. 
Outputs: 
The outputs will be as follows: 
i. Purchase ledger update 
ii. Supplier listing 
Database: 
The only database is the stock containing the detail transaction with the 
suppliers. 
 

 
 

4. SALES ORDER PROCESSING INFORMATION SYSTEM 
A sales order processing system immediately acts and its output is feeded as the 
input for inventory control system. 
Objectives: 
The objectives of sales order (transaction) processing are as follows : 
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i. To provide a fast and efficient method of recording sales transaction and 
screening customer's orders. 
ii. To provide the inventory control system with regarding to the accepted orders 
so that it can be filled as quickly as possible. 
Inputs: 
The inputs for sales order processing consist of the requests from customers. 
Therefore the necessary inputs to the system are as follows : 
i. Sales transaction from customers or sales persons are received by mail,   
telephone or telegraph 
ii. Sales transaction taken in person by a sale clerk 
The various input documents are as follows: 
i. sales receipt or sales order forms manually or computerized 
ii. optical character recognition (OCR) 
Process: 
The sales order processing first check the input data for accuracy. Then it 
intimates the inventory control system about the orders that can be executed. 
Database: 
The sales order (transaction) processing system utilizes the database customer's 
master file. 
 

 
 

Outputs: 
The outputs will be as follows: 
i. request to Inventory Control System for supply of materials 
ii. receipt of customer's orders. 
iii. acknowledgement to customers about complete sales transactions or orders 
rejected for exceeding the credit limits. 
 
5. MARKETING INFORMATION SYSTEM : 
The basic areas of marketing function that lend themselves to improvement 
through information systems include Forecasting, sales planning, market 
research, advertising, operating and control information required to manage the 
marketing function. 
Objectives: 
The overall objectives of this integrated set of marketing subsystem are to 
improve the organization's ability to: 
i. Identify and evaluate potentially profitable sales opportunities. 
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ii. React rapidly to changes in market conditions 
iii. Establish profit-maximizing product prices 
iv. Control marketing costs 
v. Deploy sales personnel most effectively 
vi. Assist in allocating expenditures for advertising and other forms of promotion. 
Inputs : 
The various inputs are 
i. Customer invoices 
ii. Annual reports (customers, suppliers etc) 
iii. Competitor share value 
iv. Competitor product price 
v. Dealer sales transaction 
vi. Sales forecasts 
vii. Sales expenses 
viii. Marketing budgets 
ix. Cost reports 
x. Inventory reports 
xi. Warehouse reports 
xii. Manufacturing cost 
xiii. Accounts Receivable 
xiv. Accounts payable 
xv. Payroll(marketing) 
 
Process : 
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Figure 5: Information Flows within the Marketing System 

 
 
The major sources of information for these activities are : 
i. Sales invoices and other transactions information  
ii. Salespersons' customer call reports 
iii. Salespersons' debriefing by marketing managers 
iv. Sales history files 
v. Customer account files 
vi. The cost accounting system 
vii. The profit planning (budgeting) system 
viii. Market research and intelligence-gathering activities. 
ix. Sales forecasts 
x. Production schedules 
xi. Inventory status reports. 
 
Outputs: 
The various outputs are : 
i. Sales recap: An overall performance summary to date, compared with previous 
periods, budgets or other standards. Major areas of performance analysis might 
include total sales by product, sales expense, new accounts, and variety of 
profitability analysts, market share. 
ii. Record summaries: Sales by model, by sales plan, by industry, by customer 
type. 
iii. Transaction analysis: Transactions defined in terms of dollar volume, no of 
sales etc. 
iv. Exception inquiries: Any inquiry. 
 
6. Human Resource information systems (HRIS) : 
Human resource information system is a system that supports planning, control, 



SRINIVAS MBA:MIS:CH 10  2009 
 

196 
 

coordination, administration and management of Human resources of 
organizations. HRIS also includes a large number of subsystems that address 
the information needs of various human resource functions. They provide 
managers with information, policies, and procedures concerning recruiting, 
layoffs, employee evaluation, promotion, termination, transfer, salary equity 
monitoring, job descriptions and responsibilities, training etc. 
 
Since HRIS also facilitate vital information on matters such as payroll, central and 
state taxes, health benefits, child care, grievance procedures, and other personal 
information that affects the employees personal and professional lives, it is 
imperative that these systems be highly responsive to employee needs. The 
HBIS is derived from the strategic business plan, the strategic human resources 
plan, and the strategic information plan as shown below. 
 

 
 
Some subsystems within the HRIS are personnel data, payroll, benefits, 
administration, equity monitoring, processing job applications, monitoring 
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positions, training and development, safety, employee compensation, union 
negotiations and collective bargaining. The core of an HRIS is a database that 
contains detailed personal and professional information about each employee in 
the organization. Personal data include name, age, gender, address, and social 
security number; professional data include educational level, job title, job 
description, department code, years of employment. Number of promotions, 
performance evaluations and so on. All other human resource subsystems derive 
their information from this core database. 
 
An important subsystem of the HRIS is the compliance system, which closely 
tracks and monitors the organizations record of compliance with government, 
laws and regulations, such as affirmative action, equal employment opportunities 
and others. In the last two decades, the amount of regulatory paperwork has 
increased manifold and organizations are actively looking for ways to cut down 
the time and money they spend on these activities. One way to achieve this 
objective is through compliance subsystems. 
 
Another vital HRIS subsystem manages records and generates information 
regarding recruitment, transfer, promotion, layoff and termination of employees. 
Often, when any of the above situations occur, a large amount of information is 
generated and the organization needs a system that processes it. As the number 
of lawsuits for improper hiring, promotion and firing policies increases, accurate 
and timely record keeping becomes even more important. 
 
Other subsystems of the HRIS include systems that develop and maintain job 
and job descriptions for all jobs in the firm, compensation and benefits 
information systems, and manpower planning systems. A performance appraisal 
system that provides employees with real-time' information or corporate 
performance measurements, thus making continuous performance improvement 
a way of corporate life rather than an annual chore, is another important 
subsystem in an HRIS. Pre testing, compensation policies, ensuring that 
employees meet certification requirements, identifying problem areas in 
employee turnover, and providing training and employee empowerment 
programs are some other functions of an HRIS. 
 
7. Write a note on Accounting information systems ? 
Accounting information systems-are used for the financial activities that take 
place in any organization. These include the operation of sales order processing 
systems, payroll, budgeting and reporting of the financial condition of the 
organization. Other functions include the management of capital investment and 
general cashflow management. 
 
. Operational accounting systems focus on daily recording of business 
transactions, that is, the flow of funds through an organization. All businesses 
require this basic information. In larger businesses these systems will be linked 
to other operational functions, such as sales order processing and inventory. 
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. Management accounting systems enable planning and control of business 
finance.  These are sometimes referred to as financial information systems and 
will be linked to executive information systems. 
Application areas for accounting information systems Most companies use an 
integrated accounting system that covers a number of application areas, as 
shown in Fig 6.25. ,The essential modules are accounts receivable, accounts 
payable and the general ledger. Many companies will look to extend these to 
related areas such as sales order processing and payroll. 
 

 
. Sales order processing. The SOP system is particularly important, as it records 
sales transactions and supplies documents to other areas such as stock control 
and manufacturing. There might also be links to payroll to calculate such 
elements as bonus payments to sales people on receipt of a customer order. The 
accounts receivable system contains customer information such as sales made, 
payments made and account balances for overdue payments. These can be 
used to halt the extension of further credit until the balances have been cleared. 
The system may also be searched to identify lists of customers who have 
purchased certain items, which is then used as the basis for a mailing list for 
promotional purposes. The accounts payable system contains information 
regarding the firm's creditors (as opposed to customers for the accounts 
receivable). The system provides information on which a schedule of supplier 
payments can be made and thus ensures that payments can be made as late as 
possible (to optimize cashflow) without losing discounts offered from suppliers for 
prompt payment. 
. Inventory. The inventory system maintains stock levels by recording when stock 
is used for sales orders. A reorder point (ROP) system will generate an order for 
stock once the level of a stock item falls below a number of units. Other time-
based systems will replenish stocks after a predetermined time interval. 
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. Payroll. The payroll system processes payments to employees, "including 
deductions for such items as National Insurance and income tax. Many 
organizations will have electronic links to banks for direct deposit to employee 
accounts rather than issuing pay cheques.  
. Budgeting systems. Budgets are an important control tool for management. A 
predetermined budgeted amount is periodically compared to the actual 
expenditure and any difference noted as a variance. This comparison of 
allocations (budgeted amounts) against actual (amounts spent or received) can 
be reported to management. The identification of a variance will normally 
instigate a discussion and  may lead to corrective action being taken to eliminate 
any adverse variance. 
Budgets for areas or departments can be aggregated or brought together to form 
a functional or organizational budget statement for higher-level decision making. 
+ Cashflow reporting. A major cause of business failure is inadequate cash 
reserves to keep the organization functioning. Cashflow reporting is necessary to 
keep track of the organization’s cash reserves. Cash is needed for working 
capital (day-to-day expenses) and for the purchase of long-term assets such as 
plant or machinery. A cashflow report will contain a running total of the cash 
balance from information on cash inflows and outflows for each reporting period. 
An adverse cash position may necessitate the deferring of a planned acquisition. 
The report can be used as a planning tool by incorporating different cost and 
revenue scenarios and studying the results. 
+ Capital budgeting system. The financial system should contain tools which 
allow for the evaluation of capital spending plans. Major investments are 
compared to the financial return that the organization could have gained from 
placing the cash in a bank account and accruing interest. The investment 
evaluation may also inform the decision to buy or lease equipment. Financial 
measures often used to assess an investment include net present value (NPV), 
internal rate of return (IRR)and payback period.  
+ Financial analysis system. Financial analysts use a variety of performance 
measures to gauge the financial position of an organization. These include such 
measures as the current ratio, inventory turnover and earnings per share (Dyson, 
1997). An information system can be used to generate these values 
automatically using figures stored in a database of such items as current assets 
and current liabilities. 
+ Forecasting systems. By projecting budget statements into the future, an 
organization is able to forecast the potential financial state of the organization. 
These forecasts will need to incorporate economic and market forecasts in order 
that sales and cost data can be estimated. 
 
9. Write a note on Financial Information System ? 
 
Computer-based financial management systems support financial managers in 
decisions concerning (1) the financing of a business and (2) the allocation and 
control of financial resources within a business. Major financial management 
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system categories include cash and investment management, capital budgeting, 
financial forecasting, and financial planning. 
 
Cash management systems : These collect information on all cash receipts and 
disbursements within a company on a realtime or periodic oasis. Such 
information allows businesses to deposit or invest excess funds more quickly, 
and thus increase the income generated by deposited or invested funds. These 
systems also produce daily, weekly, or monthly forecasts of cash receipts or 
disbursements (cash flow forecasts) that are used to spot future cash deficits or 
surpluses. Mathematical models frequently can determine optimal cash collection 
programs and determine alternative financing or investment strategies for dealing 
with forecasted cash deficits or surpluses. 
 

 
Investment Management : Many businesses invest their excess cash in short-
term low risk marketable securities or in higher-return/higher-risk alternatives, so 
that investment income may be earned until the funds are required. The portfolio 
of such securities can be manage with the help of portfolio management software 
packages. Investment information and securities trading are available from 
hundreds of online sources on the Internet and other networks. Online 
investment management services help a financial manager make buying, selling, 
or holding decisions for each type of security so that an optimum mix of securities 
is developed that minimizes risk and maximizes investment income for the 
business. 
 
Capital budgeting : This process involves evaluating the profitability and 
financial impact of proposed capital expenditures. Long term expenditure 
proposals for plants and equipment can be analyzed using a variety of 
techniques. This application makes heavy use of spreadsheet models that 
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incorporate present value analysis of expected cash flows and probability 
analysis of risk to determine the optimum mix of capital projects for a business. 
 
Financial Planning : Financial analysts typically use electronic spreadsheets to 
evaluate the present and projected financial performance of a business. They 
also help determine the financing needs of a business and analyze alternative 
methods of financing. Financial analysts use financial forecasts concerning the 
economic situation, business operations, types of financing available, interest 
rates, and stock and bond prices to develop an optimal financing plan for the 
business. Electronic spreadsheet packages, DSS software, and Web-based 
groupware can be used to build and manipulate financial models. Answers to 
what-if and goal-seeking questions can be explored as financial analysts and 
managers evaluate their financing and investment alternatives. 
 

********* 
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CH – 11 
 

SYSTEM  IMPLEMENTATION  &  MAINTENANCE 
 
System implementation has different meanings, ranging from the conversion of a 
basic application to a complete replacement of the existing system. Therefore the 
activities involved in system implementation vary. There are basically three types 
of implementation: 
1. Implementation of a computer system to replace a manual system which 
requires acquisition of computer hardware and software, file conversion, creating 
accurate files, and user training. 
2. Implementation of a new computer system to replace an existing one like from 
mainframe to a network of microcomputers or independent computing to 
client/server computing. 
3. Implementation of a modified application to replace an existing one using the 
same computer. 
A broad view of system implementation involves hardware acquisition, software 
acquisition, Installation, Conversion, user training, and post-implementation 
evaluation. It also involves managing resistance to change if the organization. 
 
1. HARDWARE ACQUISITION : 
The type of hardware that is required for implementing a system is specified in 
system analysis and design documentation. After the specifications are made 
available, the particular type of computer may be chosen for acquisition. There 
are mainly three types of computers-mainframe, minicomputer, and 
microcomputer-that are used by business organizations. Though each of these 
computers has its own pros and cons, there is increasing emphasis on the use of 
microcomputers because of their low prices and increasing processing 
capabilities. Therefore, many organizations prefer to acquire microcomputers or 
a network of microcomputers instead of acquiring mainframes or minicomputers. 
In acquiring a computer, an organization has to evaluate its performance as well 
as its vendors' performance and to decide the methods of acquisition. 
 
Hardware Evaluation : 
For acquiring a computer hardware. two aspects are evaluated-hardware 
capability and vendor capability. For evaluating hardware, information may be 
collected from different sources-vendors' catalogues, other publications, and 
current users of the same hardware. After collecting the information from different 
sources, the evaluation is generally made by a committee consisting of technical 
experts and users. The committee evaluates hardware in the light of certain pre-
determined criteria. For using these criteria in evaluation, three approaches can 
be adopted-ad hoc approach, scoring approach and cost-value approach. 
 
Ad hoc approach : Ad hoc approach is the least methodological and uses 
personal opinions, including biases to a particular hardware of evaluation 
committee members. Members may be inclined to a particular hardware based 
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on their observations of functioning of the same hardware elsewhere or hearsay. 
However, this evaluation approach is not very scientific. 
Scoring Approach : In scoring approach, the characteristics of each hardware 
are listed and each characteristic is given a score in relation to maximum rating 
points. The alternative which has the maximum points may be selected as shown 
in Table 1.  
 
Based on the scoring approach, hardware A may be selected as it has the 
maximum score. An alternative to the above scoring method is to assign points 
based on the characteristics of each element of hardware alternatives. These 
characteristics may be termed as excellent. very high, high, average, and below 
average and points may be assigned ranging from 5 to 1 with 5 for excellent and 
1 for below average. Total of these points for different hardware alternatives will 
be taken as base for selecting an alternative. 
 
Table 1: Scoring approach for hardware evaluation 

 
 
Cost-value Approach :. In the scoring approach. only characteristics of different 
hardware alternatives have been taken into consideration and not their prices 
while prices may be an important consideration in selecting a hardware. Price 
impact can be calculated by cost-value approach in which monetary value is 
assigned to different characteristics of hardware alternatives. The total of these 
values assigned to different hardware alternatives is compared to their prices and 
the alternative which gives the highest value in comparison to its price is selected. 
 
Vendor Capability : Apart from the hardware evaluation, there must be 
evaluation of vendors too who are likely to supply the hardware. In evaluating 
vendors, various criteria, such as delivery time, performance records, quality of 
service, maintenance charges, user training, and number of hardware installed 
should be taken into consideration. For evaluating these characteristics, either ad 
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hoc approach or scoring approach may be used, as discussed above. If scoring 
approach is used, that vendor should be selected which has the highest score. 
Hardware Acquisition Method : 
When the decision to acquire a particular hardware has been made, another 
issue arises about the method to be adopted for acquiring this. Since the 
acquisition of hardware has financial implications, an organization may adopt any 
of three methods: 
1. Rental directly from the manufacturer. 
2. Leasing through a third party. 
3. Outright purchase. 
 
Rental Option : Rental option is a form of lease by the manufacturer. Rental 
may be payable monthly or any other period decided by the manufacturer and 
the user. Many computer users prefer renting a hardware because of the 
following reasons: 
1. There is financial leverage for the user. With no investment required in 
procuring the hardware, the user is able to utilize the fund elsewhere profitably. 
This also eases the liquidity problem of the user. 
2. Rental makes it easier to change to other hardware systems, thereby 
protecting itself from the risk of technological obsolescence. 
3. Insurance, maintenance, and other expenses are included in the rental charge. 
4. Rental charge is tax deductible though the user loses the benefit of tax saving 
in the form of depreciation deduction. 
Rental option has one basic disadvantage in that rental charges are quite high 
because of the uncertainty of rental revenues to the manufacturer. 
 
Lease Option : Instead of taking a hardware system directly from the 
manufacturer, it can be taken on lease from a third party. In this case, the lessor, 
usually a leasing company. remains the owner of the hardware and charges 
lease rental from the user. Leasing period may be for a year with a provision of 
renewal on year-to-year basis or may be for longer period. 
Both options have their own pros and cons. While a short-term lease may involve 
higher rental but frees the user to run the technological risk, reverse is the case 
with longer-term lease. There are several advantages in lease options: 
1. No fund is required for acquiring hardware system and the technological risk is 
borne by the lessor. 
2. Lease charges are generally lower as compared to rental charges for the 
same period and are also tax deductible. 
However, the lease option has its own limitations. In the absence of an up 
gradation clause, the user may not be able to exchange the leased system for 
another system. Further, if interest rates have declining trend, the user has to 
bear fixed rental charges as committed earlier. If the lease contract is terminated, 
it may involve heavy financial penalty. 
Purchase option. An user can purchase a hardware system outright. 
Purchasing means assuming all the risks of ownership including taxes, insurance, 
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and technological obsolescence. Purchase option has certain advantages over 
rental and lease options: 
1. There is a flexibility of modification of the hardware system at will. 
2. Tax benefits are available in the form of depreciation. 
3. Residual value can be realized if the user disposes off the hardware system. 
However, purchase option has high initial investment outlay and runs the risk of 
technological obsolescence. 
Each option of acquiring a hardware system has unique characteristics. These 
options can be evaluated both qualitatively as well as quantitatively. Qualitative 
method evaluates the options by taking their features and the user's ability to 
bear the financial burden in different alternatives and the risk of technological 
obsolescence. 
 
2. SOFTWARE ACQUISITION 
System analysis and design specifies the types of software that would be 
required to produce desired outputs to satisfy user needs. There are basically 
two types of software-system software and application software. System software 
runs the computer hardware and application software makes the computer useful 
for producing outputs. 
Separate set of issues is involved in selecting system software and application 
software. 
 
Selection of System Software 
A system software manages the resources of the computer, such as central 
processor, communication links, and input/output devices. Some of the system 
software can be used on any type of computer while some can be used on only 
specified type of computer. Some of the commonly used system software include 
DOS, MS Windows, MS Windows NT, OS/2, and UNIX. In evaluating the 
suitability of a system software, following factors should be taken into 
consideration: 
1. The type of computer required for using a given system software. 
2. The type of applications that can run on a system software. 
3. Ease of learning and using a system software. 
4. Extent to which multiple users on networks can use the system software.  
5. Extent of multitasking capabilities of the system software. 
6. Reliability of the system software. 
7. Technical support and assistance required to install the system software. 
8. Cost of installation of the system software. 
If an organization wants a system software for its mainstream business 
applications, it needs a software that is compatible with the software required by 
these applications. The system software should be easy to install and operate. 
Mission-critical applications require special system software. For such 
applications, software that can support multitasking and memory management is 
required. The software should be able to run multiple applications quickly without 
having the system crash because different applications contend for the same 
memory space. Mission-critical applications typically have large volume of 
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transactions to process and require system software that can handle large 
complex software programs and massive files. 
 
Selection of Application Software : 
While system software has to be acquired from developers or their vendors 
because a system software cannot be developed in-house as development cost 
is prohibitive, in case of application software, an organization has the option 
either to develop it in-house or to acquire it from the market. For this purpose, the 
organization has to assess its technological capability to find out whether it is in a 
position to develop application software tailored to its requirements at a given 
cost. Since the organization’s main job is not to produce software, it finds that it is 
not in a position to develop application software at competitive cost. Therefore, it 
is better to acquire standardized application software known as application 
software package or simply as software package, from the market. A software 
package is a set of prewritten, pre-coded application software programs that is 
commercially available for sale or lease. There are a number of software 
packages that are available for different applications. 
 
Advantages of Software Packages 
There are certain advantages of software packages as compared to inhouse 
development. .The major advantages are as follows : 
1. Rapid implementation-Software packages are readily available for 
implementation while in-house software development may take much time may 
be many months. 
2. Low risk-Since software packages are readily available, the organization is 
free from the risk involved in software development process. In-house 
development of software has uncertainty both in terms of time and cost. 
3. Quality-Since software packages are developed by specialists, they are 
generally of higher quality. Such specialists may not be available internally 
because employment of such specialists has recurring cost implications.  
4. Low cost-Since software package developers produce the packages in bulk 
quantity, their cost of development per unit of a package tends to be low. 
 
Disadvantages of Software Packages 
There are some disadvantages of software packages which are as follows : 
1. Lack of customization-Software packages are produced in bulk quantity in 
standard format. This standard format may not suit all organizations, as each 
organization has its unique requirements. 
Therefore, an organization has to modify a package according to its requirements. 
This involves additional cost. 
2. Commercial software packages have not yet achieved the level of 
sophistication and technical quality needed to produce multipurpose packages 
that can do every thing well that users want in a specific application. 
3. There is a significant fringe element in the software market that does not 
subscribe to ethical marketing practices. Therefore, a buyer has to be very 
careful while buying software packages. 
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Software packages can be used in the following conditions effectively : 
1. When functions for which packages are being acquired are common to many 
organizations, such as payroll for which different organizations can use the same 
package. 
2. When the packages are required for desktop microcomputer applications as 
numerous easy-to-use packages have been developed for desktop 
microcomputers. 
3. When information system resources are not well equipped for inhouse 
software development: this is applicable more in the case of smaller 
organizations. 
 
Evaluation of Software Packages 
Before buying a software package, it is essential that it is evaluated against the 
criteria set by the user organization. These criteria may be set on the following 
aspects of software packages: 
1. Functions included-the package must include the functional requirements of 
the application; functions that can be supported by modifying codes, degree of 
modification required, and meeting present and future requirements. 
2. User friendliness-ease of operation from non-technical stand point, training 
required to understand and operate the package, and ease of user control. 
3. Hardware and software required-type of hardware required type of operating 
system (system software) required, capacity of CPO required, and computer time 
required to run the package. 
4. Database features-nature of database/file structure required. 
5. Installation effort-changes in the existing procedures required. 
6. Maintenance-nature of maintenance required in terms of up gradation and 
enhancement. 
7. Documentation-nature of documentation and its understandability. 
8. Cost-basic price. taxes. maintenance charges etc. 
Using the above criteria. a software package may be evaluated by using ad hoc 
approach, scoring approach, or cost-value approach as used in the case of 
hardware evaluation. 
 
Process of Acquiring Hardware/Software 
When an organization is implementing its computerized information system for 
the first time, it is required to acquire hardware and software simultaneously. In a 
case where an organization has already a computerized system, it may just 
require to buy additional software. However, the process of acquisition remains 
same. For acquiring hardware/software, an organization may adopt the following 
steps: 
1. Determination of Hardware/Software Required :  
Based on system analysis and design and organizational analysis of the type of 
hardware/software it wishes to install. hardware/software requirement is 
determined. 
2. Request for Proposal. Request for proposal (RPF) is prepared and is sent to 
various computer vendors for sending their proposal to supply the required 
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hardware/software. RPF specifies the type of hardware/software that the 
organization wants to buy or get on lease. 
3. Proposal Evaluation. If there are many proposals. evaluation may be made in 
two stages-primary and final. In primary evaluation, all those proposals that do 
not meet initial selection criteria, either on technical or cost basis are rejected. 
The remaining proposals go to the final evaluation stage. At the final evaluation 
stage, evaluation exercise is conducted in more detail. Such an evaluation 
exercise evaluates both hardware/software and its vendors. The evaluation is 
generally made by a committee constituted for this purpose and it evaluates 
hardware/software and vendors against the criteria prescribed in respect of these. 
4. Finalization of hardware/software and vendor. On the basis of the detailed 
analysis of various proposals, the committee finalizes the hardware/software to 
be acquired and the vendor from which to acquire. After the finalization process 
is over, the committee prepares an evaluation report showing the details of 
proposals and the reason for selecting a particular system as well as vendor. The 
report is presented to formal approving authority as the committee normally 
works in advisory capacity. 
5. Final Approval and Acquisition. On the basis of the report submitted by the 
committee and its recommendation, the person authorized to make final decision 
may finalize the recommendation. If the authorized person wants to have more 
information about the recommendation, he can solicit it from the committee. After 
the final approval, the order is placed to the concerned vendor showing the 
details of the items required, their delivery schedule. mode of transportation, 
mode of payment, etc. After receiving the hardware and software, the next step 
of system implementation that is installation proceeds. 
 
3. INSTALLATION 
During the process of acquiring hardware/software, installation work may 
proceed so that by the time equipment arrives, the platform is ready for its 
installation. An installation checklist should be prepared during this period based 
on operating advice of the vendor and the system development team. With 
installation checklist, an installation schedule should also be prepared so that it is 
completed well in time. Installation involves site preparation, equipment 
installation, and equipment checkout. 
 
System Maintenance 
After a system is implemented and is in operation, it requires maintenance on 
regular basis. When a system is in operation, modifications are made so that the 
system continues to provide the needed support. These modifications are called 
system maintenance. Generally, system maintenance is performance for three 
reasons: 
1. To correct errors-uncovering bugs in the programs or weaknesses in the 
design that were not detected ,during testing, and correcting these weaknesses. 
2. To keep system current-over the time, changes occur in the system's 
environment that require modifications in the system design and software. 
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3. To improve the system--continuous improvement in the system is required to 
meet user requirements. 
System maintenance may be undertaken either by in-house maintenance team 
of the maintenance work can be assigned to vendors or other system 
maintenance agencies. In those organizations, where number of computers 
installed is large enough, in-house maintenance team may be given the 
responsibility of system maintenance. In smaller organizations, the job may be 
assigned to outside agency on contract basis. System maintenance involves 
hardware maintenance and software maintenance. 
 
4. HARDWARE MAINTENANCE 
Hardware maintenance includes computer hardware and its peripherals as well 
as network maintenance. Hardware maintenance can take place in three forms-
preventive maintenance, breakdown maintenance, and replacement 
maintenance. 
Preventive Maintenance. Preventive maintenance is regarded as 'stitch in time 
that saves nine'. Preventive maintenance of hardware is a precautionary 
measure. There should be a schedule for weekly or monthly maintenance of 
each machine. Though sometimes, it appears that preventive maintenance is an 
addition a cost, it saves lot by avoiding loss due to production loss. It also helps 
increasing the useful life of hardware. 
Breakdown Maintenance. Breakdown maintenance is undertaken when a 
machine breaks down and stops working because of damage of any part. When 
the machine fails because of damaged part, the part can be got repaired or a 
new part is installed. In part repairing, the organization should make a decision 
regarding the number of times, a particular part may be repaired. 
Replacement Maintenance. Replacement maintenance involves replacing the 
major devices of hardware like keyboard, monitor, printer, or other devices that 
are at ending stage of their useful life. Generally, various devices of hardware do 
not complete their life cycle simultaneously. Therefore, the organization should 
formulate a policy indicating the time by which a particular device has to be 
replaced. 
 
5. SOFTWARE MAINTENANCE 
Software maintenance is more critical as compared to hardware maintenance 
because there are many issues involved in software maintenance. Software 
maintenance covers a wide range of activities, including correction of coding and 
design errors, updating documentation and test data, and providing user support. 
Many activities classified as software maintenance are actually enhancements: 
While maintenance means restoring something to its original condition, 
enhancement means adding. modifying, or redeveloping the codes to support 
changes in the specifications. Although software does not wear out like the 
hardware, it ages and eventually fails to perform because of cumulative 
maintenance. Over the time, the integrity of the program, test data, and 
documentation degenerates as a result of modifications. Eventually, it takes more 
effort to maintain the application than to rewrite it. 
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Software maintenance may be classified as corrective, adaptive, or perfective. 
Corrective maintenance means repairing processing or performance failures or 
making changes because of previously uncorrected problems and assumptions. 
Adaptive maintenance means changing the program function. Perfective 
maintenance means enhancing the performance or modifying the program to 
respond to the users' additional or changing needs. For software maintenance, 
software reengineering concept has been developed. 
 
6.  SUCCESS AND FAILURE OF MIS : 
Most organizations use MIS more successfully than other organizations. Through 
hardware, software and technology available are the latest and the best, its use 
is more for the collection and storage of data and its elementary processing. 
There are some factors, which make MIS, a success while there are some 
factors, which make it a failure. 
Factors contributing to success of MIS : If MIS is to be a success, then it 
should have all the features listed below 

• MIS is integrated into the management function. It sets clear objectives to 
ensure that MIS focuses on the major issues of the business. Also 
adequate development resources are provided and human & 
organizational barriers to progress are removed. 

• An appropriate information processing technology required to meet the 
data processing and analysis needs of the users of MIS is selected. 

• MIS is oriented, defined and designed in terms of the users requirements 
and its operational viability is ensured. 

• MIS is kept under continuous surveillance, so that its open system is 
modified according to the changing information needs. 

• MIS focuses on results and goals, and highlights the factors and reasons 
for non achievements. 

• MIS is not allowed to end up into an information generation mill avoiding 
the noise in the information and the communication system 

• MIS recognizes that a manager is a human being and therefore, the 
systems must consider all the human behavioral aspects in the process of 
management. 

• MIS recognizes that the different information needs for different objectives 
must be met with. The globalization of information in isolation from the 
different objectives leads to too much information and its non use. 

• MIS is easy to operate and therefore, the design of MIS has such good 
features which make up a user friendly design. 

• MIS recognizes that the information needs become obsolete and new 
needs emerge. The MIS design, therefore, has a potential capability to 
quickly meet newer and newer needs of information. 

• MIS concentrates on developing the information support to manage critical 
success factors. It concentrates on the mission critical applications serving 
the needs of the top management. 
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Factors contributing to failures : Many times, MIS is a failure. The common 
factors which are responsible for this are as follows : 

• MIS is conceived as a data processing and not as an information system. 
• MIS does not provide that information which is needed by managers but it 

tends to provide the information generally the function calls for. MIS then 
becomes an impersonal function. 

• Underestimating the complexity in the business systems and not 
recognizing it in the MIS design leads to problems in the successful 
implementation. 

• Adequate attention is not given to the quality control aspects of the inputs, 
the process and the outputs leading to insufficient checks and controls in 
MIS. 

• MIS is developed without streamlining the transaction processing systems 
in the organisations. 

• Lack of training and appreciation that the users of the information and the 
generators of the data are different, and they have to play an important 
role in the MIS. 

• MIS does not meet certain critical and key factors of its users, such as a 
response to the query on the database, an inability to get the processing 
done in a particular manner, lack of user friendly system and the 
dependence on the system personnel. 

• A belief that the computerized MIS can solve all the management 
problems of planning and control of the business. 

• Lack of administrative discipline in following the standardized systems and 
procedures, wrong coding and deviating from the system specifications 
result in incomplete and incorrect information. 

• MIS does not give perfect information to all the users in the organization. 
Any attempt towards such a goal will be unsuccessful because every user 
has a human ingenuity, bias and certain assumptions not known to the 
designer. MIS cannot make up these by providing perfect information. 

 
******* 
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CHAPTER 12 
 

Emerging Concepts &  Issues in  MIS 
 
 
 
    1.  Knowledge Based Systems 
        Artificial Intelligence + Expert System + Robotics + Neural Networks 
    2. Data warehousing 
    3. OLAP 
    4. Data Mining 
    5. Enterprise Wide Information System (ERP) 
    6. Latest Trends in IS :  
        (a) Object Oriented Systems 
        (b) Total Quality Management Systems 
        (c) Manufacturing Execution Systems 
        (d) Business Process Re-engineering 
        (e) Geo-graphical Information systems 
 

Emerging Concepts & Issues in MIS 
 

A. Knowledge Based Systems  
B. Enterprise Wide Information System (Enterprise Resource Planning) 

 
A. Knowledge Based Systems : 
Knowledge based system contains Artificial intelligence, Expert systems, neural 
network, robotics etc.  
 
1.1 Artificial Intelligence (AI) 
Artificial intelligence can be defined as a field of study that designs and develops 
machines capable of performing tasks that would require intelligence if performed 
by a human being.  
A more formal definition of artificial intelligence is that, it is a branch of computer  
science concerned with designing intelligent computer systems, ie; systems that 
exhibit the characteristics associated with intelligence in human behavior - 
understanding, language, learning, reasoning etc. 
 
1. Components of AI : 
Broadly speaking, AI consists of 
(a) Expert systems 
(b) Robotics 
(c) Natural Language 
(d) Learning 
(e) Computer Vision 
(f) Perceptive Systems 
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(g) Artificial Intelligence hardware 
(h) Neural Networks 
 
(a) Expert Systems: It is a computer program that attempts to represent the 
knowledge of human experts in the form of heuristics.  
(b) Robotics : They consist of computer controlled devices that help in AI 
applications. 
(c) Natural Language : This enables users to communicate with the computer in 
different languages and also enables the computer to check grammar and 
spellings. 
(d) Learning : This encompasses all the activity that enables the computer or 
other device to acquire knowledge in addition to what has been entered into the 
memory by its manufacturers and programmers. 
(e) Computer vision: This is to endow computers with the ability to recognize 
and identify objects and the context to which they belong. This also entails an 
ability to recognize shapes, features etc. automatically and in turn automate 
movement through robots. 
(f) Perceptive Systems: These use visual images and auditory signals to 
instruct computers or other devices such as robots. 
(g) Artificial intelligence hardware: This includes physical devices that help in 
artificial intelligence applications. Examples are hardware that is dedicated to 
knowledge based systems, neural computers used to speed up calculations –etc. 
 
(h) Neural networks: They are highly simplified models of the human nervous 
system that exhibit abilities such as learning, generalization and abstractction.  
These abilities enable the models to learn human like behavior. 
 
1.2 Expert system (ES) 
An expert system is a computer application that guides the performance of ill 
structured tasks, which usually require experience and expertise. Using an expert 
system, a non expert can achieve performance, which is comparable to an 
experts performance in that particular domain. 
An expert system is vary similar to a decision support system, ie.; both are 
intended to provide a high level of problem solving support to their users. But 
they differ in two major ways: 
First, a DSS consists of routines that reflect as to how the manager believes a 
problem should be solved, as well as the manager's style and capabilities. An 
expert system on the other hand, offers the opportunity to make decisions that 
exceed the manager's capabilities. 
The second but most important difference between DSS & ES is that, the expert 
system (ES) to explain its line of reasoning in reaching a particular solution. Very 
often, the explanation of how a solution was reached is more valuable than the 
solution itself. 
1.2.1 Components of ES  
Expert system consists of 4 major parts 
(a) user interface 
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(b) knowledge base 
(c) inference engine 
(d) development engine 
Applications of ES 
The business applications of expert systems are many. Some of them are as 
follows: 
Manufacturing 
. Maintaining facilities 
. Analyzing quality and providing corrective measures 
. Determining whether a process is running correctly or not 
. Scheduling job shop tasks 
. Selecting transportation routes 
. Assisting with product design and facility layouts 
Marketing 
. Establishing sales quotas 
. Responding to customer inquiries 
. Assisting with marketing timing decisions 
. Determining discount policies 
Accounting and Finance 
. Providing tax advice and assistance 
. Helping with credit authorization decisions 
. Selecting forecasting models 
. Providing investment advice 
Personnel 
. Assessing applicant qualifications 
. Giving employees assistance in filling out forms 
General Business 
. Assisting with project proposals 
. Recommending acquisition strategies 
. Educating trainees 
. Evaluating performance 
 
B. Enterprise Resource Planning (Enterprise Wide Information System) : 
 
Originally, ERP packages are targeted at the manufacturing industry and 
consisted mainly function for planning and managing core businesses such as 
sales management, production management, accounting and financial affairs, 
etc.  
However, in recent years, adaptation not only to the manufacturing industry, but 
also to diverse types of Industry has become possible and the expansion of 
implementation and use has been progressing on a global level. 
 
ERP software has been designed to model and automate many of the basic 
process of a company, from finance to the shop floor with the goal of integrating 
information across the company and eliminating complex, expensive links 
between computer system that were never meant to talk to each other. 
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Figure 1 : Information Integration through ERP Systems 
ERP System's set to generic processes produce the dramatic improvements that 
they are capable of only when use to connects parts of an organization an 
integrate its various processes seamlessly.  
When a warehouse in Noida enters a customer order, for example, the data flows 
automatically to others in the company who need to see it - to the finance 
department and the company head quarters in Mumbai and manufacturing plant 
in Chennai. 
 
Advantages of ERP : 
Installing an ERP system has many advantages - both direct and indirect.  The 
direct advantages include improved efficiency, information integration for better 
decision making, faster response time to customer queries, etc. The indirect 
benefits include better corporate image, improved customer goodwill, customer 
satisfaction, and so on.  
The following are some of the direct benefits of an ERP system: 
. Business integration 
. Flexibility 
. Better analysis and planning capabilities 
. Use of latest technology 
 
 
ERP and Related Technologies : 
ERP is an abbreviation for Enterprise Resource Planning and means, the 
techniques and concepts for the integrated management of businesses as a 
whole, from the viewpoint of the effective use of management resources, to 
improve the efficiency of an enterprise. 
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ERP systems serve an important function by integrating separate business 
functions - materials management, product planning, sales, distribution, finance 
and accounting and others - into a single application. However, ERP systems 
have three significant limitations: 
 
1. Managers cannot generate custom reports or queries without help from a 
programmer and this inhibits them from obtaining information quickly, which is 
essential for maintaining a competitive advantage. 
 
2. ERP systems provide current status only, such as open orders. Managers 
often need to look past the current status to find trends and patterns that aid 
better decision making. 
 
3. The data in the ERP application is not integrated with other enterprise or 
division systems and does not include external intelligence. 
 
There are many technologies that help to overcome these limitations. These 
technologies, when used in conjunction with the ERP package, will help in 
overcoming the limitations of a standalone ERP system and thus, help the 
employees to make better decisions. Some of these technologies are BPR, Data 
Warehousing, Data Mining, Online Analytical Processing (OLAP), Supply Chain 
Management and so on. 
 
With the competition in the ERP market getting hotter and hotter, and ERP 
vendors searching for ways to penetrate new market segments and expand the 
existing ones, tomorrows ERP systems will have most of these technologies 
integrated into them. In this chapter, we will see how each of these technologies 
are related to ERP systems.  
 
1. Business Process Reengineering (BPR) : 
BPR has been around for quite some time and a lot has been written about it in 
both, the practitioner trade press and the academic research journals. However, 
the controversy still remains about whether there is any accurate description of 
BPR or BPR is just a fad - an appealing label to tag on to whatever your 
company is doing, to suggest that your latest and greatest work is 'in vogue'. But 
if reengineering is to continue in the long run, then it must do more than advertise 
its considerable successes to date. It must become more proactive and inclusive 
with regard to human, organizational and motivational change issues. 
 
Dr. Michael Hammer defines BPR as “... the fundamental rethinking and radical 
redesign of business processes to achieve dramatic improvements in critical, 
contemporary measures of performance such as cost, quality, service and 
speed." One of the main tools for making this change is the Information 
Technology (IT), any BPR effort that fails to understand the importance of IT, and 
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goes through the pre-BPR analysis and planning phases without considering the 
various IT options available and the effect of the proposed IT solutions on the 
employees and the organization, is bound to crash during takeoff. 
 
We have seen that the ERP systems help in integrating the various business 
Processes of the organization with the help of modern developments in IT. With a 
good ERP package, the organization will have the capability of achieving 
dramatic improvements in critical areas such as cost, quality, speed and so on. 
So many BPR initiatives end up in the ERP implementation. 
 
2. Data Warehousing : 
If operational data is kept in the databases of the ERP system, it can create a lot 
of problems. As time passes, the amount of data will increase and this will affect 
the performance of the ERP system. So it is better to archive the operational data 
once its use is over. When I say 'the use is over', it does not mean that the 
archived data is useless. On the contrary, it is one of the most valuable 
resources of the organization. However, once the operational use of the data is 
over, it should be removed from the operational databases. For example, one the 
financial year is over, the daily transactional data can be archived. Figure 2 
shows what happens if the data is not archived. 
 

 
 

Figure 2 : Operational Data vs. Archive Data 
 
It is evident from the Figure 2 that even though the operational data volume is 
nearly the same each year, since the data is not archived, the total amount of 
data that is stored in the operational database will go on increasing. Figure 2 
shows the effect of keeping this huge amount of data in the operational 
database. 
It is clear from the graph (Figure 3) that as the volume of the data in the database 
increases, the performance of the database and the related applications 
decreases. 
It is evident that we should separate the operational data from the non-
operational data. Here the term archive data is not used because if the non-
operational data is archived, there is little or no use for it. But this data is a very 
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valuable resource and is too precious to be kept in some archive. It is in this 
situation that a data warehouse comes in handy. 
 

 
 

Figure 3. Data Volume Vs. Performance 
 
Separating it from the data in operational systems can access the primary 
concept of data warehousing is that the data stored for business analysis most 
effectively. The most important reason for separating data for business analysis, 
from the operational data, has always been the potential performance since 
analysis processes much more complex and sophisticated. In addition to 
producing standard reports, today's data warehousing systems support very 
sophisticated online analysis, including multi-dimensional analysis. 
 
3. Data Mining : 
We are living in the information age. The importance of collecting data that 
reflects one business or of activities that achieve competitive advantage, are 
widely recognized now. Powerful systems for collecting data and managing it in 
large databases are available in most organizations. However, the major 
bottleneck of converting this data into effective information is the difficulty faced 
in extracting knowledge about the system from the collected data. Modeling the 
investigated system discovering relations that connect variables in a database 
are the subjects of data mining. 
Data mining is the process of identifying valid, novel, potentially useful and 
ultimately comprehensible information from databases that is used to make 
crucial business decisions. Modern data mining systems self learn from the 
previous history of the investigated system, formulating and testing hypotheses 
about the rules, which the system obeys. When concise and valuable knowledge 
about the system of interest has been discovered, it can and should be 
incorporated into some decision support system which helps the manager make 
wise and informed business decisions. 
The main reason for needing automated computer systems for intelligent data 
analysis is the enormous volume of existing and newly appearing data that 
require processing. The amount of data accumulated each day by various' 
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businesses, scientific and governmental organizations around the world is 
daunting. Research organizations, academic institutions and commercial 
organizations create and store huge amounts of data each day. It becomes 
impossible for human analysts to cope with such overwhelming amounts of data. 
The other problems that surface when human analysts process data are: 

  The inadequacy of the human brain when searching for complex 
factorial dependencies in the data 

 The lack of objectiveness in analyzing the data  
 
A human expert is always a hostage of the previous experience of investigating 
other systems. Sometimes this helps, sometimes this hurts, but it is almost 
impossible to get rid of this fact. 
One additional benefit of using automated data mining systems is that this 
process has a much lower cost than hiring an army of highly trained (and paid) 
professional statisticians. While data mining does not eliminate human 
participation in solving the task completely, it significantly simplifies the job and 
allows an analyst, who is not a professional in statistics and programming, to 
manage the process of extracting knowledge from data. 
 
4. Online Analytical Processing (OLAP) : 
According to Business Intelligence Ltd., (httP://www.OlAPReport.com), OLlAP 
can be defined in five words - Fast Analysis of Shared Multidimensional 
Information. FAST means that the system is targeted to deliver most responses 
to users within about five seconds, with the simplest analysis taking no more than 
one second and very few taking more than 20 seconds. ANALYSIS means that 
the system can cope with any business logic and statistical analysis that is 
relevant for the application and the user, and keep it easy enough the target 
user. 
SHARED means that the system implements all the security requirements for 
confidentiality (possibly down to cell level) and, if multiple write access is needed, 
concurrent update locking at an appropriate level. MULTIDIMENSIONAL means 
that the system must provide a multidimensional conceptual view of the data, 
including full support for hierarchies and multiple hierarchies. INFORMATION is 
refined data that is accurate, timely and relevant to the user. 
Simply put, OLAP describes a class of technologies that are designed for live 
adhoc data access and analysis. While transaction processing (OLTP) generally 
relies solely on relational databases, OLAP has become synonymous with 
multidimensional views of business data. These multidimensional views are 
supported by multidimensional database technology and provide the technical 
basis for calculations and analysis required by Business Intelligence applications. 
 
OLAP technology is being used in an increasingly wide range of applications. 
The most common are sales and marketing analysis; financial reporting and 
consolidation; and budgeting and planning. Increasingly however, OLAP is being 
used for applications such as product profitability and pricing analysis; activity 
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based costing; manpower planning; and quality analysis; or for that matter any 
management system that requires a flexible, top down view of an organization. 
 
5. Supply Chain Management : 
A supply chain is a network of facilities and distribution options that performs the 
function of procurement of materials, transformation of these materials into 
intermediate and finished products, and the distribution of these finished products 
to customers. Supply chains exist in both service and manufacturing 
organizations, although the complexity of the chain may vary greatly from 
industry to industry and firm to firm. 
Traditionally, marketing, distribution, planning, manufacturing, and the 
purchasing organizations along the supply chain operated independently. These 
organizations have their own objectives, which are often conflicting. Marketing's 
objective of high customer service and maximum sales revenue conflict with 
manufacturing and distribution goals. Many manufacturing operations are 
designed to maximize throughput and lower costs with little consideration for the 
impact on inventory levels and distribution' capabilities. Purchasing contracts are 
often negotiated with very little information beyond historical buying patterns. The 
result of these factors is that there is not a single, integrated plan for the 
organization - there are as many plans as businesses. Clearly, there is a need for 
a mechanism through which these different functions can be integrated together. 
Supply chain management is a strategy through which such integration can be 
achieved. 
 

******** 
14. Write a note on Input and Output Devices ?  
Input Devices : 
Data and instructions must enter the computer system before any processing can 
be performed and the results of processing must be supplied to users. This 
requires input-output devices. They are also known as peripheral devices or 
peripherals because they surround the CPO. Input devices are used to enter 
data into primary storage. A variety of input devices are available and for a 
particular application. one type of device may be more desirable than another. 
Various input devices are classified into four categories: 
1. Keyboard : 
2. Pointing devices : 
(a) Mouse 
(b) Trackball 
(c) Joystick 
(d) Touch screen 
(e) Degitiz1ng tablet 
3. Source data automation : 
(a) Scanner 
(b) Bar code reader 
(c) Optical character reader 
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(d) Optical mark reader 
(e) Magnetic ink character recognition 
(f) Voice input device 
(g) Sensor 
KEYBOARD : 
Keyboard is an input device consisting of a set of typewriter-like keys that enable 
the computer operator to enter data into a computer. Computer keyboards are 
similar to electric typewriter keyboards but contain additional keys. The keys on 
computer keyboards are often classified as follows: 
1. Alphanumeric keys-letters and numbers. 
2. Punctuation keys-comma. colon. semicolon. period. etc. 
3. Special keys-function keys. control keys. arrow keys. caps lock key. etc. 
The standard layout of letters. Numbers, and punctuation is known a QWERTY 
because the first six keys on top row of letters is spelled QWERTY. In fact, the 
QWERTY keyboard was designed in the 1800s for mechanical typewriters and 
was designed to slow typist down to avoid jamming the keys. However, it is in 
practice in the same way today. Another keyboard designed which has letters 
positioned for speed typing is the Dvorak keyboard. The developers claim that 
their keyboards are easier to learn as compared to QWERTY keyboard. 
However, Dvoark keyboard is not widely accepted because most people have 
already learned the QWERTY keyboard. QWERTY keyboard is relevant for 
English language only and in languages other than English different patterns are 
followed. 
There is no standard computer keyboard although many manufacturers imitate 
the keyboards of PCs. There are three different PC keyboards - original PC 
keyboard with 84 keys; the AT keyboard also with 84 keys; and the enhanced 
keyboard with 101 keys. The three keyboards differ some what in placement of 
function keys, shift keys, control keys and return keys. Some new keyboards 
have 107 keys with new keys designed to simplify working with Windows 
operating systems. The speed and accuracy of data entry through computer 
keyboard depend on the efficiency of computer operator. Prolonged keyboard 
use can cause wrist problems to the computer operators. To overcome this 
problems ergonomic keyboards have been developed. An ergonomic keyboard is 
fully suited to human posture while operating the keyboard. One special type of 
keyboard is membrane-switch keyboard in which the keyboard is covered by the 
protective film. Membrane-switch keyboards are reliable durable and resistant to 
such hazards as liquids or grease. These keyboards are ideal in manufacturing 
situations that require lesser use of keyboard. 
POINTING DEVICES : 
Many computer operators use pointing devices in place of keyboards whenever 
possible. Pointing devices minimize the amount of typing errors and relieve the 
operator from developing wrist problem. The main pointing devices are mouse, 
trackball, joystick, touch screen and digitizing tablet. 
Mouse : 
Mouse is a palm-size device with a ball built into the bottom. It is called mouse 
because it functions as a natural mouse. that is. it moves here and there very 
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fast. A mouse is usually connected to a computer by a cable and may have one 
to four buttons. but usually two. Out of these two buttons, mostly left side button 
is used. As the computer operator moves the mouse, the pointer on the display 
screen moves in the same direction. 
Mouse is one of the great breakthrough in computer ergonomics because it frees 
the user to a large extent from using the keyboard. In particular, the mouse is 
important for graphical user interfaces because the user can simply point to 
options and objects and click a mouse button. Such applications are often called 
point-and-click programs. The mouse is also useful for graphics programs that 
allow users to draw pictures by using the mouse like a pen pencil or paint brush. 
There are three basic types of mouse-mechanical, optomechanical and optical. 
 
Mechanical Mouse : Mechanical mouse has a rubber or metal ball on its bottom 
that can roll in all directions. Mechanical sensors within the mouse detect the 
direction the ball is rolling and move the screen pointer accordingly. 
Optomechanical Mouse : Optomechanical mouse functions in the same way as 
a mechanical mouse does but it uses optical sensors to detect motion of the ball. 
instead of mechanical sensors. 
Optical Mouse : Optical mouse uses a laser to detect the mouse's movement. 
Optical mouse has no mechanical moving parts but the user must move the 
mouse along a special mat with a grid so that the optical mechanism has a frame 
of reference. An optical mouse responds more quickly and precisely as 
compared to mechanical or optomechanical mouse but it is more expensive. 
A mouse is connected to a microcomputer in one of the following three ways: 
1. Serial mouse is connected directly to an Rs-232C serial port or a PS/2 port. 
This is the simplest type of connection. 
2. Bus mouse is connected to the bus through an interface card. This is 
somewhat more complicated because the user needs to configure and install the 
expansion board. 
3. Cordless mouse is not physically connected to the computer at all. Instead, it 
relies on infrared or radio waves to communicate with the computer. The choice 
between the first two connections depends on whether the user has a free serial 
port. If he has, it is usually simpler to connect a serial mouse. Cordless mouse is 
more expensive than serial or bus mouse but it eliminates the cord which can 
sometimes get in the way. 
The use of mouse requires a mouse-pad over which the user can move the 
mouse. A mouse-pad provides more friction than smooth surfaces such as glass 
or wood. A mouse-pad makes it easier to move a mouse accurately. For an 
optical mouse, a special mouse-pad that has grids drawn on it is required. 
Trackball : 
Trackball is another pointing device which functions essentially like a mouse. To 
move the pointer. the user rotates the ball with his thumb, fingers, or the palm. 
Like mouse, a trackball has one to three buttons. In some computer systems, 
trackball has been replaced with a red plastic button called a trackpoint which is 
located in the middle of the keyboard. 
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The main advantage of a trackball over a mouse is that it requires less space as 
it is stationary. Further, the trackball can be placed on any type of surface. For 
these reasons, trackballs are becoming popular pointing devices. In fact, some 
people of the computer industry believe that the mouse will soon be replaced by 
devices that do not require much space to use. 
Joystick : 
Joystick has a gearshift-like lever that is used to move the pointer on the 
computer screen. A joystick is similar to a mouse, except that with the mouse the 
cursor stops moving as soon as the user stops moving the mouse. In the joystick 
the pointer continues moving in the direction the joystick is pointing. To stop the 
pointer the user must return the joystick to its upright position. 
Joystick device is often used for playing games on computers. In business, 
joysticks are used to control robots. Flight simulators and other training 
simulators also use joysticks. 
Touch Screen : 
Touch screen is a type of display screen that has a tough-sensitive transparent 
panel covering the screen. If enables the user to select an option by pressing a 
specific part of the screen. Instead of using a pointing device like mouse, 
trackball or pen, the user can use his finger to point directly to objects on the 
screen. Touch screen system is commonly used in grocery stores, fast-food 
restaurants, information kiosks, etc. 
Although touch screen system provides a natural interface for computer devices, 
it is unsatisfactory for most of the applications because the finger is such a 
relatively large object that it is not possible to point accurately to small areas of 
the screen. 
 
Digitizing Tablet : 
Digitizing tablet also known as digitizer graphics tablet or touch tablet, is an input 
device that enables the user to enter drawings and sketches into the computer. A 
digitizing tablet consists of an electronic tablet and a cursor or pen. A cursor, also 
called puck, is similar to a mouse, except that it has a window with cross hairs for 
pinpoint placement. It can have as many as 16 buttons. A pen, also called stylus, 
looks like a simple ballpoint pen but uses an electric head instead of ink. 
Electronic tablet contains electronics' that enables it to detect movement of the 
cursor or pen and translate the movement into digital signal that is sent to the 
computer. 
A digitizing tablet has different points and each point represents a point on the 
display screen in a fixed manner. This differs from a mouse in which a movement 
is relative to the current cursor position. The static nature of the digitizing tablet 
makes it particularly effective for tracing drawings.  
 
SOURCE DATA AUTOMATION 
Source data automation is a technology that captures data in computer readable 
form at the time and place the data are created. The main advantage of source 
data automation is that the errors that occur when people use keyboards to enter 
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data are almost eliminated. Further, it makes data entry operation fast. Source 
data automation devices can be divided into three broad categories; 
1. Scanner. 
2. Voice input device. 
3. Sensor. 
Scanner : 
A scanner is basically an input device that is capable of recognizing characters. 
marks. and pictures. Thus, it can be used for direct data entry into the computer. 
A scanner reads the printed surface and translates it into machine codes. 
Scanners can be broadly classified into two broad categories-optical scanners 
and magnetic ink character recognition scanners. Optical scanners are of three 
types-bar code reader, optical character reader, and optical mark reader. 
 
Bar Code Reader : Data coded in the form of light and dark lines are known as 
bar codes. Bar codes are used particularly by the retail trade for labelling goods 
and for stock control. They are also used for numbering books. A bar code 
reader is a device used for reading bar codes. It is a scanner linked to a 
computer which uses laser beams for reading bar codes. The laser beams are 
stroked across the pattern of bits which are recorded as input data. 
 
Optical Character Reader : An optical character reader (OCR) reads alphabetic 
and numeric characters printed on paper. These characters may be either 
typewritten or handwritten. However, in the case of handwritten characters, 
special care has to be taken to ensure that the characters are of standard size, 
lines making up the characters are connected, and no stylish loops are made. An 
OCR examines each character as if it were made of a collection of minute spots 
(pixels). Once the whole character has been scanned, it is compared with the 
characters the machine has been programmed to recognize. Whichever pattern it 
matches or nearly matches, is considered to be the character read. OCRs are 
used mostly by publishing and printing industry. These can also be used for 
office automation if the volume of work justifies their use. 
 
Optical Mark Reader : An optical mark reader (OMR) recognizes specified types 
of marks made by pencil/pen. For recognizing marks, an OMR focuses light on 
the page being scanned and detects the reflected light pattern from the marks. 
The presence of a mark is indicated by drop in light. This method is applied 
where marks are made by any instrument other than a graphite pencil. For 
recognizing marks made by a pencil. Residing process is used in which marks 
are determined by conductivity of graphite. OMRs are used for evaluating answer 
sheets having answers marked by pens/pencils. 
For recognizing pictures and other graphics. flatbed scanners are used which 
function on the principle of reflectance of light. 
Magnetic Ink Character Recognition : Magnetic ink character recognition 
(MICR) devices have been developed primarily for banking sector for processing 
cheques/drafts. MICR devices can be used to process only those cheques on 
which numeric codes are printed by using magnetic ink which contains 
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magnetize able particles of iron oxide. The most commonly used character set by 
MICR devices is known as E13B that consists of the numerals 0 to 9. Coded data 
in the form of these fonts are transferred from cheques to the computer by a 
MICR reader and sorter. When a cheque enters the reading unit, it passes 
through a magnetic field which causes the particles in the ink to become 
magnetized. Read heads then interpret these characters by examining their 
shapes. The sorter is used to sort the cheques into different pockets according to 
their identification numbers. 
To process the amount of cheques either keyed input is used or the amount can 
be encoded by a bank employee in the lower right corner of a cheque before it 
goes for processing. 
 
Voice Input Device : 
Voice input device makes it possible to communicate with a computer orally. This 
is known as voice recognition system which consists of a microphone that 
converts human voice into electrical signals. A signal pattern is transmitted to the 
computer where it is matched against presorted patterns to identify the input. The 
set of pre-stored patterns is known as the vocabulary of the system. To build this 
vocabulary, the system has to. be programmed to recognize words and phrases 
that are present in the vocabulary. Voice recognition systems though in their 
infancy stage have wide application where people want to communicate orally 
with the computers. 
Sensor : 
A sensor is a device that collects data directly from the environment for input into 
a computer system. For example. sensors are used to measure the intensity of 
earthquakes. Similarly. sensors are used to measure environmental pollution 
caused by smokes, dirts. etc. In business, sensors are not used for input meant 
for information systems. However, many  vehicle manufacturers deploy sensors 
along with computers and screens in their vehicles that display the surrounding 
area, driver's routes, and vehicle's location.  For example, many models of cars 
manufactured by General, Motors have sensors, computers, and screens. 
 
Output Devices : 
Output is anything that comes out from a computer as a result of input 
processing. Most computer output can be divided into two categories-soft copy 
and hard copy. Soft copy is in the form of visuals and voices which can be only 
seen or heard and cannot be stored. Soft copy is in some physical form which 
can be used again and again. for example, printed paper. A soft copy can be 
converted into a hard copy with the help of output devices. An output device is 
any machine that is capable of representing information from a computer. Output 
devices include the following: 
1. Monitor. 
2. Printer, 
3. Plotter. 
4. Audio output device. 
5. Computer output microfilm. 
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Monitor : 
Monitor is the term used for the display screen. However, the term monitor 
usually refers to the entire box, whereas the display screen means just the 
screen. There are different types of monitors and they can be classified on the 
basis of colour capabilities and size. 
Colour Capabilities : On the basis of colour capabilities, monitors can be 
classified into monochrome and colour. A monochrome monitor displays two 
colours, one for the background and one for the foreground. The colours may be 
black and white, green and black, or amber and black. The most usual colour 
combination is black and white. That is why monochrome II monitors are called 
black and white monitors. A colour monitor can display anywhere from 16 to 1 
m1llion different colours. Colour monitors are sometimes called RGB (red. green. 
and blue) monitors because they accept three separate signals-red, green and 
blue. The colour monitor differs from the colour television as the latter uses 
composite video signals, In which all the colours are mixed together. An RGB 
monitor consists of three electron guns-one each for red, green, and blue-at one 
end of the screen. 
The three electron guns fire electron at the screen which contains a phosphorous 
coating. When the electron beams excite the phosphors, they glow. Depending 
on which beam excites them, they glow red, green or blue. Ideally, the three 
beams should converge for each point on the screen so that each pixel (picture 
element) is a combination of the three colours. 
Monitor Size: Monitors come in different sizes. Monitor size, like television size. 
is measured from one corner of the screen to its opposite corner, and the 
measurement is expressed in inches. Monitors of 14 inches and larger than 
these are cathode-ray tube (CRT) monitors. CRT monitors are most widely used 
for video display devices. The smaller monitors that are used on laptop and 
notebook computers are known as flat-panel displays. 
Common types of flat-panel displays include liquid crystal display (LCD), electro-
luminescent (EL) display, and gas plasma display. 
In order to connect a monitor to a computer, graphics adapter board, I also 
known as a video card. is used. Each type of monitor requires a ; different type of 
board. The graphic board plugs into an expansion slot I inside the computer, and 
the monitor plugs into the board. For running graphics-intensive programs 
properly and quickly, most graphics boards come with some memory capability. 
known as video memory. 
PRINTER : 
A printer is an output device in the computer system that produces hard copy of 
output on paper (mostly), transparency, and other media. Printer is the only 
means of written-printed communication between the user and the computer as 
this translates the computer's Internal character representation Into alphanumeric 
Information familiar to the user. Though some printers can print graphics and 
pictures but their quality is low. 
Therefore, for such purpose, plotters are used. Printers are categorized by 
whether anything mechanical actually touches the paper; whether they do or do 
not produce a solid character; and whether they produce a character, a line, or a 
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page at a time. On the basis whether anything mechanical touches the paper or 
not, printers are divided into two categories-impact printer and nonimpact printer. 
These Impact and nonimpact printers can print a character, a line or a page at a 
time depending on their technology. 
Impact Printer : 
When a part of printer presses the paper to form the character, the printer Is 
considered as Impact printer. Impact printers can produce copies along with the 
original printing. Impact printers are fairly loudy, although covers are available to 
muffle the noise. Impact printers can print a character or a line at a time. There 
are four types of impact printers-dot-matrix printer, letter-quality printer, chain 
printer and drum printer. 
Dot-Matrix Printer : A dot-matrix printer prints one character at a time and each 
character as a pattern of dots. Dot-matrix printers do not have a fixed character 
form. Therefore. they can print any shape of character that a programmer can 
describe. This enables the dot-matrix printers to print text as well as graphics. 
such as charts and graphs. The print head comprises a matrix of tiny needles. 
typically 7 rows with 9 needles each. which hammer out characters in the form of 
pattern of tiny dots. The shape of each character is obtained from information 
held electronically in the printer. 
The print quality of dot-matrix printers is inferior than letter-quality printers but 
dot-matrix printers are generally faster with speed ranging from 40 to 250 
characters per second. These printers are comparatively cheaper. Therefore, if 
print quality is not a prime consideration. dot-matrix printers are more suitable. 
Letter-Quality Printer : A letter-quality printer prints a character at a time. It 
uses a print wheel font, known as a daisy wheel. A daisy wheel consists of 
several petals and different characters are embossed on different petals. A motor 
spins the wheel at a rapid rate. When the desired character spins to the desired 
position. a print hammer strikes it to produce the character. The output of a letter-
quality printer resembles a typed output and the quality of printing is superior to a 
dot-matrix printer. The speed of a letter-quality printer is slower as compared to a 
dot-matrix printer and ranges from 10 to 50 characters per second. 
Chain printer : A chain printer uses a rapidly moving chain known as print chain. 
Each link of the chain is a character font. For each possible print position. there is 
a print hammer located behind the paper. As the print chain rotates. the properly 
timed print hammer strikes the paper, along with the ribbon against the proper 
character on the chain. Speed of chain printer ranges from 400 to 2500 
characters per minute. 
Drum Printer : A drum printer is basically a line printer which prints a line at a 
time. A drum printer consists of a solid, cylindrical drum that has raised character 
in bands on its surface. There are as many bands as there are printing positions. 
Each band contains all the possible character. For each possible print position. 
there is a print hammer located behind the paper. The drum rotates at a rapid 
speed and the hammer strikes the paper along with the inked ribbon against the 
proper character on the drum as it passes. One revolution of the drum is required 
to print each line. Typical speed of drum printers ranges from 300 to 2000 lines 
per minute. 
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Nonimpact Printer : 
A nonimpact printer does not presses or strikes the paper but ink used for 
printing is spread by some other means. A nonimpact printer can produce only 
original and cannot produce a carbon copy. Because of their quality of print and 
speed of printing. nonimpact printers are increasingly becoming more popular. 
There are two types of nonimpact printers-ink jet printer and laser printer. 
Inkjet Printer : An inkjet printer is a character printer in which electronically 
charged ink is spread through a jet nozzle and passed to an electronic field which 
deflects the ink to form a character. Inkjet printer produces high quality output 
because the characters are formed by dozens of tiny dots. 
Inkjet printers can produce mult1-colo~r print. The document printed by an inkjet 
may contain multiple character styles and variety of type sizes. However, the 
speed of inkjet printers is considerably slower. 
Laser Printer : A laser printer prints one page at a time. It works in the same 
manner as a photocopy machine works. In laser printers. a laser beam creates 
electrical charges that attract toner to form an image and transfer it to paper. The 
print quality of a laser printer is of high level and its printing speed is also high. 
The speed of laser printers ranges from about 4 to 20 pages of text per minute. A 
typical rate of 6 pages per minute is equivalent to about 400 characters per 
second. However, a laser printer is the costliest printing device. Therefore, laser 
printers are suitable only for those applications where high quality printing in high 
volume is required. 
PLOTTER : 
A plotter is an output device that produces hard copies of graphs and designs 
based on commands from the computer. A plotter differs from a printer in that it 
draws line using a pen. As a result, it can produce continuous lines, whereas a 
printer can only simulate lines by printing a closely spaced series of dots. Plotters 
are basically of two types-drum plotter and flatbed plotter. 
Drum Plotter : In the case of a drum plotter, the paper on which the design has 
to be made is placed over a drum that rotates back and forth to produce vertical 
motion. The mechanism also consists of one or more pen holders mounted 
horizontally across the drum. The pen(s) clamped in the holder(s) can use to 
produce horizontal motion. The drum and the pen move simultaneously to 
produce the design and the graph. In order to produce multi-coloured designs. 
pens having inks of different colours can be mounted in different holders. 
Flatbed Plotter : A flatbed plotter plots on paper that is spread and fixed over a 
rectangular flatbed table. In flatbed plotter system. the paper does not move and 
the pen holding mechanism is designed to provide all the motions. In the case of 
flatbed plotter. pens for different colours can be mounted which are used for 
multi-coloured plotting. The plot size is restricted by the area of the bed. Some 
beds may be as small as A4. size while some beds may be very large and can 
be upto 20x50 feet. These large beds are used in the design of cars, ships, 
aircrafts, buildings, highways, etc. 
Plotters are normally very slow in motion because of excessive mechanical 
movement required during plotting. Therefore, there is a mismatch between the 
speed of CPU and the speed of a plotter. In order to overcome this mismatch 
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problem, in most cases, output is first transferred by the CPU to a tape and the 
plotter is activated to plot the design from the information contained in the tape. 
However, in the case of a computer system dedicated to design work. the CPU 
may send output directly to a plotter. 
AUDIO OUTPUT DEVICE 
Audio output device, also known as audio response device, is an output medium 
that produces verbal output from the computer system. In an audio output 
system, all the sounds are needed to process the possible enquiries on pre-
recorded storage medium. Each sound is given a code. 
When enquiries are received, the computer follows a set of rules to create a reply 
message in a coded form. This coded message is then transmitted to an audio 
output device which assembles the sound in the proper sequence and transmits 
the audio message back to the station requesting the information. 
Audio output devices have a number of applications ranging from toys that 
entertain young children to businesses that are using audio output devices, such 
as banking, Insurance, Telephone, Railways, airports, etc. 
COMPUTER OUTPUT MICROFILM 
Computer output microfilm (COM) technology is used to record computer output 
information as microscopic film images. In COM. the information is recorded 
either on a sheet or roll of microfilm. A sheet of film measuring 4. x 6 inches is 
called a microfiche. (Fiche is a French word meaning card and is pronounced as 
'fish'.) An ordinary microfiche is capable of holding 270 frames (pages of 
information) while an ultrafiche can store about 1.000 frames in the same space. 
Microfilm comes in the form of a roll. 
Rolls of 16 or 35 mm film packaged in cartridges are also used for COM 
recording. COM recording devices store characters that are about 4.8 times 
smaller than those produced by conventional printers. 
A COM recording device consists of a microfilm recorder that receives 
information either stored on magnetic tape/disk or directly from the CPU. After 
receiving the information, the reader projects the characters of output information 
on a CRT screen. A high speed camera. in-built into the system takes the picture 
of the displayed information. In some systems, the recorder processes the film 
from the camera and in other systems, a separate automated film developer is 
used. When the film is required in many copies. a film duplicator is used. For 
reading the contents of the microfilm or microfiche. a special device known as 
microfilm reader is used. The microfilm operates on a back projection principle 
displaying a frame at a time on a translucent screen, typically about A4 size. 
Some COM systems also use a reader-printer combination to produce a hard 
copy of what is displayed on the screen. 
A COM system is ideal for use in applications where there is a large amount of 
Information to be retained such as manuals. Industrial catalogues and archives. 
Where companies need to retain records of such things as bills and invoices for a 
number of years. also find COM system useful. Generally, banking and 
Insurance companies, government agencies, public utilities and many other 
types of organizations are regular users of COM. 
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 Chapter  13 
 
 

MS  DOS  Operating System 
 
1. Introduction : 
 
Disk Operating (DOS) System is most important software for IBM personal 
computers (PC) or compatibles. Like any other operating system, DOS controls 
all activities on a computer. It decides where in memory to load any programs, 
transfers files from hard disk to memory, accepts data from keyboard, displays 
information on the screen, handles printing and so on. 
 
There are two main types are DOS operating systems available for use : MS-
DOS and PC-DOS.  Both are developed by Microsoft corporation.  
 
PC-DOS was developed specifically for IBM PC. Microsoft still owns PC-DOS 
and earns large amount of royalty fees from IBM. MS-DOS is very similar to PC-
DOS but Microsoft sells it to IBM clone manufacturers or directly to customers. 
Both MS-DOS and PC-DOS are very similar.  
 
When we switch on the computer, the computer will try to find DOS. It checks 
disk drive A first (you may notice the light glow of drive A) although the DOS 
installed in disk drive C (hard disk). After the disk drive C is accessed and 
searched. If DOS is found, it is loaded automatically in to the memory (RAM). 
This process is called booting up. Now you will see the DOS command prompt 
as follows : 
 
 C> _  
 
Alternately your computer may booted up to Microsofts Windows operating 
system if it has been set up in your system. In such case you can boot up MS-
DOS from Start menu and then from Programs. Now also you will see the DOS 
command prompt as follows : 
 
 C> _  
 
The DOS command prompt is a prompt for you to type a DOS command. It is 
also sometimes called the System prompt. The letter C is the current disk drive. It 
can be A or B, if you log on to one of these floppy disk drives. Drive C is usually 
the hard disk and is default drive.  The greater-than symbol (>) just tells you that 
this is where you should type your DOS commands. The small flashing dash (_) 
after it is called a cursor. This is where the first character you type will appear. 
The cursor will also move to the right automatically, ready to receive the next 
character, and so on.  This invisible line where DOS commands are typed is 
referred to as the Command Line. 
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2. DOS Basic Commands : 
 
All DOS commands have a structure or a format. Each command is made up of 
up to three parts. Command, Parameters, Options or switches. For example, 
consider following DOS command : 
 
C> dir  a : / w 
 
Here, “dir” is the command part, “a :” is the parameter, and “/w” is the option or 
switch part.  
The parameter “a :” indicates that you want to see the files in the disk in A drive. 
The /w switch will display the directory in wide format, occupying up to five 
columns.  
 
I. Commands for Displaying Directory :- 
 
The DIR command can be issued in number of formats given bellow : 
 
DIR                                                      DIR  A:  
 
DIR /P                                                  DIR  A:  /P 
 
DIR  /w                                                 DIR A: /w 
 
 
To read a pure text file (also called ASCII file) of name say aithal, type : 
 
C> type  aithal.txt 
 
II. Changing disk drives :- 
 
To access another disk drive, type the letter designated to represent the drive 
followed by a colon. For example, to access the A floppy disk drive, type : 
 
C> a: 
 
Ensure that you have inserted a floppy disk into your drive A before accessing it. 
 
To access the C drive (hard drive), type :  
 
A>  c: 
 
III  Making the Directory :- 
 
For creating a new directory type the command as  
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C:\> MD  BOOK 
This will create new subdirectory by the name BOOK. 
 
IV. Changing the Directory :- 
 
In DOS operating system, the main directory (say c) is called the root 
(represented by a backslash “\” symbol) and all other directories are sub-
directories. A sub-directory from the root can also have other sub-directories and 
so on. ( This is exactly like folders, sub-folders in windows operating system.) 
 
For example,  
 
C> cd \ accounts 
 
This changes the directory to accounts which exists directly under root. 
 
C> cd \ accounts \ feedata 
 
This changes the directory to feedata which exists under accounts. Note that the 
whole path needs to be specified. 
 
The following command changes the directory to the root : 
 
C>  cd \  
 
The CD command is a short version of CHDIR command, standing for Change 
Directory.   
 
DOS hierarchy is : 
 
Drive -> Directory  -> Sub Directory  -> File name 
 
For example, 
 
C:\letters\personal\raju.txt 
 
V.  Changing Computer Date and Time : 
 
You can change or set correct date and time on your PC or just check it ! by 
typing : 
 
C> date 
 
Then the system will display the current date  as follows : 
 
 Current date is Tue  21 – 02 – 2003 
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 Enter new date (dd-mm-yyyy) : _ 
 
 
To reset the date to 4th March 2003, type : 
 
  04 – 02 – 2003 
 
If the date is correct and you don’t want to change it, just press the Enter key.  
 
To check the current time type : 
 
C> time 
 
The computer may display : 
 
 Current time is 10 : 37 : 29.56a 
 Enter new time :_ 
 
To set the new time to 3.45 p.m. say, type : 
 
15 : 45 
 
Since, the computer has 24-hour clock, you have to do so. You need not change 
the second and hundredth of the second. 
 
DOS versions : 
 
If you don’t know which version of DOS you have installed on your computer, just 
type : 
 
C> ver 
 
Now DOS will tell you whether it’s version is 2.0, 2.1, 3.1, 3.2, 4.0, 5.0, 6.0, 6.2 
etc.  
 
Clearing the Screen : 
 
To clear the screen quikly (!) type :  
 
C> cls 
 
Now whole screen will clear.  
 
Help on a DOS command : 
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For DOS version 5 and above, you can use the HELP command followed by 
DOS command to obtain information on how to use specific command (including 
the parameters and options you can use). For example : 
 
C> help  dir  or  dir / ? 
 
Help on its own will display all commands alphabetically.  
 
The Prompt Command : 
 
When you are moving around different directories at the command prompt, it is 
difficult to know which directory / subdirectory you are using at a time. To solve 
this, the PROMPT command can be used to change the DOS command prompt 
and give you this information. For this type :  
 
C> prompt $p$g 
 
This changes the command prompt to display current directory too. For example, 
when you are at the root directory, the command prompt will look like :  
 
C : \ > 
 
The \ again indicating that it is the root directory. If you change to aithal 
directoary, the command prompt changes to : 
 
C : \ aithal > 
 
Changing the directory again to PERSONAL will show : 
 
C : \aithal \ PERSONAL >  
 
IV. Internal and External Commands : 
 
There are two types of DOS commands that you can issue at the DOS 
command prompt : internal and external. Internal commands include : 
 
   COPY,  DEL,  DIR,  TYPE, COPY, MD, CD, DATE, TIME, CLS etc. 
 
These commands can be issued from any disk drive or directory because they 
are in the computer’s memory (RAM).  
 
External commands, however, are not in the memory  to start with. They resides 
as separate files on hard disk; one for each command. When you issue an 
external command, the relevant file has to be located and loaded into memory 
from disk – just like when you want to run a program.  Examples for external 
commands include : 
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   BACKUP,  CHKDSK,  FORMAT,  UNDELETE, DIDKCOPY, MOVE etc. 
 
VI  Basic File Commands : 
 
DOS manages Files are basic units of information. All your work is stored in a 
number of files. These files include word processor documents, spreadsheet 
forecasts and graphic illustrations.   
 
1. Naming MS –DOS Files : 
A DOS file name is divided into two parts : 
*  The file name, which identifies the specific contents of a file.  
*  An optional extension, which identifies the type of the contents.  
   For example  :      srinivas.txt 
                                Book.EXE 
Following rules are used to govern the file name : 
(1) The file name can not exceed 8 characters in length (1-8 characters). 
(2) The extension portion can not be more than 3 characters (0-3 characters). 
(3) You have to use a period to divide the file name from extension. 
(4) You can not include a blank space in either the file name or extension portion. 
(5)  A file name and name extension can contain alphabet, as well as numbers 

and they can start with alphabet or number. 
(6) You can not use certain characters like “/ \ [ ] ! < > + : = ; ? “ 
(7)  A file name can not contain more than one period symbol. 
(8)  A file can not have same name as another file in the same directory. 
(9)  A file name can not be from following reserved words. These words have 

special use for the DOS. These are AUX, COM, CON, LPT, PRN. 
          
 
File name extension for different software are as follows : 
 
1.  BAK      - Back-up file, when a file is saved after some change, old file is 
renamed with .BAK extension 
2. BAS   -  Basic language programs. 
3. BAT  -  DOS Batch files. 
4. BIN  -  Binary files. Files that contains instructions to computer. 
5. CDR  -  Coreldraw files 
6. CHK  -  File created by DOS CHKDSK command. 
7. COM -   Command file, a file contain instructions for DOS execution. 
8. DAT   -  Data file. 
9. DBF  -   Data file created by DBase program. 
10.  DBT  - Data file created by DBase program. 
11.  DLL  - Dynamic Link Library, files that contain instruction for computer, used 

by Windows program. 
12.   DOC -  Document files, contain text. 
13.   EXE  -  Executable file, instructions executed by DOS. 
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14.   FNT  -  Font file. 
15.   GIF   -  Graphic Image File. 
16.   HLP  - Help file. 
17.   LBL   -  Label file, created by dBase program. 
18.   NDX  -  Index file for data, created by dBase program. 
19.   OVL  -  Overlay file. Files that contain instruction for computer. 
20.   PIF   -  Program Information file, used by Windows. 
21.   PRG  -  Program files contains dBase program. 
22.   SYS  -  System files, used by DOS, contain instruction for computer. 
23.   TIF  -  Tagged Image Information File, image files. 
24.   TTF  -  True Type Font file, font file used by Windows 
25.   TMP  -  Temporary file used by many programs. 
26.   WK1  -  Spreadsheet file, used by Lotus 1-2-3 program. 
27.   ZIP  -  File compressed using the PKZIP program. 
28.    $$$  -  Temporary file created by many programs. 
 
2. To see a Directory : 
 
Type  DIR *. *  on command line. This will list all the file contained in that 
directory. 
 
If you type  DIR * .EXE on command line, all the files with extension EXE will be 
listed. 
 
If you type DIR  A *.*  on command line, all the files beginning with A will be 
listed. 
 
 
3. Copying just one File : 
 
Using the COPY command you can easily copy a file. For this you want to know 
the name of the file and where you want to copy it to.  For example, to copy a file 
named srinivas.txt from your hard disk C to a floppy disk A, type : 
 
C> copy srinivas.txt a: 
 
This assumes that you are issuing the COPY command from the appropriate 
directory in your C disk. If you are not in that directory, prefix the filename with 
the correct path : 
 
C> copy  c : \ aithal \ teaching \ srinivas.txt  a: 
 
The path can also be specified on the other side (the destination side) of the 
command. For example, 
 
C> copy c : \aithal \ teaching \ srinivas.txt  b : \ mis 
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4. Formatting a Disk : 
 
Type FORMAT  Disk Name. For example, 
 
C:\> FARMAT  A: 
 
This will format the floppy inserted in Drive A. 
 
 
5. Assigning Label to a Disk : 
 
To label a disk after formatting and storing some files following command can be 
used : 
 
C:\> label  a: ACCOUNTS_2000 
 
 
6. System Disk Formatting : 
 
While formatting a disk, it is possible to copy the main DOS system files to it too.  
For this : 
 
C:\> format a:  /s 
 
The system program will be copied in formatted floppy disk. 
 
If you want to copy entire system DOS program to a already formatted floppy, 
use following command : 
 
C:\> sys  a: 
 
The above command is same as /S option on the FORMAT command. 
 
 
7. Duplicating a Disk : 
 
To duplicate a disk from drive A (source) to a disk inserted in drive B (target), 
type : 
 
    C :\> diskcopy  a :  b : 
 
If you only have one disk drive and you want to duplicate a disk, type : 
C;\>  diskcopy  a :  a : 
 
First insert source disk and then the target disk. 
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8. Comparing Disks : 
 
If you want to compare the content of two disks after DISKCOPY operation, use 
DISKCOMP command. 
 
C> diskcomp a:  b: 
 
For DOS version 5 and above, instead of DISKCOMP, after DISKCOPY, type 
following single command. 
 
C> diskcopy a:  b:  /v 
 
9. Working with Hard Disk : 
 
For formatting hard disk  type on command line 
 
C> format C: 
 
To make hard disk ready after purchasing a new computer, use FDISK 
command. 
 
C:\> FDISK  ↵ 
 
This will start FDISK program and display the FDISK main menu on the screen. 
You can choose various options from menu. 
 
FDISK command is mainly used to partition a hard disk drive, to divide a hard 
disk drive into number of logical drives. However, even if you do not want to 
divide the hard disk into number of smaller partitions, you must use the FDISK 
program and specify the complete hard disk drive as a single partition. 
 
For checking disk (status of files and directories) type 
 
C> chkdsk 
 
To compress the disk to increase the disk space (only in versions 6 and above) 
you can use Double space command. 
 
C> dblspace 
 
You can use the DBLSPACE command with following switches : 
 
DBLSPACE/COMPRESS Compress a hard disk drive or floppy 

disk. 
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DBLSPACE/CREATE Create a new compressed drive in the 
free space on an existing drive. 

DBLSPACE/ DEFRAGMENT Defragment a compressed drive. 
DBLSPACE/ DELETE Delete a compressed drive. 
DBLSPACE/ FORMAT Format a compressed drive. 
DBLSPACE/INFO Display information about compressed 

drive. 
DBLSPACE/ LIST Display a list of drives on ypur 

computer. 
DBLSPACE/ MOUNT Mount a compressed Volume File 

(CVF) 
DBLSPACE/ RATIO Change the estimated compression 

ratio of a compressed drive. 
DBLSPACE/ SIZE Change the size of a compressed drive 
DBLSPACE/ UNCOMPRESS Uncompress a compressed drive. 
DBLSPACE/ UNMOUNT Unmount a compressed drive. 
 
 
For scanning the hard disk, to analyze and repair problems,  
 
C> scandisk C: 
 
10. Moving files : 
 
To move a file from one directory to another : 
 
C> move myfile.doc  \ windows 
 
Here, Myfile.doc will move from the current directory to the windows directory. 
 
If file with same name exist in that directory, it will be over-written. 
 
11. Renaming Files : 
 
To rename the file without making a copy of it, use REN command : 
 
C> ren aithal.txt  aithal.new 
 
First filename typed after REN will be renamed as second filename. 
 
You can use wildcards to rename several files 
 
C> ren  *.txt  *.old 
 
All files in the current directory ending with .txt will be renamed with a new file 
extension, .old. 
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12. Deleting Files :  
 
To delete files use either DEL  or ERASE commands. 
 
C> del srinivs.txt 
 
To delete all the files in that disk use wildcard 
 
C> del *.* 
 
13.   Undeleting Files : 
 
To undelete the deleted file, use UNDELETE command. 
 
C> undelete  srinivas.txt 
 
By typing undelete /list, one can list  the list of all files that can be recovered. 
 
C> undelete / list 
 
C> undelete /all        This will recover all deleted files. 
 
14.  Printing Files : 
 
To print a text file from DOS, type : 
 
C> print srinivas.txt 
 
Another easy way to print text files is to use the COPY command : 
 
C> copy srinivas.txt prn 
 
This will copy the srinivas.txt file to your printer, designated by prn. 
 
15.  Virus Scanning  : 
 
MSAV (Microsoft Anti Virus) command is used to scan files on your storage 
device for known viruses.  The following command scans the disk in the A: drive 
for known viruses. 
 
C : \> MSAV  A :  ↵ 
  
The following command scan the disk in drive A and remove any virus found. 
C:\ > MSAV  A :/C  ↵ 
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VSAFE is a memory – resident program which continuously monitors your 
computer for virus like activity and displays warning when it finds any. 
 
This is an external command. 
 
C : \ > VSAFE  ↵ 
 
The above command will install the VSAFE in the computer’s memory. 
 
If you want to remove the VSAFE from memory use following command. 
 
C:\> VSAFE / U ↵ 
 
16.  GRAPHICS  - Printing Graphics 
 
GRAPHICS  command loads a memory resident program GRAPHICS.EXE into 
the memory. This program allows DOS to Print the graphics displayed on screen 
to a variety of printers.  This is an external command. 
 
The following command will load the program GRAPHICS.EXE into computers 
memory. Then you can use Print Screen (PrtSc Key) to print screen images to a 
printers. 
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4. Installing DOS : 
 
When you purchase DOS, it comes to you in a number of floppy disks. To install 
or to copy the DOS into your machine you need to copy the DOS from the floppy 
disk to the hard disk drive. 
 
This process of copying DOS from the floppy disk into your machine’s hard disk 
is called “Installing the DOS”. 
 
Once the DOS is installed on the hard disk drive, you will not require the DOS 
floppies.  Every time the computer is switched on, the computer will start the 
DOS from the hard disk drive.  
 
To install the DOS Do following steps : 
 
1. Turn off your computer, if  it is on. 
2. Insert the setup disk number 1, received with the DOS package, into drive A. 
3. Switch on the computer. 
4. Wait for sometime for the computer to load the DOS from the setup disk into 

the computers memory. At the end of this process you will see A:> prompt on 
the screen. 

5. Once the DOS prompt comes on the screen, type SETUP and press Enter 
key as shown below : 
A : \ > SETUP ↵ 

6. This will executes the DOS installer program SETUP.  Now follow the 
instructions appearing on the screen, given by the SETUP program. 

7. To check that the install is done properly, remove the floppy disk from the A : 
drive, and switch off the computer. Now switch on the computer without the 
DOS disk in A : drive. 

8. If the install process was successful then the DOS should be started from the 
hard disk without any trouble and you should get the DOS prompt  C: \> on 
the screen. 

 
5. Batch Processing : 
 
Batch Files : 
 
A batch file is basically a text file with .BAT extension, that contains one or more 
DOS commands, each command on a different lines. 
 
When this file is executed at DOS prompt, the commands in the file are taken by 
DOS, one at a time and executed. 
 
For example, if you have WordStar program in the WS directory then to use the 
WordStar, each time you need to type the following three DOS commands 
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C : \ > CD \ WS  ↵ 
 
(this will take you to WordStar Directory) 
 
C : \WS  \WS ↵ 
 
(This command will start the WordStar program) 
 
After using the WordStar,  to go back to root directory type 
 
C : \ WS> CD \ ↵ 
 
Instead of typing these three commands each time, you can use batch file 
W.BAT (you can use any primary name). 
 
To make the batch file for the above, you can use the following DOS command 
 
C : \ > COPY  CON  W.BAT ↵ 
 
Now type following DOS commands one after another.  
 
CD \ WS ↵ 
WS ↵ 
CD \  ↵ 
 
After typing the above three lines, in the fourth line, press Ctrl + Z keys and press 
the Enter key, this will take back to the DOS prompt. 
 
^ Z  ↵ 
 
C : \>  
 
Now you will have a batch file W.BAT on your directory. 
 
To execute /run this batch file type W at the DOS prompt and press Enter. 
 
C : \ W ↵ 
 
Now you can see that all three commands that you have typed in the W.BAT 
batch file, execute one after another. 
 
 
CALL – Calling one batch file from another batch file : 
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CALL command is used in a batch file to call one batch program from another 
without causing the first batch program to stop. 
For example, to run the START.BAT program from W.BAT program, include the 
following command in the W.BAT batch program. 
 
CALL START . BAT 
 
GOTO – Directing batch program flow to a line identified by a label : 
 
The GOTO command directs MS-DOS within a batch program to a line identified 
by a label. When MS-DOS finds the label, it processes the commands beginning 
on the next line. 
 
This command is used in only in batch programs. 
 
GOTO  label 
 
The label cannot include separator such as spaces, semicolons or equal signs. 
 
GOTO uses only the first eight characters of label. 
 
The label value specified on the GOTO command line must match a label in the 
batch program. 
 
MS DOS recognizes a batch-program line beginning with a colon (:) as a label 
and does not process it as a command. 
 
The following batch program formats floppy in drive A:. If the operation is 
successful, the GOTO command directs MS-DOS to a label named NOERROR, 
otherwise an error message is displayed. 
 
ECHO OFF 
FORMAT  A:/Q/U 
IF NOT ERRORLEVEL 1 GOTO NOERROR 
ECHO AN ERROR OCCURRED DURING FORMATTING. 
GOTO END 
:NOERROR 
ECHO SUCCESSFULLY FORMATTED DISK. 
:END 
 
 
REM – Including comments in a batch file or in CONFIG.SYS file : 
 
The REM command  can be used to add some remarks in the batch file and 
CONFIG.SYS files. 
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When using the remark in a batch file, use the following syntax : 
 
REM [string] 
 
The parameter [string] specifies the comment you want to add to batch file. 
 
ECHO – Display / Hide text in batch program : 
 
ECHO command displays or hides the text in batch programs when the program 
is running. It also indicates whether the command –echoing feature is on or off. 
 
When you run a batch program, MS DOS typically displays (echoes) the batch 
program’s commands on the screen. You can turn this feature on or off by using 
the following syntax of the ECHO command. 
 
ECHO  [ON/OFF] 
 
ON / OFF specifies whether to turn the command – echoing feature on or off. 
 
To use the ECHO to display a message, use the following syntax : 
 
ECHO  [MESSAGE] 
 
Message specifies the text you want MS – DOS to display on the screen. 
 
To display the current ECHO setting, use the ECHO without a parameter.  
 

*************** 
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Comparisons between MS DOS, MS WINDOWS and UNIX Operating 
Systems : 
 
No Feature MS DOS MS 

WINDOWS 
UNIX 

1 Multi-tasking Not Available Available Available 
with better 
feature 

2 Multi-
programming 

Not Available Available Available 
with better 
feature 

3 File concept Not applicable 
(EXE Files) 

Not 
applicable 
(EXE Files) 

Any type of 
files 

4 Core Concept Not available Not available Available 
5 Graphical User 

Interface 
Not available Available Available 

6 Object linking 
& Embedding 

Not available available available 

7 Networking & 
Internet 

Not available Available Available 

8 Virus affection Possible Possible Not Possible 
9 Security Low Low High 
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CHAPTER 14 
MICROSOFT WORD 

 
1. MS word Basics 
2. Paragraph Formatting 
3. Tables 
4. Inserting Objects 
5. Page Design 
6. Mail Merge 
7. Views & Zooming 
8. Printing & protecting 
9. Style & Templates 

 
1. MS-WORD BASICS : 

 
MS Word is a word processor developed by Microsoft Corporation.  Using  this you can create, 
edit and print the documents according to your requirement.  You can also use features like auto 
correct, spelling and grammar checking, text formatting, mail merge, graphics, table etc. 
The minimum system requirement to run MS Word are 80486 or higher microprocessor, Hard 
disk with minimum 100 MB, minimum 16 MB RAM, VGA monitor, Keyboard and Mouse. 
To start MS Word 95/97/2000, select Start → Microsoft Word.  Word opens an empty document 
after displaying the Logo. 
 
1.1 PARTS OF MS Word Screen : 

Identify the following parts in MS Word Screen. 
Control box, Title bar, Minimize, Maximize, Restore and Close buttons, Menu bar, Standard 
Toolbar, Formatting Tool bar, Ruler lines (Horizontal and vertical), View bar (4-Normal 
view, Online layout view, Page layout view, and outline view), Drawing toolbar, Status bar 
and Task bar. 
 

1.2 Creating a Document : 
When you load the MS Word, a blank window will display automatically.  Type the text in 
this document window.  Note the following tips. 
- Type the text at inserting point.  While typing, when the right margin is encountered, the 

insertion point will automatically return to the next line with out entering Enter key. 
- To change the paragraph, press Enter key. 
- To start a new line without considering it as a new paragraph, press Shift+Enter. 
- In case of mistakes, to delete backwards, press Backspace.  To delete character at the 

cursor (insertion point), press Delete key. 
- To edit a word, the cursor must be moved to that word by clicking the left mouse button 

on that place. 
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- By using Arrows keys, Page up, Page down keys, Home, End, and  Ctrl + these keys, you 

can move the cursor to different places in the document. 
Ex: Type  a 3 paragraph text and study various cursor movements. 
 

1.3  File operations : 
 Study the following File Operations. 
1. Saving the File> Using File   → Save and Save As or Save icon 
2. Creating a new File > Using File → New or icon 
3. opening a File> Using File → Open or icon 
4. Closing a File > Using File  → Close or icon 
 

1.4 Editing the Text : 
Editing a process of changing the appearance of the text by deleting, duplicating or moving a 
part of it.  For this, you must first select a portion of text, which needs the change. 
Ex: use following methods to select a portion of the text. 
1. Click and drag 2. Click and Shift Click 3. Double Click on the word. 
4. Click on line from outside 5. Ctrl+ Click 6. Double click on a  line 
7. Ctrl + Click to block entire document  8. Alt + click and drag to block Column wise 

 
1.5 Simple formatting the text : 

Study various formatting features, like – font, font size, fold, italics, underline, text color, text 
background and text border by blocking a portion of text and clicking on appropriate icon on 
formatting toolbar. 
Study how to remove them. 
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Study the advanced formatting features like  - different types of underlines, Subscript, 
Superscript, Spacing between characters, and Animation by using Format. 
→ Font →Font dialog box. 

1.6 Changing the Case of the Text : 
You can change the case of the text to Upper case, Lower case or Toggle case by selecting 
Format and then Change Case. 

1.7 Moving the Text : 
Following steps can be used to move the piece of text from one place to another place or from 
one file to another file. 
- Block the text to be moved. 
- Select Edit → Cut. 
- Click on new place where the blocked text should appear. 
- Select Edit → Paste. 

1.8 Copying the Text : 
The steps required are 
- Block the text to be copied. 
- Select Edit → Cut. 
- Click on the new place where the blocked text should copied. 
- Select Edit → Paste. 

1.9 Undo, Redo and Repeat : 
For this, either go through Edit or click the corresponding icons. 

1.10 Existing the Word : 
To exist from MS Word, do one of the following. 
- Click on Close button. 
- Select File → Exit. 

 
2. Paragraph Formatting 

 
In MS Word, a paragraph may be a text, graphics or other items that is followed by a paragraph 
mark.  Paragraph mark is not displayed unless the Show/hide icon in standard toolbar is selected.  
This paragraph mark is inserted every time after Enter key is pressed. 
To make any changes in the paragraph, first select the paragraph, then use Format → paragraph 
option.  To gives a Paragraph option.  This gives a Paragraph dialog box.  From this you can align 
paragraphs, create line spacing, indent the paragraph, and specify line and page  breaks. 
 
2.1 Paragraph Alignment: 

Study Left alignment, Center, Right alignment and Justified from Formatting toolbar as well 
as Format → Paragraph option. 

2.2 line Spacing : 
Study various types of line spacing from Format → paragraph option. 

2.3 Spacing between Paragraphs: 
Set different spacing before and after a paragraph using Format → Paragraph option. 

2.4 Paragraph Indents : 
In a letter You may wish to start the first line of every paragraph after some space. 
These extra spaces are called indents. 
 Study the 4 types of indents → left, Right, First line, and Hanging (Which leaves a gap at 
the left side of paragraph except for first line).  For this use Format → Paragraph option. 

2.5 Drop Cap : 
Drop cap is used to drop the first character of a paragraph to spread over more than one line 

(i.e., larger in size.) Drop cap can be specified using following steps. 
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- Select Format → Drop cap… option 
- Select the position – Dropped or In Margin. 
- Select the font of the word to be dropped. 
- Specified the number of lines to be dropped. 
- Specify the distance to be maintained between dropped text and the remaining  text. 
 

2.6  Borders and Shading : 
Borders can be specified  for paragraphs and pages.  Also to emphasize the paragraph, the 
text can be shaded. 
1. Paragraph Borders : 

Various borders can be applied to a single paragraph or a group of paragraphs.  Different 
styles of borders, like  - thin, thick line, double or doted lines are available with different 
colors.  Shadow can be also selected for right side or left side of a  paragraph.  To apply 
borders to a paragraph perform following steps. 

- Click on the paragraph. 
- Select Format → Borders and Shading. 
- In borders tab, from settings select Box, Shadow 3-D or Custom. 
- Select the line style of border. 
- Select the line color of border 
- Select the width of the line and click on OK.  
Ex: Check how to remove paragraphs borders. 
 
2. Page Borders : 

You can also apply border to the full page.  The steps required are 
- Click on any page in the document. 
- Select Format → Borders and Shading. 
- Select the second tab Page Border. 
- Select the type of the boarded from the settings or select an Art from drop down list. 
- Under apply to : drop down list, whether page boarder is to be applied to the whole 

document etc.,  and click on OK. 
Ex: Check how to remove the page boarder. 
 
3. Paragraph Shading : 

The paragraph shading can be done on one or any selected number of paragraphs using 
different colors.  The steps  required are 

- Block one or more paragraphs. 
- Select Format → Borders and Shading. 
- From the shading tab, choose the desired color for filling, select the file style if required 

and click on OK. 
Ex: Check how to remove paragraph shading. 

 
2.7  Bullets and Numbering : 

You can create Bulleted and Numbered list at the beginning of each paragraph using Bullets 
and Numbering icons or select Format → Bullets and Numbering.  Also you can change the 
style of bullets from Bulleted tab. 
Ex: Study more about it.  Study also Outline numbering using Decrease Indent and Increase 
indent icons. 
 

2.8  Tab Stops : 
Tabs are used to type the text in columns.  MS Word has tab stops set to every 0.5 inch by 
default.  You can see these tab stops as gray thick marks that appear at the bottom of the 
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ruler.  There are 5 types of  Tabs as left, right, center, decimal and bar (thin vertical bar 
appears to separate the columns).  The typed text can be aligned on the basis of these tabs.  
To set the tab stops perform the following steps. 
- Select Format → Tabs to open the Tabs dialog box. 
- Type the tan stop position number in inches. 
- Select the type of leader if required. 
- Click on Set. 
- Repeat the above steps to set other tab positions. 
- To remove the tab position, click on the tab stop number and click on Clear. 
- To remove entire tab stops that are set, click on Clear All. 
- Click on PK to come put. 
Ex: Set different Tab stops using Ruler. 
 

2.9 Checking Spelling & Grammar : 
You can check the spelling of the words used in the document and also possible grammar and 
style errors. 
In window 95 and above, the spelling errors are underlined with red color and grammar mistakes 
are underlined with green color.   
Ex: Study these things in detail either using short cut menu (ABC) or selecting them in Tools 
menu.  To correct the grammar, right click on such words. 
 
2.10 Auto Text : 
Frequently used words can be stored as Auto Text entries and can be inserted using few short cut 
keys.  For example, Thanking you, Yours sincerely etc. 
To store an Auto Text entry, type the text, and block it, then select Insert → Auto Text → New.  
A dialog box named Create Auto Text → New.  A dialog box named Create Auto Text will 
appear.  Type a short cut name to the Auto Text entry and click on OK.  For example, You can 
give short cut name foe yours faithfully as YF. 
To insert Auto text into the document, select Insert →Auto Text → Auto Text, click on the 
required shortcut name and click  on Insert.  You can also insert Auto text just by typing short cut 
name and pressing Function Key F3. 
To delete the Auto Text entry, select Insert→Auto Text → Auto Text, click on the Auto Text 
short cut name to be deleted and click on Delete.  To come out from dialog box, click on Close. 
 
2.11 Auto Correct : 
This is a facility used to correct the spelling of frequently typing word like Pandeshwar.  This 
facility can be also used to get entire text just after typing its short cut without pressing any key 
further (unlike Auto Text).  For example, by typing SRINIVAS you will get Srinivas College of 
P.G. Management Studies. 
To create an Auto Correct entry, select Tool → Auto Correct.  A dialog box will be displayed.  
Type the spelling of the word that we generally type e.g., SRINIVAS in Replace box.  In With 
box, type the correct spelling of the word and click on Add on click on OK.  Now onwards, if 
SRINIVAS is typed,. it will  automatically  convert to Srinivas College of P.G. Management 
Studies. 
To delete the Auto Correct entry, select Tool → Auto Correct, click on the name of Auto Correct 
to be deleted and click on delete. 
 
2.12 Word Count : 
In MS Word, you can count the number o f pages, words, characters, paragraphs, and lines in the 
document.  For this, select Tool → word Count, A dialog box will be displayed with the results. 
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2.13  Text Background : 
Any pattern or picture can be displayed behind the text by selecting Format → Background.  
From the dialog box, select any color or select Fill effects… to select a design from gradient, 
texture, pattern or picture.  If picture  tab is selected from fill effects, click on Select picture 
button and select the name of the file that contains the picture (generally BMP file). 
To remove the background, select Format → Background and click on No Fill.   
Note: The background is visible in only  Online layout view. 
 
2.14 Breaks: 

MS Word provides 3 types of breaks.  They are, Page Break, Column Break, and Section 
Break.  To insert any one, select Insert → Break.  A dialog box appears.  
Ex: study these things in detail. 

2.15 Columns: 
Columns are used to type the text in different columns.  Text can be typed into the columns  
after defining the columns or the existing text can be converted into columns. 
1. Typing the text by defining the columns: 
perform following steps. 

- Click on place where the text has to be in columns. 
- Select insert → Break → Continuous, click on OK. 
- Select Format → Columns.  The columns dialog box will be displayed. 
- Specify the number of columns required (two, three etc.) 
- Specify  whether a separator line is required in between the columns.  If required, select 

the check box line Between. 
- By default, the width of each column will be equal.  If you want to have columns with 

different widths, change the width and spacing between the columns after deselecting 
Equal Column Width and click on OK. 

- Type the text in the first column.  When you have finished typing in first column and 
want to go to the next column, select Insert →  Break → Column Break.  Type the text in 
other columns. 

- At the end of last column, select Insert →Break→Continuous. 
- To end the columns  and start typing the text as regular paragraphs, select Format → 

Columns and from Presets, select the number of columns as one. 
Ex: Study how to create 3 equal columns and two unequal columns? 
 

2. Converting existing text to columns text : 
For this two methods available. 

(a) To convert the existing text into columns text using Section breaks, include the 
continuous breaks at the beginning and at the end of the text.  By clicking inside 
the text you can define the number of columns and its width etc. 

(b) To convert the existing text into columns using the Block, block the text and 
define the columns by specifying the number of columns, width etc.  This is 
preferred method of converting the text to columns because the number of lines 
in all  columns will be equally distributed by including section breaks 
automatically. 

3. Converting columns text to regular paragraph : 
For this block the text written in columns and define the columns with number of 
columns  1. 
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3. Tables 
In MS Word, table is any information arranged in rows and columns.  Each intersection 
of row and column is considered as a cell.  Any data especially numbers, is more 
presentable and easier to type in the tabular form. 

1. Creating a Table : 
  To draw a  table, you can use Draw a Table feature.  For this, click on the Tables 
and Borders icon, or select, Table → Draw Table.  With the help of a pencil tool, 
draw the table with any number of rows and columns. 
 To draw a table, you can also use, Insert table feature.  For this, use following 
steps. 
- Click on the portion of the text where the table must be created. 
- Select Table  → Insert Table. 
- Enter the number of columns (between 1 to 63) and rows (between 1 to 32767) 

and click on OK. 
- You can also insert a table by clicking Insert Table icon from the standard toolbar. 
- This produces a grid containing 5 columns and 4 rows.  Click on the box 

containing the  table to specify number of rows and columns.  For example, if you 
need a table having 4 columns and 3 rows, Click on the box of 3rd line 4th column.  
A blank table will be inserted in to the document. 

 
2. Moving around the Table : 

To move to any cell click inside that cell.  You can use following keyboards for 
further movement. 
TAB → To the next cell:  Shift + Tab → To the previous cell. 
→ Forward one character  ← Backward one character 
    ↑ To the previous row   ↓    To the next row 
Alt + Home → to the first cell in the row;     Alt+End → To the last cell in the 
row. 
Alt + PgUp → To first cell in the column; Alt + PgDn → To last line in 
column. 

 
         3. Typing in the Table : 

Move to the appropriate cell and type next or number.  You can go to next cell by 
pressing TAB key.  Pressing Tab at the end of the row will move the insertion 
point to the next row and pressing Tab at the end of the table, will add a new row 
at the bottom of the table. 
 

4. Selecting the Table : 
1. To select entire table, click on any cell inside the table and select Table → 

Select Table. 
2. To select a row, click inside any cell in that row and select Table → Select 

Row. 
3. A row can also be selected by clicking in the selection area (space before first 

column in the left side) of the row to be selected.  To select many rows, click 
and drag in the selection area of the rows. 
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4. To select a column, click on any cell in the column and select Table → Select 
Column.  To select many columns, click and drag in the selection area (space 
above first row in the table) of the column. 

5. To select a cell, click on the selection area of the cell (left side of the cell 
before to the cell content. 

 5. Inserting and Deleting a row or column : 
To insert a row at the end of the table, click inside the last cell of the table and 
press tab key.  A blank row will be inserted.  To insert a row at the middle of a 
table, click inside any cell in the row, where a new row has to be inserted and 
select Table → Insert Rows.  A blank row will be inserted. 
To delete a row in the table, click on any cell in that row and select Table → Select 
row to select the entire row, then select Table → Delete Rows. 
Ex: Study how to insert and delete a column? 

 
6. Setting the row height and column width: 
To align the table, i.e., to bring it to  center or to the right side, select Center or Right 
from Alignment in Row of Cell Height and Width in Table menu. 
 

7. Applying the borders: 
Borders  can be applied to any part of the table  or entire table.  For this select the 
cells (select the table for full border),  and select Format → Borders and Shading.  
Select Grid ( for inside boarders only) or Box (for outer boarder only) or All (for 
outer and gridline boarders),  select the color and width , click on OK. 
 

8. Sorting a table: 
To sort the contents of a table, perform following steps. 
1. Click on any cell inside the table, Select Table → Sort. 
2. In the table, if there are column headings that should not be sorted, then select the 

option button My list has  Header Row. 
3. From the Sort by drop down list, select the column on which the table is to be 

sorted. 
4. From the type drop down list, choose the type of content such as Text, Number or 

Date and select Ascending or Descending order. 
5. Click on OK button to sort the data. 

Note: When the table is created, generally the table will be displayed with gridlines.  
If the gridlines are not displayed, select Show Gridlines from Table menu. 
 
9. Table Auto Format : 
This can be used to format the table, using pre-defined table formats.  For this, click 
inside the table and select Table → Table Auto Format.  A dialog box of  Table Auto 
Format will be displayed.  Select the type of format like sample 1, Classic 1 etc and 
click on OK. 
 

10.  Merging the Cells : 
To merge two or more cells and make them into one cell, select the cells to be 
merged and select Table → merge Cells.  To split a cell into two or more columns or 
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rows, click on the cell to be split and select Table → Split cells.  Specify the required 
number of columns and rows and click on OK. 

 
11. Converting table into text and text into table : 
(a) To convert the table to text by removing the gridlines, click inside the table  and 

select Table → Select Table.  Then select Table → Convert Table to text.  Select 
how the text must be separated i.e., paragraph marks, commas, or other  
characters and click on OK.  The table border will  be removed automatically and 
the contents of the table will be converted into text. 

(b) To convert a text written using spaces, Tabs, Commas or any other special 
character, block the text and select Table → Convert Text to Table.  A dialog box 
will appear.  Specify how many columns and rows are required, what is the text 
separator character used when typing the text and click on OK. The selected text 
will be converted into a table. 

 
4. Inserting objects 

 
You can insert date and time, symbol, pictures and word art. 
1. Inserting Date and Time: 
For this, click on the place  where the system date and time   to be inserted and select on 
required format.  If the date insert into the file has to be changed automatically, every time 
the file is opened, click the check box Update automatically. 
 
2. Insert Symbol : 
For this, select Insert → Symbol.  A dialog box will appear.  Select symbol or special 
characters.  Select required Font and click on desired Symbol, click on Insert and Click on 
Close. 
 
3. Insert Drawings : 
MS Word allows you to draw, resize, and reposition the graphics in the page layout  view.  
To draw the designs, display the drawing tool bar if it is not visible.  For this select View → 
Toolbars →Drawing.  A drawing object can be selected using  Shift + click.  Selected objects 
can be rotated, flipped etc. 
Ex: 1. Draw object and type text on it and select Draw → Order →Send behind text and also 
other commands. 
2. Draw objects using  Auto shapes. 
 
4. Creation of Callout : 
A callout is a text with the line that points to an area of interest in an  illustration.  Callout 
allows the user to type the text directly inside it.  But, to type the text inside any other auto 
shape, right click  on object and select Add text.  To edit the text, simply click on text inside 
the object. 
 
5. Insert Picture : 

A number of pictures are available in MS Word that can  be inserted into any document.  
To insert a picture into a word document perform following steps. 

a. Click on the place, where the picture is to be inserted. 
b. Select Insert → Picture → Clipart. 
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c. Select the required category and click on required picture from the selected 
category. 

d. Select Insert and Click on Close. 
To insert a BMP file into word document, select Insert → Picture → From File.  
Select the file name to be inserted an click on Insert. 
 
6. To type the word Art Text: 
 Do the following steps. 

a. Click on the place where Word Art text is to be placed. 
b. Select Insert → Picture → WordArt … WordArt Gallery will be displayed on the 

screen. 
c. Click on required Word Art Style and click on OK. 
d. Now Edit Word Art Text dialog box will appear. 
e. In place of  “Your Text Here”, type the required text.  Select the required font 

type, size, bold or italic and click on OK. 
f. The text will be inserted into the document and Word Art tool bar will be 

displayed to make necessary changes. 
 

5. Page Design 
 
1. Header / Footer : 
Header is a text that will be printed at the top of the page and Footer is the text that will be 
printed at the bottom of the page.  The header and footer can include text or graphics such as 
page numbers, date, the logo, file name, authors name etc.  
To add a Header or Footer to a document, select View → Header and Footer.  A box will be 
displayed to type the header text along with Header and Footer toolbar displayed below the 
box. 
Ex: Work more on Header and Footer.  Insert page number, date , time etc.  Align the text. 
 
2. Footnotes and Endnotes: 
These are the reference notes written at the end of the same page or at the end of the 
document.  Footnotes will be printed at the end of same page and Endnote will be printed at 
the end of the document. 
For this, place the cursor at a position where the note mark has to appear and select  Insert → 
Footnote.  A dialog box will appear.  Select whether Footnote or Endnote has to be written 
and style of numbering.  Instead of number, if any symbol by selecting appropriate font.  To 
start typing the footnote or endnote text, click on OK. 
If Footnote is selected the cursor will appear at the bottom of the page by displaying the 
footnote number or symbol where footnote text can be typed.  If Endnote is selected.  The 
cursor point will appear at the end of the document.  To return to the text click outside the 
footnote area. 
 

6. Mail Merge 
 
Using Mail Merge facility, you can quickly create from letters, mailing labels, envelopes and 
catalogs by merging the information from two different files.  Mail merge is used to   print 
multiple copies of a particular letter addressed to many members.  Mail Merge requires 3 
steps. 

1. Creating a Main Document. 
2. Creating a Data Source 
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3. Merging two files. 
Main document contains subject matter to the letter to be printed.  It may contain, text, 
graphic objects, data etc.  It has to be specified that, where the data from Data Source is to be 
inserted into it. 
Data Source file contains information in the form of records, to be inserted into the main 
document.  Each record contains one member information (say address). 
1. Creating Main Document 

Open a new document first to create a Main document.  For this select File → New.  
Then select Tools  → Mail Merge.  A mail merge helper dialog box will be displayed  on 
the screen. 
Click on Create button to display the available formats (form letter, mailing labels, 
envelope or catalog) of the main document.  A List will be displayed. 
From the list, click on Form Letters. 
Then one more dialog box will be displayed asking the place to create the main document 
(whether in the Active Window (current file)  or  in a New Document).  Click on Active 
Window to create the main document in active window.  An Edit button will be displayed 
to the right of Create button.  Before selecting Edit in Main document, you have to 
specify the address of members to whom the letters must be sent by creating Data Source.    

 
2. Creating Data Source : 
2.1 To create a data file which contains address, click on Get Data Source.  A data source 

button with Get Data List will be displayed. 
2.2 Click on Create Data Source, which display a Create Data Source dialog box.  Here you 

can retain  only required  Field name in header row, by removing others using Field name 
and Remove field name buttons.  Then click on OK. 

2.3 A dialog box will be displayed to specify a name for the data source.  Type a name and 
click on Save. 

2.4 Another dialog box will be displayed asking to Edit the Data Source or Edit the Main 
Document.  Click on Edit Data Source, which display another Data Form Dialog box.  
Type the addresses of each record.  Type the details by pressing Enter after typing the 
name, address etc. 

2.5 To type the other addresses, click on Add New button.  After the typing is completed 
click on OK. 

2.6 Data form dialog will end and a blank screen will be displayed to type the subject matter 
of the letter. 

2.7 Type content of the letter.  Wherever the content of data source is to be included,  click 
on Insert Merge Field icon available in Mail Merge Toolbar. 

2.8 This will display a list of available fields in the data source.  Click on desired field name 
to insert into the file. 

2.9  After typing the letter, save it under any name. 
2.10 To merge the data source with the main document and to print it for every address in the 

data source, select Tools → Mail Merge. 
2.11 Mail Merge Helper dialog will be displayed.  Click on Merge displayed at the bottom of 

the dialog box.  This display a Merge dialog box. 
2.12  By default the merging will be done in a new document and a letter  will be printed for 

every address in the data source. 
2.13 If the letter has to be printed for only few address in the data source, specify    From and 

To for address numbers in Merge dialog box. 
2.14  In merge dialog box,  by selecting Merge button, you can merge the addresses with the 

letter. 
The merged letters can be saved in a file and printed later. 
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3. Editing the Data Source : 

To edit the addresses already entered in the data source, do the following steps. 
1.  Open the Main document. 
3 Select Tools → Mail Merge.  Mail Merge dialog box will be displayed. 
4 Click on Edit in the Data Source.  The data source name will be displayed below it.  Click 

on the data source name to open it. 
5 Addresses will be displayed one after another.  Go to the address to be edited by changing 

the record number displaying  the address, edit it and select OK. 
Note:  The data source can also be edited by clicking on Edit Data Source icon (last 
icon) in the mail merge toolbar. 
 

7. Views and Zooming 
 
1.     Views :  

In MS Word, a document can be edited by displaying it in different ways on the screen.  This 
process is called View.  There are 6 different views.  They are normal View, Online Layout 
View, Page layout View, Print Preview, Outline View, and Master Document.  Except Print 
Preview, others can be selected from view menu. 
Ex: Study all these views in detail. 

2. Full Screen : 
The command View → Full Screen allows the user to view the text on the entire screen by 
removing the toolbars, menus, rulers, scroll bars and status line.  After choosing this option, 
the menu bar will disappear.  To return to the document, click on Close Full screen icon.    

3. Ruler : 
Ruler is used to quickly change the paragraph indents, to adjust page margins, to change 
width of table columns and newspaper style columns and set the tab stops.   

     To view or hide ruler, select View → Ruler.   Both horizontal and vertical  rulers will be 
displayed . 

4. Zooming : 
  You can use zoom facility to change the display size of text on the screen.  For this, select 
View → Zoom.  A zoom dialog box will be displayed from which you can  choose require 
zoom.  The default is 100% .  The Zoom control icon in the standard Toolbar can be also used 
for the same purpose. 

5. Summary Information : 
Summary Information of a file helps to search the files related to particular subject or created 
by a particular author.  The extra  information of a file like, the Title, Subject, Author, 
Keywords, and comments can be entered in Summary information. 
To type the summary information, select File → Properties.  Summary Information dialog 
will be displayed to type the title, subject etc.  Type the required details and click on OK. 
 

8. Printing & Protecting 
 

1. Page Setup : 
 Using Page Setup, you can set margins for the document, paper size, text alignment for 

printing etc.  For this, select File → Page Setup.  You will get Page Setup dialog box with 4 
tabs – Margins, Paper size, Paper Source, and Layout. 

  Margin tab can be used to specify the top, bottom, left and right margins of the document.  
Default top and bottom margins will be 1 inch and left and right margins will be 1.25 inch.  
An extra place at the left edge called gutter can be given.  The position of Header and Footer 
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margins can also be specified.  By selecting  Mirror Margin button, two pages (even and odd) 
can be displayed to type inside and outside margins, instead of left and right margins.  
Finally, by selecting Apply to the settings can be applied to entire document or portion of it. 

 Paper size tab can be used to specify the size of the printing paper.   Default paper width is 8.5 
inch and height is 11 inch.  You can change this setting according to the size of the paper is 
used for printing.  The orientation, Portrait (default, with less width and more height ) or 
landscape (with more width an less height) specifies the manner of printing on the paper. 

 Paper source tab can be used to specify the place where (manual feed or upper tray) the paper 
is to be taken by the printer for printing. 

 Layout  tab is used to specify header and footer.  Vertical alignment can be used to specify 
whether the text must be printed starting from the top (default) or from center or from 
justified.  Line number option is available to specify whether to print line numbers or not. 

2. Print preview : 
Print preview, chosen from File menu is use d to view how the document will actually appear 
on the printed paper.  There is a facility to view one or more pages the text can also be edited 
in print preview screen. 

3. Printing the document : 
In MS word, an open file can be printed by selecting File → Print.  A print dialog box will be 
displayed to select the name of the printer, Print range, No. of copies etc.  
Ex: Study each more detail. 

4. Protecting the document : 
 A document can be protected from being opening or editing by others by giving a password. 

You can type two types of passwords : One to open the document and another to make 
changes in the document.  A password can be given to an already existing document or a new 
document. 

 To give the password to a file, select File → Saves As.  From Save As dialog box, select 
options to display the save options in the form of Save dialog box. 

 Here, the text box password to Open allows you to open the document only after typing the 
password correctly.  The password is case sensitive.  If the password is not known, the 
document cannot be opened or edited. 

 The text box, Password to Modify allows you to save the modifications made in the document 
only if the password is known.  You can open the document for Read Only and you can make 
some changes I the file but, you can not save Read Only and you can make some changes in 
the file but, you can not save under same name.  If any changes are made after opening a 
document, save it under a new name. 
 

5. Inserting a File into another File : 
Any existing word document can be inserted  into the opened document at the insertion point 
position, by selecting  Insert → File.  Select the name of the document to be inserted and 
click on OK.      

6. Style & Templates : 
1. Style : 
Style is a collection of character formatting and paragraph formatting settings.  Style reduces 
the time required for text formatting. 

- For example, if the heading of the text is to be boldfaced, underlined, centered,     with a  
required font size, color etc., the heading must be first blocked, then boldfaced, then underlined 
etc.  On the other hand, by using required style, you can automatically boldface, underline, center 
the heading. 

 Word has a number of built-in styles, which can be applied to different portions of 
document.  You can also create your own style if it is not available in built – in styles. 
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 To see or to select the available styles, click on the drop down style list on the lower side 
of the Formatting Toolbar.    Default style name is Normal. 
2. Template : 
Template is a pre-defined format of a document.  Using templates is an easy way of creating 
documents.  A template contains the format of the document which can be filled in blank 
places to create good documents.  Generally templates are used to do repetitive work such as 
certificates, letters, circulars, bio-data etc. 
To create a template of certificate, perform following steps. 

 Open a blank document and type as shown in fig.1. 
 The format of the document can contain text, drawing objects, WordArt text  etc. The 

information to be entered must be left blank. 
 When designing a template, it is better to view the screen small in size, say 50 % zoom 

control.  After design is completed, to type the text, return to normal 100%                                                                
                                             
                
 
 
                                                                                          
 
 
 

 
  
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
The Fig.1 is the template of a certificate that can be anybody who completes the course.  After 
creating such document of the certificate, save it by selecting File → Save As…  This will display 
Save As dialog box.  Type a file name (say,  Certificate) and from the Save As Type drop down 
list, select Document Template.  Click on Save.  Close the document. 
- To use the template, select File → New.  A list of template will be displayed.  Click on the 
required template name ( for example, Certificate) and click on OK.  Displaying the information 
typed in the template will open a new document.  Fill in the details (name and month) and print it.  
The original template will not be affected by typing the text  (name & month) because the text is 
not actually written in the template, instead, it is written in the document. 
 

******* 

Srinivas College of Management 
 
 
This is to certify that, Mr./Ms.---------------------------- 
 
Is completed a short term course on Window Based  
 
Applications successfully in                     2003. 
 
 
 
 
     Principal 
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CH 15 
INFORMATION & SYSTEMS 

 
1.  Information Concept :- 
 
Information is the output of Information Systems generated using data. 
Information is processed data. Data is in the form of raw material and it is 
subjected to some manipulation or processing to generate useful information. 
When the data is processed and placed in a context, it becomes meaningful. 
Information System is analogous to light. When light is present, objects are 
visible. Information presents a picture of reality to a user who is not aware of that 
reality. Like light, too little or too much of information disturbs the picture of reality 
conveyed. 
 
Information is a resource like materials and money. The purpose of information is 
to reduce uncertainty about decision situations and consequences. Information 
helps in understanding and analyzing problems and opportunities. It raises the 
confidence with which the decisions are made. Since the user of information 
places so much trust and belief on the information reported, generation and 
communication of information assume great importance. 
Data and Information : - 
Data is the result of measurements of various attributes of entities such as 
product, student, inventory item and employee. The measurements may be 
recorded in alphabetical, numerical, image, voice or other forms. Thus, the raw 
and unanalyzed numbers and facts about entities constitute data. On the other 
hand, information results from data has to be placed in a context for it to derive 
meaning and relevance. Relevance in turn adds to the value of information in 
decisions and actions. Data-processing requires some infusion of intelligence 
into data to generate information. The application of intelligence may be in the 
form of some principles, knowledge and experience to convert data into 
information. 
 
Difference between Data and Information : - 
Even if the words ‘data’ and ‘information’ are often used interchangeably, there is 
clear distinction between the two. Some of the major differences are as follows: 

1) Data is fact, but information is not fact even if it depends on data. 
2) Though information arises from data, all data does not become 

information. There is a lot of selective filtering of data before 
processing it into information. 

3) The relation of data to information is that of raw material to finished 
product. 

4) Data is the result of routine recording of events and activities taking 
place. Generation of information is user driven which is not always 
automatic.  
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5) Data is independent of users whereas information is user dependant. 
Most information reports are designed to meet anticipated information 
needs of a user or a group of users. 

Definition of Information : - 
The term ‘Information’ is a common word and it conveys some meaning to the 
recipient. It is very difficult to define it comprehensively. Yet, Davis and Olson 
give a fairly good definition. They define information as “data that has been 
processed into a form that is meaningful to the recipient and is of real or 
perceived value in current or prospective actions or decisions”. 
This implies that information is: 
♦   Processed data 
♦   It has a form 
♦   It is meaningful to the recipient 
♦   It has a value, and 
♦   It is useful in current or prospective decisions or actions. 
 
Data processing and Information Processing : - 
 
 
 
 
 
 
 
 
        
 
 
                  Fig 1.1: Transformation of data into information system. 
 
Data, as it arises is ill structured. Forms, vouchers etc. are designed to capture 
data at source. The captured data is structured for storage or further processing. 
The database is huge repository for transition data. Data is retrieved from 
database for processing it into information. A series of operations are performed 
on the data to generate information. The type of operation to be performed on the 
data like aggregation, summarization, calculation etc, depends on the type and 
quality of information required. Information processing includes the traditional 
data processing as well as processing text, images, audio, video and animation. 
The focus of information processing is on creation of information products for 
users. The figure 1.1 shows the block diagram of transformation of data into 
information in an information system. 
The analogy of raw material to finished product illustrates the concept that 
information for one person may be raw data for another – just as the finished 
product from manufacturing division may be the raw material for another division 
as given in fig 1.2. For example, shipping orders are information for the shipping-
room staff, but they are raw data for the vice president in charge of inventory. 

Data 
Storage 

Data Processing Information 
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Because of this relationship between data and information, the two words are 
often used interchangeably. 
Management      Information + decision rules = decision by  
Level       management 
 
 
      

  Data Summarized  
 
 
 
Operating level                  Information + decision = decision by operations  
       Rules         personal 
 
 
 
  Transaction data 
Fig .1.2: Data for one level of an organization may be information for another 
 
Features of Information : - 
Information possesses some features or attributes that give it value and 
usefulness. Some of the important features of information are: 
               Information resources (in the sense of stored data of all types) are 
                  reusable. 
    Information adds to a representation 
    It corrects or confirms previous information. 
    It has surprise element or news value. 
    It has value in decision-making. 
    It has value within the context of future decisions and actions. 
Dimensions of Information : - 
Information has many dimensions of interest to information system people, which 
are: 
    Economic dimension, 
    Business dimension, and  
    Technical dimension. 
The Economic Dimension : - 
This includes both the cost of information and its benefits from use. The cost of 
information consists of the cost to acquire data, the cost to maintain data, and the 
cost for generating and communicating information. The cost is related to 
accuracy, speed of generation, etc. of information. If the system has to be more 
reliable and accurate, the costs have to be higher. In a given system beyond a 
certain level of accuracy the cost will rise rapidly. Costs are also related to the 
response time required to generate information and communicate it. For real time 
systems, where response time is low, the costs are very high. 
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The Business Dimension: - 
The characteristics of information required by managers at different levels of 
hierarchy are different. The characteristics of information for top management are 
in contrast with those of operating level management. The information 
characteristics of middle management lie somewhere in between. 
The top management requires information that is: 

- future oriented, 
- external, 
- unstructured, 
- non programmable, and 
- in exact. 

 
Whereas the operating management needs information that is: 

- historical, 
- internal, 
- structured, 
- programmable, and 
- exact. 

Since the top management is concerned with strategic planning and giving 
direction to the organization, it requires environmental information. 
 
The Technical Dimension : - 
The Technical Dimension of information is concerned with the database that is 
vital for any information system. The database is an orderly collection of centrally 
controlled data that minimizes data redundancy, facilitates storage of massive 
data, quick retrieval of data and ensures data security. The technical 
considerations of database are its capacity, response time, data 
interrelationships, security and validity. 
 
Types of Information : - 
 
Information broadly divided into two classes on the basis of its intrinsic nature 
and organizational use. They are 

♣ planning information and 
♣ control information 
 
The strategic level management is mostly concerned with planning information 
and its requirement for control information is very limited as most of the control 
function is exercised at lower levels. On the other hand, the operational level 
management requires a large amount of control information and small amount 
of planning information. 
 
 

Difference between planning and control information : - 
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 Planning information covers all organizational divisions and provides 
information about a few divisions or the entire organization. The control 
information covers to functions or divisions or such small area of 
responsibility 

 Planning information covers a wider time span whereas the control 
information relates to a short time span say a shift to a few months at the 
most. 

 Trends and patterns are more important in planning information. Fitness 
details are important in control information. 

 The purpose of planning information is to guide planning by projecting 
trends and patterns whereas incase of control information; the purpose is 
to invite managerial intervention to correct a deviation. 
The planning information can also be classified into three categories 
such as 

              Strategic    tactical  and    operational information. 
 
1.  Strategic Information : - 
This relates mostly to organization as a whole and its surroundings such as 
information about population changes, natural resources, new technologies, new 
products, competitors, political, legal and economic changes, and so on. Top 
management needs strategic information for its long term planning which affects 
the whole or significant part of the organization over a fairly long period of time. 
2.  Tactical Information : - 
This is required for short-term planning by middle level managers. Sales analysis 
and forecasts, cash flow projections etc. are examples of tactical information. 
3.  Operational Information : - 
This information relates to very short period that may be a few hours to a few 
weeks. It may be about current stock levels of inventory, outstanding orders from 
customers, work schedule for next shift, etc. This information can be generated 
from current activity data arising from internal sources. It is of immediate use and 
is of interest to a few people. 
 
 
 
 
 
2.1 System Concept  :-  
 
A system is a set of interrelated components. The systems are orderly arranged 
according to a design and each component has a definite function to perform in 
the system. The components forming a system are called subsystems. Each 
such subsystem can further be divided into lower level subsystems. This process 
of dividing system into lower level subsystems is called factoring of a system and 
this can be carried on until we get a unit, which is easy to manage. The hierarchy 
of systems is shown in fig. 2.1. 
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Fig. 2.1  :  Hierarchy  of Systems. 
 
A system  can be defined as an organized or complex  entity, combination of 
things or parts forming a complex entity. The system may be Physical or 
Abstract. 
 
The physical system is a set of elements which operate together to accomplish 
an objective. Physical systems are made up of objects such as land, building, 
machines, people and other tangible objects. An abstract system is an orderly 
arrangement of ideas, concepts, or constructs. For example, a system of 
theology is an orderly arrangement of ideas about God and the relationship of 
humans to God. 
 
The physical systems produce some outputs which may help to achieve its 
defined objective. Organization systems are more meaningfully defined as an 
array of components designed to accomplish a particular objective according to a 
plan. 
 
Examples for a Physical Systems :- 
(1) Animal circulatory system :- The heart and blood vessels which move blood 

through the body. 
(2) Transportation system :-  The personnel, machines, and organizations which 

transport goods. 
(3) Weapons system :-  The equipment, producers, and personnel which make it possible 

to use a weapon. 

       System 1        System 2        System 3      System  n 

   Super 
system

Subsystem 1  Subsystem 2  Subsystem 3 Subsystem  n 

 Black box 1 Black box 2 Black box 3 Black box  n 
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(4) School System :-  The buildings, teachers, administrators, and text books that 
function together to accomplish the goal. 

(5) Computer System :-  The equipment which functions together to accomplish 
computer processing. 

(6) Accounting system  :-  The records, rules, procedures, equipment, and personnel 
which operate to record data, measure income, and prepare reports. 

 
These examples shows that a system is not a randomly assembled set of  
elements; it consists of elements which can be identified as belonging together to 
accomplish a common purpose, goal, or objective. The parts of physical system 
(sub-systems) interact to achieve an objective. 
 
2.2  General System Model :- 
The general model of  a physical system is a collection of related elements. 
These elements takes the form of input, process, and  output and is represented 
as in following figure. 
 
 
 
 

Fig.2.2  :  Simple system model. 
 
A system may also have several inputs and outputs as shown in fig 2.3. 
 
 
 
 
 
 
 
 
 

Fig. 2.3   :  System  with Many Inputs and Many  Outputs. 
 
System has many layers and at every level, a system can be considered to be a 
part of still larger system.  It also means that at every level a subsystem can be a 
system relative to its objective. That means, it is objective that decides the 
system, subsystems, their functions and the systems environment. The features 
which define and delineate a system form its boundary.  The system is inside its 
boundary and the environment is outside the boundary.  Thus system boundary 
separates system and its environment. Open systems interact with other systems 
in the environment and exchange inputs and outputs. The boundaries of open 
systems are relatively flexible, whereas those of closed systems are rigid. 
 
Total system is determined by definition. When the total system is determined, 
inputs of each part can be specified in relation to the objectives of the total 
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system. Once this is done, it is possible to analyze the functions and 
relationships among the parts and those of the parts in relation to the whole.  
 
In some cases, it is easy to define what is part of the system and what is not. In 
other cases, the person who steady the system may arbitrarily define the 
boundaries. Some examples of boundaries are  : 
(1) In human system, skin, hair, nails, and all parts contained inside form system 

and all things outside the human body forms environment. 
(2) In automobile system, the automobile parts in the body plus tires and all parts 

contained within form the system. 
(3) In computer system, all parts including input, CPU, output, power system 

forms the system. The person working with it is an environment. 
 
As pointed out earlier, each system is composed of subsystems, which in turn 
are made up of other subsystems, each subsystem is defined by its boundaries.  
The interconnections and interactions between the subsystems are termed 
interfaces. Interfaces occur at the boundary and take the form of inputs and 
outputs (material, energy, or information).  
 
There are subsystems at the lowest level where the inputs and outputs are 
defined, but not the process.  Such systems are called a black box.  A basic unit 
or black box which performs or provides the facility for performing some part of 
the defined transformation process can be defined as component;  for example, a 
class room is a component in case of an educational system. 
 
The idea of Boundary, interface and environment of a system is shown in fig. 2.4. 
As an example, a computer system along with its sub-systems and interfaces is 
shown fig. 2.5. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 2.4    :  Boundary, Interface and environment of a system. 
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Fig. 2.5 (a) :  Computer configuration as System. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 2.5  (b) : CPU as a sub system. 
 
A  system permits flow of information, energy and other resources to ensure its 
survival.  The flow from the environment into the system forms the input for 
processing and after input is processed, the output again flows out from the 
system into the environment. 
 
Concept of Black Box  :-   
 
The concept of black box is used to simplify design work during systems 
development. In a new system development process, according to the concept of 
black-box, the output of the system is defined first. Once the output requirement 
are clearly defined, the designers turn to identifying and defining input 
requirements to generate the specified output. After defining output and input, the 
last step to design is to specify black box operation. The black box represents the 
conversion process. The steps in conversion process are to be identified to 
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convert a specified input into the specified output. This approach to the system 
design is highly specific and is often used in information system design.  
The concept of black box is shown in fig. 2.6 . 
 
 
 
 
 
 
 

 
Fig. 2.6  :  Concept of  black box. 

 
 
2.3 :  System Concept :-  
 
A system contains subsystems, interfaces, boundaries, environments and black 
box and is represented diagrammatically in following  figure 2.7  : 
 
2.4  Characteristics of systems : - 
 
Systems possess some characteristics that enable them to be distinguished from 
components. They are: 

i. Objective orientation 
ii. Design of components in a particular arrangement (i.e. Structure) 
iii. Inputs of information, energy and materials 
iv. Processing of inputs 
v. Outputs or result, and  
vi. Interdependence 

 
 
 
 
 
 
 
 
                          
 
 
 
 
 
 
 
 

     Input  n  
  Output n 

Black box (Process initially ignored) 

 
System 

Outside the boundary 
    is the environment The boundary which 

delineates the system 

Fig. 2.7 (a) The boundary concept. 
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2.5 :   Systems Classification (Types of Systems) : - 
 
Systems are classified into a number of groups, some of them are explained 
below. 
 
i. Probabilistic and deterministic systems : - This classification of 

systems is based on their predictability of outcomes. In a probabilistic 
system, some states can be predicted from the previous state only with 
certain amount of error. For example, in an inventory system, the average 
stock, average demand, etc. may be predicted but the exact values of 
these factors at any given time cannot be known in advance. 
A deterministic system is perfectly predictable. That is, it is possible to 
predict the output accurately from the inputs without any error. For 
example, a given electric motor and an input of particular voltage will 
produce an output of a known number of revolutions per minute (rpm). 
Similarly, a computer program which performs exactly according to a set 
of instructions. 

ii. Open and closed systems : - 

Fig. 2.7 (b)  Interface 
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Fig. 2.7 (d)  A block box representation 
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           Open systems interact with the environment and exchange information, material 
or energy with environment. They are difficult to study. Examples for open 
systems are biological systems, organizational systems, etc. Open systems tend 
to have form and structure to allow them to adapt to changes in their environment 
in such a way as to continue their existence. They are “self-organizing” in the 
sense that they change their organization in response to changing conditions. 
Living systems like cells, plants, humans etc are open systems. They attempt to 
maintain equilibrium by homeostasis, the process of adjusting to keep the 
systems operating within prescribed limits. An example is the body which 
maintains its temperature within very narrow limits. 

 
           Organizations are open systems. A critical feature of their existence is 

their capability to adapt in the face of changing competition, changing 
markets etc. 

           A closed system is a self-contained system and does-not interact with its 
environment. It has a well defined boundary which keeps the environment 
from influencing the system directly. Most computer systems may be 
considered as closed systems. This is because, it accepts only previously 
defined inputs, processes them and provides previously defined outputs. 
In summary, the relatively closed system is one that has only controlled 
and well defined inputs and outputs. It is not subject to disturbances from 
outside the system.  
The concept of open and closed system is diagrammatically shown in fig 
2.8 
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disturbance 
        inputs 
     
           Open System 
   Fig 2.8: Concept of Open and Closed Systems. 
 
 
iii. Social and Machine Systems: - 

Systems made up of people may be viewed purely as social system. 
Business organizations, government agencies, political parties, etc are 
examples of social systems. 
Machine system is made up of machine or machines only. Such systems 
would have to their own inputs and maintain themselves. Solar power 
system may be in this category except for its creation. Most empirical 
systems are man-machine or socio-technical systems with people and 
machines forming part of the system. 

iv. Adaptive and non-adaptive systems: - 
 A system that reacts to its environment in such a way as to improve its 
functioning is called an adaptive system. Most biological systems are 
adaptive systems. They change with the changes in their environment to 
ensure their survival. A non adaptive system does not change with changes 
in its environment. It is free from its environmental influences and may 
degenerate eventually. 

v. Natural and Artificial Systems : - 
   Natural systems abound in nature such as solar systems and water 

system. They are not the result of human effort. Artificial systems are 
man-made. Examples of artificial systems are transport system, 
communication system etc. 

vi. Permanent and temporary systems : - 
 Systems enduring for a long time relative to the people belonging to the 
system are called permanent systems. Most man-made systems are 
permanent systems. Temporary systems are designed to last only for 
limited period of time. Once the purpose is achieved such systems cease to 
exist. 

 
2.6  Subsystem :- 
 
Each system seems to be nested in a larger system. Smaller systems within a 
system are called subsystems. Super systems refer to extremely large and 
complex systems. Systems exist at an infinite number of levels of scale. Foe 
example, the system of education can be classified into global education system, 
national educational system, state education system, block education system, 
panchayat education system and so on. Each subsystem may have many inputs 
and many outputs. Between subsystems many interconnections are required for 
the exchange of input and output. The number of interconnections or interfaces 
rapidly rises when the number of subsystems rises. 
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Algebraically, the number of interconnections (N) in a system is   
 
N = ½  n (n-1)         - - - - - - -         (1) 
 
Thus a system with eight subsystems (n) will have 28 interconnections, 

and a system with 10 subsystems will have 45 interconnections. Though not all 
subsystems interconnect with all others, yet very large number of 
interconnections exist in most systems. Since such large number of 
interconnections cause problems in the normal functioning of a system, steps are 
taken to reduce them. 

The need for forming subsystems arises because of the following reasons. 
1. simplification 
2. decoupling, and  
3. decomposition. 

 
1.  Simplification: - 
Most system are complex with large number of interrelated and interdependent 
elements. The complex systems are broken down into lower level systems to 
simplify design, operation and control of systems. Thus simplification is the 
process of organizing subsystems so as to reduce the number of 
interconnections. Some methods of simplification are: 
 

i. clusters of subsystems are established which interact with each other, 
then a single interface path is defined from the cluster to other subsystems 
or clusters of subsystems (Fig 2.9). An example is a database which is 
accessed by many programs, but the interconnection is only through a 
database management interface. 

ii. methods are established for decoupling systems so that the need for 
interconnection is reduced. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  Fig 2.9: (a) All systems are interconnected. 
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Fig 2.9: (b) Systems connected within cluster and clusters interconnected with 
single interface. 
 
2.  Decoupling : - 
 
Subsystems of a system constantly interact with each other for inputs and 
passing of outputs etc. if subsystems are tightly coupled or connected, close so-
ordination is necessary for the smooth functioning of the system. For example, 
exact matching of output of one subsystem with the input of the next subsystem 
requires detailed planning and close co-ordination. The kind of co-ordination is 
very difficult to obtain always. It is therefore common to decouple subsystems. 
Decoupling means loosing the connection, so that the two systems can operate 
in the short run with some measure of independence. Some of the techniques of 
decoupling are described below. 

a. Stock capacity is one way of decoupling. For example, if machine center 
‘A’ stocks raw material enough for a couple of days, even if raw material is 
not issued to it from the store, for a day or two, it does not affect its 
functioning. Similarly, stocking some processed goods at machine center 
‘A’ enables it to transfer output to machine center ‘B’ (which forms input to 
machine center ‘B’) without any pressure on it to immediately process and 
transfer output to B. This kind of decoupling reduces the need for 
communication and co-ordination among subsystems. 
 

b. Data buffers are used in some computer systems to compensate for 
different rates of input and output of data. 

 
c. Standardization is another technique of decoupling which enables 

subsystems to plan and organize their processes without continual 
reference to other subsystems. 

 
d. Advantages of Decoupling : - 

A1 A2 B1 B2

A3 A4 B3 B4



SRINIVAS:MBA:MIS:CH 15  2009 
 

276 
 

Decoupling allows subsystems more independence in planning and control. 
Decoupling by increasing flexibility and independence may encourage initiative 
and self-reliance within individual subsystems. It is likely that with some 
decoupling of subsystems, the system as a whole is better able to deal with 
random and probabilistic movements. 

 
3.  Decomposition :- 
This is a process of breaking down a system into hierarchical subsystems. The 
purpose of decomposition is to make subsystems efficient and effective. The 
process of decomposition is combined with subsystems divided into smaller 
subsystems until the smallest subsystems are of manageable size. The 
subsystems resulting from decomposition process generally form hierarchical 
structure as shown in fig 2.10. In the hierarchy, a subsystem is one element of a 
super system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
               Fig 2.10: Hierarchical relations of subsystems.  
An example of decomposition is the factoring of an information processing 
system into subsystems. Information system divided into subsystems as 

1. Sales and order entry 
2. Inventory 
3. Production 
4. Personnel and payroll 
5. Purchasing 
6. Accounting and control 
7. Planning 
8. Environmental intelligence 
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Each subsystems can be further divided into subsystems. For Example, the 
personnel and payroll subsystem might be divided into the following smaller 
subsystems: 

1. Creation and update of personnel-payroll records 
2. personnel reports 
3. payroll data entry and validation 
4. hourly payroll processing 
5. salaried payroll processing 
6. payroll reports for management 
7. payroll reports for government 

 
The above subsystems can be further divided into smaller subsystems or  
modules. For example, the hourly payroll processing subsystem might be further 
divided into 

1. calculation of gross pay, deductions and net pay 
2. preparation of payroll register and audit controls 
3. check printing 
4. payroll register and controls output 

 
decomposition into subsystems is used both to analyze an existing system and to 
design and implement a new system. In both cases, the investigator or designer 
must decide how to factor, i.e, where to draw the boundaries. The decisions will 
depend on the objectives of the decomposition and also on individual differences 
among designers; the later should be minimized. 
 

****** 


